To register online with Sonic Foundry, please follow the steps outlined in the registration wizard upon first execution of this application.

Registering your product will provide you with technical support, notification of product updates, and special promotions exclusive only to Vegas 2.0 registered users.

**Registration is required within 7 days of installation or your product will expire.**

Sonic Foundry product registration helps protect against software copyright infringement and allows us to provide support exclusively to registered users.

If you do not have access to the Internet, registration assistance (in English) is available. Please contact our Customer Service Department at:

- **Telephone**: 1-800-577-6642 (toll-free) in the US, Canada, and Virgin Islands.
  +800-000-76642 (toll-free) in Australia, Denmark, France, Germany, Italy, Sweden, UK, Netherlands, and Japan.  
  +608-256-3133, extension 2300 in all other countries.
- **E-mail**: customerservice@sonicfoundry.com
- **Fax**: 1-608-250-1745

* Registration assistance is available by telephone 24 hours per day, seven days per week.

Sales/Customer Service Only (in North America): 1-800-57-SONIC

**Sonic Foundry, Inc.**  
1617 Sherman Ave.  
Madison, WI 53704

**Sonic Foundry Europe**  
PO Box 2903  
2601 CX Delft  
Netherlands
The information contained in this manual is subject to change without notice and does not represent a commitment on the part of Sonic Foundry. The software described in this manual is provided under the terms of a license agreement or non-disclosure agreement. The software license agreement specifies the terms and conditions for its lawful use. No part of this manual may be reproduced or transmitted in any form or by any means for any purpose other than the purchaser's personal use, without written permission from Sonic Foundry, Inc.

Sonic Foundry and Vegas are trademarks of Sonic Foundry, Inc. Ligos, Ligos GoMotion, and LSX-MPEG are trademarks of Ligos Corporation in the US and/or other countries. All other products mentioned in this manual are trademarks or registered trademarks of their respective holders.

© 2000 Sonic Foundry, Inc.
# Chapter Overview

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction</td>
<td>21</td>
</tr>
<tr>
<td>2</td>
<td>Tutorial</td>
<td>45</td>
</tr>
<tr>
<td>3</td>
<td>Getting Started</td>
<td>81</td>
</tr>
<tr>
<td>4</td>
<td>Basic Editing Techniques</td>
<td>109</td>
</tr>
<tr>
<td>5</td>
<td>Advanced Editing Techniques</td>
<td>141</td>
</tr>
<tr>
<td>6</td>
<td>Events</td>
<td>163</td>
</tr>
<tr>
<td>7</td>
<td>Tracks</td>
<td>177</td>
</tr>
<tr>
<td>8</td>
<td>Audio FX</td>
<td>189</td>
</tr>
<tr>
<td>9</td>
<td>Using the Audio Mixer</td>
<td>213</td>
</tr>
<tr>
<td>10</td>
<td>Recording Audio</td>
<td>223</td>
</tr>
<tr>
<td>11</td>
<td>Advanced Video</td>
<td>241</td>
</tr>
<tr>
<td>12</td>
<td>Video FX and Masks</td>
<td>263</td>
</tr>
<tr>
<td>13</td>
<td>Video Transitions and Motion</td>
<td>297</td>
</tr>
<tr>
<td>14</td>
<td>Saving and Rendering Projects</td>
<td>323</td>
</tr>
<tr>
<td>15</td>
<td>Customizing Vegas</td>
<td>341</td>
</tr>
<tr>
<td></td>
<td>Troubleshooting</td>
<td>373</td>
</tr>
<tr>
<td></td>
<td>Glossary</td>
<td>385</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>i</td>
</tr>
</tbody>
</table>
# Table of Contents

1. Introduction ........................................... 21
   Welcome to Sonic Foundry Vegas™ ....................... 21
   System requirements ................................... 22
   Technical Support ..................................... 22
   About this version of Vegas ............................ 23
   Installing Vegas ....................................... 24
   Starting Vegas ......................................... 24
   Registration ............................................ 25
      Registering online .................................... 25
      Registering by telephone .............................. 26
      Registering online from another computer .......... 26
   Using the online Help ................................ 27
      Accessing the Help .................................... 27
   Overview ............................................... 29
      Main window ......................................... 29
      Toolbar ............................................... 30
      Marker bar .......................................... 30
      Ruler ............................................... 31
      Track Header ....................................... 31
      Track View ......................................... 32
      Transport bar controls .............................. 32
      Status bar .......................................... 32
      Scrub control ....................................... 33
      Window Docking Area ................................ 33
      Keyboard command reference ......................... 37
      Cursor indications ................................... 42
   Audio Signal Flow .................................... 43
# Video Signal Flow

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Signal Flow</td>
<td>44</td>
</tr>
</tbody>
</table>

## 2. Tutorial

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting the tutorial folder</td>
<td>45</td>
</tr>
<tr>
<td>Getting Started</td>
<td>47</td>
</tr>
<tr>
<td>1. Voiceover narration (01_voiceover.veg)</td>
<td>47</td>
</tr>
<tr>
<td>Using the Explorer window</td>
<td>47</td>
</tr>
<tr>
<td>Placing the video</td>
<td>48</td>
</tr>
<tr>
<td>Displaying a Video Preview</td>
<td>49</td>
</tr>
<tr>
<td>Playing back the video</td>
<td>50</td>
</tr>
<tr>
<td>Placing the new voiceover</td>
<td>50</td>
</tr>
<tr>
<td>Aligning the new voiceover with video</td>
<td>51</td>
</tr>
<tr>
<td>Editing the voiceover</td>
<td>52</td>
</tr>
<tr>
<td>Aligning the remaining voiceover events</td>
<td>54</td>
</tr>
<tr>
<td>Unlocking the events</td>
<td>55</td>
</tr>
<tr>
<td>Grouping the new voiceover and video</td>
<td>55</td>
</tr>
<tr>
<td>Saving a Vegas project (*.veg)</td>
<td>56</td>
</tr>
<tr>
<td>Summary</td>
<td>57</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Music bed (02_musicbed.veg)</td>
<td>58</td>
</tr>
<tr>
<td>Placing the music bed</td>
<td>58</td>
</tr>
<tr>
<td>Repositioning the voiceover</td>
<td>58</td>
</tr>
<tr>
<td>Adding a volume envelope</td>
<td>58</td>
</tr>
<tr>
<td>Setting the volume envelope</td>
<td>59</td>
</tr>
<tr>
<td>Adding equalization (EQ) to the voiceover</td>
<td>60</td>
</tr>
<tr>
<td>Summary</td>
<td>61</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3. Background video (03_background.veg)</td>
<td>62</td>
</tr>
<tr>
<td>Creating a new video track</td>
<td>62</td>
</tr>
<tr>
<td>Crossfading to a new video event</td>
<td>62</td>
</tr>
<tr>
<td>Inserting a transition effect</td>
<td>64</td>
</tr>
<tr>
<td>Summary</td>
<td>65</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. Overlay titles (04_overlay.veg)</td>
<td>66</td>
</tr>
<tr>
<td>Repositioning the project</td>
<td>66</td>
</tr>
</tbody>
</table>
4. Basic Editing Techniques ........................................109

Getting around ................................................. 109

Making selections .............................................. 111
  Selecting multiple events .................................... 111
  Modifying events in selections .............................. 112
  Selecting a time range ...................................... 112
  Looping playback ........................................... 114
  Selecting events and a time range .......................... 114

Basic event editing ............................................. 114
  Copying events .............................................. 114
  Cutting events .............................................. 116
  Pasting events .............................................. 117
  Duplicating events ......................................... 120
5. Advanced Editing Techniques

Importing media from other projects

Snapping events

Using the event snap offset

Snapping to grid lines

Snapping to grids and rulers

Snapping to markers

Disable snapping

Ripple editing

Ripple editing from the Trimmer

Cutting and deleting in ripple mode

Ripple editing across all tracks (Paste Insert)
Velocity envelope ................................. 171
Envelope Edit Tool ............................... 174
Grouping events .................................. 174
   Creating a new group ............................ 174
   Removing events from a group ................. 175
   Clearing a group ................................ 175
   Selecting all members of a group .............. 175
   Temporarily disabling grouping ............... 175

7. Tracks ............................................ 177
   Working with Tracks ............................. 177
      Adding an empty track ......................... 177
      Duplicating a track ............................ 178
      Deleting a track ................................ 178
      Naming or renaming a track .................... 179
   Organizing tracks ............................... 179
      Reordering tracks .............................. 179
      Changing track color ........................... 180
      Changing track height ......................... 180
   Track Headers .................................... 181
      Using the audio track fader ................... 181
      Muting a track .................................. 181
      Muting all audio or video tracks .............. 182
      Soloing a track ................................ 182
   Audio track envelopes ........................... 182
      Adding a volume or pan envelope ............... 183
      Hiding the audio track envelopes .............. 185
      Removing audio track volume envelopes ....... 185
   Video track envelopes ......................... 186
      Composite Level envelopes ...................... 186
      Fade to Color envelopes ....................... 186
      Envelope Edit tool ............................. 187
Locking envelopes to events ........................................ 187
Rendering to a new track ............................................ 187

8. Audio FX ................................................................. 189
Assigning an audio track to a bus .................................. 189
Assigning an audio track to an auxiliary bus ................. 190
Assigning audio tracks to an Assignable FX ................ 191
Setting up to record into audio tracks ......................... 192
Using Audio FX ......................................................... 193
Bus FX ................................................................. 193
Assignable FX ......................................................... 194
Adding plug-ins ......................................................... 195
Saving customized FX ............................................... 197
Plug-in chains .......................................................... 198
Removing plug-ins from a chain .................................. 199
Saving plug-in chains ................................................. 200
Editing saved plug-in chains ..................................... 201
Organizing your plug-ins ............................................ 201
Non Real-Time Event FX ............................................. 202
Audio plug-ins ........................................................ 203
Equalization (EQ) ...................................................... 204
Compression .......................................................... 206
Using the Noise Gate plug-in ..................................... 209
Using the Dither plug-in ............................................. 210
Additional plug-ins ................................................... 211

9. Using the Audio Mixer ............................................... 213
Using the Mixer window ............................................. 213
Viewing the Mixer window ......................................... 213
Using the Mixer tool bar ............................................ 214
Using the Mixer Preview fader ..................................... 214
Using busses ........................................... 216
   Adding busses to the project ......................... 216
   Deleting busses from the project .................... 217
   Routing busses to hardware .......................... 218
   Working with busses .................................. 219

10. Recording Audio ................................. 223
   Setting up your equipment ............................. 223
      Basic setup ........................................ 223
      Setup with mixer ................................. 224
      Setup with digital multitrack ...................... 224
   Arming the track for recording ...................... 225
      Using the metronome ................................ 226
      Using the Sound Mapper for stereo or mono recording ........................................ 226
      Assigning tracks to input devices .................. 227
   Recording ............................................ 227
      Starting and stopping recording ..................... 227
      Chasing MIDI Time Code ............................. 228
      Recording into an empty audio track ............... 229
      Recording into a time selection .................... 231
      Recording into an event ............................ 232
      Recording into an event with a time selection .... 232
   Working with multiple recorded takes ............... 234
      Previewing takes ..................................... 234
      Choosing an active take after loop recording ....... 235
      Renaming an event take ............................. 236
      Deleting an event take .............................. 237
   Specifying where recordings are stored .............. 238

11. Advanced Video ...................................... 241
   Pan/Crop ............................................. 241
Cropping .......................................................... 241
Zooming .......................................................... 243
Rotating .......................................................... 244
Panning .......................................................... 245
Scrolling titles - Pan/Crop technique ....................... 246
Working with images .......................................... 248
Titles ............................................................... 249
Creating titles from images ...................................... 249
Fading titles ........................................................ 250
Customizing the Video Preview window .................... 252
Optimizing previews ............................................. 253
Video properties and preferences ............................ 256
Project properties - Video tab. .................................. 256
Event properties .................................................. 257
Resampling ....................................................... 258
Media file properties ............................................ 259
Output properties ................................................ 260
Edit Decision Lists (EDL) ...................................... 262

12. Video FX and Masks ........................................ 263
Video plug-ins ................................................... 263
Filters ............................................................... 264
Using a video filter .............................................. 264
Modifying filters ................................................ 266
Ordering filters .................................................. 266
Keyframe animation and filters ............................... 267
Transitioning into an effect .................................... 268
Video filter dictionary .......................................... 269
Correction filters ................................................ 269
Creative filters ................................................... 269
Mask filters ....................................................... 269
Add noise .................................................. 270
Black and White ........................................... 270
Brightness and Contrast ................................ 271
Broadcast Colors ......................................... 271
Chroma Keyer ............................................... 272
Gaussian Blur ............................................... 272
HSL Adjust .................................................. 273
Invert ....................................................... 273
Levels ........................................................ 274
Mask ........................................................ 274
Median ........................................................ 275
Min and Max ............................................... 275
Pixelate ...................................................... 276
Quick Blur .................................................. 276
Sepia ........................................................ 277
Sharpen ...................................................... 277
Threshold ................................................... 278
Waves ........................................................ 279
Generators .................................................. 279
  Color Surface ............................................. 280
  Test Pattern .............................................. 280
  Text ....................................................... 280
Compositing ............................................... 285
  Parent/Child track relationship ..................... 285
Masks ....................................................... 286
  Image masks ............................................. 286
  Masks and tracks ...................................... 288
  Video masks ............................................ 289
  Fine tuning masks ..................................... 290
  Chromakeying .......................................... 292
  Compositing Modes .................................... 295
Transitions ............................................... 296
13. Video Transitions and Motion. .......................... 297

Transitions ......................................................... 297
  Cuts .......................................................... 297
  Fading ......................................................... 298
  Crossfades .................................................... 298

Using Transition effects ......................................... 299
  Adding a transition ......................................... 299
  Adding transitions to the ends of an event .................. 300
  Understanding the A/B roll .................................. 300
  Converting cuts to transitions ................................ 301
  Previewing a transition ..................................... 303
  Modifying a transition ...................................... 303

Keyframe animation .............................................. 305
  Keyframe Controller ......................................... 305
  Adding a keyframe .......................................... 306
  Modifying keyframes ........................................ 306
  Keyframes and transition effects ................................ 307

Video transition dictionary ..................................... 308
  Additive Dissolve ........................................... 308
  Barndoor ....................................................... 309
  Clock Wipe .................................................... 309
  Cross Effect .................................................. 310
  Iris ............................................................. 311
  Linear Wipe ................................................... 311
  Page Peel and Page Roll .................................... 312
  Push ............................................................ 312
  Slide ........................................................... 313
  Spiral .......................................................... 313
  Split ............................................................ 314
  Squeeze ........................................................ 314
  Swap ............................................................. 315
  Zoom ............................................................. 315
Track Motion. .................................................. 316
  Track Motion context menu .................................. 317
  Controlling the Track Motion workspace. .............. 317
  Keyframing and Track Motion attributes. ................ 317
  Shadows and Glow ........................................... 318
  Picture-in-Picture ........................................... 319
  Animating the overlay ....................................... 320
  Scrolling titles - Video Motion technique. .............. 321

14. Saving and Rendering Projects. ................. 323
  Saving your project. ....................................... 323
  Creating a copy of a project (using Save As...). .... 324
  Rendering projects ......................................... 325
  Rendering to an audio format ................................ 326
  Rendering to a video format ................................ 327
  Partial rendering and timeline playback .............. 327
  Rendering to a streaming media format .............. 328
  Using rendering format controls and templates .... 329
  Customizing a render ..................................... 329
  Custom rendering settings ............................... 330
  Audio tab - Custom Settings ............................... 331
  Video tab - Custom settings ............................... 332
  Project tab - Custom settings ............................ 333
  Selecting a video format .................................. 335
  Miscellaneous formats .................................... 336
  Creating *.mp3 files ....................................... 336
  Creating *.wma or *.wmv files ............................ 337
  Creating MPEG files ....................................... 339

15. Customizing Vegas ................................. 341
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dockable Vegas windows</td>
<td>341</td>
</tr>
<tr>
<td>Floating (undocking) a window</td>
<td>342</td>
</tr>
<tr>
<td>Docking a window</td>
<td>342</td>
</tr>
<tr>
<td>Using the Explorer window</td>
<td>344</td>
</tr>
<tr>
<td>Managing your media files</td>
<td>345</td>
</tr>
<tr>
<td>Using the Explorer window Transport bar</td>
<td>347</td>
</tr>
<tr>
<td>Changing the Explorer window views</td>
<td>348</td>
</tr>
<tr>
<td>Changing the Ruler format</td>
<td>349</td>
</tr>
<tr>
<td>Grid spacing</td>
<td>351</td>
</tr>
<tr>
<td>Working with the Toolbar</td>
<td>351</td>
</tr>
<tr>
<td>Moving the Toolbar</td>
<td>351</td>
</tr>
<tr>
<td>Resizing the Toolbar</td>
<td>352</td>
</tr>
<tr>
<td>Hiding and displaying the Toolbar</td>
<td>352</td>
</tr>
<tr>
<td>Reordering the Toolbar buttons</td>
<td>353</td>
</tr>
<tr>
<td>Adding buttons to the Toolbar</td>
<td>354</td>
</tr>
<tr>
<td>Removing buttons from the Toolbar</td>
<td>355</td>
</tr>
<tr>
<td>Using the Time Display window</td>
<td>356</td>
</tr>
<tr>
<td>Changing the Time Display window's settings</td>
<td>356</td>
</tr>
<tr>
<td>Changing the Time Displays colors</td>
<td>356</td>
</tr>
<tr>
<td>Setting the Time Display to monitor MIDI time code</td>
<td>357</td>
</tr>
<tr>
<td>Working with project properties</td>
<td>358</td>
</tr>
<tr>
<td>Summary tab</td>
<td>358</td>
</tr>
<tr>
<td>Audio tab</td>
<td>359</td>
</tr>
<tr>
<td>Video tab</td>
<td>359</td>
</tr>
<tr>
<td>Ruler tab</td>
<td>360</td>
</tr>
<tr>
<td>Using Vegas preferences</td>
<td>360</td>
</tr>
<tr>
<td>General tab</td>
<td>361</td>
</tr>
<tr>
<td>Video tab</td>
<td>362</td>
</tr>
<tr>
<td>Audio tab</td>
<td>363</td>
</tr>
<tr>
<td>Routing tab</td>
<td>365</td>
</tr>
<tr>
<td>Editing tab</td>
<td>366</td>
</tr>
<tr>
<td>Sync tab</td>
<td>367</td>
</tr>
</tbody>
</table>
Troubleshooting ................................. 373
  Why are some of my DirectX plug-ins not working correctly? .............. 373
  Why do I hear gaps in my audio playback? ................................... 373
  QuickTime Video Audio/Video Synchronization Issues ......................... 375
  Why do mono events increase 6 dB when panning a track hard? ............ 375
Trouble-free video: software solutions ............................................ 375
Trouble-free video: hardware solutions ............................................ 376
  Video subsystem ................................................................. 376
  Hard disk .............................................................................. 377
  CPU and RAM (memory) .......................................................... 378
The 2GB limitation ........................................................................... 378
Audio proxy files (*.sfap0) ............................................................... 378
Interlacing and field order ............................................................... 379
Timecode ..................................................................................... 382
  Timecode in Vegas ................................................................... 382
  Troubleshooting DV hardware issues .............................................. 384
Glossary ......................................................................................... 385
Index .............................................................................................. i
Welcome to Sonic Foundry Vegas™

Sonic Foundry Vegas is an innovative and advanced multitrack media-editing system. Vegas was designed to create an efficient audio/video production environment without sacrificing the quality and processing power that you expect from Sonic Foundry. Whether it's the standard and familiar Windows navigation commands or the clean and uncluttered interface, you'll find Vegas to be a tool that will be mastered in minutes. Beneath the unique and customizable interface, you'll find a product that is both powerful and flexible. This table lists some of the features available in Vegas, the perfect multitrack media-editing system for your studio or production environment:

<table>
<thead>
<tr>
<th>Nondestructive editing</th>
<th>Unlimited undo/redo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Includes Ligos GoMotion-powered MPEG-1 and MPEG-2 transcoding and decoding software.</td>
<td></td>
</tr>
<tr>
<td>Automatic crossfade functionality</td>
<td>EQ and compressor inserts available on every track</td>
</tr>
<tr>
<td>Quick-edit media trimmer with direct link to *.wav editor</td>
<td>Simultaneous multitrack record &amp; play</td>
</tr>
<tr>
<td>Loop recording</td>
<td>Plug-in manager</td>
</tr>
<tr>
<td>Real time event resampling</td>
<td>32 assignable DirectX FX sends</td>
</tr>
<tr>
<td>Audio/video scrub control</td>
<td>DirectX Plug-in support</td>
</tr>
<tr>
<td>Edit detail list management</td>
<td>Dual processor support</td>
</tr>
<tr>
<td>Sonic Foundry Perfect Clarity™ audio (*.pca)</td>
<td>Multiple I/O support</td>
</tr>
<tr>
<td>24-bit/96 kHz</td>
<td>MIDI Time Code generate &amp; chase</td>
</tr>
<tr>
<td>26 Auxiliary outputs</td>
<td>Dual monitor support</td>
</tr>
<tr>
<td>Internet streaming file authoring (Windows Media Technologies 4.0 and RealNetworks G2)</td>
<td>Ability to incorporate timeline metadata (markers/captions) for Internet content authoring</td>
</tr>
<tr>
<td>Imports: .wav, .w64, .pca, .aif, .avi, .mp3, .mov (using Microsoft DirectShow), .bmp, .gif, .jpg, .png, .tga, .tif</td>
<td>Exports: .wav, .aif, .pca, .avi, .wma, .wmv, .rm, .mp3 (with optional plug-in), .mov (streaming), .w64</td>
</tr>
</tbody>
</table>
System requirements

Minimum requirements

- Microsoft® Windows™ 98SE, Me, 2000, or NT 4.0 SP4
- CD-ROM drive
- 40 MB hard-disk space for program installation
- Windows-compatible sound card
- Internet Explorer™ 4.0 (included on CD-ROM) or later to view online Help
- 400 MHz processor
- 128 MB RAM
- 16-bit color display

Technical Support

About this version of Vegas

The Vegas family of products includes a number of different versions including Vegas Video and Vegas Audio, in both full and LE versions. All versions boast a suite of professional level multi-track audio tools. Vegas Audio and Vegas Video both include a number of more advanced audio features, while Vegas Video also includes advanced NLE video editing features, making it a true all-in-one multimedia editing solution.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Vegas Video</th>
<th>Vegas Video LE</th>
<th>Vegas Audio</th>
<th>Vegas Audio LE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Tracks</td>
<td>unlimited</td>
<td>2</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Audio Tracks</td>
<td>unlimited</td>
<td>4</td>
<td>unlimited</td>
<td>8</td>
</tr>
<tr>
<td>Compositing</td>
<td>X</td>
<td>alpha only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Track Level Fader</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Video Track Motion</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Preview Window: Action</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Safe, Grid, Isolate Channels</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Envelopes: Fade to Color, and</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Composite Level, Velocity</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Real time effects and processes</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Video Media Generators</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Transitions, FX, and DirectX Video Plug-in</td>
<td>X</td>
<td></td>
<td>crossfades</td>
<td>only</td>
</tr>
<tr>
<td>Support</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DirectX Audio Support</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>DirectX Audio Plug-ins Included</td>
<td>X</td>
<td>X press FX</td>
<td></td>
<td>X press FX</td>
</tr>
<tr>
<td>Xpress FX 1 &amp; 2</td>
<td></td>
<td></td>
<td></td>
<td>Xpress FX 1 &amp; 2</td>
</tr>
<tr>
<td>Rubber audio</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit Depth/Sample Rate</td>
<td>24/96Khz</td>
<td>16/48Khz</td>
<td>24/96Khz</td>
<td>16/48Khz</td>
</tr>
<tr>
<td>Overall level of video control</td>
<td>high</td>
<td>moderate</td>
<td>moderate</td>
<td>moderate</td>
</tr>
<tr>
<td>Ligos MPEG support</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Most versions can be immediately upgraded to a more advanced version over the Internet. From the Help menu, select Instant Upgrade to purchase a license and unlock these more powerful features.

This manual covers all of the features available in all of the various versions of Sonic Foundry Vegas. Since different versions have different features, more advanced features available only in certain versions of Vegas are marked with a special icon.
Installing Vegas

To install Vegas:

1. Insert the Vegas CD-ROM. The Vegas Installation screen appears (if CD-ROM AutoPlay is enabled).

   If CD-ROM AutoPlay is disabled, click on the button and choose Run. In the Run window that appears, type the CD-ROM drive's letter and add :\setup.exe. Click the OK button to start the installation.

2. Click Install Software. The installation process begins.

3. Follow the screen prompts and enter the necessary information when required.

4. At the last screen prompt, click Finish to conclude the installation.

   Note: Vegas uses a Windows 2000 installer for all versions of Windows (e.g. 98SE and NT4). Vegas will install the Windows 2000 installer and then ask you to restart your system.

Starting Vegas

After Vegas has been installed on your computer, there are two ways to start the program.

Using the shortcut Vegas

Double-click the Vegas icon on your desktop upon completion of the installation procedure. This icon is a shortcut to the Vegas program located on your hard drive.

Using the Start button

The second method also allows you to start Vegas right from the desktop.

1. Click the button on the Taskbar. The Start menu appears.

2. From the Start menu, choose Programs.
3. From the **Programs** menu, choose **Sonic Foundry Vegas**. A submenu appears.

4. From the submenu, choose **Sonic Foundry Vegas** to start the program. The registration dialog window appears the first time you run Vegas. Select whether you want to use a limited demonstration version of Vegas, purchase Vegas or if you have already purchased Vegas you can enter your serial number. Once you have registered, this will not appear again.

**Registration**

The registration dialog that appears when you start Vegas allows you to quickly and easily register:

- **Register online** - instantly registers the product over the Internet.
- **Register by phone** - call Sonic Foundry to register manually.
- **Register online from another computer** - if the computer Vegas is installed on does not have an Internet connection, but you have another computer that does.
- **Not register at this time** - allows you to continue using Vegas for a limited time without registering.

**Registering online**

When you register online, one click is all it takes to instantly register Vegas.

**To register online:**

1. Connect your computer to the Internet.
2. Start Vegas. In the dialog that opens, select **I would like to register online**.
3. Another dialog opens that asks you if you want to **Provide information** or simply **Finish my registration**. Select one of these options and click Next.

   - **Provide information** - If you select this option, another dialog opens and allows you to enter some information about yourself. At your request, this information will be held in strictest confidence and will only be used by Sonic Foundry internally to improve our products and services. You may also elect to allow Sonic Foundry to occasionally send you information about the latest updates to Vegas and other exciting multimedia products.
• Finish my registration - If you select this option, registration will be completed without any further delay.

Vegas now automatically connects to Sonic Foundry's registration utility and registers your product.

Registering by telephone

When you register by telephone, a Customer Service Representative will help you to obtain your activation code.

To register by telephone:
1. Select Register by phone.
2. Click the button. A new dialog appears with a box where you can enter the activation code. Your Computer ID number appears below this.

3. Please contact our Customer Service Department at:
   • Telephone*: 1-800-577-6642 (toll-free) in the US, Canada, and Virgin Islands.
   • +800-000-76642 (toll-free) in Australia, Denmark, France, Germany, Italy, Sweden, UK, Netherlands, and Japan.
   • +608-256-3133, extension 2300 in all other countries.
   • E-mail: customerservice@sonicfoundry.com
   • Fax: 1-608-250-1745
   * Registration assistance is available by telephone 24 hours a day, seven days per week.

4. When the Customer Service Representative gives you the activation code, type it in the field.
5. Click the button to activate Vegas and become a fully registered customer.

Registering online from another computer

In situations where Vegas is installed on a computer that does not have access to the Internet, you can use another computer that does have access to acquire and activation code. Since the Activation (registration) Code is base on your computer's individual
identity, it is necessary to generate a registration number based on the computer that Vegas is installed on. Therefore, you need to begin the registration on that computer, save an HTML file with that computer's identity on it to a floppy, and then use that floppy on a computer with an Internet connection to register. The Activation Code and an *.reg file will then be sent to you via e-mail, at which point you can write the number down to use it on the other computer, or transfer the *.reg file to the computer without the Internet connection and double-click the file to automatically register. The Activation Code and *.reg file is based on your computer's ID number and cannot be used on another machine.

Using the online Help

Vegas includes HTML online Help. To view the online Help, you need to have Internet Explorer 4.0 or higher loaded on your system (5.0 is included on the Vegas CD-ROM).

Accessing the Help

The online Help is available in two forms: in a Main Help window or What's This? Help window. Both forms are available via the keyboard (F1) or by clicking the Help menu.

Main Help window

The Main Help window is accessed either by choosing Contents or Index from the Help menu or by pressing the F1 key. This window has three tabs that you can use to find the information that you need.

The Contents tab provides a list of available help topics. Click on a closed book ( ) to open the pages, and then on a topic page ( ).

The Index tab provides a complete listing of the Help topics available. Scroll through the list of available topics or type a word in the text field to quickly locate topics related to that word. Select the topic and click the button.
The Search tab allows you to enter a keyword and display all of the topics in the online Help that contain the keyword you have entered. Type a keyword in the text field and click on the List Topics button. Select the topic from the list and click the Display button.

What's This? Help
What's This? Help allows you to view pop-up descriptions of Vegas menus, buttons, and dialog boxes.

To use What's This? Help:
1. Click on the question mark ( ) in the upper right-hand corner of the dialog box or program workspace. Alternately, you can choose What's This? from the Help menu or press the Shift+F1 keys.
2. The cursor changes to a question mark icon: ( ).
3. Click on an item in the program’s interface.

Tip of the Day
The Tip of the Day displays functional tips to increase your productivity with Vegas. To view and scroll through the Tip of the Day messages, choose Tip of the Day from the Help menu.

PDF manual
There is a *.pdf version of the manual available on the Vegas CD-ROM. The PDF version of the manual contains some information that was written after this manual went to press. To view this manual, you will need Adobe® Acrobat® Reader (also included on the Vegas CD-ROM). Please read the vegas_readme.doc for more information on the latest updates and changes.

Help on the Web
Additional Vegas help and information is available on the Sonic Foundry Web site. From the Help menu choose Sonic Foundry on the Web to view a listing of Web pages pertaining to Vegas and Sonic Foundry.
Overview

Vegas is designed to be an easy-to-use program with many tools that provide power and flexibility when creating and working with multimedia files. Many Vegas operations, menu items, and shortcut keys are consistent with other popular Windows software applications. The following sections are a graphical tour of the Vegas workspace.

Main window

This is the window that appears when you open Vegas. The work area is subdivided into three primary areas: the Track Header, the Track View (or timeline), and the Window Docking Area.

The full version of Vegas Video has many advanced video editing features, as pictured above. Other versions of Vegas have more limited video capabilities (for example limited to only one video track). Please see the README file for more information.
**Toolbar**

The Toolbar allows you to quickly access the most commonly used functions and features in Vegas. From the **Options** menu, choose **Customize Toolbar** to specify which buttons are displayed.

**Marker bar**

The Marker bar is the area where informational tags may be placed, named, and positioned along the project’s timeline. These can serve as cues or reminders highlighting important events in your project.
Ruler

The Ruler is the timeline for your project. You may specify how the Ruler measures time: seconds, measures and beats, frames, etc.

Track Header

This area identifies the track order in your project and contains controls used to determine track compositing and mixing.

Multiple video tracks, compositing, and video effects are only available in the full version of Vegas Video.
Track View

All arranging and editing is done in the Track View. This area contains all of a project’s events.

Transport bar controls

The Transport bar contains the playback and cursor positioning buttons frequently used while working on and previewing your project.

<table>
<thead>
<tr>
<th></th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Record]</td>
<td>Record into track</td>
</tr>
<tr>
<td>![Loop]</td>
<td>Loop playback</td>
</tr>
<tr>
<td>![Play]</td>
<td>Play from beginning of project</td>
</tr>
<tr>
<td>![Play]</td>
<td>Play project from cursor position</td>
</tr>
<tr>
<td>![Pause]</td>
<td>Pause project playback</td>
</tr>
<tr>
<td>![Stop]</td>
<td>Stop playback</td>
</tr>
<tr>
<td>![Move to start]</td>
<td>Move cursor to start of project</td>
</tr>
<tr>
<td>![Move to end]</td>
<td>Move cursor to end of project</td>
</tr>
<tr>
<td>![Move left]</td>
<td>Move cursor left at grid increments</td>
</tr>
<tr>
<td>![Move right]</td>
<td>Move cursor right at grid increments</td>
</tr>
</tbody>
</table>

Status bar

The Status bar is located at the bottom of the main program window and displays information about roughly how much space is left on your computer to record audio (Record Time). During the rendering processes, the left side of the Status bar also contains information about the progress of the render.

The Video Preview window also has its own status bar that displays project specific information.
Scrub control

The Scrub control is used to play your project forward or backward for editing purposes. You may adjust playback speed by setting the Speed Control Marker located beneath the Scrub control.

Window Docking Area

This area allows you to keep frequently used windows available, but out of the way while you are working with a project. To dock a window, simply drag it to the Docking Area. When windows are docked, they are stacked on top of one another. Each window has a tab at the bottom with its name on it. Click the window’s tab to bring it to the top. Drag the handle on the left side of a docked window to remove a window from the Docking Area and float it.

Explorer window - Alt+1

The media Explorer window is similar to the Windows Explorer. Use the Vegas Explorer window to select media files to place into your projects.
Trimmer window - Alt+2

The Trimmer window is a good place to edit any media file. When a media file is placed in the Trimmer window, you may take portions of the event and place them on separate tracks by dragging and dropping. For more information, see Using the Trimmer window on page 154.

Mixer window - Alt+3

The Mixer window gives you access to your project’s audio properties, bus assignments, output levels, and plug-in chains.

Edit Details window - Alt+4

This window serves as a highly detailed and customizable database of all of the events in a project. The database can be organized and sorted according to a large number of attributes.
Plug-ins window - Alt+5
This window organizes all of the plug-ins, effects, and transitions available in Vegas. These are organized in a folder structure and include both audio and video plug-ins.

Video Preview window - Alt+6
This window displays a project’s video event during project editing and playback. For more information, see Customizing the Video Preview window on page 252.

Video will appear during project playback or as the cursor is moved during editing.
Media Pool window - Alt+7

The Media Pool is used to organize the media files that are being used by a project. The information about these files is displayed in a highly flexible database that can be instantly sorted. The Media Pool can also be used to apply effects and plug-ins to media files and can be used to set the specific properties (e.g., Interlace) of these files. For more information, see Using the Media Pool on page 88.

Transitions window - Alt+8

The Transitions window contains all of the transitions available in Vegas. The thumbnails display animated examples of each transition. Transitions can be dragged from this window to the Transition roll between two video events. For more information, see Transitions on page 297.
Keyboard command reference

**Project file commands**
These commands refer to the overall project.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new project</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open existing project or media file</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save project</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Open project’s properties</td>
<td>Alt+Enter</td>
</tr>
</tbody>
</table>

**Window view commands**
These commands display the dockable windows included with Vegas.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track view</td>
<td>Alt+0</td>
<td>Plug-ins</td>
<td>Alt+5</td>
</tr>
<tr>
<td>Explorer</td>
<td>Alt+1</td>
<td>Video Preview</td>
<td>Alt+6</td>
</tr>
<tr>
<td>Trimmer</td>
<td>Alt+2</td>
<td>Media Pool</td>
<td>Alt+7</td>
</tr>
<tr>
<td>Mixer</td>
<td>Alt+3</td>
<td>Transitions</td>
<td>Alt+8</td>
</tr>
<tr>
<td>Edit Details</td>
<td>Alt+4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Edit commands**
These commands refer to the event editing that you can use while you are working on a project.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z or Alt+Backspace</td>
<td>Split event(s)</td>
<td>S</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Shift+Z or Ctrl+Y</td>
<td>Trim/Crop selected events</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Cut selection</td>
<td>Ctrl+X or Shift+Delete</td>
<td>Edge trim either audio or video of grouped events independently</td>
<td>Alt+drag edge</td>
</tr>
<tr>
<td>Copy selection</td>
<td>Ctrl+C or Ctrl+Insert</td>
<td>Open in Sound Editor</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Paste from clipboard</td>
<td>Ctrl+V or Shift+Insert</td>
<td>Mix to new</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Paste repeat from clipboard</td>
<td>Ctrl+B</td>
<td>Mix to Player</td>
<td>Ctrl+Shift+M</td>
</tr>
<tr>
<td>Paste Insert</td>
<td>Ctrl+Shift+V</td>
<td>Mix to Video Preview</td>
<td>Shift+M</td>
</tr>
<tr>
<td>Delete selection</td>
<td>Delete</td>
<td>Rebuild peaks</td>
<td>F5</td>
</tr>
</tbody>
</table>
Cursor placement commands

These commands refer to cursor navigation within the Track View.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to beginning of selection or view (if no selection)</td>
<td>Home or W</td>
</tr>
<tr>
<td>Go to end of selection or view (if no selection)</td>
<td>End or E</td>
</tr>
<tr>
<td>Go to beginning of project</td>
<td>Ctrl+Home or W</td>
</tr>
<tr>
<td>Go to end of project</td>
<td>Ctrl+End or E</td>
</tr>
<tr>
<td>Move left by grid marks</td>
<td>Page Up</td>
</tr>
<tr>
<td>Move right by grid marks</td>
<td>Page Down</td>
</tr>
<tr>
<td>Go to Marker #</td>
<td>0-9 keys (not number pad)</td>
</tr>
</tbody>
</table>

Selection commands

These commands refer to creating time selections or preview ranges.

**Note:** Many of the preceding Cursor placement commands, when combined with the Shift key, are also Selection commands.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range selection (events)</td>
<td>Shift+click range of objects</td>
</tr>
<tr>
<td>Multiple selection (events)</td>
<td>Ctrl+click individual objects</td>
</tr>
<tr>
<td>Snap select to event edges</td>
<td>Ctrl+Shift+Alt+ Left or Right Arrow</td>
</tr>
<tr>
<td>Recover previous selection areas</td>
<td>Backspace</td>
</tr>
<tr>
<td>Select all</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Unselect all</td>
<td>Ctrl+Shift+A</td>
</tr>
<tr>
<td>Select left by grid marks</td>
<td>Shift+Page Up</td>
</tr>
<tr>
<td>Select right by grid marks</td>
<td>Shift+Page Down</td>
</tr>
<tr>
<td>Make a selection during playback</td>
<td>I (in) and O (out)</td>
</tr>
<tr>
<td>Create time selection while dragging on an event</td>
<td>Ctrl+Shift+drag with mouse</td>
</tr>
<tr>
<td>Expand selection one frame</td>
<td>Shift+Alt+Left or Right Arrow</td>
</tr>
</tbody>
</table>
## Playback commands

These commands refer to the playback controls, which are also found on the Transport bar.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/stop playback</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Stop playback</td>
<td>Esc</td>
</tr>
<tr>
<td>Looped playback mode</td>
<td>L</td>
</tr>
<tr>
<td>Scrub playback</td>
<td>Ctrl+drag on cursor on the timeline</td>
</tr>
<tr>
<td>Pause</td>
<td>Enter</td>
</tr>
<tr>
<td>Record</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Play back from any window</td>
<td>Ctrl+Spacebar or F12</td>
</tr>
</tbody>
</table>

## Event commands

These commands apply to selected events.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move selected event(s) right one pixel</td>
<td>Right Arrow number pad 6</td>
</tr>
<tr>
<td>Move selected event(s) left one pixel</td>
<td>Left Arrow number pad 4</td>
</tr>
<tr>
<td>Move selected event(s) up one track</td>
<td>Up Arrow number pad 8</td>
</tr>
<tr>
<td>Slip: move media within event without moving the event</td>
<td>Alt+drag inside the event</td>
</tr>
<tr>
<td>Slip Trim: moves the media with the edge as it is trimmed</td>
<td>Alt+drag edge of event</td>
</tr>
<tr>
<td>Select next take</td>
<td>T</td>
</tr>
<tr>
<td>Select previous take</td>
<td>Shift+T</td>
</tr>
<tr>
<td>Move selected event(s) down one track</td>
<td>Down Arrow number pad 2</td>
</tr>
<tr>
<td>Move selected event(s) right on grid</td>
<td>Ctrl+Right Arrow number pad 6</td>
</tr>
<tr>
<td>Move selected event(s) left on grid</td>
<td>Ctrl+Left Arrow number pad 4</td>
</tr>
<tr>
<td>Trim Adjacent: trims selected event and adjacent event simultaneously</td>
<td>Ctrl+Alt+drag edge of event</td>
</tr>
<tr>
<td>Slide: Trims both ends of event simultaneously</td>
<td>Ctrl+Alt+drag middle of event</td>
</tr>
<tr>
<td>Slide Crossfade: moves crossfade</td>
<td>Ctrl+Alt+drag over a crossfade</td>
</tr>
<tr>
<td>Stretch (compress) the media in the event while trimming</td>
<td>Ctrl+drag edge of event</td>
</tr>
</tbody>
</table>
Track commands

These commands refer to editing functions related to the tracks in your project.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>New audio track</td>
<td>Ctrl+Q</td>
<td>Mark in point (when playing)</td>
<td>I or [</td>
</tr>
<tr>
<td>New video track</td>
<td>Ctrl+Shift+Q</td>
<td>Mark out point (when playing)</td>
<td>O or ]</td>
</tr>
<tr>
<td>Enable/disable snapping</td>
<td>F8</td>
<td>Insert/Show/Hide track-volume envelope</td>
<td>V</td>
</tr>
<tr>
<td>Snap to markers</td>
<td>Shift+F8</td>
<td>Remove track-volume envelope</td>
<td>Shift+V</td>
</tr>
<tr>
<td>Snap to grid</td>
<td>Ctrl+F8</td>
<td>Insert/Show/Hide track-panning envelope</td>
<td>Shift+P</td>
</tr>
<tr>
<td>Ripple edit mode</td>
<td>Ctrl+L</td>
<td>Insert Region</td>
<td>R</td>
</tr>
<tr>
<td>Auto crossfade mode</td>
<td>X</td>
<td>Insert Marker</td>
<td>M</td>
</tr>
<tr>
<td>Edit tool selection</td>
<td>D</td>
<td>Insert Command Marker</td>
<td>C</td>
</tr>
<tr>
<td>Normal edit tool</td>
<td>Ctrl+D</td>
<td>Minimize all tracks</td>
<td>'</td>
</tr>
<tr>
<td>Group selected events</td>
<td>G</td>
<td>Insert Transition</td>
<td>Number Pad: / , * , -</td>
</tr>
<tr>
<td>Ungroup selected events</td>
<td>U</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

View commands

These commands refer to magnification of tracks and the events contained on them.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase track height</td>
<td>Ctrl+Shift+Up Arrow</td>
<td>Zoom out</td>
<td>Ctrl+Down Arrow</td>
</tr>
<tr>
<td>Decrease track height</td>
<td>Ctrl+Shift+Down Arrow</td>
<td>Zoom in</td>
<td>Ctrl+Up Arrow</td>
</tr>
<tr>
<td>Zoom in time (incremental)</td>
<td>Up Arrow</td>
<td>Zoom in (audio only)</td>
<td>Shift+Up Arrow</td>
</tr>
<tr>
<td>Zoom out time (incremental)</td>
<td>Down Arrow</td>
<td>Zoom out (audio only)</td>
<td>Shift+Down Arrow</td>
</tr>
</tbody>
</table>

Miscellaneous commands

These commands allow you to access help related items and refresh the screen.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online help</td>
<td>F1</td>
<td>Shortcut menu</td>
<td>Shift+F10</td>
</tr>
<tr>
<td>What’s This? Help</td>
<td>Shift+F1</td>
<td>Refresh screen</td>
<td>F5</td>
</tr>
<tr>
<td>Change relative keyframe spacing</td>
<td>Alt+drag keyframes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Trimmer commands

These commands apply to the Trimmer window.

Note: Many of the shortcuts that apply to the timeline (e.g. Cursor placement, Selection commands, etc.) also work in the Trimmer.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Media From Cursor</td>
<td>A</td>
</tr>
<tr>
<td>Add Media to Cursor</td>
<td>Shift+A</td>
</tr>
<tr>
<td>Select from Cursor to start project</td>
<td>Ctrl+Shift+A</td>
</tr>
<tr>
<td>Transfer time selection</td>
<td>T</td>
</tr>
<tr>
<td>Transfer time selection</td>
<td>Shift+T</td>
</tr>
</tbody>
</table>

Mouse scroll-wheel shortcuts

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>zoom in on timeline</td>
<td>default mouse wheel behavior</td>
</tr>
<tr>
<td>vertical scroll</td>
<td>Ctrl+wheel</td>
</tr>
<tr>
<td>horizontal scroll</td>
<td>Shift+wheel</td>
</tr>
<tr>
<td>moves the cursor in small incremeats</td>
<td>Ctrl+Shift+wheel</td>
</tr>
<tr>
<td>move cursor one frame at a time</td>
<td>Ctrl+Shift+Alt+wheel</td>
</tr>
<tr>
<td>auto-scrolling</td>
<td>press mouse wheel and move mouse left or right</td>
</tr>
</tbody>
</table>
Cursor indications

The cursor in Vegas changes depending on which functions are available. In Windows, for example, the cursor changes to an hourglass when the system is busy.

<table>
<thead>
<tr>
<th>Cursor</th>
<th>Indicates</th>
<th>Modifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>none</td>
<td></td>
<td>This is the standard arrow cursor that means events can be dragged.</td>
</tr>
<tr>
<td>Trim</td>
<td>none</td>
<td></td>
<td>Position the cursor over the edge of an event and drag to trim the event, shorter or longer.</td>
</tr>
<tr>
<td>Slip Trim</td>
<td>Alt</td>
<td></td>
<td>Position the cursor over the edge of an event, press Alt, and drag to trim. The media within the event moves with the edge. This is useful to preserve the beginning or end of an event while trimming.</td>
</tr>
<tr>
<td>Stretch</td>
<td>Ctrl</td>
<td></td>
<td>Position the cursor over the edge of an event, press Ctrl, and drag the edge to stretch or compress it. This makes the media in the event play slower or faster.</td>
</tr>
<tr>
<td>Slip</td>
<td>Alt</td>
<td></td>
<td>Press Alt and drag on the middle of a clip to move the media within the event without moving the event itself.</td>
</tr>
<tr>
<td>Trim Adjacent</td>
<td>Ctrl+Alt</td>
<td></td>
<td>Position the cursor over the boundary between two adjacent events, press Ctrl+Alt, and drag. Both events are edge trimmed simultaneously.</td>
</tr>
<tr>
<td>Slide</td>
<td>Ctrl+Alt</td>
<td></td>
<td>Position the cursor over the middle of an event, press Ctrl+Alt, and drag to simultaneously trim both ends.</td>
</tr>
<tr>
<td>Slide Crossfade</td>
<td>Ctrl+Alt</td>
<td></td>
<td>Position cursor over a crossfade, press Ctrl+Alt, and drag on a crossfade to move it.</td>
</tr>
</tbody>
</table>
Audio Signal Flow

Audio event → Normalize event → Event ASR

- Pre/Post vol.
- Assignable FX send

Auxiliary send → Track FX

- Track fader
- Pan track
- Mute track

Bus Assign. → Bus Control → Master Fader

FX → Mute

Hardware output
Video Signal Flow

Multiple video tracks and compositing are only available in Vegas Video. This diagram shows the master order of how Vegas processes video information. The first step, Media Interpretation, happens when media files are added to a project. Global effects are applied to the entire project and can be used by dragging an effect onto the Video Preview window.

1. Media Interpretation (interlacing, alpha channel, etc.)
2. Media FX
3. Opacity Envelope
4. Velocity Envelope
5. Event FX & Pan/Crop
6. Transitions
7. Track Envelopes
8. Track FX
9. Track Motion
10. Parent/Child Compositing
11. Track Motion for Parent/Child Groups
12. Track Compositing
13. Video Output FX
Welcome to the Vegas tutorial. This chapter is designed to familiarize you with the basic features and tools of Vegas while creating an actual project.

Note: This tutorial demonstrates many advanced video features (e.g. multiple video tracks and compositing) found only in Vegas Video.

This tutorial will teach you how to place media files in the project, edit them, and save them together into a video file. The files you need to create this sample project are included on the program’s CD-ROM in the tutorials folder. The video length is approximately forty seconds. As you work, you will see how easy it is to master the powerful features that Vegas has to offer. Some of the techniques are only briefly demonstrated here, however, and many complex operations are described in a sentence or two.

There are nine separate sections or steps in the tutorial. Each step has a completed project file included on the CD-ROM. When you have worked through section 1. Voiceover narration, your project should look something like the included project file 01_voiceover.veg. These complete project files can also be used as references if you find any of the explanations in this chapter to be unclear. If you make a mistake during the tutorial, just undo it by pressing Ctrl+Z.

Getting the tutorial folder

Copy the sample media files to your hard drive. The tutorial folder is located on the Vegas CD-ROM.

To install the tutorial:

1. Insert the CD-ROM into the disc drive.
2. Locate the Tutorial folder on the CD-ROM and copy it to your hard drive.
3. After the folder is copied, start Vegas.

**Note:** After copying the files to your hard drive, you may need to re-establish the source media file links. When opening a project file (*.veg) for the first time, Vegas may prompt you to find the media and re-link it to the project. All of the files will be READ ONLY when copied to your hard drive and you will be unable to save changes to them unless you change their properties.

The finished project is called 08_velocity.veg and looks like the illustration below. The project is designed to highlight a few of the features Vegas Video. Some aspects of the project are fairly complex. Use the map below to go to the tutorial section that explains a particular technique.
Getting Started

This tutorial is designed to walk the beginner through a complete project, while at the same time demonstrating a few more advanced techniques. This means that some sections are more difficult than others. By following the instructions explicitly, you should be able to complete the project even if some of the concepts are unfamiliar. There are also a number of terms that may be strange if you have never used Vegas or if you are new to NLE (Non-Linear Editing). Here are some resources outside of this chapter that may be useful.

- Map of the user interface: (pg. 29).
- Glossary of terms: (pg. 385).
- Hold the mouse pointer over items in the user interface to see ToolTips that display the names of the various controls.
- Press F1 and click on an item for a What's This? Help definition.

1. Voiceover narration (01_voiceover.veg)

The first section of this project is a talking-head video that contains the main message. The quality of the audio in the source video (talkinghead.avi) is poor and needs to be replaced with a new voiceover (voiceover.wav), recorded in a studio. While the audio quality of the new voiceover is good, there is some unwanted material that needs to be edited out and removed. Finally, the voiceover needs to be synchronized with the video. While the concepts in this section are fairly easy to understand, the actual process of aligning the voiceover with the talking-head can be difficult. This is a surprisingly common technique used throughout the television and movie industry. The finished project can be used as a reference: 01_tutorial.veg.

Using the Explorer window

The Explorer window allows you to view and access your media files without leaving the work area. This window works just like Windows Explorer.

To open the project folder in the Media Explorer:

1. Locate the \tutorial folder on your hard drive.
2. Select the \tutorial folder so that its contents appear in the media list.
Once a media file is placed into the project, it is contained in an event.

**Placing the video**

In the media files list in the Explorer window, the media files needed for this project are displayed. We are going to place the `talkinghead.avi` file.

**To insert the talkinghead video:**

1. Move the cursor over the timeline.
2. Press **Ctrl + Home** to place the cursor at the beginning of the project.
3. Double-click the media file (`talkinghead.avi`) in the Explorer window. The video portion (stream) is placed on a video track and the audio portion (stream) is placed on an audio track at the cursor's position.

A media file as it appears on the timeline in Vegas is displayed in an event. In fact, there...
are two events on the timeline for the talkinghead.avi: a video event that serves as a window into the video stream of the media file and an audio event that serves as a window into the audio stream. Edits that are made to either of these events do not affect the source media file, talkinghead.avi, in any way.

It is a good idea to label the tracks using the Scribble Strip on the Track Header on the left side of the track. Double-click on the Scribble Strip for the video track and enter “Talkinghead.” You can name the audio track “Talkinghead narration,” but this track will eventually be deleted.

**Displaying a Video Preview**

The Video Preview window shows a preview of your project.

To view and dock the Video Preview, from the View menu, make sure Video Preview is selected. Initially, the Video Preview may be hidden beneath one of the other windows at the bottom of the program in the docking area. Click the Video Preview tab to bring the window to the top so it can be seen.

The Video Preview window can also be freely floated anywhere in the workspace.
Playing back the video

To playback or preview a project:

1. Click the Play button ( ) on the Transport bar to start playing. Playback begins at the current cursor position. If playback starts in the middle of the project, click the Play From Start button ( ) to start playback from the beginning.

2. Click the Stop button ( ) to stop playback.

3. Click the audio track’s Mute button ( ) to mute the video’s audio track.

We are preparing to place and work with the new voiceover. Eventually, we will delete the original audio, but for now it can be used as a reference.

Placing the new voiceover

A new voiceover was recorded in a studio to replace the original audio stream from talkinghead.avi.

Note: The new audio track could have been recorded straight into Vegas. For more information, see Recording Audio on page 223.

To insert the voiceover:

1. In the media list, select the file titled voiceover.wav.

2. Drag the file into the timeline below the lowest track. Vegas creates a new track for it.

3. Click either the Play ( ) or the Play From Start ( ) button to play the voiceover.

4. Click the Stop button ( ) to stop playback.

During playback, the narrator pauses to review notes and cough. These are the type of problems that will be fixed in the next section. The following is a map of the voiceover.
These errors (B and D) will be removed later. Also, during playback you probably saw that the new voiceover and the video are out of sync. Next, we will align the voiceover with the video.

**Aligning the new voiceover with video**

We will now position the voiceover so that it will be synchronized with the video. We will use the poor-quality audio as a reference. Since we can see the audio waveform, synchronizing is made easier.

To make it easier to see the audio events, we can zoom in on the project. There are several ways to manage the project’s view. *For more information, see Changing track height on page 180.*

**To align the voiceover:**

1. Press **Alt+0** or click on the timeline so the Track View (timeline) takes focus of keyboard commands.
2. Press and hold the **Ctrl+Shift** keys.
3. Press either the **↑** or **↓** keys. You will toggle through different Track heights.
4. On the timeline, click and drag the mouse to select a time region.
5. Click either the Play (▶) or the Play From Start (▶) button to play just the time selection. Click the Loop button (↺), on the Transport bar, to have playback loop continuously within the selection.

6. Watch the Video Preview window to see if the new voiceover is roughly in the correct position. This will be fine-tuned later.

7. Click the Stop button (■) to stop playback.

Now would be a good time to double-click the Scribble Strip and rename the new track “Voiceover”.

Editing the voiceover

When you played back the new voiceover, you noticed the interruption errors that it contained. We will remove those errors and synchronize the remaining voiceover to the video. Vegas allows you to edit both time and events. We will use both methods to edit the voiceover.

Locking the original events

Time selection edits affect all tracks in the project unless a specific track is selected. Before we start editing the voiceover, we will lock the original audio and video events, which are our references, to prevent them from accidently being edited.

To lock events:

1. Select both the original video and audio events. Hold down the Ctrl key while clicking on each of these events.

2. From the Edit menu, choose Switches and then Lock.
Editing a time selection

By looking at the waveform, you will see where the “um” and cough occur. You will also see where the narrator is speaking. We will delete the “um” using time selection.

To make a time selection:

1. On the timeline, click and drag to make a time selection where the “um” occurs.

   ![Waveform with time selection](image)

2. Click the Play button (_play_button_ ) to play back the error to ensure that your time selection does not include part of the voiceover that we need.

3. Increase or decrease the time selection by clicking and dragging an edge of the selection.

4. Once the time selection is made, choose Delete from the Edit menu, or press the Delete key to remove the “um.”

Next, we will split the event that contains the narrator’s cough and then delete the error.

Splitting an event using time selection

Splitting creates multiple events from an existing one. We will make a time selection that contains the narrator’s cough and split it from the audio, then delete the cough.

To split the event:

1. On the timeline, click and drag to make a time selection where the cough occurs.

   ![Waveform with time selection](image)
2. Click the **Play** button (play) to play back the error to ensure that your time selection does not include part of the voiceover that we need.

3. Increase or decrease the time selection by clicking and dragging an edge of the selection.

4. Once the time selection is made, choose Split from the **Edit** menu, or press the **S** key to split the event.

---

**Editing an event**

We have the cough as a new event that can now be deleted.

**To delete the cough:**

1. Click the event with the cough.

---

2. From the **Edit** menu, choose **Delete** or press the **Delete** key to remove the cough event.

After the edits have been made, the voiceover should look something like this:

---

**Aligning the remaining voiceover events**

With the voiceover edited, we need to align the remaining audio to the video. When you move events, they snap to other event edges. You may extend or shorten an event’s length by clicking and dragging its edges, which is useful for fine-tuning the alignment. Moreover, you may turn off snapping by choosing **Enable Snapping** from the **Options** menu.
To align the remaining audio:

1. Select the event that begins “This tutorial will introduce you....”

2. Drag the event to the approximate point where the narrator is saying this. Use the original audio as a reference.

3. On the timeline, drag the mouse to select a time region.

4. Click either the Play ( ) or the Play From Start ( ) button to play just the time selection. Click the Loop button ( ), on the Transport bar, to have playback loop continuously within the selection.

5. Watch the Video Preview window to see if the new voiceover is close.

6. Click the Stop button ( ) to stop playback.

7. Repeat the above steps for the event that begins “found in this new....”

Next, we will group the synchronized events with the video and delete the original audio from the project.

Unlocking the events

Earlier, the original video and audio events were locked to prevent changes from being made to them. Since the synchronizing work is done at this point, both of these events can be unlocked, permitting further modification.

To unlock an event:

1. Right-click on a locked event.

2. From the shortcut menu, select Switches and choose Unlock.

Grouping the new voiceover and video

The voiceover and video are synchronized, and we want to make sure that they stay together. The Grouping feature will do that for us. First, we will delete the original audio.

To group events:

1. Select the original audio’s track by clicking it.

2. Right-click and choose Delete from the shortcut menu. The entire track is removed from the project and the new voiceover becomes the first track.

3. Press the Ctrl key and click the video event and the voiceover events to select them.
4. From the **Edit** menu, choose **Group** and then **Create New** or press the **G** key to group the events.

**Saving a Vegas project (*.veg)**

A Vegas project file contains all of the information about a single project. However, it does not contain any media, but maintains the references to media files used in the project.

**To save a project:**

1. Select one of the following to save the Vegas project:
   - From the **File** menu, choose **Save**.
   - Click the Save button ( ).
   - Press **Ctrl+S** on the keyboard.

   The first time you save a project, the Save As dialog appears.

   2. Select the drive and folder where you want to store the project.
   3. Type the project name “MyTutorial” in the **File Name** field.
   4. Click the **Save** button.

   The subsequent times you save the project, the above Save As dialog is bypassed, your existing file name is retained, and your project is updated to include any implemented changes.
Summary

In this section, we replaced the audio from the original video with a cleaner audio track recorded in a studio. Here is what the project should look like at this point:
2. Music bed (02_musicbed.veg)

Adding background music to the talkinghead event is very easy. Using a Track envelope, the volume can be lowered while the narrator speaks and then increased for the remainder of the video.

Placing the music bed

To add the music bed to the timeline:

1. Press the Ctrl+Home key to move the cursor to the beginning of the project.
2. In the media list, drag the musicbed.wav file to the timeline below the lowest track (the voiceover track). A new track is created with the musicbed event on it.
3. Click the Play button ( ) to play the project.

After creating the new track, double-click the Scribble Strip and rename the track “Musicbed.”

Repositioning the voiceover

The music bed is considerably longer than the voiceover portion of the project. Eventually, we are going to add additional video to fill out the project. If you were creating this project from scratch, you might not know exactly where to position the voiceover, but you could roughly position it and fine tune it later. In the case of this pre-planned tutorial, however, we have a pretty good idea where everything needs to be: drag the voiceover group (talkinghead video and voiceover audio) so that the talkinghead event begins at approximately 4.700 seconds.

Adding a volume envelope

The music bed’s volume needs to be lowered (ducked) as the narrator speaks. A track volume envelope can be used to lower the volume, and then raise it again when the narrator finishes speaking. We will use the voiceover’s starting and ending points as a reference for the envelope.

To add a volume envelope:

1. Click the musicbed track or event.
2. From the Insert menu, choose Audio Envelopes and then choose Volume. A blue line appears across the track.
3. On the musicbed event, place the mouse pointer slightly ahead of the voiceover’s starting point. The mouse pointer appears as a hand (右手).

4. Right-click and choose Add Point from the shortcut menu. A square point appears on the envelope line.

5. Repeat step 4 to add three more points on the line, for a total of four. The initial positions of the points is unimportant.

Setting the volume envelope

Now we will use the points on the envelope to lower and raise the volume so that the music bed does not interfere with the voiceover. When you click or hover over a point, information about it appears.

To control the volume over time:

1. Drag the points so that they are positioned with two near the start of the voiceover, and two at the end.

2. Drag the two inner points so that their volume level is at approximately -7.0 dB.
3. Set the outer points so that their volume level is at 0.0 dB.

4. Click the Play (_nonce) or the Play From Start (_nonce) button to play the project and check the timing of the volume envelope.

5. Adjust the outer and inner points along the timeline as needed.

Adding equalization (EQ) to the voiceover

Now that the music is mixed in, you can hear the voiceover has a strong bass quality to it. We will adjust that quality slightly with EQ on the first band.

To adjust the equalization:

1. Click the FX button ( ) on the voiceover's track. The Track FX dialog appears.

   ![Track FX dialog](image)

   You can set the EQ settings by typing in the appropriate field, dragging the slider, or clicking the arrow buttons between the slider and the setting field. The easiest way to adjust the EQ is to drag the numbers on the EQ map, however.

2. Set the Frequency to 160 Hz.

3. Set the Gain to -inf.

4. Set the Rolloff to 12 (dB/oct).

5. Close the Track FX dialog by clicking anywhere outside it.

6. Click the Play (Nonce) or the Play From Start (Nonce) button to play the project with the new EQ settings.
Summary

In this section, we added a music bed to a new track below the narration. The video and audio events from the last section were grouped together so they could be moved further down the timeline. The volume of the music was faded out (ducked) during the narration and back in after it was over. In addition, equalization was used to improve the tone of the voiceover. Here is what the project looks like so far:
3. Background video (03_background.veg)

In this section, we are going to add some video clips to the background. The techniques we are going to focus on are inserting video, crossfading events, and adding transitions. This section of the tutorial can only be completed with Vegas Video.

Creating a new video track

To add a new video event to a new video track:

1. Browse for a video file (powderskier.avi) in the Media Explorer.
2. Drag the media file just below the musicbed audio track. Position the new powderskier event at the beginning of the project.

Since the new video event is being dropped at a location that does not already contain a video track, a new video track containing a new video event is created.

Crossfading to a new video event

One way to transition from one video scene to another is with a crossfade. This is a common technique where one scene fades out while another fades in.

To crossfade between two video events:

1. Browse for a video file (mountains.avi) in the Media Explorer.
2. Drag this file to the “Background” track.
3. Position the new event to the right of the first event (powderskier) overlapping by about a second.

Multimedia projects can get very complicated, so it may be useful to rename the track at this point. Double-click the Scribble strip on the Track header and enter “Background”.

The overlapping region between the two events has an “X” across it, indicating a crossfade.

If you preview the project, you can see the smooth transition between the two. Repeat this procedure to add and automatically crossfade the remaining background video files: beach.avi, fireweed.avi, boat.avi, and sunset.avi. The total length of these events when overlapped should be the same as the music bed. The events can be repositioned by dragging them and trimmed slightly by dragging their edges. The background video track should look something like the illustration below.

Compositing, or video mixing, in Vegas occurs from the top down. Video in higher tracks obscures video in lower tracks. Since there are no video events above the powderskier event, this video is visible on the output. The later part of the powderskier event has a portion of the talkinghead event over it. The talking head completely obscures the lower video events at this point in the project.

**Note:** At this point, the talkinghead event obscures much of the underlying background video, especially the mountain and fireweed events. In Tutorial 7, the Track Motion tool will be used to change this behavior. For now, you can preview the crossfades by soloing the background video track. Click the Solo button ( ) on the Background video track to isolate the video from this track.
Inserting a transition effect

While almost all transitions in the movies and on television are either straight cuts (e.g. no transition) or some type of fade, Vegas also has a number of more interesting transition effects available. One of the easiest ways of doing this is to replace an existing crossfade.

To replace a crossfade transition:

1. From the View menu, choose Transitions to open the Transitions window. This window may already be open by default.
2. Click the Transitions tab in the docking area at the bottom of the workspace.
3. Locate the Iris transition effect.
4. Drag the Iris transition to the crossfade between the beach event and the fireweed event.

A few things happen when you do this. First of all, the track appears to have doubled in size. Second, all events before the transition are on an upper sub-track (known as the A roll) and all events after the transition are on a lower sub-track (known as the B roll). Third, between these two sub-tracks is a very narrow Transition roll, where the Iris transition is containted.

This change, from a simple track to a track composed of a number of rolls, is useful in some situations, but is not really necessary here. You can click the Compact Track button ( ) on the Track Header to hide this detail and simplify the track's appearance. In Compact mode, the two events are split by a diagonal line and the portion of the track to the left of the transition is shifted slightly upward and the portion of the track to the right of the transition is shifted slightly downward.

Before we move on to the next step, select both the musicbed event and all of the video events in the background video track (hold the Ctrl key while clicking on each of these events). Right-click one of the selected events and, from the Group submenu, choose Create New Group. This will allow us to move all of these events as a unit in the next step.
Summary

In this section, a second video track with six new video events was added to the project. The events were arranged such that they overlapped each other by about one second. This created an automatic crossfade at each of the overlapping sections. The final duration of all of the events was made to equal the duration of the **musicbed** event. Finally, one of the crossfades was replaced with an Iris transition effect. Here's what the project should look like so far:
4. Overlay titles (04_overlay.veg)

In this step, we’re going to insert some logos, or titles, into the beginning and ending of the project. This section of the tutorial can only be completed with Vegas Video.

Repositioning the project

The core of the project (the voiceover, music, and background video) is finished. At this point, we want to add a flashy introduction and nice closing. To do this, all of the events in the current project need to be repositioned. One way to do this is to group all of the events together and drag them.

Using the Selection tool

To insert an introduction, it is necessary to move the contents of the project further down the timeline to make room for the new media. Earlier, when there were only four events in the project, selecting and moving everything was a matter of holding down the Ctrl key, selecting all of the events, and then dragging them. This becomes more and more difficult as the project becomes more complex.

To use the Selection tool:

1. Click the Lock Envelopes to Events button ( ) on the Toolbar. This makes the track Volume envelope on the music bed track move with the musicbed event as it is moved.
2. Click the Selection Edit Tool button ( ) on the Toolbar.
3. Drag a rectangle encompassing all of the events to be moved.
4. Group all of these events: right-click one of the selected events and, from the Group menu, select Create New.
5. Drag the group of events down the timeline so that the musicbed and powderskier events begin at the 13.000 second mark.

Inserting the introduction splash

In this section, we are going to insert an introductory sequence at the beginning of the project. Parts of the introduction will overlay, or appear on top of, other video events.
To insert the introduction:

1. Locate implosion.avi in the Media Explorer.
2. Drag implosion.avi onto a blank location on the timeline below the lowest track so that a new track is created. This new event should start at the very beginning of the project.
3. Drag vegas_logo.bmp onto the same track. Position it so that it ends at 13.000, when the powderskier event begins. This means that it overlaps the implosion event by approximately two seconds and an automatic crossfade is created.
4. Click in the Track Header on the left side of the new introduction track and drag the track to the top of the timeline, above the talking head track. This is necessary if the logos are to appear as overlays on top of other video events.

The first track in the project now contains the introductory splash and logo. Double-click the Scribble Strip to rename the track. Like the talkinghead event that appears on top of the background video, the introduction also appears over all lower tracks.

To insert the overlay logo:

1. Drag the corporate_logo.png to a new track at the bottom of the timeline. Double-click the Scribble Strip and rename the track “Overlay.”
2. Drag the Track Header of the new overlay track to the very top of the timeline so that the overlay track is track one, the introduction track is track two, and the talking head track is track three.
3. Position the corporate_logo event so that it also ends where the powderskier event begins.
4. The default duration for an image event is five seconds. Drag the right edge of the corporate_logo event back to the 6.000 second point in the timeline. The duration of the event is now seven seconds.
The corporate_logo event overlaps a large portion of the underlying implosion and vegas_logo events. Events in upper tracks normally completely obscure lower tracks. In this case, however, most of the logo is transparent, so the underlying video shows through, and the corporate_logo appears to float over the rest of the project.

Note: The corporate_logo.png image file used here is a *.png image file which was created in an image-editing program. It has a transparent Alpha Channel that is a part of the file that allows the background video to show through. For more information, see Creating titles from images on page 249.

Duplicating events
To create a sense of a beginning, a middle, and an end to the project. We are going to duplicate both of the logos (the corporate_logo and the vegas_logo) and place the copies at the end of the project.

To duplicate an event:
1. Press and hold the Ctrl key.
2. Drag the corporate_logo event horizontally on the Overlay track. This instantly creates an identical copy of the event.
3. Position the newly duplicated event so that it ends at the same time as the end of the music bed.

4. Drag the left edge of the event back to the 30.000 second mark. The duration of the event is now roughly ten seconds.

5. Duplicate the vegas_logo event in the Introduction track and position it so that it ends with the end of the music bed.

Adding sound effects to the introduction

We are going to add some sound effects to three new tracks at the bottom of the project.

To add a sound effect:

1. Locate the introwarp.wav audio file in Vegas Media Explorer.

2. Drag introwarp.wav to the timeline below the lowest track. This creates a new track with the new introwarp event.

3. Repeat with the remaining two sound effects:
   - introtabla.wav: start - 0.000.
   - introgong.wav: start - 3.500 (timed to match the action of the implosion event).
Summary

All of the media files that are going to be used have now been inserted into the project. The events and tracks have all been repositioned to their final locations. The first track contains the transparent overlay corporate_logo event. The second track has an introductory splash video (implosion event) that fades into the product’s logo (vegas_logo event). That logo, as well as the corporate logo, is repeated at the end of the project. The next four tracks contain the earlier work: the voiceover, the background video, and the music bed. Finally, three audio events were added to three new tracks at the bottom of the project as sound effects for the introduction. Here’s what the project should look like so far:
5. Pan/Crop motion (05_panning.veg)

The Pan/Crop tool can add dynamic motion to video or still image events. We’re going to use it here to animate the corporate_logo event at the end of the project. This is a powerful tool with many advanced features, such as keyframe animation. In this tutorial, we’re going to highlight the tool and show you how it is used, without explaining the complexity of keyframe animation. For more information, see Keyframe animation on page 305.

To animate the second corporate_logo event:

1. Right-click on the second corporate_logo event and choose Pan/Crop Event. The Pan/Crop Event dialog opens.

2. Resize the Crop area at the middle to roughly 168 X 126. Enter the numbers manually in the Size boxes on the left side of the dialog. The small Crop area will zoom in on the corporate_logo event.

3. Reposition the Crop area off of the left edge of the event at roughly -73 X 63 (as pictured). Use the Center boxes on the left side of the dialog to enter the coordinates.

4. On the main workspace, click on a blank space on the timeline at 00:00:32.000 seconds to move the cursor to that position. Use the left and right arrow keys to position the cursor more precisely. Watch the Time Display to the upper left of the timeline to find this position. Then, back in the Pan/Crop Event dialog, click the Sync Cursor button ( ). This button is on the very bottom of the dialog. This will position the cursor on the Keyframe Controller at 32.000 seconds to match the cursor on the timeline.

5. Drag the Crop area to the right edge of the event to 564 X 59. Use the Center boxes to enter the coordinates. The Crop area will now animate, scrolling right across the
corporate_logo event, ending at 32 seconds. Notice that a new, gray keyframe diamond has been created on the keyframe controller.

6. Click on the main workspace timeline at 33.000 seconds to navigate to that point. Click the **Sync Cursor** button ( ) in the Pan/Crop Event dialog.

7. Resize the Crop area to its original size (640 X 480) and position (320 X 240). A new keyframe is created. The result is that the logo appears to zoom out and away between the two final keyframes.
Preview the project to see the results of this procedure (click the Play button below the timeline or press the Spacebar on your keyboard). Again, there is a lot going on here that we have only touched on briefly. If you are not familiar with keyframe animation techniques, much of this might be confusing. Even if you are familiar with keyframe animation, the Pan/Crop Event tool is a complex and powerful tool. For more information, see Pan/Crop on page 241.

Summary

In this section, motion was added to the last corporate_logo event using the Pan/Crop Event tool. The logo flies in from the right across the screen and finally zooms back to its final position. All of this was accomplished using keyframe animation techniques in the Pan/Crop Event dialog.
6. Fades (06_fades.veg)

Fading, whether fading the volume in and out on an audio event or fading to and from black on a video event, is a very easy process in Vegas.

**To fade into a video event:**

1. Position the cursor at the upper-left corner of the implosion event. The cursor changes to a fade icon.
2. Drag the corner towards the center (right) of the event to about 0.500 seconds.

The blue diagonal line that appears represents a fade in from black that lasts half of a second.

**To fade the volume (gain) of an audio event:**

1. Position the cursor at the upper-right corner of the intro song event. The cursor changes to a fade icon.
2. Drag the corner left towards the center of the event to about 11.000 seconds.

This time, a curved white line appears. The audio will smoothly and gradually fade out. This effective technique is used repeatedly (seven times) throughout this project:

- Fade out of the intro song audio event.
- Fade in and out of the first corporate logo event.
- Fade in and out of the talking head event (very briefly).
- Fade out from the first vegas logo event for a duration of about one second.
- Fade into the last vegas logo event for a duration of about three seconds.

**Summary**

In this easy tutorial section, instant fades, both audio and video, were created to fine tune and polish the project.
7. Track Motion (07_trackmotion.veg)

Another method of adding motion to video or still-image events in Vegas is to use the Track Motion tool. This feature adds motion to an entire track and can be used to create picture-in-picture effects and scrolling motion. In this project, the Track Motion tool is going to be used to spin the talking head out of the way and into a picture-in-picture, revealing the previously covered background video, specifically the mountain event.

To create a picture-in-picture:

1. Click the Track Motion button ( ) on the talking head track.

2. On the timeline in the main workspace, click at the 19.400 second mark to move the cursor to this position. Use the left and right arrow keys to position the cursor more precisely. 19.4000 corresponds to where the first part of the speaking ends. The exact time may be slightly different in your recreation of this project.

3. Click the Sync Cursor button ( ) at the bottom of the Track Motion dialog. This moves the Keyframe controller cursor to the same position in time as the main cursor. Since this tool operates on the entire track (as opposed to the Pan/Crop Event tool, which only applies to one event), you probably need to zoom in on the Keyframe controller to reveal more detail. Click the Zoom In button to the lower right of the Keyframe controller until only about 22 seconds of time are showing.

4. Click the Add Keyframe button ( ). The keyframe that is created at this point has the same attributes as the first keyframe at 0.000. Since there is no change between these two keyframes, no animation will occur between them.
5. Move the cursor one-half second down the Keyframe Controller.

6. Resize the Track Motion Area to 180 X 135. Enter these values into the Size boxes on the left side of the Track Motion dialog. The numbers do not have to be precise.

7. Reposition the Track Motion Area to 102 X 162 (lower-left corner). Use the Center boxes to enter these values.

In the one-half second between the two keyframes, the talking head event will quickly shrink from full screen to a smaller window in the lower-left corner, revealing the underlying background video. In this project, two more details were added:

- Select the Shadow option on the Keyframe Controller in the Track Motion dialog. This adds a drop shadow behind the track's contents. The Track Motion Tool and dialog can also be used to create a shadow behind the corporate logo track.
- The talking head track is also spun around. Click the last keyframe on the Position bar on the Keyframe controller and set the Angle to -360°. The track makes one complete rotation in the half-second between the two final keyframes.

Summary

In this section, the Track Motion tool was used to create an animated picture-in-picture effect of the talking head narration. Keyframe animation techniques were used, and a drop shadow was added behind the insert picture for emphasis. As a result of these changes, the previously hidden background video was revealed.
8. Velocity (08_velocity.veg)

Speeding up and slowing down a video event in Vegas can be done a number of ways. One of the easiest is to use a Velocity envelope. This feature is used to speed up the powderskier and then dramatically slow her down again towards the end of the event.

To change the velocity:

1. Right-click the powderskier event and, from the Insert/Remove Envelope menu, choose Velocity. A horizontal blue line appears on the event. This is the envelope.

2. Drag the line up. A ToolTip appears telling you the percent speed increase. Release the line to set the speed increase to approximately 160%.

3. Move the cursor to the 16.000 second mark in the project above the powderskier event and double-click the envelope. This adds a point (node) to the line that serves as a type of keyframe.

4. Double-click further down the line to add another point. Reposition the new point below the first point you added. The ToolTip displays the percentage again. Set this point to about 28%. The entire line after this point moves. The event now plays at 160% speed until it gets to the pair of points, where the video slows to 28% speed.

5. Drag the right edge of the powderskier event left to 19.000 seconds. Trim the left edge of the mountain event to be flush with the end of the powderskier event. This needs to be done to keep the duration of the event consistent with the velocity changes. If this was not done, the event would run out of media to play back and would display a freeze frame after 19.000 seconds project time.

Summary

In this section, the powderskier event’s speed was changed using a Velocity envelope. The envelope was animated so that the video started out playing very quickly and then dramatically slowed down near the end.
9. Rendering the project as an *.avi

Rendering refers to the process of converting the Vegas project into one file and formatting it for the desired playback method: media player, Internet streaming media, CD-ROM, etc. The Vegas project (*.veg) itself is not altered during the rendering process.

The following procedure is broken into two sections: setting the format and applying compression.

Setting the format

Multimedia video files can be saved in a number of formats, such as *.rm or *.mov.

To select a file format:

1. From the **File** menu, choose **Render As**. The Render As dialog appears.

2. Select the drive and folder where you want to save the rendered project.

3. Type a new name in the **File name** field, if necessary.

4. In the **Save as type** drop-down list, select **Video for Windows (*.avi)**.

5. Click the **Save** button.
Applying compression

Compressing video files is an important part of creating a movie. In video, the program that compresses the video is called a codec. It is important in determining the quality and size of the final media file.

To configure the compression:

1. On the Render As dialog, click the Custom button. The Custom Settings dialog appears.
2. Click the Video tab, select Cinepak Codec by Radius (or Indeo Video) from the Video Format list.
3. Click the OK button to close the Custom Settings dialog.
4. Click the Save button on the Save As dialog.

A status bar appears in the lower-left portion of Vegas and a dialog pops up displaying the progress of the render. Upon completion of the render, your new media file is ready for distribution and playback.

Note: You may cancel the rendering process by clicking the Cancel button (X) on the status bar.
Getting Started

Vegas is a new way of creating multimedia productions. Whether you are an experienced multimedia author or a budding novice, the powerful features and capabilities of Vegas are organized to increase both your creativity and your productivity. The following chapter summarizes the basic functions and operations of Vegas.

Projects

The process of creating a multimedia production can be an extremely complicated undertaking, involving hundreds of shots, takes, voiceovers, music beds, and special effects. Organization quickly becomes a critical issue in this process. In Vegas, organization is handled by a small project file (*.veg) that saves the relevant information about source file locations, edits, cuts, insertion points, transitions, and special effects. This project file is not a multimedia file, but is instead used to create (render) the final file when editing is finished.

The greatest advantage of working with projects is not the organizational benefits, however, but the fact that you are working on, and editing, a project file, and not the original source files. When you copy, cut, paste, trim, and otherwise edit your movie, the process is nondestructive. You can edit without worrying about corrupting your source files. This not only gives you a strong sense of security, but it also gives you the freedom to experiment.

To create a new project:

1. From the File menu, choose New. The first time you run Vegas, a new project will automatically be started for you.

2. Enter your project settings on the various tabs:
• **Summary** - Enter any relevant information and reminders about your project.

• **Audio** - Set up the basic audio settings.

• **Video** - Select the format and other video parameters. *For more information, see Project properties - Video tab on page 256.*

• **Ruler** - Choose the way the Ruler is delineated (beats, seconds, etc.).

**Note:** *The easiest way to set the often complex properties on the Video tab is to select a Template that matches your media (e.g. NTSC DV (720x480, 29.970fps)).*

3. Click OK.

4. From the **File** menu, choose **Save**. Enter a name, browse for a location, and click the **Save** button to save your project (*.veg file).

The project settings determined in step 3 can be changed at any time while you are working on a project. From the **File** menu, choose **Properties** to change any of these settings. These settings automatically determine the overall quality of the rendering (creation) of your final video. Carefully setting up the properties at the beginning of your project will save a significant amount of time later. You can override these settings when you are ready to render the final movie.

**Determining the proper video settings**

Since the only way to maintain 100% quality is to match the project’s properties to the final output properties, video files that have been captured to your hard disk from your camcorder already contain all of the necessary project information. This procedure is useful for projects that will eventually be sent back to a camcorder (e.g. DV In/DV out) at full frame size and rate. Very different settings would be used for different types of projects, such as highly compressed streaming video.

To determine a **project’s properties from a video file:**

1. From the **File** menu, choose **Properties**.

2. In the Project Properties dialog, click the **Match Media Settings** button ( ).

3. Browse for a file that has been captured from your camcorder. This file should be unaltered and unedited in any way.

4. Click **OK**.
Vegas will automatically detect the frame size, frame rate, pixel aspect ratio, and field order of this file and set the Project Properties to match. In the Project Properties dialog, enter a name for a Template and click the Save button ( ) to save this information for future use and select the Start all new projects with these settings if most of your projects will typically use these settings.

**Saving the project**

When you save your work, it is saved in a project file (*.veg). Project files are not a rendered media files. The first time a project is saved you will have two options. The one you select will affect the project's file size and its portability.

<table>
<thead>
<tr>
<th>Format</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vegas Project</td>
<td>*.veg</td>
<td>Saves all of the information about a single project. This file format does not contain any media. It saves the references to media files used in the project and project information, such as track FX, envelopes, bus assignments, and output properties.</td>
</tr>
<tr>
<td>Vegas Project with External Media</td>
<td>*.veg</td>
<td>When the Copy all media with project is selected, all of the media in the project will be copied into the same folder as the project file. This option makes transporting the project easy and convenient.</td>
</tr>
</tbody>
</table>

**To save the project:**

1. Select one of the following save methods:
   - From the **File** menu, choose **Save**.
   - Click the **Save** button ( ).
   - Press **Ctrl+S** on the keyboard.

   The first time you save a project, the Save As dialog appears. In subsequent saves, the above dialog is bypassed, your existing file name is retained, and your project is updated to include any implemented changes.

2. Select the drive and folder where you want to store the project.

3. Type the project name in the **File Name** field.

4. Click **Save**.

**Renaming a project (using Save As...)**

After you have been working with your project, you may use the **Save As** command in the **File** menu to save a copy of a project with a new name. This is very useful for backing up different versions of a project. For more information, see **Creating a copy of a project (using Save As...)** on page 324.
Capturing video media

Getting video media onto your computer can be more complex than simply recording an audio file. The Vegas Video software package therefore includes an independent Video Capture application that can be used to capture video from your camcorder or other video source to your computer. To run this application, click the Launch Video Capture button on the toolbar in Vegas. Video Capture is only included with Vegas Video.

Files and events

The objects you work with in Vegas are referred to as media files and events. Tracks are timeline containers where events are placed and arranged.

- **Files** are objects that are stored on your hard disk. In Vegas, you will mostly be working with media files, such as music and video files. Vegas does not operate on, nor change these files. Files can be accessed from Vegas Explorer.
- **Events** are periods of time on the timeline in Vegas that act as windows into media files, either whole or in part. When dragging a media file onto the timeline, you are automatically creating an event that contains that file’s contents. An event can contain video, audio, still images, and some special generated media. The event window may contain only a small portion of a much larger media file. A single media file can be used repeatedly to create any number of different events, since each event can be trimmed independently.

Media files (e.g. *.wav or *.avi) are on your computer’s hard drive and can be accessed from Windows Explorer or from Vegas’ Explorer. Events contain media files, are the most basic unit of editing in Vegas, and can be found on the timeline or in the Media Pool.
### What type of media can you use?

<table>
<thead>
<tr>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.wav</td>
<td>Standard audio format used on Windows-based computers</td>
</tr>
<tr>
<td>*.avi</td>
<td>Standard audio/video format used on Windows-based computers</td>
</tr>
<tr>
<td>*.aif</td>
<td>Standard audio format used on Macintosh computers</td>
</tr>
<tr>
<td>*.mov, *.qt</td>
<td>Quicktime standard audio/video format used on Macintosh computers</td>
</tr>
<tr>
<td>*.bmp</td>
<td>Standard graphic format used on Windows-based computers</td>
</tr>
<tr>
<td>*.mp3</td>
<td>Highly compressed audio file</td>
</tr>
<tr>
<td>*.gif</td>
<td>256 index color, lossless image and animation format widely used on the Internet</td>
</tr>
<tr>
<td>*.jpg</td>
<td>True color, lossy Internet image format</td>
</tr>
<tr>
<td>*.png</td>
<td>True color or indexed color, lossy or lossless Internet image format</td>
</tr>
<tr>
<td>*.tga</td>
<td>True color, lossless image format that supports Alpha Channel transparency</td>
</tr>
<tr>
<td>*.w64</td>
<td>Sonic Foundry proprietary Wave64 audio file that does not have a limited file size (unlike Windows .wav files that are limited to ~2GB)</td>
</tr>
<tr>
<td>*.psd</td>
<td>Adobe Photoshop proprietary image format (flattened)</td>
</tr>
</tbody>
</table>

MPEG (*.MPG) files can also be used with the full version of Vegas Video.

#### Finding media files to use

Media files can be located and inserted into a Vegas project by using the Vegas Explorer window, clicking the **File** menu and choosing **Open** or by dragging directly from Windows Explorer.

**Vegas Explorer window**

The media Explorer window in Vegas is similar to the Windows file management Explorer. You can expand and collapse drives and folders in the tree view. The contents of selected drives and folders appears in the list view.
Note: If you cannot see the Explorer window, it may be under another window. Click the Explorer tab at the bottom of the workspace to display the window. If you do not see the Explorer tab, from the View menu, choose Explorer to display it.

To find media using the Explorer window:

1. From the drop-down list or tree view, choose the drive or folder where the media is located.

   Note: Vegas is preset to display all supported file types. However, you may change the list view to display all files within a selected drive or folder.

2. From the list view, you may place the file into your project by dragging it or double-clicking it.

Using the Open command

You may also find media using the File menu and choosing Open.

To find media using the Open command:

1. From the File menu, choose Open or click the Open button ( ) on the Toolbar.
2. Browse for the media's location in the Open dialog by doing one of the following:
   - Selecting it from the Look in drop-down list.
   - Double-clicking drives and folders in the list view.
   - Typing the file's path in the File name field.
3. Select the media format from the Files of type drop-down list.
4. Click Open to automatically place the file in the project.

**Previewing a media file**

Once you have located media files, you may preview them before placing them in your project. The Explorer window has a mini-transport bar with Play, Stop, and Auto Preview buttons (▶ ▶ ▶). When you preview a file, its stream is sent to the Mixer window's preview bus (for audio files) or to the Video Preview window (for video files).

**To preview a media file:**

1. Select an event in the list view.
2. Click the Play button (▶) to listen to the file.
3. Click the Stop button (■), select a different file, or place the file in the project to stop previewing to the file.

**Note:** To automatically preview selected files, click the Auto Preview button (▶) on the Explorer window's transport bar.

When a media file is placed on a track, one or more events are created that contain, or reference, the entire media file. Each track can contain more than one event. Events can be trimmed to contain only part of a larger media file. There are two basic types of tracks: audio and video. You may place events on separate tracks, or place all events of a similar media type (audio or video) on the same track:
Video tracks have different controls and features, but video events and tracks behave in a similar way to audio events and tracks. If a video file has associated audio, Vegas automatically creates a new track and places the video’s audio on it as an audio event.

Using the Media Pool

Media files, both video and audio, tend to be the largest files on your hard drive. It is therefore not always easy to move them around and it may not be practical to store multiple copies of these files. These files can be dragged into the Media Pool in Vegas to organize them before any editing actually begins. From the View menu, choose Media Pool to open this window if it is not already visible. Adding a media file onto a track will also automatically add it to the Media Pool. Information about individual clips is visible in this window.

- You can control the information that is displayed by right-clicking on the Media Pool and choosing View. This opens a submenu menu containing a list of the available fields.
- Specific fields can be hidden by dragging them off of the Media Pool window.
- The data fields are listed along the top of the Media Pool window and can be reordered by dragging them. Click on the tabs along the top to instantly organize or sort the data according to that criterion.
- The Comments field can be used to add your own annotations to a file’s entry in the Media Pool. Double-click the field to enter text. This information is saved with the project and is not saved with the media file itself.
- Each entry acts as a pointer to the actual source file. Video, audio, image files and generated media can all be organized in the Media Pool. Files that are being used in the project (on the timeline) are automatically inserted into the Media Pool.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Remove All Unused Media From Project</td>
<td>Removes all files in the Media Pool that are not actively being used (not inserted on any tracks and the Use Count = 0).</td>
</tr>
<tr>
<td></td>
<td>Remove Selected Media From Project</td>
<td>Removes the selected media file from the project, but does not delete the source file from your hard disk.</td>
</tr>
</tbody>
</table>
The Media Pool can also be used to control some of the more advanced aspects of individual files and events. For more information, see Pan/Crop on page 241.

Replacing media in events in the Media Pool

The Media Pool contains and organizes events in your project. Since events are windows into, or containers for, media files, replacing the contents of an event is possible. When changing the media file that an event contains, every occurrence of the event on the timeline is updated with the same contents.

To replace media in an event in the Media Pool:

1. Right-click an event in the Media Pool.
2. Choose Replace from the shortcut menu.
3. In the Replace Media File dialog, browse for and select the file that you want to replace the current file.
4. Click the Open button.

Audio Peak files (*.sfk)

Audio Peak files (*.sfk) are special proprietary files that are used by Vegas (and other Sonic Foundry applications) to save information about an audio file's waveform. When an audio file or a video file with an audio track is inserted into Vegas, the audio event is displayed graphically as a waveform (or two parallel waveforms for a stereo audio file). These waveforms take time to process and draw. Depending on the speed of your computer and the complexity of a project, this process can significantly delay the opening of a project or audio file. The solution to this potential problem is the Sonic Foundry Peak file (*.sfk), which saves this waveform information, dramatically cutting down on loading time. The name of the *.sfk file is derived from the name of the source media file. For example, when thunder.wav is opened in Vegas, the companion peak file that is generated is named thunder.sfk. These files are safe to delete at any time, but Vegas will have to regenerate
them the next time the media file is opened. Audio Peak files are saved to the same folder as
the source media. If the source media folder is read-only (e.g. a CD-ROM), the files will be
saved to a temporary directory.

Normally, Vegas automatically handles Peak files, but there may be times when you need to
recreate the Peak files manually. To do this, from the View menu, choose Rebuild Peaks.

A related concept is the Sonic Foundry Audio Proxy File (*.sfap) that is used for the audio
stream of some types of video files. For more information, see Audio proxy files (*.sfap) on
page 378.

Event Basics

Events are the most basic objects in a project in Vegas. An event is something that happens
in time, has a specific duration, and can be video or audio. In Vegas, there are two primary
types of events: audio events and video events.

Audio events are created from audio files on your computer (e.g. *.wav, *.au, or *.mp3) or
can be a part of a video file (e.g. *.avi). An audio event can contain an entire audio file or
only a portion of it. It can be modified with effects to change many of its characteristics,
such as speed, volume and equalization. Audio events can be mixed with other audio events.

Video events are created from video files captured to your computer (typically *.avi, *.mov,
*.qt) or images (*.bmp, *.jpg, *.png or *.tga). A video event can be the whole file or a small
section of that file. It can be modified with filters to change many of its characteristics, such
as speed, color, and size. Video events can overlay other video events and are visual elements
that appear on top of a background video, image or color. Overlays can be video files, still
images, titles or other graphics and logos. Vegas can also generate titles that are contained in
an event on the timeline and in the Media Pool.

You can see from the timeline ruler above that the duration of the event is six seconds.
Within the event, many things can happen. This is a rather complex event, with many
envelopes (blue lines) and effects modifying it; typical events may not be quite this complex.
The important concept to understand about this and other events is that it is not a set shot
or scene, but is instead a period of time filled with some type of media. It could be the video
clip of a boy jumping into the water, a six-second freeze frame, or a twenty-four-second
source video sped up to fit into the six second event. The event is a window into the media
and is distinct from the media file itself.

Video event envelopes are not available in all versions of Vegas.

There are a number of ways to work with events once they have been placed in your project.
The following sections describe basic event-editing techniques.

**Inserting media**

Media files may be inserted into your project by double-clicking them or by dragging them.
Either method places the media file in an event in its entirety in the Track View. After the
file is placed, it becomes an event along the project’s timeline. At this point, the contents of
the event and the media file are identical.

**Drag-and-drop**

You can create a new track by dragging a media file to a blank area on the timeline and
dropping it in place. Vegas tracks can contain multiple events, so you can place different
events next to each other on a track. Video and audio events cannot be mixed on the same
track.

To place multiple events:

1. Select multiple events in the Media Explorer or the Media Pool. Select a range of
   adjacent media files by holding down the `Shift` key and clicking the first and last files in
   the range or select files that are not adjacent by holding down the `Ctrl` key and clicking
   individual files.

2. Right-click and drag the files to the Track View (timeline).

3. Before you drop the files, select a placement option from the pop-up
   menu.

   - Add Across Tracks

   ![Add Across Tracks]

   - Add Across Time

   ![Add Across Time]

   - Add As Takes
For more information, see Working with multiple recorded takes on page 234.

- Video Only and Audio Only allow you to isolate either the video or audio, and add that stream from a multimedia file either across tracks, across time or as takes.

**Note:** A left-click drag-and-drop automatically inserts the events across time. The various modes can also be cycled through by right-clicking (without releasing the left mouse button) while performing the drag-and-drop operation.

**Double-clicking an event**

This method creates a new track and places the event at the cursor's position along the timeline. Once the events are placed, you can move them from one track to another or change their position on the timeline.

**Drag-and-drop or double-clicking a video event**

Video event placement is the same as placing an audio event; drag-and-drop controls timeline placement and double-clicking places the event at the cursor's position. Media files with video frequently include associated audio. When you insert a media file into the timeline, the associated audio is automatically inserted into a separate audio track below the video track. The two associated events are grouped together and behave as a single unit when moved or otherwise edited.
Crossfades
If two events are inserted on the same track and occupy the same space, the events (both video and audio) can be made to automatically crossfade. For more information, see Crossfades on page 298.

When inserting multiple events across time, the events may be set to automatically crossfade one into the next.

**To set the duration of an automatic crossfade:**
1. From the **Options** menu, choose **Preferences**.
2. Click the **Editing** tab.
3. Select the **Automatically overlap multi-selected media when added** option.
4. Set the duration of the automatic crossfade in the **Cut to overlap conversion** section of the dialog by entering an **Amount** in milliseconds (1000ms = one second).

To enable the automatic crossfade feature, from the **Options** menu, make sure **Automatic Crossfades** is selected.

**Moving events along the timeline**
Events may be moved along the timeline individually or as a group. The left edge of an event is its starting point. Therefore, where the left edge lines up on the ruler determines when the event starts.

Events may overlap each other or be placed on top of each other. You may crossfade overlapping events automatically or with envelopes.

**Moving a single event**
You can move an event along the timeline within a track or move it to a different track.

**To move an event:**
1. Select the event by clicking on it. The event is highlighted in the track's color.

2. Drag the event along the timeline.

   If you move the event along the original track’s timeline, the event’s appearance (color) remains the same.

   ![Original track position](image)

   However, you may move the event to a different track. When you do, the event appears as a simple outline and you will see its original track and position on the timeline. Once you release the mouse, the event will assume the new timeline position and track color.

   ![New track and position](image)

3. Release the mouse to place the event.

Moving multiple events

You can move multiple events along the timeline within a track or move them to a different track, similar to the previous procedure. Selected events do not need to be within the same track. You may select events on different tracks and move them as a group along the timeline. Use the `Ctrl` key, the `Shift` key, or the Selection Edit tool ( ) to select multiple events and drag them as previously outlined. For more information, see Selecting multiple events on page 111.

To more precisely move an event, you can nudge it by clicking on the event on the timeline and pressing “4” and “6” on the number pad on your keyboard to bump it one small unit at a time. The amount of movement caused by each nudge is determined by how far the timeline is zoomed in or out. If you zoom in far enough, each nudge can move the event one frame of video at a time or even less.

You can arrange your video events on a single video track or on as many separate tracks as you like. The audio portion of a video clip is inserted into the timeline as a separate audio event. The video and audio events are connected as a single unit (grouped) however, and may be moved together. Right-click either of the grouped events and choose Ungroup to split the video from the audio. Video events are placed on video tracks. If a media file has associated audio, Vegas creates an audio track below the video track.
Once the event is in place, you may move the video event along the timeline, delete its audio, and preview the event in the Video Preview window. For more information, see Drag-and-drop or double-clicking a video event on page 92.

Moving a video event

Moving a video event is identical to moving an audio event. However, a video event may be slightly different in that it may have audio grouped with it. If a video event has audio, Vegas is preset to group the video event with its audio when it is placed. As a result, the video event and its audio will always be moved together along the project's timeline.

To move a video event:

1. Place the mouse pointer on the video event or its associated audio.
2. Drag the events to the desired starting point on the timeline.
3. Release the mouse when the events are in the desired location.

Note: Ungroup a video and audio by right-clicking either event. From the shortcut menu, choose Group, and then Clear.

Removing the video's audio

As mentioned earlier, video events with audio are placed together in your project. However, you may delete the original audio completely or replace it with new audio. This feature is nice for redubbing poor-quality audio.

To remove the audio:

1. Right-click either the video or its audio event to display a shortcut menu.
2. From the shortcut menu, choose Delete.

You can also access delete events by pressing the Delete key or, from the Edit menu, choose Delete.
Track Basics

Multiple video tracks are only available in the video versions of Vegas. The height of individual tracks can also be resized by dragging their borders on the Track header. In the example below, the main video track is fairly large to show the details of the scene while the two tracks above it, which are overlay titles, have been resized to be smaller. For more information, see Changing track height on page 180.

Once an event is placed on a track, Vegas automatically displays track controls that you can use to affect the event or events contained within the track. The following illustration shows the track controls for an audio track. Multiple busses are only available in Vegas Video and Audio, and not in the LE versions.

Scrolling and zooming

Scrolling and zooming in the workspace is simple.

- Click the scroll bar arrows in Vegas to move up and down the tracks or move forward and back along the timeline.
- Drag the scroll bars to move up and down the tracks or move forward and back along the timeline.
- Click the Zoom tools (slider) to reveal more or less of the timeline.
Drag the edge of the Scroll Thumb, found on the scroll bar, to zoom or press the up (↑) and down (↓) arrow keys.

Click the **Zoom Edit Tool** (Zoom) button or, from the Edit menu, choose Editing Tool and then choose Zoom. In this mode, drag on the timeline to draw a rectangle that defines the zoom region.

Vegas also has mouse scroll wheel support:

- The default behavior of the Wheel is to zoom horizontally.
- Shift+Wheel scrolls horizontally (through time).
- Ctrl+Shift+Wheel moves the trackview cursor in small increments.
- Ctrl+Shift+Alt+Wheel moves the cursor in one-frame increments.
- Pressing the mouse wheel activates auto-panning.

Zooming directly controls the accuracy of your editing. Each video event has thumbnail representations of the frames within the event. Depending on how far you have zoomed in on a video event, this thumbnail can be one image representing the entire event, or every frame can be displayed as a thumbnail. At the bottom of the event is a small box with the frame offset, time or timecode in it that indicates the frame shown in the image thumbnail. The small black arrow marks the exact position of that frame in time. When the workspace is zoomed in far enough, each thumbnail is numbered and represents an actual frame in the source video file. At intermediate zoom levels, marks between the frame numbers show the location of intermediate frames. These frame marks are not visible at lower magnifications.
Track number and color

This area identifies the track’s order number in a multitrack project. You may rearrange the track order by dragging selected tracks up or down within the Track Header.

Track color
Change the color by right-clicking and choosing Track Color, and then selecting the color you prefer.

View buttons

These buttons control the track’s appearance (size) in the Track View.

Minimized
Normal
Maximized

Track height can also be controlled by simply dragging the lower edge.
Track FX button

This button accesses Noise Gate, equalization (EQ), and compression FX controls for audio tracks. For more information, see Using Audio FX on page 193. On video tracks, it accesses the video filters, effects, and plug-ins. For more information, see Using a video filter on page 264.

Bus assignment

Multiple busses are only available in Vegas Video and Audio, and not in the LE versions. This button allows you to assign an audio track to a specific output bus. This option is available for projects being mixed for multiple stereo busses. (A bus is where various track signals are mixed together and output.) For more information, see Assigning an audio track to a bus on page 189.

Arm for Record button

This button allows you to prepare an audio track for recording. You may record directly into tracks. A track is ready when you see the recording meter appear on it. For more information, see Setting up to record into audio tracks on page 192.
Mute button

This button enables you to temporarily disable playback of the track, so you can focus on other tracks. When a track is muted, it appears grayed out on the Track View.

Solo button

This button isolates a track's events for playback, while muting the other tracks. If there is only one track of a certain type, for example only a single video track, the button is unnecessary and may not be displayed.

Scribble Strip

This area lets you label a track. Double-click in the strip and type the track's name or right-click anywhere in the Track Header and choose Rename from the shortcut menu and then type the track's name. If you do not see the Scribble Strip, change the track's height. For more information, see Changing track height on page 180.
Volume fader

This fader controls an audio track volume relative to the other tracks when it is played back. Vegas audio tracks are preset at 0.0 decibel (dB). Use this fader to emphasize or de-emphasize a particular track. A track’s volume range is -inf. to 12 dB. Drag the slider left and right to adjust the volume.

![Volume fader image]

**Note:** You may also move the fader by clicking it and using the right or left arrow keys on the keyboard. Press and hold the Ctrl key while dragging for finer control.

Multipurpose slider

If you do not see this slider on an audio track, drag the track’s bottom edge to change its height. This slider controls the track’s stereo panning and auxiliary bus volume (if multiple busses are available). You may select what the slider controls by clicking the label button. Each item’s slider position is independent from the others.

![Multipurpose slider image]

**Note:** The Auxiliary Bus button ( ) is not visible if you are only using one bus in your project or if the version of Vegas you are using does not support multiple busses.
Panning

Vegas audio tracks are preset to center the signal. Move the slider to adjust the signal’s output left or right. As you move the slider, Vegas displays the signal’s percentage going to either the left or right channel. For example, moving the slider to 60%L means that sixty percent of the signal is mixed to the left channel, while forty percent is mixed to the right.

Auxiliary bus

*Multiple busses are only available in Vegas Video and Audio, and not in the LE versions.* Vegas projects that have multiple busses enable you to send audio track signals to primary and secondary (auxiliary) busses. The primary bus is set using the Bus button (A) on a track. For more information, see *Bus assignment* on page 99. The auxiliary bus sends the audio signal to a separate bus independent of the primary bus.

When you select an auxiliary bus, you need to adjust its playback volume with the slider. Auxiliary track volumes are preset to -inf. dB (mute) for playback. For more information, see Assigning an audio track to an auxiliary bus on page 190.

Assignable FX send

*Assignable FX sends are only available in Vegas Video and Audio, and not in the LE versions.* If you add an Assignable FX control to your project, Vegas adds it to the multipurpose slider’s shortcut menu. You will be able to adjust the control’s volume using this slider.

Playback and preview

Vegas allows you to play back your project in two ways: directly from the timeline from within Vegas or by mixing the entire project to a preview file.

Playback from within Vegas

Vegas has a Transport bar that allows you to play back your entire project or portions of your project based on a either a time selection or the current cursor position.
If your project includes video, make sure the Video Preview window is displayed for playback: from the View menu, choose Video Preview or press the \texttt{Alt+6} keys.

To play back an entire project:

1. Click the Play From Start button (\texttt{\textbardbl}) to begin playback at the beginning of the project.
2. Click the Stop button (\texttt{\textbar}) to stop playback.

Most of the time, you will only want to preview a small portion of the project to perfect a section. This can be done by creating a time selection.

To play back a time selection:

1. Place the mouse pointer above the ruler (on the Marker bar). The mouse pointer changes to include a left/right arrow cursor (\texttt{\textleftarrow\rightarrow}).
2. Drag to select the time region. To increase or decrease the time selection, click and drag its start and end points. The time selection is highlighted and the Loop bar appears above the ruler on the timeline.
3. Click the Play button (\texttt{\textbardbl}) to begin playback. Only the non-muted tracks and events within the time selection will play back.
4. Click the Loop button (\texttt{\textbar\textbar\textbar}) to toggle Vegas to continually play back the events within the time selection. Click it again to toggle this feature off.
5. Click the Stop button (\texttt{\textbar}) to stop playback.

By looping the playback, you can repeatedly watch the same section of the project over and over as you make changes to filters and effects in real-time. Selection areas can be quickly defined automatically, depending on what you would like to preview:

- Double-click any event to set the preview range to the duration of that event. This is useful if you are modifying an event with some kind of filter or transition and you want to check the results.
- Press \texttt{Ctrl+Alt+Shift+\textdownarrow} or \texttt{Ctrl+Alt+Shift+\textuparrow} to create a selection area from the current cursor position to the next event edge.

For more information, see Customizing the Video Preview window on page 252.
Playback reference

The following table describes all the playback buttons and keyboard equivalents. You may use these playback functions at any time while working in your project.

<table>
<thead>
<tr>
<th>Button</th>
<th>Keyboard</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rec</td>
<td>Ctrl + R</td>
<td>Begin recording into record-enabled tracks</td>
</tr>
<tr>
<td>Loop</td>
<td>L</td>
<td>Turn on/off loop play during time selection playback</td>
</tr>
<tr>
<td>Scrub</td>
<td>Shift + Space</td>
<td>Begin playback from the start of the project</td>
</tr>
<tr>
<td></td>
<td>Space</td>
<td>Begin playback from cursor position</td>
</tr>
<tr>
<td>Play/Pause</td>
<td>Enter</td>
<td>Pause playback, cursor stops and holds at pause position</td>
</tr>
<tr>
<td>Stop</td>
<td>Space or Esc</td>
<td>Stop playback, cursor stops and returns to prior cursor position</td>
</tr>
<tr>
<td></td>
<td>Ctrl + Home</td>
<td>Place cursor at the beginning of project</td>
</tr>
<tr>
<td></td>
<td>Ctrl + End</td>
<td>Place cursor at the end of the project</td>
</tr>
<tr>
<td></td>
<td>Page Up</td>
<td>Moves the cursor to the left in grid increments (if grid is displayed)</td>
</tr>
<tr>
<td></td>
<td>Page Down</td>
<td>Move the cursor to the right in grid increments</td>
</tr>
</tbody>
</table>

Note: Vegas also supports the use of many multimedia keyboards for controlling playback.

Scrubbing

Scrubbing is a type of timeline playback that gives you precise control over the speed and direction of playback. There are two simple methods of doing this. First, the Scrub Control slider can be dragged back and forth. The further from the center that the handle is dragged, the faster the playback, both forward and in reverse. Below the slider is a small yellow marker that can be used to set the Normal Rate playback speed. This is the speed that the project plays at when the Play button on the Transport bar is clicked.

The second way that a project can be scrubbed is by positioning the mouse pointer over the timeline cursor at a location that is not over any events and holding down the Ctrl key on your keyboard. The cursor changes to a speaker icon. Now, when you left-click, the cursor icon changes again to a pan/scrub icon. When the mouse is dragged left or right, the timeline is scrubbed.
Previewing to media player

A preview file is mixed and rendered according to the project's properties that you set and is played back using the media player associated with the file type.

To mix a project for preview:
1. From the **Tools** menu, choose **Preview in Player**. The Preview dialog appears.
2. Select the file type from the drop-down list.
3. Click **OK** to begin the mixing and rendering process. A progress dialog appears indicating the percent complete of the new file.

**Note:** You may cancel the Preview to Player by clicking the **Cancel** button or the **x** button on the status bar.

When mixing is completed, the associated media player opens and begins playback.

Rendered video previews

Playing a project using the transport controls is used to instantly show how a movie is progressing, but it does not actually render your movie as it will appear in its final form. The preview you see in the Video Preview window may be different from your final movie in a number of ways: frame size, frame rate, and quality. In most cases, this is all you need and it is a real time saver for checking the timing of events in your project. Eventually, you may need to output a full-quality preview of a section of your project. To do this, from the **Tools** menu, choose **Pre-render Video in Loop Region** [Ctrl+M]. For more information, see **Pre-render Video in Loop Region** on page 254.
Rendering a Vegas project

Rendering refers to the process of creating a new media file from a Vegas project. The project file is not affected (overwritten, deleted, or altered) during the rendering process. You may return to the original project to make edits or adjustments and render it again. The following table describes the formats available for rendering your Vegas project:

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Interchange File Format</td>
<td>*.aif</td>
<td>The standard audio file format for audio used on Macintosh computers.</td>
</tr>
<tr>
<td>RealSystem G2</td>
<td>*.rm</td>
<td>The RealNetworks standard for streaming media via the Web. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Vegas EDL</td>
<td>*.txt</td>
<td>This option creates a text version of event placements in the Track View. This text description can then be imported into a database or text application and used as an Edit Decision List.</td>
</tr>
<tr>
<td>Vegas project</td>
<td>*.veg</td>
<td>This option saves the references to media files used in the project. Also saved is project information, track plug-ins, envelopes, bus assignments, and output properties. The *.veg file does not combine events into a single file.</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>*.avi</td>
<td>The standard video file format used on Windows-based computers. This option renders both audio and video into one multimedia file.</td>
</tr>
<tr>
<td>Wave (Microsoft)</td>
<td>*.wav</td>
<td>The standard audio file format used for audio used on Windows-based computers.</td>
</tr>
<tr>
<td>Windows Media Audio</td>
<td>*.wma</td>
<td>The Microsoft audio-only format used to create files for streaming or downloading via the Web.</td>
</tr>
<tr>
<td>Advanced Streaming Format</td>
<td>*.wmv</td>
<td>Microsoft streaming media format for Internet distribution.</td>
</tr>
<tr>
<td>Wave64</td>
<td>*.w64</td>
<td>A Sonic Foundry proprietary wave format that does not have a restricted file size (unlike Windows standard *.wav format which is limited to ~2GB).</td>
</tr>
<tr>
<td>MP3</td>
<td>*.mp3</td>
<td>A subset of the MPEG format for audio compression.</td>
</tr>
<tr>
<td>MPEG-1 and MPEG-2</td>
<td>*.mpg</td>
<td>Some versions of Vegas also support MPEG-1 and MPEG-2 file creation through the use of Ligos GoMotion technology.</td>
</tr>
</tbody>
</table>

There are more detailed instructions for rendering to a specific format later in this manual.
Creating a movie (basic)

Saving, exporting, or creating a final movie file in its most basic form is not difficult. The actual process is called rendering. The final output format depends on the destination of the new media file. Some examples are *.avi, *.mov, *.rm, and *.wmv. For this simple procedure, *.avi is going to be used as an example.

To create a movie:

1. From the File menu, choose Render As.
2. In the Render As dialog box, from the Save as type list, choose Video for Windows (*.avi).
3. Set up the details of your file’s compression. These variables are set automatically by your project’s Preferences. Click the Custom button to change these settings.
4. Enter a name and browse for a destination for your file.
5. Click OK.

The default settings for this movie were set up in the Project Properties when the project was begun. There area a number of output formats and settings available.
Vegas projects are multitrack compilations of events that occur over time. The events in your project are references (pointers) to source media files on your hard drive or other storage device. Vegas is a nondestructive editor, so altering events in your project will not affect the source media files in any way. As a result, editing events in Vegas is as simple as trimming event edges, arranging events, and mixing events along the timeline.

Getting around

When editing and playing back the project, the cursor identifies where you are along the project's timeline. The cursor can also be used to control the placement of events in the project. For more information, see Inserting media on page 91. By clicking and dragging you may select a time range in which you can perform edits, record into, and play back. For more information, see Selecting a time range on page 112.

The cursor may be controlled by the following mouse or keyboard commands.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to beginning of selection or view (if no selection)</td>
<td>Home or W</td>
</tr>
<tr>
<td>Go to end of selection or view (if no selection)</td>
<td>End or E</td>
</tr>
<tr>
<td>Go to beginning of project</td>
<td>Ctrl+Home</td>
</tr>
<tr>
<td>Go to end of project</td>
<td>Ctrl+End</td>
</tr>
<tr>
<td>Move left by grid marks</td>
<td>Page Up</td>
</tr>
<tr>
<td>Move right by grid marks</td>
<td>Page Down</td>
</tr>
<tr>
<td>Go to</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Jump to opposite side of selection</td>
<td>Num. pad 5</td>
</tr>
<tr>
<td>Move left to marker(s)</td>
<td>Ctrl+Left Arrow</td>
</tr>
<tr>
<td>Move right to marker(s)</td>
<td>Ctrl+Right Arrow</td>
</tr>
<tr>
<td>Move left to event edit points including fade edges</td>
<td>Ctrl+Alt+Left Arrow</td>
</tr>
<tr>
<td>Move right to event edit points including fade edges</td>
<td>Ctrl+Alt+Right Arrow</td>
</tr>
<tr>
<td>Make time selection</td>
<td>Shift+Left or Right (arrow)</td>
</tr>
<tr>
<td>Move one frame</td>
<td>Alt+Left or Right Arrow</td>
</tr>
</tbody>
</table>
Jumping the cursor

The cursor can be rapidly jumped to various locations instantly. \texttt{Home} and \texttt{End} jump to the left and right edge of the screen, while \texttt{Ctrl+Home} and \texttt{Ctrl+End} jump to the beginning and end of a project. \texttt{Ctrl+Alt+\leftarrow} or \texttt{Ctrl+Alt+\rightarrow} moves to the previous or next event edge in the active track. Event edges are the start or finish of an event, including transition events. A single video event may therefore have a number of jump points including the start, the end of the transition into the event, the beginning of the transition out of the event, the actual end of the event, and the start/finish of any envelopes. In the illustration below, the arrows mark the locations where the cursor will jump to within this expanded view track. Note especially the second jump, which marks the end of an Opacity envelope.

![Cursor jump illustration]

The cursor can also be skipped ahead and back to the grid units on the timeline. The grid units can be set to display in time units or beats in a measure of music by right-clicking on the timeline ruler and selecting the type of units. To skip the cursor click the \texttt{Skip Ahead} or \texttt{Skip Back} buttons. The cursor will skip two grid units for every click of these buttons.

Frame-by-frame movement

The cursor can also be moved frame-by-frame (video frame) through a project or media file.

- Press \texttt{Alt+\leftarrow} or \texttt{Alt+\rightarrow} to move one frame at a time back and forth through a project on the timeline. One frame is defined by the project’s frame rate, configured by clicking the \texttt{File} menu, choosing \texttt{Properties}, and then going to the Video tab.
- Press \texttt{Alt+\leftarrow} or \texttt{Alt+\rightarrow} to move one frame at a time back and forth through a media file that is opened in the Trimmer. One frame is defined by the project’s frame rate.

The cursor can also be moved in the same way by pressing \texttt{Ctrl+Shift+Alt} and using the mouse scroll wheel.

Focus

Focus is used to describe which objects have the attention of a program. The title bars of windows that do not have focus are gray, while windows that have the focus are colored (often blue by default). In Vegas, the focus determines the behavior of many commands and functions. For example, when you double-click a media file in the Explorer, it can be inserted into the track that has the focus. To instantly switch the program’s focus to the Track View (timeline), press \texttt{Alt+0} or, from the \texttt{View} menu, choose \texttt{Focus to Track View}. 
Making selections

Vegas gives you the flexibility to select one or more events, a time range, or events and a time range. All selection options can apply to a single track or to multiple tracks.

To select an event, simply point and click on it.

Selecting multiple events

By using the `Ctrl` key, the `Shift` key, or the Selection Edit tool ( ), you may select individual or multiple events in your project. Multiple events may be selected within a track or across tracks. Once events are selected, you may apply any of the Edit menu commands, switches or editing shortcut keys to them collectively.

Note: Media-specific (audio or video) effects and switches can only be applied to multiple events of the same type (e.g. Normalize can only be applied to multiple audio events).

Whichever method you choose, you may include or exclude events from a selection area by holding down the `Ctrl` key and clicking on an event. The most common mode of operation is to select events by clicking on them while in Normal Edit mode, which is the default editing mode. Click the Normal Edit tool button ( ) or, from the Edit menu, choose Editing Tools and the choose Normal to switch back to this mode.

To select non-adjacent events:
1. Hold the `Ctrl` key.
2. Select the events by clicking on them. To deselect an event, simply click it again to toggle the event selection on or off.

To select a range of events:
1. Hold the `Shift` key.
2. Click the first event that you want to select.

3. Click the last event that you want to select. All events between the first and last selected events are highlighted and selected.

To select a block of events:
1. On the Toolbar, click the Selection Edit Tool ( ).
2. Position the cursor in a corner of the area that you want to select.
3. Click and hold the left mouse button.
4. Drag the cursor to the opposite corner of the area you want to select. A rectangle is drawn on the workspace. All events within this rectangle will be selected.

To deselect individual events in the middle of a selection area, hold the key while clicking on the events. To deselect all of the events, click anywhere in the workspace outside of the selected events.

Hold down the left mouse button and right-click to toggle through the three types of selection boxes: Free, Vertical or Horizontal.

Once events have been selected, they can be grouped together. For more information, see Grouping events on page 174.

Modifying events in selections

Selections can be made of multiple video events only, multiple audio events only or a combination of both video and audio events. Only commands and operations that apply to both types of events can be used for multiple selections that are composed of both audio and video events. For example, Normalize is an audio event switch. Therefore, when you right-click on an audio event and, from the shortcut menu, click Switches, the Normalize command is unavailable if it is part of a selection that also includes video events.

Selecting a time range

Time selections are indicated by a shaded box and a bar that appears on the top of the timeline. You may use the time selection bar for playing back a smaller portion of your project or to apply cross-track edits.
Unless an event is locked, a selected time range affects all events, or portions of events, that occur within the range.

To select a time range:
1. Position the mouse pointer above the ruler (on the Marker bar). The mouse pointer changes to a left/right arrow cursor (\\textarrow{left}), (\\textarrow{right}).
2. Click and drag to select a region. All events, or portions of events within the region are highlighted.
3. Click and drag the yellow handles on either end of the time selection to increase or decrease your time range selection.

\textbf{Note: You may move the entire selection range by dragging the Time selection bar.}

There are a few shortcuts to speed up the process of making precise time selections.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set time selection duration equal to an event's duration</td>
<td>Double-click the event</td>
</tr>
<tr>
<td>Extend selection to the end of the currently selected event edge</td>
<td>Ctrl+Shift+Alt+Left Arrow</td>
</tr>
<tr>
<td>Extend selection to the beginning of the currently selected event edge</td>
<td>Ctrl+Shift+Alt+Right Arrow</td>
</tr>
</tbody>
</table>
Looping playback

If you want to play back the time range, click Play ( ) to listen to only the events within the time range. Click the Loop button ( ) or press the ` key on your keyboard to toggle loop playback on and off. Vegas will continually play back the timeline within the time selection when looping is on.

Selecting events and a time range

Selecting a time range does not automatically select events. Excluding locked events, all items within the time range will play back and be affected by Edit menu commands. However, you may select specific events to edit or play back, and then select a time range.

1. Use the Ctrl key, the Shift key, or the Selection Edit Tool ( ) to select the events. For more information, see Selecting multiple events on page 111.

2. Place the mouse pointer above the ruler (on the Marker bar). The mouse pointer includes a left/right arrow ( ).

3. Click and drag to select the region. Notice that events that were not initially selected in step 1 remain unselected (not highlighted).

Basic event editing

Event editing includes common copying, pasting, and deleting operations. However, these editing procedures and how they are implemented depend on what type of selection is made: event only, time only or event and time selections.

Copying events

Vegas allows you to copy events, or portions of events, to the Clipboard and paste them into your project. You may copy a single event or multiple events. Copying preserves the original event information, edits, and other modifications.

To copy events:
1. Click on the events to select them. For more information, see Selecting multiple events on page 111.

2. Select a time range, if applicable.

3. Copy the event to the Clipboard by doing one of the following:
   - Press the $\text{Ctrl} + C$ keys.
   - Click the Copy button (\text{\small $\mathbf{C}$}) on the Toolbar.
   - From the Edit menu, choose Copy.

Copying selected events

Selected events can also be placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Events before copy" /></td>
<td><img src="image2" alt="Clipboard contents" /></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>

Copying a time selection

Events within the time selection and across all tracks are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Events before copy" /></td>
<td><img src="image4" alt="Clipboard contents" /></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>
Copy a time selection and events

Events and portions of events within the time selection and across all tracks are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="waves1.png" alt="Waveform" /></td>
<td><img src="clipped_wave.png" alt="Clipped Waveform" /></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>

Cutting events

Cutting events removes them from their respective tracks, but places the cut information (events and time) on the Clipboard. Once on the Clipboard, you may paste the information into your project.

**To cut an event:**

1. Click on the event to be cut to select it or select a time range.
2. Cut the event to the Clipboard by doing one of the following:
   - Press the **Ctrl+X** keys.
   - Click the **Cut** button ( ![Cut Button](cut_button.png) ) on the Toolbar.
   - From the **Edit** menu, choose **Cut**.

Cutting events

Selected events are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="waves2.png" alt="Waveform" /></td>
<td><img src="clipped_wave.png" alt="Clipped Waveform" /></td>
<td><img src="clipped_wave.png" alt="Clipped Waveform" /></td>
</tr>
</tbody>
</table>
Cutting a time selection
Events within the time selection are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.jpg" alt="Events Before Cut" /></td>
<td><img src="image2.jpg" alt="Clipboard Contents" /></td>
<td><img src="image3.jpg" alt="Events After Cut" /></td>
</tr>
</tbody>
</table>

Cutting a time selection and events
Events and portions of events within the time selection are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.jpg" alt="Events Before Cut" /></td>
<td><img src="image2.jpg" alt="Clipboard Contents" /></td>
<td><img src="image3.jpg" alt="Events After Cut" /></td>
</tr>
</tbody>
</table>

Pasting events

Once information is copied to the Clipboard, you may choose a variety of ways to paste the Clipboard items. Vegas always pastes from the insertion point’s position along the timeline.

To paste events from the Clipboard:

1. Move the cursor to the desired location on the timeline.

2. Click either the track number or within the track where you want to paste the event. This track is the focus track; there can be only one focus track at a time.

   If you are pasting multiple events from different tracks, Vegas automatically creates new tracks as needed.
3. Paste the event into the track by doing one of the following:

- Press the Ctrl+V keys.
- Click the Paste button ( ) on the Toolbar.
- From the Edit menu, choose Paste.

Clipboard events are pasted at the cursor position on the track. Existing track events can be overlapped with newly pasted information.

<table>
<thead>
<tr>
<th>Clipboard contents</th>
<th>Events before paste</th>
<th>Events after paste</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Clipboards" /></td>
<td><img src="image" alt="Events before paste" /></td>
<td><img src="image" alt="Events after paste" /></td>
</tr>
</tbody>
</table>

**Paste repeat (Ctrl+B)**

You specify how many times the Clipboard events are pasted at the cursor position on the selected track and specify the space between each pasted event.

After you have copied something to the Clipboard, do one of the following:

- Press Ctrl+B on your keyboard.
- From the Edit menu, choose Paste Repeat.

Vegas displays the Paste Repeat dialog. Specify the number of times to paste the Clipboard contents and the space between successive copies. Click OK when finished.

**Paste insert (Ctrl+Shift+V)**

Clipboard events are placed at the cursor position on the selected track and existing events on a track are moved further down the timeline by the total length of pasted information. This action is similar to Ripple editing. For more information, see Ripple editing on page 145.

After you have made your selection and copied it to the Clipboard, do one of the following:
• Press the Ctrl+Shift+V keys.
• From the Edit menu, choose Paste Insert.

<table>
<thead>
<tr>
<th>Clipboard contents</th>
<th>Events before paste</th>
<th>Events after paste</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Clipboard contents" /></td>
<td><img src="image2.png" alt="Events before paste" /></td>
<td><img src="image3.png" alt="Events after paste" /></td>
</tr>
</tbody>
</table>

**Punch-In**

You can insert video events into the middle of (on top of) existing events without altering the timing of the project. When the inserted event ends, the video jumps back to the original event that then continues playing as if it had never stopped. Any associated audio is inserted into a new track and is mixed with the audio from the other event.

**To automatically crossfade Punch-Ins:**

1. From the Options menu, choose Preferences. The Preferences dialog appears.
2. Click on the Editing tab.
3. Select Fade edit edges of video events and specify a duration for the transition.

Events that have previously been inserted or punched-in will not be affected by this change. The concept of punching in and out only applies when you are inserting an event that is shorter than the event that it is being inserted into, so that the inserted event ends before the original event. In the following illustration, every frame is numbered so you can see how the original event continues after the inserted event ends, as if it continued to play underneath the original.

![Timeline Illustration](image4.png)
Ripple edits
It is possible to insert a clip into the original, dividing it into two parts and moving the second part down the timeline. When the inserted event ends, the original resumes playing at the cut point (this is sometimes referred to as a “film-style insert”).

To perform a ripple edit:
1. Position the cursor at the insertion point for the new event.
2. Make sure ripple editing is turned on. Click the Ripple Edits button or, from the Options menu, choose Ripple Edits [CTRL+L] to toggle ripple editing on and off.
3. Open the media file you want to insert in the Trimmer. For more information, see Using the Trimmer window on page 154.
4. Create a selection area in the Trimmer of the section of the media files that you want to use.
5. Click the Add media from cursor button.

Note the frame numbers of the original event in the illustration below. For more information, see Ripple editing on page 145.

Duplicating events
Duplicating is a combination of a copy and paste in one action.

To duplicate an event:
1. Hold the [Ctrl] key on your keyboard.
2. Drag the event you want to duplicate to the place where you want the new event to be positioned.

The process is like moving the event to a new position while leaving a copy behind. This technique is a great way to copy the attributes of an event (e.g. filters, stretching, envelopes) and apply them to a new media file.

To copy attributes to a new video event:
1. Duplicate the event with the desired attributes (switches, envelopes, filters, etc.).
2. Using Vegas Explorer, locate the video file that you want to copy the attributes to.
3. Right-click the file and drag it to the duplicated (new) event.
4. From the shortcut menu, choose *Add as Takes*.

5. The new media file becomes the Active take. You can delete the original take.

Basically, what you are doing is duplicating an event and then replacing the contents with new video. *For more information,* see *Takes* on page 151. If you only want to apply a specific filter with particular settings to another event, save the filter settings to a preset for future use. *For more information,* see *Modifying filters* on page 266.

**Empty events**

You can insert events into the timeline that do not have any contents and are not references to any media files. This can be useful as placeholders in the timeline to be filled with media at a later time or can be used to create specific events that are to be recorded into at a later time. In either case, the new media is added to the empty event as a take. *For more information,* see *Takes* on page 151. To add an empty event to a track, from the *Insert* menu, choose *Empty Event*.

It is also possible to make space in a project by inserting time into a track. To insert a period of time into a track, from the *Insert* menu, choose *Time*.

**Trimming events**

To edge trim a video event:

1. Insert an event into the Timeline.

2. Move the cursor over the edge of the event.
   
   The cursor changes when properly positioned ( ).

3. Drag the edge of the event to trim.

During the trimming process, the last thumbnail image on the event shows the last frame in the event, allowing you to edit events very accurately. In the lower-left corner of the thumbnail you can see the frame number within the event where the trimming will occur. Events cannot be trimmed back from their starting point towards an earlier position on the timeline unless the beginning has been previously trimmed. However, you can extend a video event beyond its end, in the process making it longer. The extended section is simply the last frame of the video file repeated (a freeze frame) for the remaining duration. You can tell that it is a freeze frame because the frame indicated (the last frame in the event) will not change as you lengthen the event. A notch also appears at the point in the event where the video ends and the thumbnails begin repeating. Since a multimedia file often has both a video and an audio component, both events are trimmed as a group (unless you ungroup them). *For more information,* see *Looping an event* on page 165.
Trimming events removes all media outside the time selection from their respective tracks. The removed information is not placed on the Clipboard. Trimming is different from cutting in that the events within the time selection are preserved.

**To trim an event based on a time selection:**

1. Select a time range.
2. Press the Ctrl+T key or, from the Edit menu, choose Trim.

Events outside the time selection are removed from the project. However, the time information (space) between events is not removed.

### Trim time and event selection

Only selected events outside the time selection are removed from the project. Unselected events remain. The time information (space) between events is not removed.

### Splitting events

Vegas allows you to create multiple, independently functioning events from a single event by splitting it. Splitting creates a new ending point for the original event and creates a starting point for the newly created event.
Splitting an event does not alter the original media. The original media file’s information is there, but omitted for playback based on where the event’s starting or ending point occurs on the timeline.

When initially split, the two new events are flush against one another. The two events can be moved independently.

**To split an event:**

1. Select the event to be split.

   To split multiple events, use the `Ctrl` key, the `Shift` key, or the Selection Edit Tool (房东) to select the events. *For more information, see Selecting multiple events on page 111.*

2. Place the cursor at the timeline position where the split will occur.

3. Split the event(s) by doing one of the following:
   - Press the `S` key.
   - From the **Edit** menu, choose **Split.**
Splitting all multiple events
All events will be split at the cursor’s position (unless the event is locked). The split will occur across all tracks (if no events are selected).

<table>
<thead>
<tr>
<th>Events before splitting</th>
<th>Events after splitting</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram" /></td>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

Only the selected events will be split at the cursor’s position.

<table>
<thead>
<tr>
<th>Events before splitting</th>
<th>Events after splitting</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Diagram" /></td>
<td><img src="image4.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

Splitting time only selection
Unless locked, all events within the time selection will be split at the starting and ending points of the time range, meaning that two splits will actually be made. The split will occur across all tracks.

<table>
<thead>
<tr>
<th>Events before splitting</th>
<th>Events after splitting</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Diagram" /></td>
<td><img src="image6.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>
Splitting time across multiple events

Only selected events within the time selection will be split at the starting and ending points of the time range.

<table>
<thead>
<tr>
<th>Events before splitting</th>
<th>Events after splitting</th>
</tr>
</thead>
</table>

Shifting the contents of an event

Events in Vegas are defined by their duration and not by the actual content. Typically, an event contains a portion of a larger source media file saved somewhere on your computer. For example, you could have an event that contains only the ten seconds (e.g. from 00:40 to 00:50) of a one minute long video file. The actual footage it contains can be modified in a number of ways, including shifting it to encompass, for example, from 00:20 to 00:30 in the original video file. Again, any associated (grouped) audio will remain in sync with the video.

To shift the contents:

1. Hold the Alt key.
2. Drag left or right on a video event.
3. Watch the contents of the thumbnails and the frame numbers to position the video displayed within a video event or the waveform in an audio event.
The power of working this way is that the event operates as a placeholder or container in time for the media clip. The project as a whole remains unaltered as you fine tune the exact contents that will fill a particular event.

Deleting events

Deleting events removes all events within the time selection from their respective tracks. Multiple events can be deleted and time selections can be used to modify the process. Ripple editing also applies to delete actions. Deleting operates exactly like a cutting operation, but the removed information is not placed on the Clipboard. For more information, see Cutting events on page 116.

To delete an event:

1. Click on the event to be deleted to select it or select a time range.
2. Delete the event(s) by doing one of the following:
   - Press the Delete key.
   - From the Edit menu, choose Delete.
Crossfading events

Vegas allows you to crossfade between two events (audio and video) on the same track. Crossfading gives you the ability to fade out one audio event's volume while another event's volume is fading in on or to transition between two video events, one fading out while the other fades in. Lines appear indicating how and when the event's volume or transparency is being affected.

Automatic crossfades

The Automatic Crossfade feature turns the overlapping portions of two events into a smooth crossfade. Click the Automatic Crossfade button (a) or press the X shortcut key to enable or disable Automatic Crossfades.

The crossfade “x” will automatically adjust itself as you move one event over another as long as one event's edge is crossing the other event’s edge. In the case where edges do not cross (one event is wholly contained in another), the shorter event will be placed on top of the longer event. Automatic crossfade can be toggled on and off: from the Tools menu, choose Automatic Crossfade. You may still set a crossfade in this situation. Use the event's handles to adjust the desired crossfade between the two events.

Manually setting a crossfade

If you are using Automatic Crossfades, Vegas will not insert a crossfade if a shorter event is placed on top of and within the same time frame of a longer event. In this case, the longer event will begin playing, then the shorter event will play, and then the longer event will resume playing at the timeline position.

To manually set the a crossfade between the edges of the overlapping events:

1. Place the mouse pointer on one of the shorter event's handles. The envelope cursor will appear (x).
2. Click and drag the handle to the desired position.
This is a very fast and effective method of inserting a voice-over on top of a background music track (although the music will fade out completely) or to replace a bad section of audio. For more information, see Punch-In on page 119.

Changing crossfade curves

You can set the crossfade curve(s) that Vegas uses to fade in and out between two events. The crossfade curves determine how Vegas raises and lowers the events’ volumes over time.

To change the crossfade curve:

1. Right-click anywhere in the crossfade region to display a shortcut menu.
2. From the shortcut menu, choose Fade type to display the fade types submenu.
3. Click the desired fade type.
Undo and Redo commands

Vegas gives you unlimited undo and redo functionality while working on your project, even to the extent of being able to undo changes made before the last time a project was saved (but not closed). While you are working with a project, Vegas creates an undo history of the changes that you have performed. Each time you undo something, that change is placed in the redo history.

When you close the project or exit Vegas, both the undo and redo histories are cleared.

Undo command

Pressing the Ctrl+Z keys or Undo button ( ) on the Toolbar will undo the last edit performed. Repeatedly using the keyboard command or Toolbar button will continue undoing edits in reverse order, from most recent to oldest. In addition, you may undo the last edit by choosing it from the Edit menu.

Undoing a series of edits

Click the arrow to the right of the Undo button ( ) on the Toolbar to view a history of your edits. A drop-down list appears. The top listed item is the most recent edit. If you want to undo a specific edit that appears farther down the list, all subsequent edits will also be undone as well.

To undo a series of edits:

1. Click on the arrow to the right of the Undo button ( ).

2. From the drop-down list, choose the edit that you want to undo. Items above it (subsequent edits) will be selected automatically. Click outside the drop-down list to cancel the undo.
3. Click the item to undo it and all selected edits. Vegas will restore your project to the state prior to those edits.

When you undo an edit or a series of edits, they are added to the redo history. This feature allows you to restore your project to a previous state.

**Note:** From the *Edit* menu choose *Undo All* to undo all edits in the history. All edits will be undone and added to the redo history.

### Redo command

Pressing the `Ctrl+Shift+Z` keys or the *Redo* button ( ) on the Toolbar will redo the last undo performed. Repeatedly using the keyboard command or Toolbar button will continue redoing undos in reverse order, from most recent to oldest. In addition, you may redo the last edit by choosing it by name from the *Edit* menu.

**Redoing a series of edits**

The redo history may be viewed by clicking the arrow on the right side of the *Redo* button ( ) on the Toolbar, revealing a drop-down list composed of previously undone edits. The top listed item is the most recent undo edit. If you want to redo a specific edit that appears farther down the list, all subsequent edits above it must be redone as well.

When you redo an edit or a series of edits, they are added to the undo history again. The redo history is cleared when a new edit is performed.

### Clearing the edit history

You may clear both undo and redo histories without closing your project or exiting Vegas. Once the histories have been cleared, Vegas will begin creating new ones as you continue working on the project. While clearing the edit history is not usually necessary, this can be a method of freeing up disk space. To clear the edit histories, from the *Edit* menu, choose *Clear Edit History*. 
Project markers and regions

Vegas allows you to use three types of project markers that identify parts of your project, serve as cues, and provide additional functionality for certain file formats. The three types of markers are:

- **Markers**—points that you place along the project's timeline. They are typically used to mark interesting parts in the project for later reference or to mark timing cues.
- **Regions**—ranges of time. Typically, regions identify ranges of time that you need to get back to later. Regions can function as permanent time selections.
- **Command markers**—are used to enable metadata in streaming media files. These markers can be used to display headlines, captions, link to Web sites, or any other function you define. In addition, these markers can be used to embed Scott Studios data information, which is used extensively in broadcasting. There are a number of metadata examples complete with source code on the Sonic Foundry Web site.

Working with markers

Markers are useful for identifying and navigating to specific locations in longer projects. As you place markers in your project, Vegas automatically numbers them in the order that they were placed. You may name them and reposition them along the project’s timeline.

Placing and moving a marker

Markers are placed at the cursor’s position via the **Insert** menu, by right-clicking on the Marker bar, or by pressing the **M** key. You may place a marker by positioning the cursor or on-the-fly while your project is playing back. Markers appear as red tags above the ruler.

Markers can be repositioned or moved by dragging them left or right on the Marker bar.

To name (rename) a marker:

1. Place the mouse pointer on the marker you want to name or rename. The pointer changes to a hand icon ( htonl ).
2. Right-click to display a shortcut menu.
From the shortcut menu, choose Rename. A text box opens next to the marker.

Type the marker name.

Press the Enter key or click anywhere in the Track View to set the marker’s name.

You can also double-click an existing name or double-click the space just to the right of a marker to rename it.

**Navigating to a marker**

The cursor position can be instantly jumped to any marker on the timeline by simply clicking on the marker. You can also jump to a marker by pressing the number keys along the top of the keyboard (not the number pad numbers).

---

**Note:** The cursor can be jumped to the next or previous marker by pressing the Ctrl + or keys.

---

**Deleting a marker**

**To delete a marker:**

1. Place the mouse pointer on the marker that you want to delete. The pointer will appear as a hand (�建).

2. Right-click to display a shortcut menu.

3. From the shortcut menu, choose Delete. The marker will be removed from your project.

The marker numbers will remain the same, Vegas will not renumber the tags as you remove them. For example, if you have five markers in your project and delete markers 3 and 4, the remaining markers will be listed as 1, 2 and 5. However, as you add markers again, Vegas will begin numbering the missing sequence first, in this case 3 and 4, then to 6, 7, 8, etc.

**To delete all markers and regions:**

1. Right-click on the Marker bar.
2. From the shortcut menu, choose Markers/Regions.
3. From the submenu, choose Delete All.

Working with regions

Typically, regions identify ranges of time that you need to get back to later. Regions can function as semi-permanent time selections. Region information can be displayed in the media Explorer: click the arrow next to the View button and select Region View.

Placing and adjusting a region

Region markers may be placed at the cursor position and at the beginning and end points of a time selection via the Insert menu or pressing the F key. A region is defined as the area between two region markers that share the same number.

Individual Region Markers can be repositioned independently by dragging the marker left or right on the Marker bar.

Naming a region marker

To name a region:
1. Place the mouse pointer on the left region marker you want to name or rename. The pointer changes to a hand icon ( ).
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Rename. A text box appears next to the region marker.
4. Type the regions marker’s name.
5. Press the Enter key or click anywhere in the Track View to set the name.
Selecting a region
You may select the events, across all tracks, within the region for editing or playing back.

To select the region:
1. Right-click on one of the region markers to display a shortcut menu.

2. From the shortcut menu, choose Select Region.

Note: Regions can also be navigated to by pressing a number on your keyboard (not the Number Pad). Double-click on a region marker on the Marker bar to select the region.

Navigating to a region
The cursor can be moved to a region by simply clicking on either region marker. You may click in the Track View (timeline) to move the cursor to the current location, press the Ctrl+→ or ← shortcut keys to move the cursor, or use a region to reposition the cursor more precisely.

Right-click on a region marker to display a shortcut menu that allows you to navigate to the beginning (Go to Start) or the end (Go to End) of a region.

To remove a region from your project:
1. Place the mouse pointer on the region marker’s starting or ending point. The pointer changes to a hand icon ( ).
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Delete. The marker will be removed from your project.

The region marker numbers will remain the same, Vegas will not renumber the tags as you remove them. For example, if you have five regions in your project and delete region 3 and 4, the remaining regions will be listed at 1, 2 and 5. However, as you add regions again, Vegas will begin numbering the missing sequence first, in this case 3 and 4, and then continue with 6, 7, 8, etc.
Adding regions as takes

A single media file may contain a number of separate regions. These regions can be viewed in the media Explorer (click the View button until the Region View is displayed) and selected individually or as groups and inserted as takes into the timeline. This is especially useful when loop-recording numerous takes to a single file. For more information, see Takes on page 151.

Working with command markers

Command markers add interactivity to a multimedia presentation streamed over the Internet by inserting metadata into streaming media files. As your video plays, any number of other actions can be programmed to occur. These commands are a part of the Microsoft WMV and RealMedia streaming formats. Most frequently, these actions add text or open a related Web site where the viewer can find more information about the topic at hand. The specific commands available vary depending on the final format of your project.

Command markers can also indicate when an instruction (function) will occur in a *.wav file being used in a radio broadcast environment (Scott Studios data). The following two sections define the markers for both streaming media and Scott Studios files.

Note: Streaming media files can be played back off of any hard drive or CD-ROM, but in order to stream properly across the Internet, you must use a special streaming media server provided by your ISP. Microsoft *.wmv files must be embedded into a Web page (HTML file) in order for the dynamic text commands to function properly.
Defining streaming media commands

In a streaming media file, command markers can be used to display headlines, show captions, link to Web sites, or any other function you define. Vegas includes several command types that you may add to a streaming media file. Some command types are exclusive to either the Windows Media (*.wmv) or the RealMedia (*.rm) player.

<table>
<thead>
<tr>
<th>Command</th>
<th>Player type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Windows Media and RealMedia</td>
<td>Indicates when an instruction is sent to the user’s internet browser to change the content being displayed. With this command, you enter the URL that will display at a specific time during the rendered project’s playback.</td>
</tr>
<tr>
<td>Text</td>
<td>Windows Media</td>
<td>Displays text in the captioning area of the Windows Media Player located below the video display area. You enter the text that will display during playback.</td>
</tr>
<tr>
<td>WMClosedCaption</td>
<td>Windows Media</td>
<td>Displays the entered text in the captioning window that is defined by an HTML layout file.</td>
</tr>
<tr>
<td>WMTextBodyText</td>
<td>Windows Media</td>
<td>Displays the entered text in the text window that is defined by an HTML layout file.</td>
</tr>
<tr>
<td>WMTextHeadline</td>
<td>Windows Media</td>
<td>Displays the entered text in the headline window that is defined by an HTML layout file.</td>
</tr>
<tr>
<td>Title</td>
<td>Windows Media and RealMedia</td>
<td>Displays the entered text on the RealPlayer's title bar.</td>
</tr>
<tr>
<td>Author</td>
<td>Windows Media and RealMedia</td>
<td>Displays the entered text (Author’s name) when a user selects About This Presentation from the RealPlayer's shortcut menu.</td>
</tr>
<tr>
<td>Copyright</td>
<td>Windows Media and RealMedia</td>
<td>Displays the entered copyright information when a user selects About This Presentation from the RealPlayer's shortcut menu.</td>
</tr>
<tr>
<td>HotSpotPlay*</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to another RealMedia file.</td>
</tr>
<tr>
<td>HotSpotBrowse*</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to a Web page that you specify.</td>
</tr>
<tr>
<td>HotSpotSeek*</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to a point in the current RealMedia file.</td>
</tr>
</tbody>
</table>

* Hotspots are defined:

HotSpotPlay MM:SS (LEFT, TOP, RIGHT, BOTTOM) "LABEL" FILENAME  
HotSpotBrowse MM:SS (LEFT, TOP, RIGHT, BOTTOM) "LABEL" URL  
HotSpotSeek MM:SS (LEFT, TOP, RIGHT, BOTTOM) "LABEL" MM:SS

The parameters for a typical HotSpotBrowse command for a hotspot rectangle that is 50 pixels wide by 20 pixels tall and lasts for 10 seconds would look like this:

HotSpotBrowse 00:10 (0, 0, 50, 20) "Go to Sonic Foundry" http:\\www.sonicfoundry.com

All parameters are optional except the last. The hotspot will default to the entire duration of the file and the entire video frame if the duration and dimensions are not specified.
Defining Scott Studios data commands

For *.wav files using Scott Studios data, command markers can be used to define information about the *.wav file.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCOTT EOM</td>
<td>Calculates when the next queued clip will start playing in a Scott Studios system. For more information, please refer to your Scott Studios documentation.</td>
</tr>
<tr>
<td>SCOTT Cue In</td>
<td>Set the beginning of a file in a Scott Studios System without performing destructive editing. For more information, please refer to your Scott Studios documentation.</td>
</tr>
</tbody>
</table>

Placing a command marker

Command markers are placed at the cursor's position via the Insert menu or by right-clicking on the Command Ruler. Command markers can also be placed during playback by pressing the  key while your project is playing back. Command markers appear as blue tags on the Command Ruler, which is above the Marker bar.

To view the Command Ruler, choose Command Ruler from the View menu.

When you place command markers, the Command Properties dialog will appear (if the Command Ruler is not displayed, Vegas will automatically make it visible). The Command Properties dialog can be accessed at any time by double-clicking any command marker.
Use this dialog to define your own command or select a command from the drop-down list. This dialog is also where you edit the behavior of the selected command markers.

- The **Command** drop-down list allows you to select the type of command to place.
- The **Parameter** field defines the behavior of the command.
- The **Comments** field is simply used to remind you of the command’s purpose while you work on the project. Its function is similar to naming markers and regions.
- The **Position** field allows you to specify the timing of the command. Otherwise, command markers are automatically set to the current cursor position.

Once the command properties are set, click OK to place the command marker on the Command Ruler. Command Markers can be moved by dragging them to a new location. To edit command marker properties, double-click the command marker. Command Markers can be renamed and deleted by right-clicking the marker and selecting the appropriate option from the shortcut menu.

### Using an external sound editing program

Vegas is a nondestructive editing environment, which means that the original source files remain unchanged by any editing done in Vegas. Destructive (constructive) edits may be done in a separate application such as Sonic Foundry’s Sound Forge® to modify the actual source media file. By setting up a separate sound editor, you can quickly access the program from Vegas via the **Tools** menu or Ctrl+E shortcut keys.

#### Setting up the sound editing program

If you already have Sound Forge loaded on your computer when you installed Vegas, the installation should have detected it and made it your default sound editing program. However, if you do not have Sound Forge or want to specify a different sound editor, you may do so in the Preferences dialog.

**To set up the sound editor program:**

1. From the **Options** menu, choose **Preferences**. The Preferences dialog will appear.
2. In the Preferences dialog, choose the **Audio** tab.
3. Click the **Browse** button to the right of the Location of preferred audio editor item. The Preferred Audio Editor dialog will appear.
4. From this dialog, navigate to the application to use for editing audio files.

5. Select the application’s executable icon (*.exe) and click Open to set the application as your default sound editor.

   The application’s path will be displayed in the Location of preferred audio editor field.

Opening a sound editor from Vegas

All events in your Vegas project are actually references to media files on a storage device. When you edit an event in a sound editor, you are editing the media file to which the event is referenced. Any changes you make and save in the sound editor are permanent and will be reflected in the event in your Vegas project.

To edit an event in the sound editor:

1. Click on the event that references the file to be edited to select it.

2. From the Tools menu, choose Open in Sound Editor or press the Ctrl+E shortcut keys.

   Your selected sound editing application will open and the event’s referenced media file will open in the application. Make the necessary changes and save the file in the sound editor. If you keep the media file’s name and location the same, its event will be updated immediately in your project. However, if you change the media file’s name or location (Save As), you will need to import the edited (new) file into Vegas.

Opening a copy of an audio file in an external editor

You can also create a copy of an audio file and open that in an external sound editor. While this is a similar procedure to the one previously outlined, it has the advantage of preserving the original file unchanged. The modified copy is inserted into the event as a take and is automatically added to the Media Pool.

To open a copy of an audio file in an external editor and add it as a take:

1. From the Tools menu, choose Audio.

2. From the submenu, choose Open Copy in Sound Editor. You can also execute this command by right-clicking on an audio file and choosing Open Copy in Sound Editor.

   When you are finished editing, save the file, which has already been automatically named. If you save it to a new file (Save As), you must manually add it as a take into the project. For more information, see Takes on page 151.
This chapter builds on the techniques that were introduced in the last chapter. Ripple editing, pitch shifting, and takes are just three of the more advanced editing topics that are covered in this chapter. Later chapters are broken down by specific subject and go into even greater detail.

Importing media from other projects

For organizational purposes, it is possible to instantly import all of the media files from a project into the Media Pool of the current project. One possible use for this feature is to create a base project to be used as a template for other projects. This base project would contain all of the media files on your computer or network that are most frequently reused in your projects, such as corporate logos, animations, title sequences, and theme songs.

To import media from another project:
1. From the File menu, choose Open.
2. Select the Vegas project file (*.veg) that contains the media files to be imported.
3. Select Merge media from Vegas project files into current project at the bottom of the dialog.
4. Click OK.

Vegas then places all of the media files in the project's Media Pool into the Media Pool of the current project. You will be prompted to resolve any conflicts that may occur (e.g. two different files with the same name). Multiple projects can be imported at the same time by selecting multiple files in step 2 (press and hold Ctrl or Shift while selecting).

Snapping events

Vegas is preset to snap, or jump, dragged events to another event's edges, grid lines, markers, the cursor position, or a time selection. As you move an event along the timeline, its edge will automatically align to designated snap points.
Using the event snap offset

Each event in your project has a snap offset flag that can be moved along the length of the event. The flag is the white triangle that is located in the lower-left corner of each event. This flag allows you to designate where snapping occurs. This is useful if you need to align the snap with a beat in the event instead of the edge.

To set the snap offset:
1. Place the mouse pointer on the snap offset triangle. The pointer changes to a hand icon (ручка).
2. Drag the snap offset flag to the new position in the event. As the flag is moved, you will see a time display appear. This time display indicates where the snap offset flag occurs in time in the event.
3. Release the mouse to set the snap offset flag.

Snapping to grid lines

Vegas allows you to specify what type of grid you want to use in your project. The grid lines can be used as snapping points for events and markers.

Enabling/disabling snapping to grid

You may enable and disable grid snapping by choosing Snap To Grid from the Options menu or by pressing the Ctrl+F8 keys. When the grid is disabled for snapping, it will still be visible for reference. However, unlike a snap-enabled grid, it will disappear when the lines get too close together when zooming the view.
Changing the grid type

Vegas includes many grid types that you may apply to your project. Grids are only used for reference and snapping purposes and do not affect the output. From the **Options** menu, choose Grid Spacing and then the type of grid you want from the submenu.

**Note:** In some cases, the grid lines and the Ruler will not match, for example when the grid lines are in beats and the Ruler units are seconds. This is because these are two independent functions.

Snapping to grids and rulers

Two clips in the same track always automatically snap to their ends, but because of the potentially large number of tracks and events in a project, it is not useful to make every end of every event in every track a snapping point. You can easily snap to specific event boundaries in any track by quickly moving the cursor to that boundary using the following procedure.

To snap two events together:

1. Double-click on the event you want to snap to. Notice that the time selection area on the Ruler now encompasses the event.

2. Drag another clip in a different track near the end of the first clip. It will snap into position.

In reality, you are snapping to the time selection’s boundary, and not the event’s edge. In the illustration, the bottom event is effortlessly snapped to the end of the top event because the duration of the top event is marked by the time selection.
Snipping to markers

Vegas allows you to place markers in your project. The marker (or region) lines that appear across all tracks can be used as snapping points for events, cursor, and time selections. For more information, see Project markers and regions on page 131.

Enabling/disabling snapping to markers

You may enable and disable snapping to markers by choosing Snap To Markers from the Options menu or by pressing the Shift + F8 keys. When you disable snapping to markers, the marker lines will not appear across the tracks and events will not snap to them.

Disable snapping

Vegas allows you to snap events to project markers that you have placed and to grid lines that appear in the timeline. You may disable snapping to either markers, grid lines, or disable snapping altogether.

To disable/enable all snapping, click the Snap button ( ) on the Toolbar or toggle the snap commands located on the Options menu. When a command is enabled, a check mark appears next to it. To disable a snap command, simply click it again to toggle it off and disable it.
Ripple editing

Ripple editing is a timeline-based procedure that allows you to cut, delete, and paste events or portions of events and simultaneously re-adjust existing events on the timeline. For example, existing events may be automatically moved out of the way (down the timeline) to make room for a newly inserted event.

Ripple Edit mode is activated by clicking the Ripple Edits button ( ) on the Toolbar or by pressing the shortcut keys.

Ripple editing from the Trimmer

The first illustration is of the timeline with an event already inserted.

The next illustration shows what happens when an event is inserted before another event already on the timeline. The length of the inserted event is longer than the duration of the available space. This means that, with ripple editing off, it will run into, and overlap, the original event.

In the final case, ripple editing is turned on. As a result, the original event is pushed out of the way, down the timeline. The events do not overlap. Notice how the empty space on the timeline is also preserved. Ripple editing applies only to the selected track. If the selected track is a video track with an associated audio track, the audio remains locked to the video and is also rippled. Ripple editing also works with Paste operations.
To ripple insert events from the Trimmer:

1. Click the Ripple Edits button ( ) or, from the Options menu, choose Ripple Edits [CTRL+L] to toggle ripple editing on and off.

2. Open the media file you want to insert in the Trimmer. For more information, see Using the Trimmer window on page 154.

3. Create a selection area in the Trimmer of the section of the media file.

4. Click the Add Media from Cursor button ( ) or press A on the keyboard. The Add media to cursor button also works with ripple inserts.

Inserting time

It is also possible to make space in a track by inserting time into a track. To insert a period of time into a track, from the Insert menu, choose Time. The empty time is inserted across all tracks.

Cutting and deleting in ripple mode

When Ripple mode is turned on, cutting and deletion operations on a time selection area ripples all events further down in a project, moving everything left.

To cut/delete time:

1. Click the Ripple Edits button ( ) on the Toolbar to toggle it on.

2. Create a time selection.

3. Cut the event to the Clipboard by doing one of the following:
   - Press the Ctrl+X keys to cut or Delete.
   - Click the Cut button ( ) on the Toolbar.
   - From the Edit menu, choose Cut or Delete.

The exact behavior of the ripple depends on any event selections within the time selection area. If one or more events are selected, only those tracks with selected events are ripples.

So if you wanted to remove an event and ripple everything downstream in only one track, double-click the event (which selects it and automatically creates a time selection area) and then press Delete. To ripple every track in the project when a single event is removed, double-click the event (which selects it and automatically creates a time selection area), then press the Ctrl key and click the same event again (this selects all events within the time selection area), and then press Delete.
Ripple editing across all tracks (Paste Insert)

Ripple editing can also be applied across tracks in a project. In the following example, a five-second opening credits clip is inserted into a mature project with dozens of carefully positioned events.

**Before ripple:**

- Insertion point (cursor position)

**After ripple:**

- Ripple inserted event

Events that are bisected by the insertion point are split.

**Video compositing and multiple video tracks are only available in Vegas Video.**

**To ripple edit across all tracks:**

1. Copy an event to the Clipboard (from the timeline or Trimmer).
2. Move the cursor to the desired timeline location.
3. Position the cursor at the location where you want to paste the event.
4. Paste insert the event into the track by doing one of the following:
   
   - Press the `Ctrl`+`Shift`+`V` keys.
   - From the **Edit** menu, choose **Paste Insert**.

Clipboard information is pasted at the cursor’s position on the selected track. Existing track events or portions of events after the cursor are adjusted to occur later in the project (moved right). The amount of adjustment is based on the total length of the information being pasted. Vegas does not need to be in Ripple mode for this to work.

**Paste insert multitrack information**

When you have copied or cut information from multiple tracks, how the information is pasted is determined by the track that you select for the paste. Vegas will add tracks if necessary or simply paste the information into an existing track.

<table>
<thead>
<tr>
<th>Clipboard contents</th>
<th>Events before paste</th>
<th>Events after paste</th>
</tr>
</thead>
</table>

- **Information requires three tracks**
  - Paste position
  - Selected track to paste
  - Since the top track was selected and three tracks exist, no new tracks were created. Existing events on the tracks were moved later in the project.

- **Information requires three tracks**
  - Paste position
  - Since the third track was selected and the Clipboard information required three tracks, Vegas added two more tracks.
You can Paste Insert an event into the timeline without switching to Ripple Mode. Existing events on a track are rippled down the timeline by the total length of pasted information.

**Pitch shifting audio events**

*Pitch shifting is only available in the full versions of Vegas Video and Vegas Audio.*

A pitch shift is a way to speed up or slow down the audio to modify its timbre or fit the audio into a certain length of time. When an event’s pitch is increased, it can speed up and the event’s overall length may be shortened. Conversely, when an event’s pitch is decreased, it can slow down and lengthen the event.

The semitone range in Vegas is -24 to 24. Twelve semitones equal one octave, so you may increase or decrease the pitch of an event within a two-octave range. Within each semitone is a finer pitch adjustment called cents. There are one hundred cents in one semitone.

To pitch shift an event:

1. Right-click an audio event to display a shortcut menu.
2. From the shortcut menu, choose Properties.
3. From the Method list, select Change Pitch, Preserve Length or Change Length and Pitch.
4. Adjust the pitch shift in the Semitone, Cents, or both using the arrows or simply typing in the desired value.
5. Click OK to set the pitch shift for the event.
Time compressing/stretching

Time stretching and compressing events is the process of using the same amount of source media to fill a shorter or longer event. While this can be done to both video and audio events, the two cases are fundamentally different.

To time compress/stretch an event:

1. Hold the \( \text{Ctrl} \) key on your keyboard.

2. Drag the edge of the event towards the center of the event to compress (shorten) it or drag the edge out away from the center to stretch (lengthen) it.

Time compressing/stretching video

Time stretching video allows you to fill a given duration with a set amount of actual video, sometimes called fit-to-fill. For example, if you have a five-second video event and you want this event to fill an eight-second slot, hold the \( \text{Ctrl} \) key and drag the edge of the event to eight seconds. The resulting video will be in slow motion, but the contents (footage) would remain the same. If you had used the Velocity Envelope to slow the video to the same rate, the event would also be in slow motion, but its duration would remain unchanged at five seconds. Stretched video has a zigzag line between thumbnails. Video can also be compressed (sped up and shortened in length) by using this method.

When stretching video events or slowing video down, a set number of frames are extended across a period of time. For example, if you take source footage at 30 frames in a second and slow it so that only 15 source frames run during that same second, an additional 15 frames must be created to maintain the project’s 30fps frame rate. Simply duplicating frames is the easiest way to do this. A more sophisticated method is to resample the frames of an event, allowing Vegas to interpolate and redraw these intervening frames.

To resample an event:
1. Right-click the event and choose Properties.

2. On the Video Event tab, select Resample.

Resampling may not improve the quality in all situations. Preview your rendered movie on a television to accurately assess the final results. For more information, see Resampling on page 258.

**Takes**

A take is a version of a scene, as in “Scene 10, Take 7”, which means the seventh time that scene number ten has been shot. Vegas has the ability to allow you to include a number of takes in the same location (event) of the project. You can then rapidly switch between these separate takes to see which one fits into the project the best. Although this is what takes are designed for, you can actually use any clips you want as a take, even completely different shots or scenes. Since an event is just a container of a specific length and at a specific location, the actual content (media file) is easily changed.

**Adding takes**

Multiple media files can be added to the timeline at the same time to a single event as takes.

To insert multiple media files to the timeline as takes:

1. Locate the media files that you want to insert as takes in Vegas Explorer and select them. Select a range by holding Shift and clicking the first and last file in the range, or select nonadjacent files by holding Ctrl and clicking the various clips individually.

2. Right-click and drag one of the selected clips in the group to the timeline or to a video track.

3. From the shortcut menu, choose Add As Takes (or Video Only: Add As Takes to insert only the video and not the audio portion of the clips).

Media files can also be added to existing events as takes.

To add a take to an existing event:

1. Right-click a media file in the Media Explorer and drag it to an existing event.

2. From the shortcut menu, choose Add as Takes.

**Selecting takes**

When you add an event with multiple takes, a single event is inserted into a video track. The last clip that was selected determines the duration of the event and is set as the active take.
To select a take (and make it the active take):

1. Right-click an event with multiple takes.
2. From the shortcut menu, select Take.
3. From the submenu, choose Next Take or Previous Take. Press the T key to select the next take or Shift + T to select the previous take. A list of takes is also displayed.

Longer takes can be positioned within a shorter event by holding the Alt key while dragging on the take in the event. You will notice that the thumbnails representing the take will change while the event itself remains unmoved.

Adding takes to an event is an excellent method of maintaining consistency between a number of events in a project that may use a complex set of effects or plug-ins. First, duplicate an event by holding the Ctrl key while dragging an event. Then, replace the contents of the event by adding a take. You can also replace the contents of an event from the Media Pool. For more information, see Replacing media in events in the Media Pool on page 89.

Deleting takes

Individual takes can be deleted from an event at any time.

To delete a take:

1. Right-click an event with multiple takes.
2. From the shortcut menu, go to the Take menu item.
3. Choose Delete Active to immediately remove the active take or choose Delete to open a dialog with a list of all of the takes contained in this event.

Take names

Displaying take names on events

Take names may be displayed on the events in the timeline. The events in your project will display their respective active take names in the lower left corner of the event. Enable the Show active take names in events check box on the Preferences dialog to use this feature.

To display take names on events:

1. From the Options menu, choose Preferences. The Preferences dialog will appear.
2. Select the Show active take names in events check box to enable it.
3. Click OK to set the preference.

Each event in your project will display their respective take names.
Note: To disable this feature, clear Show active take names in events in the Preferences dialog.

Changing take names

Changing the name of a take does not affect the source media file in any way. Typically, you may want to change an event’s name after recording multiple takes into a track or event. For more information, see Working with multiple recorded takes on page 234.

To change an take’s name:

1. Right-click the event to display a shortcut menu.
2. From the shortcut menu, choose Properties. The Properties dialog opens.
3. Type the new name in the Active take name field.
4. Click OK to set the new take name.

Viewing the take list

When you change an event’s name, the new name will appear in the event’s Take list.

To view the Take list:

1. Right-click the event to display a shortcut menu.
2. From the shortcut menu choose Take. A submenu list of takes will appear.
Using the Trimmer window

The Trimmer allows you to work with and edit one media file at a time. The entire file is always opened into the Trimmer, in contrast to events on the timeline that may only contain a portion of the actual source file. Shortcut keys and right-click shortcut menus are also available in the Trimmer window.

To open a clip in the Trimmer:
1. Click on a clip on the timeline to select it.
2. Right-click on the clip and choose Open in Trimmer.

Events can also be opened in the Trimmer by dragging them from the Explorer or the Media Pool.

Note: If the event in your project is only using a portion of a larger media file, the Trimmer will select the portion being used.

To set the Trimmer as the default destination for a clip when it is double-clicked:
1. From the Options menu, choose Preferences.
2. Click the General tab.
3. Choose Double-click on media file in Media Pool or Media Explorer loads Trimmer.
Like many other windows in Vegas, the Trimmer window can be docked to the bottom of the workspace or you can drag it to freely float it anywhere on the screen. You can open any number of clips in the Trimmer at the same time, selecting the one you currently want to work on from the drop-down list.

The Trimmer window may be placed in the Docking area of Vegas or float over the work area. For more information, see Window Docking Area on page 33.

From the View menu, choose Trimmer or press the Alt + 2 shortcut keys to display the Trimmer window, if it is not already visible.

<table>
<thead>
<tr>
<th>History drop-down</th>
<th>This drop-down list displays all the events in your current project. You may open a media file in the Trimmer by selecting its filename from the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marker bar</td>
<td>This area displays the markers that you place along the media file's timeline. The marker bar is identical to the one in the timeline (pg. 131).</td>
</tr>
<tr>
<td>Save button (✓)</td>
<td>If you have added markers or regions to a media file in the Trimmer, you can save that data to the referenced media file for use in the sound editor or in later projects.</td>
</tr>
<tr>
<td>Selection bar</td>
<td>The selection bar is identical to the one found in the timeline. Use it to select portions of audio that you would like to place on a track or for setting regions (pg. 112).</td>
</tr>
<tr>
<td>Selection tab</td>
<td>Click this tab to bring the Trimmer to the front when it is &quot;behind&quot; other docked windows.</td>
</tr>
<tr>
<td>Sound editor button (✓)</td>
<td>This button opens the event in your sound editor application (pg. 138).</td>
</tr>
<tr>
<td>Transport bar</td>
<td>The Transport bar is identical to the one found in the timeline (pg. 32).</td>
</tr>
<tr>
<td>Ruler</td>
<td>The ruler is identical in functionality as the one in the timeline (pg. 31).</td>
</tr>
<tr>
<td>Zoom buttons</td>
<td>These buttons are identical to the ones in the timeline (pg. 40).</td>
</tr>
</tbody>
</table>

**Working with the Trimmer window**

The Trimmer window’s main function is to allow you to trim a media file and place portions of it on a track. You can also add regions and markers to a file, play back the media file or export it to an external sound editing program.

As you navigate (move the cursor) around in the Trimmer, the exact frame that the cursor is over in time is displayed as in a thumbnail image under the cursor. When using the left and right arrow keys, this allows you to create edit point with frame accuracy. Make sure Animate video frames in Trimmer is selected in the Preferences dialog to use this feature.

The Trimmer works on a four point editing concept: start, mark in, mark out, and end points. Mark in and out points define the portion of a event that you want to keep, while the start and end points define the entire file. You can precisely set mark in and out values on the fly.
To set mark in and out points:

1. Open a clip in the Trimmer.
2. Click the **Play From Start** button ( ).
3. When you get to the place where you want the edit to start (Mark In), press the `I` key or the `0` key.
4. When you get to the place where you want the clip to end (Mark Out), press the `I` key or the `0` key.

If you know the exact timecode of the point where you want to create your mark in/out, you can enter it into the boxes at the lower right part of the Trimmer window. The mark area is a simple time selection and is bounded by the two yellow triangles surrounding a grey bar at the top of the event. When looping is turned on, the bar's color is blue. Once your clip has been trimmed in the Trimmer, you can insert it into your project in a couple of ways.

- Drag-and-drop it to the timeline.
- Click the **Add Media From Cursor** (A) button to insert the event after the cursor or click the **Add Media Up To Cursor** (SHIFT+A) button to insert the event before the cursor.

Ripple editing (if enabled) applies to clips inserted from the Trimmer.

**Placing smaller portions of an event on a track**

After you have placed a media file in the Trimmer, you may select a segment of it and place it in your project. Selecting a portion of the media file will not affect the event already on a track. Vegas treats the smaller portion as a separate event even though it is from the same reference media file.

**To place a smaller segment into your project:**

1. Click and drag the cursor or use the Selection bar to make a time selection. The portion of the event you want to place will be inside the selection.
2. Click in the selected region and drag it to the timeline.
Adding regions and markers to a media file

The Trimmer allows you to add markers and regions to a media file in the same way that you add them to your project. Media file markers and regions are different from project markers and regions, which were described earlier in this manual. For more information, see Project markers and regions on page 131. The difference between the two is simply that project markers and regions affect a project, while media file markers and regions are embedded in, and saved with, a media file.

When you add a marker or region to a media file, Vegas does not add the markers to the project. Markers and regions that are added from within the Trimmer are only temporary. You must save them by clicking the Save button ( ) in the Trimmer window if you want to use them again after you close the project. After the markers and regions are added and saved to the media file, they will be available when you open the media file in a sound editor program or in the Vegas Trimmer.

Markers are placed at the cursor's position. You may also place a marker on-the-fly while the media file is playing back. Markers appear as red tags above the ruler.

A region is placed at the cursor's position or at either end of a time selection. You may also place a region on-the-fly while the media file is playing back. A region appears as green tags above the ruler.

To add markers or regions:

1. Position the cursor or make a time selection.

2. Place the marker or region in one of the following ways:
   - From the Insert menu, choose Marker or Region.
   - Right-click on the Trimmer Marker bar and choose Marker or Region from the shortcut menu.
   - Press the M (marker) or R (region) shortcut keys.

3. Click the Save button ( ) to save the markers and regions to the media file.

Markers and regions can be automatically saved to a media file by clicking the Options menu and choosing Preferences and selecting Automatically save Trimmer markers and regions with media file. Markers cannot be saved to media files with properties set to read-only in Windows. For more information, see Project markers and regions on page 131.
To fill a time selection on the timeline:

1. Make a selection on the timeline. In this case, select the empty region between two events.

2. Open the media file you want to trim in the Trimmer window.

3. Right-click the event in the Trimmer window and choose Copy Track Time From the Cursor (or To the Cursor). A mark in/out area is automatically created on the event in the Trimmer window.

4. Drag the event from the Trimmer to the timeline.

Here are some other tips on using the Trimmer:

- Drag a mark in/out region to a new location.
- Create markers by pressing the \texttt{M} key.
- Click on a marker to instantly move the cursor to that location.
- Right-click a marker and choose Rename to annotate.
- Press the \texttt{Tab} key to select the video or audio portions individually.
- Press the \texttt{Backspace} key to recall the last five mark in/out areas.

Opening a file in an external sound editor from the Trimmer

The Trimmer allows you to open your selected sound editing application (e.g. Sound Forge) to perform permanent edits to the media file. After you make the necessary changes and save the file in the sound editor, Vegas will automatically update the event using that media file. Make sure that the media file's name and location remain the same. For more information, see Using an external sound editing program on page 138.

There are different ways to open the sound editor from the Trimmer when it is active:

- Click the Open in <External Sound Editor> button (\texttt{ }).
- Right-click the media file and choose Open in <External Sound Editor> from the shortcut menu.
- Press the \texttt{Ctrl+E} shortcut keys.
Using the Edit Details window

The Edit Details window is only available in the full versions of Vegas Video and Vegas Audio.

The Edit Details window provides an alternate method for working with audio events, Command markers, Markers, and Regions after they are placed in your project. The following table displays what edit functions can be performed from the Edit Details window and references to more detailed instructions for each edit.

<table>
<thead>
<tr>
<th>Event editing</th>
<th>Markers</th>
<th>Regions</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moving along timeline (pg. 93)</td>
<td>Moving along timeline (pg. 131)</td>
<td>Moving along timeline (pg. 133)</td>
<td>Moving along timeline (pg. 137)</td>
</tr>
<tr>
<td>Changing active take name (pg. 152)</td>
<td>Adding a name (pg. 131)</td>
<td>Adding a name (pg. 133)</td>
<td>Selecting a command type (pg. 138)</td>
</tr>
<tr>
<td>Using Switches (pg. 154)</td>
<td></td>
<td></td>
<td>Setting the parameters (pg. 138)</td>
</tr>
<tr>
<td>Setting Snap offset (pg. 142)</td>
<td></td>
<td></td>
<td>Adding reference comments (pg. 138)</td>
</tr>
</tbody>
</table>

In addition to editing, you may access information about the project, such as the media file’s reference paths.

The Edit Details window may be docked in the Windows Docking Area or float on the work space. For more information, see Docking a window on page 342.

Viewing the Edit Details window

This window displays a database for all of the media in your project. It shows information about how the files are being used and allows you to modify many of those properties. You may sort, add or change information, rearrange columns, and edit items in the project.

To view the Edit Details window, choose Edit Details from the View menu or press the Alt + 4 shortcut keys.

Use the scroll bar to view other columns in the window.

The Show drop-down list allows you to view categorized project information.
Events

The Events category displays information about all of the events in your project. You may sort any of the information by clicking on a column’s header. The number of columns in the Events category requires that you use the scroll bar to view them all. Right-click an event entry to display a shortcut menu.

The following table explains each column and describes its function.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Edit function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Displays the track number where the event is located.</td>
<td>Move the event to a different location by entering a different track number (pg. 93).</td>
</tr>
<tr>
<td>Start</td>
<td>Displays when on the timeline the event starts playback.</td>
<td>Enter a different value to cause the event to begin playback sooner or later in the project (pg. 93).</td>
</tr>
<tr>
<td>Length</td>
<td>Displays the total length of the event.</td>
<td>Enter a different value to increase or decrease the event’s playback time.</td>
</tr>
<tr>
<td>End</td>
<td>Displays when on the timeline the event ends playback.</td>
<td>Enter a different value to cause the event to end playback sooner or later in the project (pg. 93).</td>
</tr>
<tr>
<td>Number of Takes</td>
<td>Displays the amount of recorded takes “contained” in the event.</td>
<td>This column may not be edited it is for informational purposed. However, you may work with recorded takes outside the Edit Details window (pg. 234).</td>
</tr>
<tr>
<td>Active take Name</td>
<td>Displays the event’s current name.</td>
<td>Enter a different name (pg. 152).</td>
</tr>
<tr>
<td>Take Start</td>
<td>Displays the offset into the source media file when the placed event begins playback.</td>
<td>Enter a different value to cause the take to playback sooner or later from the source media file.</td>
</tr>
<tr>
<td>File Path</td>
<td>Displays the path of the event’s media reference file.</td>
<td>Enter a new media file reference path for the event to use.</td>
</tr>
<tr>
<td>Select</td>
<td>Displays whether or not the event is selected in the project.</td>
<td>Toggle the event’s selection by clicking the check box: a check mark in the box indicates that the event is selected (pg. 111).</td>
</tr>
<tr>
<td>Mute</td>
<td>Displays whether or not the event is muted.</td>
<td>Toggle the event’s mute switch by clicking the check box: a check mark in the box indicates that the event is muted (pg. 164).</td>
</tr>
</tbody>
</table>
Selected Events

The Selected Events category is visually identical to the Events category except that the Edit Details window only displays information about selected events in your project.

Markers

The Markers category displays information about markers that are already placed along the project’s timeline. This category displays two columns: the markers position along the timeline and the marker’s name. Both columns can be edited. Right-click a marker entry to display a shortcut menu. For more information, see Working with markers on page 131.

Regions

The Regions category displays information about regions that are already placed along the project’s timeline. This category displays four columns: each region’s start position, name, length, and end position on the timeline. Enter a different value in the Start, Length, and End column to edit a specific region. The name may also be changed. Right-click a marker entry to display a shortcut menu. For more information, see Working with regions on page 133.
Commands

The Commands category displays information about Commands that are placed along the project's timeline. This category displays four columns: the command's position along the timeline, the command type, its parameters, and any comments that were entered when the command marker was placed in your project. Right-click a marker entry to display a shortcut menu. For more information, see Working with command markers on page 135.

Customizing the Edit Details window

The Edit Details window allows you to arrange and delete columns from each category and display and save the changes to a personal template. Vegas has one template from which you may create your own display options. All Fields Display is the default.

To customize the Edit Details window:

1. From the Show drop-down list, choose the category that you want to customize.

2. Click and drag a column's header to the new position. The cursor will change to a column icon ( ) as you move the column. If you want to remove the column so that it will not display, drag the icon off the Edit Details window. Release the mouse to drop the column in its new position.

3. The Template drop-down name changes to “Untitled”. Enter a new name in the Template drop-down.

4. Click the Save button ( ) on the Edit Details window to save the custom display. You may delete a custom display by selecting it from the template drop-down list and clicking the Delete button ( ).
Events are windows into media files in a project and are the most basic unit of editing in Vegas. Media files that are inserted into the timeline are automatically contained within an event. Trimming and editing an event does not affect the source media file in any way.

Accessing event properties

The properties of an event are automatically determined by Vegas and are based on the properties of the source media file. These properties include frame rate and size for video and pitch shifting and normalization for audio. Some of these properties can be manually changed.

To view an event’s properties:

1. Right-click the event to display a shortcut menu.

2. From the shortcut menu, choose Properties. The Event Properties dialog will appear.

The first tab in the dialog contains the properties that are exclusively Vegas related. The second tab, the Media tab, contains many properties that are an inherent part of the media file itself. Although it is unnecessary to change these properties in most situations, there may be times when the advanced settings need to be altered.
Event switches

Event switches are important functions that are used to determine the basic behavior of events in Vegas. Switches may be accessed from the Edit menu by choosing Switches to display its submenu or you can right-click a selected event and choose Switches to display its shortcut menu, or open the Event Properties dialog and select the switches there. Switches may be applied to a single event or to multiple events at the same time.

To use an event switch:

1. Right-click on an event.

2. From the shortcut menu, choose Switch and then choose the specific switch from the submenu.

Switches can also be applied by selecting an event and, from the Edit menu, selecting Switch to display the submenu, and then choosing the specific switch. Active switches have a check mark next to them. Click an active switch on the menu again to turn it off.

Audio event switches:

- **Mute** prevents the event from playing back.
- **Lock** prevents the event from being moved on the timeline.
- **Loop** allows you to extend the event along the timeline (in a loop) by dragging the right edge of the event. Vegas loops the entire event, not just the displayed portion.
- **Normalize** maximizes an audio event's volume without clipping.

Video event switches:

- **Mute** prevents the event from playing back.
- **Lock** prevents the event from being moved on the timeline.
- **Loop** allows you to extend the event along the timeline (in a loop) by dragging the right edge of the event. Vegas loops the entire event, not just the displayed portion.
- **Maintain Aspect** keeps a video event's relative dimensions constant (e.g. 4:3).
- **Resample** forces Vegas to redraw (re-render) a media file, which may solve some problems.

Muting an event

You may mute an event to prevent it from playing back. Mute may be applied to one or more selected events. When you switch an event to mute, the Switch submenu displays a check mark indicating that **Mute** is enabled. The event remains muted until you disable the switch.
Locking an event

You may lock an event to prevent it from being moved or edited. A lock switch may be applied to one or more selected events. When you switch an event to lock, the Switch submenu displays a check mark indicating that Lock is enabled. The event will remain locked until you disable the switch.

Multiple events can also be locked in this way. For more information, see Selecting multiple events on page 111.

Looping an event

You may loop an event so that you can extend it along the timeline by dragging the right edge of the event. Loop may be applied to one or more selected events. When you switch an event to loop, the Switch submenu displays a check mark indicating that Loop is enabled. The event will remain looped until you disable the switch.

Notches appear in the top of the event to mark where the media in the event ends and then repeats.
Looping is slightly more complex for video events. When looping is off, the last frame will be repeated for the duration of the event beyond its original length, creating a freeze frame effect, as in the middle example. The event in the last example below is looped three times. Each repetition is noted by a notch in the event.

**Normalize (audio only)**

You may normalize an event to maximize its volume, based on the waveform's highest peak, without clipping the event during playback. Normalize may be applied to one or more selected events. When you switch an event to normalize, the **Switch** submenu displays a check mark indicating that **Normalize** is enabled. The event will remain normalized until you disable the switch.

**Recalculating the normalization**

When you normalize an event, Vegas analyzes the event and raises the volume based on the waveform’s highest peak and then adjusts the rest of the event accordingly. There may be times when you have adjusted the edge of an event to exclude the (formerly) highest waveform peak. In this case, you may want to recalculate the event’s normalization.
To recalculate the normalization:

1. Right-click the event to display a shortcut menu.
2. From the shortcut menu, choose Properties. The Event Properties dialog opens.
3. Click Re-calculate to normalize the event again.

Note: You may set the maximum decibel level used by Vegas to calculate the event during normalization. For more information, see Setting the Normalize peak level on page 364.

Maintain aspect ratio (video only)

Video and image files of various sizes and formats can be included in a single project. The project itself may have a different frame size aspect ratio from the source media files. This is not a problem, but you must specify how Vegas handles these differences. If the length-to-width ratio between the source media and the project’s frame size are the same (e.g. source media at 320x240 and project frame size of 640x480), no aspect ratio distortion occurs. If
the ratios are not the same, the source material may become distorted (stretched or squashed). By maintaining the aspect ratio of the original, Vegas will keep the video from becoming distorted by letterboxing around the edges. This is the default setting.

The *.bmp media file in this example is 320x100, while the project is set to 320x240.

Resample (video only)

Resampling allow Vegas redraw or re-render a video file and possibly to interpolate frames in an event when the frame rate of a media file is significantly different from the project’s frame rate. This may solve some interlacing problems and other jittery output problems. For more information, see Resampling on page 258.

Event switches in the Event Properties dialog

Event switches may also be applied via the Event Properties dialog.

To apply a switch from the Event Properties dialog:

1. Right-click the event to display a shortcut menu.
2. From the shortcut menu, choose Properties. The Event Properties dialog opens.
3. Select the check box(es) of the switch(es) that you want to apply to the event.
Event switches in the Edit Details window

The Edit Details window is only available in the full versions of Vegas Video and Vegas Audio.

Event switches may also be toggled on and off in the Edit Details window. To view the Edit Details window press \[ Alt + 4 \] or, from the View menu, choose Edit Details.

Audio event envelopes (ASR)

You may apply envelopes to individual events. Envelopes, also known as ASRs (attack, sustain, and release), give you the ability to control an audio event’s volume or a video event’s opacity. The fade-in, fade-out, and overall level of the event may be also controlled. Track envelopes affect the entire track. Event envelopes can be applied to video and transition events, although there are different types of envelopes for each.

When you place an event into your project, Vegas adds handles that are used to set the envelope. As you use these handles on audio events, a volume line appears indicating how the event is being affected. The waveform also graphically displays the volume change.

Setting an audio event’s volume

When you place the mouse pointer at the top of the event, the pointer changes to a hand cursor ( \( \text{hand cursor} \) ) that you may use to lower the event’s overall volume.

To set the event’s volume:

1. Place the mouse pointer at the top of the event.
2. When you see the envelope cursor ( \( \text{envelope cursor} \) ), drag the volume line to the desired level. As you drag the volume line down, Vegas displays the event’s decibel level.
Setting an event’s fade in and out

The event handles allow you to affect an audio event’s fade in and out volume and a video event’s opacity. The type of curve that the event uses to control the volume’s fade in or out can also be changed.

To set the event’s fade in or out:

1. Place the mouse pointer on a handle and the pointer changes to the envelope cursor (＋).  
2. As you drag the cursor, the volume line appears. Vegas displays both the time in the event when the volume will be maximized and its decibel level.

Changing the event’s fade curve

You can set the shape of the fade curve (fast, linear, or slow) that an event uses to raise or lower the volume over time.

There are two ways to access the fade curve types:

- Right-click anywhere in the event’s fade-in or -out region and select Fade Type.
- When the envelope cursor (＋) is displayed, right-click to display the shortcut menu.
Video event envelopes

Video event envelopes are only available in the full versions of Vegas Video.

Envelopes are a method of controlling some of the attributes of an event over time. Video envelopes include Opacity and Velocity. Envelopes appear as blue or white lines on an event and can be controlled by creating and dragging edit points.

Opacity envelopes

Video event Opacity envelopes are analogous to audio event ASR envelopes. While an ASR envelope controls the volume of an event as it fades in and out, Opacity envelopes fade video events in and out over whatever is in the background. To use an Opacity envelope, move the cursor over the small blue triangles in the upper corners of an event. When the cursor changes ( ), drag the Opacity envelope inward. This affects the transparency of the event, allowing it to fade in over a background. This background can be another video event or a background color.

Velocity envelope

Velocity envelopes are only available in Vegas Video.

Velocity envelopes are used to change the speed of a video event over time.

To view a Velocity envelope:
1. Right-click on the event and select Insert/Remove Envelope.
2. From the submenu, select Velocity.

When combined with points (nodes), envelopes can be used to animate a fade in (or out).
To add and adjust a point (node):

1. Double-click on the envelope where you want to add a point.
2. Drag the point vertically to adjust it.
3. Right-click the envelope between the two points and select Linear, Fast, or Slow to set the shape of the curve.

The envelope between the points is a straight line by default. In the example above, the Fade to Color envelope smoothly curves upward. This creates a very smoothly animating fade effect. To delete a point, right-click the envelope and select Delete.

To change the speed of a video event:

1. Right-click the event and choose Insert/Remove Envelope.
2. From the submenu, choose Velocity. The Velocity envelope appears on the event as a blue line.
3. To increase the speed, drag the line up. To slow the video down, drag the line down.
4. Double-click the line to add a point (node). Drag a point to change its position.

Points (nodes) are essentially keyframes, and the blue envelope line represents the interpolated values between two points. For more information, see Keyframe animation on page 305. Points can then be dragged to vary the speed of the video over time. Making a video play at twice its normal speed will make the duration of the video half as long. Likewise, slowing a video down will make it longer (with 0% being an infinite freeze frame). The video event, as inserted into your project, has a specific duration that will not change. Therefore, if you decrease the speed of a ten-second video event by 50%, only five seconds of video will still be shown (played over the course of the ten-second event), meaning that only half as much actual footage from the original event will play. On the other hand, if the speed is increased 200%, the ten seconds of contents will play in only five seconds. The remaining five seconds of the event will be filled either with a freeze of the last frame or with ten additional seconds of video content from the longer file.

To remove an envelope and all of its settings, right-click the envelope and select Reset All from the shortcut menu. It may be important to resample the frame rate of an event that has been significantly slowed. To resample an event, right-click the event and choose Properties. Then, on the Video Event tab, choose Resample the video. For more information, see Event properties on page 257.
Reversing a video event

Setting the velocity to a negative value reverses the video, working backwards from the point where the negative value occurs. Video events can only be reversed if there is media to reverse: an event cannot be reversed back before the beginning of a media file. An event that has been reversed will play backwards until it gets to the first frame and will then hold that frame for the duration of the event.

To reverse an event:

1. Right-click the event and choose Insert/Remove Envelope.
2. From the submenu, choose Velocity.
3. Trim the beginning of the video event to the place where you want the reversal to begin, e.g. the last frame in the media file that you want to play if it were playing forward. See the example below.
4. Drag the velocity down to -100% for a normal speed reversal.

This procedure reverses the actual media file, starting with the first frame of the trimmed event, and playing backwards from that point.
Envelope Edit Tool

While envelopes can be edited while in Normal Editing mode, you can limit your editing to envelopes only by clicking the Envelope Edit tool ( ) button or, from the Edit menu, choose Editing Tool and then choose Envelope. Events cannot be moved, trimmed or otherwise modified in this mode, protecting your project from unwanted changes.

Grouping events

Vegas allows you to group events together within tracks or across separate tracks. Once a group is created, all the events within it may be moved together as a unit and have event-specific edits applied at the same time.

You may still edit properties of individual events within a group without affecting the other events in a group.

Creating a new group

Grouping is useful when you want to preserve timing of events and move them together along the timeline.

To create a new group:

1. Select the events you want to group. Press the Ctrl key, the Shift key, or the Selection Edit tool ( ) to select them. For more information, see Selecting multiple events on page 111.

2. After the events are selected, you may group them in one of three ways:
   - From the Edit menu, choose Group to display a submenu and then choose Create New.
   - On one of the selected events, right-click to display a shortcut menu. From the shortcut menu choose Group and then, from the submenu, Create New.
   - Press G to create the group.

To add a new event to an existing group:

1. Select an event in the existing group.

2. Right-click the event and choose Group | Select All to select all of the members of the group.

3. Press the Ctrl key and click on the event to be added to the group.

4. Right-click the event and select Group | Create New.
Note: Events can only be in one group at a time. Adding an event to an existing group essentially deletes the old group and creates a new one that includes all of the selected events.

Removing events from a group

Individual events may be removed from a group without affecting the other members of the group. The event you are removing from the group is not deleted from the project and remains on the timeline.

To remove an event from the group:
1. On the event you want to remove from the group, right-click to display a shortcut menu.
2. From the shortcut menu, choose Group and then choose Remove From on the submenu.
   The event will be removed from the group. The rest of the grouped events remain intact.

Clearing a group

You may ungroup all events by clearing the entire group. Clearing a group does not delete or remove events from your project and they remain on the timeline.

To clear a group:
1. Right-click one of the members of the group.
2. From the shortcut menu choose Group and, from the submenu, choose Clear or press Ctrl+U shortcut keys.

Selecting all members of a group

While grouped events move together, selecting one member of a group does not automatically select every member of that group. To select all members of a group:
- Right-click one of the members of the group and, from the shortcut menu, choose Group and then choose Select All.
- or press Shift+G shortcut keys.

Temporarily disabling grouping

The grouping behavior of all groups (including video media files with included audio streams) in Vegas can be temporarily disabled by clicking the Ignore Event Grouping ( ) button.
Tracks

Tracks contain the media events on the timeline of a project. There are two types of tracks: video and audio. Each type of track has its own features and controls. While tracks can be organized and mixed in any order, track hierarchy can be important in determining the final output, especially for video. Because tracks are containers for events, effects and filters that are applied to a track apply to every event in that track.

Video compositing and multiple video tracks are only available in Vegas Video and is limited in Vegas Video LE.

Working with Tracks

Understanding and managing tracks is fundamental to multimedia editing in Vegas. At the start of a new project that does not yet contain any tracks, when you add an event to your project by double-clicking it from the Explorer window, Vegas automatically creates a new track and places the event on it. Otherwise, the new event is added to the existing track that has the focus of the program.

Adding an empty track

You can also add empty (eventless) tracks to a project. These tracks can be used to directly record into or serve as placeholders for specific media that you will add later. For example, you may want to create an empty track and then record a voiceover directly into a project.

To add an empty track:

1. Place the mouse pointer in either the Track View or the Track Header.
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Insert Audio Track or Insert Video Track.
Alternatively, you may add an empty track from the Insert menu by choosing Audio Track (Ctrl+Q) or Video Track (Ctrl+Shift+Q). Vegas creates and adds an empty track at the bottom of the Track List.

**Duplicating a track**

You may duplicate a track in your project including all of the events contained on it. When a track is duplicated, it is placed directly below the original track. Other existing tracks are moved down on the Track Header. You may duplicate one track or choose multiple tracks to duplicate at a time.

**To duplicate a track:**

1. Click the track that you want to duplicate to select it. To select multiple tracks, click each one while holding either the Shift key to select adjacent tracks, or the Ctrl key to select nonadjacent tracks.

2. Right-click and choose Duplicate Track from the shortcut menu.

**Deleting a track**

You may delete a track from your project and all of the events contained on it. You may delete one track or choose multiple tracks to delete at a time.

**To delete a track:**

1. Click the track that you want to delete to select it. To select multiple tracks, click each one while holding down either the Shift key to select a range of adjacent tracks, or the Ctrl key to select discontinuous tracks.

2. Right-click and choose Delete from the shortcut menu or from the Edit menu, choose Delete.
Naming or renaming a track

Every track in your project has a Scribble Strip where you can type a name for the track. The track name may be up to 255 characters long. If the Scribble Strip is not visible, you may need to increase the height of the track by dragging the track's edge to reveal it. When a track's view is minimized, the Scribble Strip is not displayed.

To name or rename a track:

1. Double-click the Scribble Strip and enter a track name or right-click the on the track to display a shortcut menu. Choose Rename from the shortcut menu. Any existing name is highlighted on the strip. Type the new track name.
2. Press the Enter key to save the track’s name.

Organizing tracks

Vegas is flexible in how tracks can be organized. Tracks may be rearranged and sized to fit your particular needs.

Reordering tracks

When you create tracks, Vegas arranges them in the order that they were added. It is a simple process to reorder tracks to fit your needs. You may reorder one or more tracks at a time.

**Note:** Track hierarchy can be critical in video compositing. For more information, see Compositing on page 285.

To move a track:

1. On the Track Header, place the mouse pointer on the track that you want to move.
2. Drag the track to the new position in the Track Header.
Changing track color

When you add a track to Vegas, a color is automatically assigned to the track. This color is easily changed. This feature is useful if you want to organize similar tracks together. For example, you may want all of your background vocals to have a different color from your lead vocals or have a single color for all overlay tracks. The color is applied to the Track Header number and to the background of all events in that track.

To change a track’s color:
1. In the Track Header, right-click on a track to display a shortcut menu.
2. From the shortcut menu, choose Track Color to display a submenu.
3. From the submenu, select a color.

Changing track height

There are two ways to control track height in your project: using the minimize and maximize buttons or dragging the bottom edge.

<table>
<thead>
<tr>
<th>Click</th>
<th>Track height</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Minimize button" /></td>
<td><img src="image2.png" alt="Track height" /></td>
<td>~ (tilde)</td>
</tr>
<tr>
<td><img src="image3.png" alt="Maximize button" /></td>
<td><img src="image4.png" alt="Track height" /></td>
<td>Shift + ~</td>
</tr>
<tr>
<td><img src="image5.png" alt="Drag button" /></td>
<td><img src="image6.png" alt="Track height" /></td>
<td>Ctrl + ~</td>
</tr>
</tbody>
</table>

Track height is changed by clicking the View buttons (`, `, `.`) on the track. Alternatively, press Ctrl+Shift+↑ or Ctrl+Shift+↓ to view different track-height scenarios. The shortcut keys affect all tracks in your project and make them all the same height.
Resizing a track

Tracks can be resized by dragging the bottom or the right border. Place the mouse pointer at the bottom of the track. The pointer turns into an up/down arrow (↑↓). Click and drag while moving the arrow up/down. Release the mouse to set the desired track size. The width of the Track Header can also be resized in a similar way.

Track Headers

Each track in your project has its own controls, faders, and sliders that are contained in the Track Header on the left side of the track. You can work with these controls to affect the event(s) that are contained on the track.

Using the audio track fader

This fader controls the volume of the events on a particular audio track. The fader’s range is -inf to 12dB. To adjust the fader, drag it to the desired volume level. As you drag the fader, you will see the volume level displayed to the left of the fader. Double-clicking the fader will reposition it to 0.0 dB.

Note: Press the Ctrl key while dragging or use the mouse wheel for finer control of the fader. You may also move the fader by clicking it and using the right or left arrow keys on the keyboard.

Muting a track

The Mute button (speaker) on the Track Header temporarily disables playback of the track, so you can focus on another track’s event(s). When a track is muted, it appears grayed out on the Track View. You may mute more than one track at a time.

To mute a track, click the Mute button. Click it again to restore the track.
Muting all audio or video tracks

You can also mute all tracks in a project by type: either audio or video. From the Options menu, choose Mute All Audio or Mute All Video.

Soloing a track

The Solo button is not available (and is not necessary) on video tracks in versions of Vegas other than Vegas Video that only contain one or two video tracks.

The Solo button (�) on the Track header isolates a track’s events for playback and mutes the other non-soloed tracks. This allows you to focus on a track’s contents without the distraction of other tracks. When you solo a track, the other tracks will be grayed out on the Track View. You may solo more than one track at a time.

Note: Soloing works by type of track: audio or video. When soloing an audio track, all other audio tracks are muted, but the video tracks remain active. Likewise, soloing a video track mutes all other video tracks, while the audio tracks remain unaffected.

To solo a track, click the Solo button on that track. Click it again to restore all tracks for playback. Soloing works on audio and video tracks. On an audio track, it allows you to hear a track and adjust it individually. On a video track, it can be used to isolate a track without compositing it with other video tracks.

Audio track envelopes

Track envelopes allow you to control and animate volume and panning aspects of a particular track over time. Volume envelopes automate the volume used for events on a track, auxiliary bus, assignable FX send, or all at the same time. A panning envelope automates the panning aspects used for events on a track.

Note: Video track envelopes are related to audio track envelopes. For more information, see Video track envelopes on page 186.
Adding a volume or pan envelope

The type of volume or pan envelope that you add will determine what Vegas component’s volume is automated. You may add volume or pan envelopes to tracks, auxiliary busses, and Assignable FX sends. A volume envelope can be added to one or to all components at the same time. You can distinguish the volume envelopes by their color. Panning envelope lines are red.

<table>
<thead>
<tr>
<th>Envelope type</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Blue</td>
</tr>
<tr>
<td>Auxiliary bus</td>
<td>Magenta</td>
</tr>
<tr>
<td>Assignable FX send</td>
<td>Green</td>
</tr>
</tbody>
</table>

To add a volume or pan envelope:

1. Select the track where you want to add the audio track envelope. Multiple tracks may be selected.

2. From the Insert menu, choose Audio Envelopes and then choose Volume (or press the V key) or choose Pan (or press the P key).

Adding envelope points

Once an envelope is placed, you may add points to it. These points will be used to move the envelope line so that volume or panning changes will be smoothly automated.

To add envelope points:

1. Place the mouse pointer on the envelope’s line. The mouse pointer changes to a hand icon (ër).

2. Right-click and choose Add Point from the shortcut menu or double-click to add an envelope point. A square point appears on the envelope line.
Deleting envelope points

Points may be deleted by right-clicking the point and choosing Delete from the shortcut menu. All envelope points may be deleted by selecting Reset All from the shortcut menu.

Moving envelope points

Once the envelope points have been added, you may raise and lower them to different decibel (dB) levels along the timeline to automate the track’s volume or change the percentage of the pan. You may move one point at a time, even during playback and listen to the results in real time. Also, you may set the type of fade curve between each envelope point.

To move an envelope point:

1. Place the mouse pointer on an envelope point. The pointer changes to a hand icon (grün).
2. Drag the points to the desired position. As you move an envelope point, a ToolTip displays both the point’s location on the timeline and its decibel level/percent pan.
3. Click the Play (▶) or the Play From Start (▶) buttons to play back the project and check the timing of the envelope.

Note: You may also set the value of the point by right-clicking an envelope point and choosing a setting from the shortcut menu or choose Select All from the shortcut menu to raise or lower all points on the envelope.

Changing the envelope fade curves

Between each envelope point, you may set the type of fade curve: fast, linear, or slow. From the selected envelope point, fade curves are applied to the volume lines that occur later on the timeline.

To set the audio track envelope fade curve:

1. Right-click on a point to display a shortcut menu.
2. From the shortcut menu, choose the curve type. Curve types are applied to volume lines.

Hiding the audio track envelopes

After you have set your envelopes on the tracks, you may hide them from the Track View. Hiding audio track envelopes does not affect playback. The points that you set still automate the volume, even though they will not be visible.

To hide an audio track envelope:

1. From the View menu, choose Show Audio Envelopes. A submenu appears. There will be a check mark next to the envelopes that are currently displayed.

2. From the submenu, click an envelope name with a check mark next to it. All envelopes in your project of that type will no longer appear in the Track View.

Removing audio track volume envelopes

When an envelope is removed, the events on the track will no longer have automated volume control and the envelope line will also no longer be displayed.

To remove an audio track envelope:

1. Select a track.

1. From the Insert menu, choose Audio Envelopes. A submenu appears. There will be a check mark next to the envelopes that are currently displayed.

2. From the submenu, click an envelope name with a check mark next to it. All envelopes in your project of that type will be removed.

Note: When you remove an audio track envelope from a track and then add it again, all volume points will be reset.
Video track envelopes

Video compositing, multiple video tracks, Composite Level envelopes and Fade to Color envelopes are only available in Vegas Video.

Composite Level envelopes

The Composite Level envelope determines the opacity/transparentcy of the video track and has a similar effect to the Composite Level slider. To use a Composite Level envelope, right-click on a blank portion of a track, select Insert/Remove Envelope and choose Composite Level. A blue envelope line appears across the top of the track. This affects the transparency of a track, allowing it to fade in over a background. The entire line can be dragged up or down, or points (nodes) can be added to the envelope to animate the opacity over time.

Fade to Color envelopes

Fade to Color envelopes for a track are used to control the fading of a track to a particular color. Conservatively, it can be used to fade a track to black. Two specific colors can be chosen to fade to: Top and Bottom. Which of the two colors is chosen by moving the envelope towards the top or bottom of the track. The color that the track fades to is chosen by right-clicking on a track and, from the Fade Colors submenu, choosing Top or Bottom. Like other envelopes in Vegas, points (nodes) can be added to animate the fade.

To view a video envelope (Fade to Color):
1. Right-click a blank portion of a track and select Insert/Remove Envelope.
2. From the submenu, select either Fade to Color.

When combined with points (nodes), envelopes can be used to animate a fade in (or out).

To add and adjust a point (node):
1. Double-click on the envelope where you want to add a point.
2. Drag the point vertically to adjust it.
3. Right-click the envelope between the two points and select Linear, Fast, or Slow to set the shape of the curve.

The envelope between the points is a straight line by default. In the example above, the Fade to Color envelope smoothly curves upward. This creates a very smooth fade effect. To delete a point, right-click the envelope and select Delete.
Envelope Edit tool

Envelopes can also be edited by using the Envelope Edit tool. To use this tool, click the Envelope Edit tool button ( ) on the toolbar. The advantage of switching to this tool to edit envelopes is that events cannot be moved when this tool is selected, thereby protecting them from changes. This effectively locks all of the events and effects in a project while the various envelopes are being modified.

Locking envelopes to events

Track envelopes extend for the length of a track and are independent of the events on the track. This means that the envelope remains in place when you move the events in the track. Carefully adjusted track envelopes can be set to move with the underlying events, thus preserving this timing. To lock all of the envelopes in a project to the events they are contained in, click the Lock Envelopes to Events button ( ) on the toolbar or, from the Options menu, choose Lock Envelopes to Events. The lock can be toggled off by clicking the button again.

Rendering to a new track

Rendering or mixing multiple tracks to a single track can be a good method of decreasing the complexity of a project and speeding up future renders. The original tracks and their events are unaffected when you render (mix) to a single track.

Multiple video tracks are only available in Vegas Video.

Typically, you would use this feature when you are finished refining a few tracks and want to combine them. When you render multiple tracks, any envelope or track effects that you have applied will be rendered into the newly rendered track. The original source files remain unaffected and the new track(s) will be saved to a new file.

Note: Every video render results in a loss of quality from the original source material. The number of video renders performed should therefore be minimized.

To mix multiple tracks to a single track:

1. Select the tracks that you want to combine. Multiple video tracks will be combined into a single video track. Multiple audio tracks will be mixed to a single stereo audio track. To mix specific events, make a time selection.
2. From the **Tools** menu, choose **Render to New Track** or press the `Ctrl + M` shortcut keys. The **Render to New Track** dialog appears.
   - From the **Save in** drop-down list, select the drive or folder to save the new media file.
   - Type a new media file in the **File name** field.
   - From the **Save as type** drop-down list, choose the file format (e.g. `*.wav` for audio or `*.avi` for video).
   - From the **Template** drop-down list, choose an audio format from the template list.
   - Select **Render loop region only** if you only want to render the time selection area.

3. Click **Save** to render to a new track.

As the tracks are being rendered (mixed down), a small dialog appears displaying the progress of the render. A status bar also appears in the lower-left portion of Vegas.

---

**Note:** You may cancel the rendering process by clicking the **Cancel** button or (X) on the status bar.

---

After Vegas render the new track, it will appear at the bottom of the **Track View**. If you render the entire project, you may delete (or mute) the other tracks from the project, since they are all contained on the new track.

**Render to new track template**

You may create your own templates for mixing down tracks or projects. When you create a template you may choose its name from the **Template** drop-down list in the **Mix to New Track** dialog.

**To create a custom template:**

1. From the **Tools** menu, choose **Render to New Track** or press the `Ctrl + M` shortcut keys. The **Render to New Track** dialog will appear.

2. Click **Custom** to display the **Custom setting** dialog. The settings that you may change are as follows:

<table>
<thead>
<tr>
<th>Template</th>
<th>Enter the name of your template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter the template’s parameters</td>
</tr>
<tr>
<td>Format</td>
<td>Choose an audio format from the drop-down list</td>
</tr>
<tr>
<td>Sample rate</td>
<td>Choose a rate from the drop-down list</td>
</tr>
<tr>
<td>Bit-depth</td>
<td>Choose a bit-depth from the drop-down list</td>
</tr>
<tr>
<td>Channels</td>
<td>Choose a channel option from the drop-down list</td>
</tr>
</tbody>
</table>

3. Click the **Save** button (✓) to save the template or click the **Delete** button (✗) to delete a selected template.
The included audio FX, or plug-ins, can be used to improve the quality of the audio in a production, or can be used as special artistic effects. Additional effects, both from Sonic Foundry and other third-party plug-ins, can also be used. Audio effects are applied to tracks, and to all of the events within a track, and can be routed through busses.

Multiple audio busses are only available in the full versions of Vegas Video and Vegas Audio. Different versions of the Vegas family of products contain different varieties of effects, with the full versions of Vegas Video and Vegas Audio containing the most complete set.

Assigning an audio track to a bus

A bus is where the various audio track signals are mixed together and output. If your project contains multiple stereo busses, you may assign a track to a specific bus output.

To assign an audio track to a bus:

1. Click the Bus button ( ) to display a drop-down list of available busses.
2. From the drop-down list, choose the bus for the track’s output.

Note: If you only have one stereo bus in your project, this button will not appear in the audio track’s controls. For more information, see Audio tab on page 359.
Assigning an audio track to an auxiliary bus

An auxiliary bus allows you to send track signals to a secondary bus independent of the primary bus. Auxiliary busses are used to separate signals from the rest of the project. For example, if a musician in a studio only wants to listen to the guitar portion of the project, you can set up an auxiliary bus for that purpose. Then the musician can play his or her part while only listening to the guitar.

Auxiliary busses do not affect the project’s overall playback. As shown in the previous section, the primary bus is set using the Bus button ( ) on a track’s toolbar. Setting up the auxiliary bus works differently.

To set up an auxiliary bus:
1. If you do not see the multipurpose slider, resize the track to display it.
2. Click on the multipurpose slider label to display a drop-down list.
3. From the drop-down list, choose the auxiliary bus output.

Note: If you only have one stereo bus without any FX sends in your project, the drop-down list will not appear. For more information, see Audio tab on page 359.

Adjusting the auxiliary bus volume

When you select an auxiliary bus, you will need to adjust its playback volume with the slider. The volume of an auxiliary track is preset to -inf. dB (mute) by default. Drag the slider handle left or right to adjust the volume.
Assigning audio tracks to an Assignable FX

Assignable FX sends are only available in the full versions of Vegas Video and Vegas Audio.

Plug-ins can be added as Assignable FX controls to the Mixer window. Assignable FX are made up of one or more plug-ins that are used to add sound effects to a track's signal. After the signal is processed by the plug-ins, the signal is sent to the assigned bus output.

Before you can assign a track to an Assignable FX control, the control needs to be added to the Mixer window.

To assign a track to an Assignable FX:
1. If you do not see the multipurpose slider, expand the track to display it.
2. Click on the multipurpose slider label to display a drop-down list.
3. Choose the Assignable FX control that you want the track to use.

Adjusting the Assignable FX control's volume
When a track is assigned to an Assignable FX, its volume may be adjusted with the multipurpose slider. The Assignable FX volume is preset to -inf dB (mute) by default.
Setting up to record into audio tracks

Vegas allows you to record into single or multiple audio tracks. You may record into tracks that are empty or into tracks that already contain events.

Before recording into a track, the track needs to be armed. Setting up a track for recording is done by clicking the Arm for Record button ( ● ) on the track. After this button is clicked, a meter appears on the Track Header displaying the level of the input.

For more information, see Recording Audio on page 223.

Choosing a track’s recording device

After you have armed the track for recording, you may select the device from which you want to record. You may also choose whether the track will record the signal in stereo, to the left channel, or to the right channel. For more information, see Assigning tracks to input devices on page 227.

To select an input device and recording method:

1. Click the Audio button ( ● ) to the left of the Record button ( ● ) to display a drop-down list.
2. From the drop-down list select the input device and recording method (Stereo, Left, or Right).

Note: When you select Left or Right, Vegas will record in mono from the selected channel.
Using Audio FX

Different versions of the Vegas family of products contain different varieties of effects, with the full versions of Vegas Video and Vegas Audio containing the most complete set. Multiple audio busses and Assignable FX are only available in the full versions of Vegas Video and Vegas Audio.

There are three ways to use audio plug-ins in Vegas: Track FX, Bus FX, and Assignable FX. These plug-ins can be accessed by clicking the Track FX, Bus FX or Assignable FX button.

- **Track FX** are effects that are applied to all events in a single track.
- **Bus FX** are applied to a bus. Tracks in turn can be assigned to a bus. Since multiple tracks can be assigned to a single bus, using bus level audio FX is an efficient method of applying carefully customize effects and chains to multiple tracks.
- **Assignable FX** give you greater control over the mix of a particular effect or chain in a project. Each Assignable FX is assigned to a single bus. In order to have the control appear in the Mixer window, at least one plug-in needs to be selected and applied.

The mix of these various methods of applying audio FX is important to the final mix of a project. For more information, see Audio Signal Flow on page 43.

**Bus FX**

DirectX compatible plug-ins or a chain of plug-ins can be added to any bus in a project. When you add plug-ins to a bus, the track signals that are assigned to the bus will be processed by the plug-in(s) to create the desired output. If plug-ins are assigned at the track level (EQ or Compression, for example), the track’s signal will flow through the track’s plug-in(s) before the bus plug-ins.
Assignable FX

Assignable FX are only available in the full versions of Vegas Video and Vegas Audio.

Plug-ins are used when processing your project's signal. These plug-ins may be added to your project as Assignable FX controls. Assignable FX controls can have a series of plug-ins (chains) assigned to them.

To insert an Assignable FX:
1. Click the Insert Assignable FX button ( ) at the top of the Mixer window.
2. In the Plug-in Chooser dialog, select a plug-in.
3. Click the Add button to add the plug-in to the chain.
4. Click the OK button.

The Assignable FX control is added to the Mixer window along with any busses. Click the Assignable FX button on the control to further modify the effect.

Mute
Prevents the Assignable FX from processing the track's signal.

Input Master Fader
Adjusts the signal's incoming volume to the Assignable FX.

Output Master Fader
Adjusts the signal's outgoing volume to the Assignable FX.

Solo
Plays only the output of that Assignable FX chain.

Assignable FX
Displays the Assignable FX dialog and allows you to adjust their attributes.

Meter
Displays the incoming and outgoing signal level to the Assignable FX.

Scribble Strip
Allows you to name the Assignable FX.

Note: To use the Output Master Fader to control the wet/dry mix, make sure you set each plug-in to 100% wet. Use the Output Master (FX return) fader to balance the dry track signal with the wet plug-in signal.
Routing Assignable FX to busses

When Assignable FX are added to your project, they may be assigned to a specific bus for output. The bus will then mix the Assignable FX control’s plug-ins along with any tracks that may be routed to the same bus.

To route an Assignable FX to a bus:

1. Click Bus button (A) on the Assignable FX. A sub-menu will appear and display all the busses that are in your project.
2. Click the bus to which you want the Assignable FX control to be routed.

The Assignable FX control will display the bus’s letter to which it is routed.

Adding plug-ins

A plug-in chain is a list of all of the plug-ins that have been applied to an event or track and the order in which they have been used. A plug-in chain can contain one or more plug-ins. The same plug-in can be added to a single track more than once.

After the plug-in chain is created, the entire track will be processed by each plug-in in order. The plug-ins are cumulative so, in some cases, you may want to rearrange their order to achieve the desired effect. There are two ways to create plug-ins chains: via the Plug-in Chooser dialog and via the Plug-in Explorer window.

Adding plug-ins via the Plug-in Chooser dialog

The Plug-in Chooser dialog is accessed from the track into which you are adding the plug-in chain.

To add a plug-in chain via the Plug-in Chooser dialog:

1. Click the Track FX, Bus FX or Assignable FX button (A). A few plug-ins are already applied to a track by default, but there are no default plug-ins on a bus or Assignable FX.
2. On the Track FX or Bus FX dialog, click the Edit Plug-in Chain button ( ). The Plug-in Chooser dialog will appear. This dialog displays the track number, plug-ins already in the chain, and the plug-ins that can be added to the chain.

3. Select the plug-ins that you want to add. The plug-ins that you add will appear in the chain area. There are three ways to add a plug-in to the chain:

   - Double-click the plug-in.
   - Drag the plug-in to the chain area.
   - Select the plug-in and clicking the Add button.

4. Click OK to save the track's plug-in chain and close the Plug-in Chooser dialog.

**Adding plug-ins via the Plug-in Explorer window**

The Plug-in Explorer is a dockable window that allows you to view and choose plug-ins that may be added to a track or a bus.

**To add plug-ins via the Plug-In Explorer:**

1. If the Plug-In Explorer is not displayed, press the Alt+5 shortcut keys or, from the View menu, choose Plug-ins.
2. On the Plug-In Explorer window, navigate to the Audio folder and select the FX folder.
3. Drag a plug-in directly to the track or to the bus.

**Note:** You may add multiple plug-ins at the same time when you click them while pressing the Shift or Ctrl keys and then dragging them to the desired track.

4. Confirm that the plug-ins were added by clicking the Track FX, Bus FX or Assignable FX button (✓) to view the FX dialog. The FX may be customized at this time.

### Saving customized FX

Each plug-in has a number of preset settings that can be used to quickly determine the behavior of the plug-in. There are also a number of controls within each plug-in’s dialog that can be used to customize the effect. Any custom configurations can be saved to a new preset.

**To save custom presets:**

1. Enter a preset name in the drop-down list.
2. Set the EQ controls on each band that you want to customize.
3. Click the **Save** button (✓) to save the preset.

**Note:** You may delete any presets that you have saved by selecting it from the list and clicking the **Delete** button (✗).
Plug-in chains

Plug-ins are cumulative during playback. For example, when the track’s signal passes through the EQ, it uses the EQ’s settings as it passes through the Compression plug-in, and then the signal is sent to the next plug-in, and so on.

Because of this cumulative effect, you may need to arrange plug-ins in a certain order so that one plug-in’s processing does not adversely affect the next plug-in on the chain. There is no right or wrong way to order plug-ins, but some plug-ins work better when arranged in a particular order.

To arrange the plug-in order from the Track FX, Bus FX or Assignable FX dialog:
1. Click the Track FX, Bus FX or Assignable FX button (/png).
2. On the plug-in that you want to move, right-click to display a shortcut menu and choose Move Left or Move Right. Plug-ins can also be dragged to a new position.
3. Once the chain’s plug-ins are in the order that you want, click anywhere outside the Track FX dialog to close it and save the new chain order.

To arrange the plug-in order from the Plug-In Chooser dialog:
1. Click the Track FX, Bus FX or Assignable FX button (/png).
2. Click the Edit Plug-In Chain button (/png). The Plug-In Chooser dialog will appear with the plug-in chain.

There are two ways to arrange plug-ins in your chain:
- Drag the plug-in to a new location in the chain.
Select the plug-in and click either the Move Left ( ) or Move Right ( ) button.

3. Once you arrange the plug-ins in the order that you want, click OK to save your changes and close the Plug-In Chooser dialog.

**Bypassing plug-ins on the chain**

You may bypass plug-ins on the chain by clearing the check box on a specific plug-in or by right-clicking the plug-in to display a shortcut menu and choosing Bypass. The plug-in will remain bypassed until you enable it again. Bypassing a plug-in prevents it from being processed on the track or bus.

You may bypass plug-ins either from the Track FX or Bus FX dialog or the Plug-In Chooser dialog.

**Removing plug-ins from a chain**

Chain plug-ins may be removed from either the audio FX dialog or the Plug-In Chooser dialog.

To remove a plug-in from the chain:

1. Click the Track FX, Bus FX or Assignable FX button ( ).
2. Select the plug-in that you want to remove.
3. Right-click to display the shortcut menu and choose Remove.

To remove a plug-in from the chain in the Plug-In Chooser dialog:

1. Click the Track FX, Bus FX or Assignable FX button ( ).
2. Click the Edit Plug-In Chain button ( ). The Plug-In Chooser dialog will appear with the plug-in chain.

3. Select the plug-in that you want to remove and click Delete to remove it from the chain.

4. Click OK to save the chain and close the Plug-In Chooser dialog.

**Saving plug-in chains**

You may save and edit the plug-in chains that you added to tracks or busses or created as Assignable FX controls. These chains will be stored by Vegas for use in future projects. If you use the same plug-in chains, saving them as presets is faster and more consistent than recreating the chain manually. Plug-in chains may be saved from existing chains that are being used in a project or as they are created for tracks, busses or Assignable FX.

The first time a plug-in chain is created, it is added as a track, bus or Assignable FX chain in the Plug-in Chooser dialog. Once the chain is saved as presets, they may be used as either track, bus or Assignable FX plug-in chains. Saved FX chains appear in the Plug-in Chooser dialog.

---

**Note:** Plug-in chains can also be saved in the Plug-in Chooser dialog. For more information, see Saving plug-in chains on page 200.

---

**Saving plug-in chains**

Plug-in chains may be saved as presets. Saving carefully constructed chains as presets will save time and maintain consistency when editing a project. Saved chains retain the order of plug-ins and the settings that have been applied.
After the preset chain is saved, it may be applied to a track, a bus or an Assignable FX.

To save an existing plug-in chain as a preset:

1. Click an existing Track FX, Bus FX or Assignable FX button ( ▶️ ) and then the Edit Plug-in Chain button ( ▶️ ) to display the Plug-in Chooser dialog.
2. Once the Plug-in Chooser dialog is displaying with the plug-ins on the chain area, click Save As. The Save plug-in chain dialog will appear.

3. Enter a name that you want to use for the preset.
4. Click OK or press the Enter key to save the preset.

Editing saved plug-in chains

Plug-ins on preset chains may be added, deleted, and rearranged at any time. Editing is preformed in the Plug-in Chooser dialog.

To edit a saved plug-in chain:

1. Click the Track FX, Bus FX or Assignable FX button ( ▶️ ).
2. From the FX dialog, click the Edit Plug-in Chain button ( ▶️ ). The Plug-in Chooser dialog will appear with the preset in the chain area.
3. Add, delete, or rearrange plug-ins associated to the preset chain.
4. Click the OK button or press the Enter key to save the preset.

Note: Click the Save As button to save the edited chain as a preset.

Organizing your plug-ins

Within the Plug-in Chooser dialog, folders may be created to organize the plug-ins. This is useful if third-party DirectX plug-ins are installed on your computer. These can then be moved to the newly created folders.
The Plug-in Chooser dialog is similar to the Windows Explorer. Only plug-ins that are loaded on your system from the Plug-in Chooser dialog will be available.

Non Real-Time Event FX

Non Real-Time Event FX are a different method of applying audio effects in Vegas. In most cases, event editing in Vegas is non-destructive, meaning that edits and effects are applied to events in real-time and not to the source media file, which remain unaltered. There may be times however when you want to create a permanent file using an effect or effects. This may be useful in a very complicated project or when a slower computer cannot process the effects quickly enough for a real-time preview.

To use non real-time effects:

1. Select an audio event.
2. From the Tools menu, choose Audio.
3. From the submenu, choose Apply Non Real-Time Event FX.
4. In the Plug-In Chooser dialog select a plug-in.

5. Click the Add button.

6. Click OK.

7. In the Destructive FX dialog, set up the effect.

8. Click the Process button ( ) to finish.

9. In the Save As dialog, save the newly processed media file.

The new media file is inserted into the event as a take. Multiple plug-ins can be added to the plug-in chain. Chains can be saved for future use.

Audio plug-ins

Different versions of the Vegas family of products contain different varieties of effects, with the full versions of Vegas Video and Vegas Audio containing the most complete set.

Vegas includes four built-in audio plug-ins that you can add to your project: Equalization (EQ), Compression, Noise Gate, and Dither. Each plug-in has its own control settings that determine how a track is processed for final output. The tracks in your project that use the same plug-in may be set independently of each other. For example, if you are applying Compression to Track 1 and Track 2, each track can have different compression settings.

Note: There is a similar Video plug-in section later in this manual. For more information, see Video filter dictionary on page 269.

The following sections describe each plug-in and how they affect the track.
Equalization (EQ)

This plug-in functions as a parametric equalizer (an equalizer with “parameter” controls.) This type of EQ gives you more control over the track’s frequencies range. When this plug-in is added to a track, it allows you to modify the track in a four-frequency range. Each band can be configured to control its bandwidth, rolloff, and whether it operates as a peak or a shelving filter with full gain (volume) control.

These controls can boost or attenuate (cut) specific frequencies modifying the track’s overall tonal characteristics. The EQ plug-in is set on the Track FX dialog, which you can access by clicking the Track FX button ( ).

If you only want to modify one frequency range, set its controls and exit the Track FX dialog. The other bands will not affect the track's events.

Presets

The drop-down list allows you to automatically set the EQ controls by choosing one of the included presets. You may also save your own custom presets for use with other tracks.
Enable control

This control turns the effect on and off.

Band mode drop-down control

Select the band that you want to modify.

This drop-down list has three options to choose from: Low shelf, Band, and High shelf.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low shelf</td>
<td>The low-shelf setting attenuates (cuts) or boosts frequencies by the amount you specify below the low-shelf cutoff frequency. This setting may also function as a high-pass filter when you increase the rolloff control.</td>
</tr>
<tr>
<td>Band</td>
<td>The band setting affects the center frequency by attenuating or boosting the frequency range around it. The frequency range that is affected is determined by the Bandwidth control’s setting.</td>
</tr>
<tr>
<td>High shelf</td>
<td>The high-shelf setting attenuates or boosts frequencies by the amount you specify above the high-shelf cutoff frequency. This setting may also function as a low-pass filter when you increase the rolloff control.</td>
</tr>
</tbody>
</table>

Frequency (Hz) control

This control determines the high- or low-cutoff frequency depending on whether the band mode is set to either High or Low shelf. If the band mode is set to Band, then the Frequency control sets the center frequency level.

Gain (dB) control

This control determines the overall gain (volume) that is applied to the selected band. Increasing the Gain control causes the frequency range to play back louder. Conversely, decreasing the Gain control causes the frequency range to play back quieter.

Select a preset from the list or save your own preset.
Rolloff (dB/oct) control

This control is only available when Low shelf or High shelf band mode is selected. The Rolloff filter determines the number of decibels that are reduced per octave (the filter's steepness).

Bandwidth control

This control is only available when Band is selected as the band mode. Bandwidth determines the range of affected frequencies, around the center frequency, that are attenuated or boosted by the EQ.

Compression

The Compression plug-in allows you to minimize the dynamic range and control the signal's volume fullness and punch. Also, you can prevent volume clipping as you increase the signal's volume. Therefore, the Compression plug-in is very useful during the mastering process because you can play back the track at a higher volume and yet the sound remains undistorted.

Controlling clipping

The Compression plug-in has two meters to monitor the input and output signals. If either signal clips, these meters will display in red at the end with a clipping value. Adjust the Compression controls and click the red area with the clipping value to reset the meter.

You may also reset the clip from the shortcut menu when you right-click on a meter. In addition, you may set the meter to use a different resolution and set it to hold peaks and valleys of the incoming or outgoing signal.
Presets
The drop-down list allows you to automatically set the Compression plug-in controls by choosing one of the included presets. You may also save your own custom presets for use with other tracks.

Input Gain (dB) control
This control adjusts the volume level of the incoming signal. The associated meter displays this incoming signal's level before the Compressor plug-in processes the signal.

Output Gain (dB) control
This control adjusts the volume level of the outgoing signal. The associated meter displays outgoing signal after the Compression plug-in processes the signal.

Reduction meter
This meter displays the level at which the Compression plug-in is lowering the signal's volume at any given time during playback. The Reduction meter is a good visual reference to monitor compression values.

Threshold (dB) control
The Threshold control determines the level at which the dynamics processor begins acting on the signal. When the signal's level is above the threshold level, it will be compressed. A lower threshold level means that more of the signal will be compressed. However, if the threshold is set too low, the compressed signal may be distorted.

Amount (x:1) control
This control determines the ratio the Compression plug-in uses when processing a signal. The ratio is determined by how many decibels the signal must rise above the threshold value to result in a 1 dB increase in output level after compression.
For example, if the Compressor plug-in is set with a 3:1 ratio and the input’s signal rises 6 dB above the threshold value, the Compressor plug-in only allows the level to increase by 2 dB. Therefore, the Compressor plug-in reduces the signal by 4 dB.

\[ \text{Note: Levels that occur below the threshold value are not affected by the Compression plug-in.} \]

**Attack (ms) control**

When the input signal rises above the threshold value, the Attack control determines, in milliseconds, how quickly the Compression plug-in reaches its maximum gain reduction value.

**Release (ms) control**

This control determines, in milliseconds, how quickly the Compression plug-in returns to no compression after the signal falls below the threshold. The release time always follows the attack time during compression.

**Auto Gain Compensation control**

This toggle control, when enabled, boosts the output’s signal by a constant amount. The boost amount is based on the Threshold and Ratio setting. This control is useful for preventing an overall level loss when compressing audio. However, even when using the Auto gain compensation control, you should use the Output Gain control to fine tune the output’s level.

**Smooth Saturation control**

This toggle control, when enabled, modifies the compression level in order to lower pumping or breathing distortion that can occur when applying a lot of signal compression.
Using the Noise Gate plug-in

The Noise Gate plug-in is a good way to eliminate (mask) subtle noises like tape hiss or low-level electric hum from the signal. This plug-in has a threshold control that determines what level of signal may pass through the gate. Signals that exist below the threshold are prevented from passing through (the gate closes); whereas signals above the threshold are allowed to pass through (the gate opens).

Presets

The drop-down list allows you to automatically set the Noise Gate plug-in controls by choosing one of the included presets. You may save custom presets for use on other tracks.

Threshold level (0dB to -inf.) control

This control allows you to set the signal’s threshold level. Signals below this level will be eliminated (muted), while signals above the threshold will remain in the output sound. If the threshold level is set too high, you may eliminate material intended to be output.

Attack time control

This control determines how quickly the Noise Gate plug-in opens when the signal rises above the threshold level. We recommend setting the attack time to a smaller value to achieve the best results. If the attack time is too slow, the beginning of wanted signal may be cutoff because the volume is rising too slowly.

Release time control

This control determines how quickly the Noise Gate plug-in closes when the signal falls below the threshold level. We recommend setting the release time to a larger value. Larger values cause the signal to sound more natural while it decays (fades). If the release time is too fast, the end of wanted signals may be cutoff because the volume fades too quickly.
Using the Dither plug-in

The Dither plug-in is best used at the last stage when processing a signal from a higher bit depth to a lower one. The Dither plug-in is best used as a Bus FX rather than a Track FX. The Dither plug-in adds a low-level, random noise to the signal. This added noise is used to mask more obtrusive noise caused by quantization. Quantization noise is the inherent distortion that is added to a signal due to digital processing.

In addition, the Dither plug-in contains three noise-shaping algorithms. These algorithms further hide quantization noise by pushing it to a frequency that is less sensitive to human hearing.

Quantization depth (8 to 32 bit) control

This control determines the audio's final target bit depth. For example, if the audio is to be rendered to a *.wav file and written to a CD, you would want to select 16-bit. This setting will optimize the signal's high bit depth that is processed by the Dither plug-in. As a result, the relatively low bit depth that is used for a signal being stored on CD will have better quality output.

Dither depth (1/2 or 1 bit) control

This control sets the different noise levels that the Dither plug-in will add to the signal based on the Quantization depth setting. Lower quantization bit-depths may benefit from a higher Dither depth setting.

Noise shape type (Off, 1, or 2) control

This control lowers the signal's noise floor by moving noise into frequencies less sensitive to human hearing. This moving of noise is referred to as noise shaping. The frequencies to which the noise is moved are close to the Nyquist frequency (half the sample rate of the audio). Consequently, you should avoid using the Noise Shape control with signals with lower sample rates. For example, a 22 kHz signal has a Nyquist frequency of 11 kHz. If you use Noise shape on this 22 kHz signal, the noise will be moved into the sensitive area of human hearing (11 kHz). It is recommend that the Noise Shape control only be used for signals that are 44.1 kHz and higher.
Additional plug-ins

Different versions of the Vegas family of products contain different varieties of effects, with the full versions of Vegas Video and Vegas Audio containing the most complete set. Complete online Help is available for all plug-ins.

XFX

XFX are professional level plug-ins that offer the highest level of control and are included with the full versions of Vegas Video and Vegas Audio.

- **XFX 1 DirectX plug-ins**: Chorus, Multi-Tap Delay, Pitch Shift, Reverb, Simple Delay/Echo, and Time Compress/Expand.
- **XFX 2 DirectX plug-ins**: Graphic Dynamics, Graphic EQ, Multi-Band Dynamics, Noise Gate, Paragraphic EQ, and Parametric EQ.
- **XFX 3 DirectX plug-ins**: Amplitude Modulation, Distortion, Flange/Wah-Wah, Gapper/Snipper, Smooth/Enhance, and Vibrato.

ExpressFX

ExpressFX are fast and easy to use plug-ins and are included with Vegas Video LE and Vegas Audio LE.

- **ExpressFX 1 DirectX plug-ins**: Distortion, Flange/Wah-Wah, Reverb, and Stutter.
- **ExpressFX 2 DirectX plug-ins**: Amplitude Modulation, Chorus, Delay, and EQ.
The Vegas Mixer is where you control the project's audio mix. All of the bus and Assignable FX controls appear in this window when you add them to your project.

The Mixer window and multiple audio busses are only available in the full versions of Vegas Video and Vegas Audio.

Using the Mixer window

The Mixer is a dockable window that can be used to control various audio busses within your project and can adjust the outgoing signal's volume and routing.

Viewing the Mixer window

The Mixer window appears in the Windows Docking Area by default when you first start Vegas. However, you may drag the Mixer within the workspace at any time to float it. For more information, see Docking a window on page 342.

To hide/view the Mixer window, choose Mixer from the View menu or use the Mixer window's shortcut keys (Alt + 3).
Using the Mixer tool bar

The Mixer's toolbar allows you to access project properties, switch your project between mono to stereo output, and add Assignable FX controls to the Mixer.

When you change a project from stereo to mono or vice versa, the bus faders and meters that appear in the Mixer window will reflect the change.

Using the Mixer Preview fader

The Preview fader allows you to adjust the volume and monitor output levels of media files when you preview them from the Explorer window or play them back from the Trimmer window. For more information, see Using the Explorer window Transport bar on page 347.

Adjusting the volume fader

You may adjust the Preview fader while you are previewing a media file from the Explorer window. Simply click on the fader and drag it up or down.
Changing meter resolution
You may select a preferred meter resolution at which the Preview fader will display the media file’s volume level. When you change the meter resolution on Preview fader, the other meters (busses and Assignable FX) automatically change to match the Preview fader.

To change the Preview fader’s meter resolution:
1. Right-click on the meter to display a shortcut menu.
2. From the shortcut menu, choose the meter resolution you prefer.

Adjusting for clipping
When you preview a media file from the Explorer, its volume level may be too high and cause clipping. The clip is displayed on the Preview fader’s meter. If signal clips, the meter will display in red at the top with the clipping value displayed in decibels (dB). Adjust the fader and click the red area with the clipping value to reset the meter. Continue to adjust the fader and reset the meter until clipping is eliminated.

Right-click on the Preview fader’s meter and click Reset Clip to clear the red clipping indication. The Preview fader’s meter can be set to remember and display the highest and lowest levels by right-clicking and selecting Hold Peaks and Hold Valleys.

Hiding/Viewing the Preview fader
You may choose to hide the Preview fader to make more room for other busses and Assignable FX. To hide or view the Preview fader, simply right-click anywhere within the Mixer and choose Show Preview fader from the shortcut menu.
Using busses

Multiple audio busses are only available in the full versions of Vegas Video and Vegas Audio.

The volume control sliders and level meters that are visible in the Mixer window are each linked to a separate bus. A bus is a master control for a track's audio-signal mix. Tracks can also be assigned to play back on a specific bus. For more information, see Assigning an audio track to an auxiliary bus on page 190. However, to assign a track to a bus, you must have more than one bus in your project. You may add up to 26 busses to the Mixer window, which provides power and flexibility on complex projects. A bus is the last stage in the signal's flow through Vegas. For more information, see Audio Signal Flow on page 43.

With Vegas busses, you control the volume level on two discrete stereo channels (unless the project is set to mono). Each bus in your project may be muted, soloed, and assigned to use DirectX plug-ins. In addition, you may configure each bus to use a specific hardware output. For more information, see Routing tab on page 365.

Adding busses to the project

You may add busses at any time during the development of your project. A bus is most commonly used as a master control for one or more tracks and to route those tracks to a specific hardware output.

However, you may already know how you want to handle a certain project and set up the busses prior to recording or placing media files. The number of busses that you specify are determined by several factors that are based on your preferences. For example, you may want to have a bus for each hardware output that you intend to use or a bus for handling DirectX plug-ins. Remember, the number of busses in your project may be changed at any time.
Busses may be added to your project from the Project Properties Audio tab.

To add busses to your project:

1. Access the Project Properties dialog. There are three ways to access this dialog:
   - From the **File** menu, choose **Properties**.
   - Click the **Project Properties** button ( ) on the Mixer window on the Toolbar.
   - Press the **Alt+Enter** shortcut keys.
2. Click the **Audio** tab.
3. In the **Number of stereo busses** box, enter the desired number of busses (up to 26) that will appear in the Mixer window. The busses will be labeled with letters in alphabetical order.
4. Click OK to add the specified number of busses and close the Project Properties dialog.

Deleting busses from the project

You may remove busses from your project at any time. When you remove a bus from a project, any tracks assigned to it will be reassigned to the previous bus in the Mixer window. For example, if you have tracks assigned to four busses (Bus A-D) in your project and remove Bus D, the tracks that were assigned to Bus D will be reassigned to Bus C.

Busses may be deleted from your project from the Project Properties Audio tab.

To delete busses from your project:

1. Access the Project Properties dialog. There are three ways to access this dialog:
   - From the **File** menu, choose **Properties**.
   - Click the **Project Properties** button ( ) on the Mixer window or on the Toolbar.
   - Press the **Alt+Enter** shortcut keys.
2. Click the **Audio** tab if it is not displayed.
3. In the **Number of stereo busses** field, enter the desired number of busses that will appear in the Mixer window.
4. Click OK to delete the specified number of busses and close the Project Properties dialog. All tracks assigned to a deleted bus will be reassigned to the preceding bus in the Mixer window.

Routing busses to hardware

You may assign busses to use specific hardware for output. When you installed Vegas, it automatically detected the hardware available for output on your computer. Routing busses is done on the Preferences dialog. There are more details about routing specifics and other preferences later in this manual. For more information, see Using Vegas preferences on page 360.

To route busses to specific hardware:

1. From the Options menu, choose Preferences. The Preferences dialog will appear.

2. On the Preferences dialog, click the Routing tab.

3. Select Use a Custom Routing.

Note: If you have selected Always Use Sound Mapper, you will not be able to assign the busses to different hardware. You can only assign busses to different hardware if you select Use a Custom Routing.
4. In the table, click the radio button in the output device’s row and in the bus’s column to assign a bus to a specific output device.

```
<table>
<thead>
<tr>
<th>Buses</th>
<th>Bus A</th>
<th>Bus B</th>
<th>Bus C</th>
<th>Bus D</th>
<th>Bus E</th>
<th>Bus F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sound card 1</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Sound card 2</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Sound card 3</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Sound card 4</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>
```

**Note:** Multiple busses may be mapped to a single sound card. Grayed-out busses are not yet being used in the project, but can still be assigned at this time for future use.

5. From the Default recording device drop-down list, select a device used when recording. This option sets the device that you use for recording into tracks. Tracks may be set to use specific devices other than the default setting. For more information, see Assigning tracks to input devices on page 227.

6. Click OK or press the Enter key to save the information and close the Preferences dialog.

**Working with busses**

Busses in the Mixer window are fully independent and may be adjusted separately. Bus volume, meter resolution, and clipping controls may all be adjusted.
Adjusting the bus fader
You may adjust a bus’s fader during project playback by dragging the handles on the fader. The fader on a stereo bus is split so that you can adjust the levels of the two stereo channels independently.

**Note:** Double-click the fader to reset it to 0.0 dB. If you have set each channel independently, double-click either the left or right fader to have the other fader match the other’s volume setting.

Changing bus meter resolution
You may select a meter resolution at which a bus will display the signal levels that are being mixed. When you change the meter resolution on this control, the other meters (Assignable FX and Preview fader) are automatically changed to match.

**To change the bus’s meter resolution:**
1. Right-click on the meter to display a shortcut menu.
2. From the shortcut menu, choose the meter resolution. For more information, see Changing meter resolution on page 215.

Adjusting the bus for clipping
If the volume level is set too high, it may cause clipping. The clipping is displayed on a meter in red at the top with the clipping value displayed in decibels (dB). Adjust the fader control and click the red area with the clipping value to reset the meter. Continue to adjust the fader and reset the meter until clipping is eliminated.

The meter can be set to remember and display the highest and lowest levels by right-clicking and selecting **Hold Peaks** and **Hold Valleys**. For more information, see Adjusting for clipping on page 215.

Muting a bus
This bus button enables you to temporarily disable playback of the bus. When a bus is muted, it is grayed out and the word **Muted** appears at the bottom of the meter. You may mute more than one bus at a time.

To mute the bus, simply click the **Mute** button ( ). Click it again to unmute the bus.
Soloing a bus

Soloing is not available, nor necessary, in versions of Vegas that only have a single bus. The full versions of Vegas Video and Vegas Audio both allow multiple busses.

Soloing isolates a bus’s playback and mutes the other busses, so you can focus on a specific output. When you solo a bus, the other busses will be grayed out and the word Muted appears at the bottom of their respective meters. You may solo more than one bus at a time.

To solo the bus, simply click the Solo button ( ). Click it again to restore all busses for playback.

Naming or renaming a bus

Every bus that appears in the Mixer window has a Scribble Strip where you can type a name.

To name or rename a bus:

1. Double-click in the Scribble Strip and type the a bus name.

2. Press the Enter key to save the bus’ name.
Vegas can record audio into multiple mono or stereo audio tracks while simultaneously playing back existing audio and video tracks. You are limited only by the performance of your computer system and audio hardware. Audio is recorded to a media file on your computer and into an event on the timeline. You may record into an empty track, a time selection, an event, or a combination of time and selection. Audio output from your computer during recording is not necessarily recorded with the new audio.

Recording in Vegas does not alter any of the source media files in your project. Even when recording into an existing event, you are not overwriting the data that is already displayed in that event. Instead, the data is recorded into a new take for that event.

Setting up your equipment

There are numerous ways to connect your equipment to your system. Refer to your equipment's documentation for specific setup instructions. The following are some possible general configurations.

Basic setup

This setup includes a simple microphone and speaker that are connected to the computer's sound card. With a more sophisticated microphone, you would typically want to use a preamplifier for input to the sound card.
Setup with mixer

This setup includes a mixer where the speaker and microphone connect. The mixer is then connected to the computer's sound card. Mixers usually have pre-amps built into them. This diagram does not show you an instrument or a physical preamplifier, such as a rack-mounted component. The reason for this omission is because these types of setup vary widely based on your mixer, instrument, and pre-amp type. Refer to your components' documentation for specific setup configurations.

Setup with digital multitrack

This setup includes a digital multitrack recorder with an optional MIDI synchronization component. Usually you would have a mixer, a microphone, etc. connected to these components. Your particular setup will vary depending on your equipment. Refer to your components' documentation for specific setup configurations.
Synchronizing MIDI Time Code

Vegas can generate (output) MIDI time code to synchronize external devices with project playback or can chase to (be triggered by) MIDI time code generated by an external device. To output, from the **Options** menu, select **Generate MIDI Time Code** or **Generate MIDI Time Clock**. To allow Vegas to be triggered by an external MIDI device, from the **Options** menu, select **Chase to MIDI Time Code**. For more information, see **Sync tab on page 367**.

Arming the track for recording

Whether recording into an empty track, a selected event, or a time selection, a track needs to be prepared for recording. To prepare a track, click the **Arm for Record** button ( ). A track must be armed before any new data is created. You may arm multiple tracks prior to recording. Once a track is armed, a record meter will appear on the track to be recorded into. There will also be one of two recording device buttons: ( ) or ( ). The button that appears is based on the preferences routing tab. For more information, see **Routing tab on page 365**.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Stereo" /></td>
<td>This button appears when Use Microsoft Sound Mapper has been selected for all busses on the Preferences routing tab. The Sound Mapper allows you to choose how the signal will be recorded: stereo or mono. Click on this button to view a menu with Stereo, Left, or Right. To record in mono choose either the left or right channel prior to recording. When either the left or right channel has been selected, the button will change to reflect your choice for mono recording.</td>
</tr>
<tr>
<td><img src="image" alt="Mono left" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Mono right" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Stereo" /></td>
<td>This button appears when Use custom bus routing has been selected on the Routing tab in the Preferences dialog. When you choose this option, you can specify which device (e.g. sound card) you will record from on any given track prior to recording. Click on this button to view a menu with all available devices and Stereo, Left, or Right. You may record in stereo or mono. The device that has been selected will have a number assigned to it. This number will appear on the button.</td>
</tr>
<tr>
<td><img src="image" alt="Mono left" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Mono right" /></td>
<td></td>
</tr>
</tbody>
</table>
Using the metronome

Vegas has a built-in metronome that marks time to help with the timing and tempo when recording a performance. The metronome’s sound is not mixed in the final rendering of the project. To use the metronome, from the Options menu, select Metronome. The metronome uses audio files to mark both the beat and accents. You can change the particular audio files that are used from the Preferences dialog.

To select audio files for the metronome:
1. From the Options menu, choose Preferences.
2. Click the Audio tab.
3. Under the Metronome sound files section, select a Normal and Accent beat audio file.

Although just about any file will work as a metronome sound, files with very short durations are recommended. The volume of the metronome can be controlled with the Preview fader in the Mixer window.

Using the Sound Mapper for stereo or mono recording

After the track has been armed for recording, you may choose whether the track will record the signal in stereo, in mono from the left channel or in mono from the right channel. Stereo is the default setting.

To select a recording method:
1. Click the Audio button (ارة) to the left of the Arm for Record button ( Phill ) to display a drop-down list.
2. From the drop-down list, choose the recording method (Stereo, Left, or Right).
Assigning tracks to input devices

After the track has been armed for recording, select the device from which the track will record, and then choose whether the track will record the signal in stereo, in mono from the left channel, or in mono from the right channel.

Vegas will display the selected device and recording options on the track’s toolbar.

To select an input device and recording method:
1. Click the Audio button ( ) left of the Arm for Record button ( ) to display a drop-down list.
2. From the drop-down list select the input device and recording method (Stereo, Left or Right).

Recording

Starting and stopping recording

To start recording, click the Record button ( ) on the Transport bar, which is located just below the timeline.

Depending on the recording selection, a waveform will be created along the timeline as you record into the armed track(s).

To stop recording, click the Record button ( ) again or the Stop button ( ) on the Transport bar. A dialog will appear allowing you to rename, delete, or keep the *.wav file.
Note: The Recorded Files dialog does not appear if you are chasing to MIDI time code, as this would interrupt the synchronizing. Instead, files are automatically named and saved according to your preferences.

Simultaneous Play & Record
By default, the project plays back while you are recording the new events. There may be times where you want to turn this off. To disable this feature, click the Options menu and make sure Simultaneous Playback & Record is not selected.

Chasing MIDI Time Code
MIDI time code can only be chased in the full versions of Vegas Video and Vegas Audio.
Recording can be triggered and synchronized in Vegas by an external MIDI device that outputs (generates) MIDI Time Code.
To chase MIDI Time Code:
1. From the Options menu, choose Preferences and go to the Sync tab.
2. From the Chase to MIDI Time Code settings, select the device that you want to trigger Vegas. Click OK and close the Preferences dialog.
3. Click the Arm for Record button (●).
4. Right-click the Time Display and choose MIDI Time Code In. The Time Display now shows the Time Code being generated from your MIDI device. The top of the display reads MTC Input Waiting.

5. Begin generating MTC from your MIDI device. The top of the Time Display now reads MTC Input Locked, the time updates from the MIDI device, and Vegas automatically begins recording. Typically, there is a short delay between when you begin generating MTC and synchronization.

For best results, it is best to not rely on the software to chase the MTC, but to have your audio devices connected together via a master digital word clock. When your devices are connected to a master digital word clock you should have Trigger playback only (do not chase) enabled in the Advanced Sync Preferences (pg. 368). The word clock will keep the audio hardware locked together, eliminating the need for the software to constantly vary its playback rate to stay synchronized. The incoming MTC is only be used for absolute time reference. For more information, see MTC input on page 368.

Recording into an empty audio track

Recording into an empty audio track is the easiest way to record new material into an existing project. Vegas will create the new event’s waveform during the recording process. The recorded event, like all events in your project, will have an associated source media file. By default, Vegas stores recorded media files in the Vegas program folder or you may specify where recorded media files are stored. For more information, see Specifying where recordings are stored on page 238.

On the Track View, the cursor position indicates where recording will begin. Positioning the cursor is not always necessary since it is easy to edit and move the event after recording.

To record into an empty track:

1. Press the Ctrl+0 keys to insert an empty audio track or from the Insert menu, choose Audio Track.
2. Place the cursor on the timeline where you want to begin recording.
3. Select the audio track that you want to record into.
4. Arm the selected track by clicking the Arm for Record button (●) on the track.
5. Start recording by clicking the **Record** button ( ) on the Transport bar.

Recording will begin at the cursor's position and continue along the timeline until you stop recording.

6. Click the **Stop** button ( ) to stop recording. A small dialog opens displaying the name and location of the file or files that were just created. Click **Done** to return to the main workspace.

When you are finished, click the **Arm for Record** button again to disarm the track. Here are some other options for recording:

- You can recording into multiple tracks at the same time.
- Choose the input device from which the track will record (pg. 227).
- Choose the recording method that the track will use (pg. 227).
- Recording can be done in stereo or to the left or right channel by clicking the Bus Assignment button after arming the recording process.

**Recording a voiceover**

Voiceover narrations are an important part of many types of productions. One of the most important features of Vegas is the ability to record live audio directly into a project while previewing the project itself. This can be done while simultaneously listening to the audio tracks and watching a preview of the video.

To view the Video Preview window, click the **Options** menu and make sure **Simultaneous Play & Record** is selected. The strength of recording narrations this way is that it is very easy to stop, restart, and edit the resulting audio events.
Recording into a time selection

By making a time selection, you specify where along the timeline to record. The time selection also determines how long Vegas will record. Any selected events that occur within the time selection will be split and the recorded data will be placed into the time selection. For more information, see Recording into an event with a time selection on page 232.

To record into a time selection:

1. Click the Arm for Record button (●) on the desired track.

   **Note:** To select multiple tracks, click them while pressing either the Shift or Ctrl keys.

2. Choose the input device from which the track will record (pg. 227).

3. Choose the recording method that the track will use (pg. 227).

4. On the Marker bar, click and drag to make the time selection. You may adjust the time selection by dragging the Loop bar’s starting and ending points.

5. Click the Record button (○) on the Transport bar to begin recording.

Vegas will display the event’s waveform as it is recorded and automatically stop recording when the cursor reaches the end of the time selection.

To record multiple takes, click the Loop Play button (●) on the Transport bar. For more information, see Working with multiple recorded takes on page 234.
Recording into an event

By recording into an event, the exact length of the recording is controlled by the duration of the event. The edges of the selected event serve as the punch-in and -out points that Vegas uses for recording. Recording into an event allows you to establish a pre-roll before recording, which gives you time to prepare before recording starts.

The existing event that you record into is not affected or deleted. Instead, the event will now contain two media files, each listed as a separate take in the event. For more information, see Working with multiple recorded takes on page 234.

To record into a selected event:

1. Place the cursor before the event to allow for pre-roll.
2. Press the **Ctrl** key and click the event to select it.

![Selected event](image1)

![Non-selected event](image2)

**Note:** You may record into multiple events by pressing the **Ctrl** key and make your selections.

3. Click the Arm for Record button ( ● ) on the event’s track. When recording into multiple selected events, arm their respective tracks at this time.
4. Click the Record button ( ○ ) on the Transport bar to begin recording.

![Start/Stop recording](image3)

Vegas will display the event’s waveform as you record.
5. Click the Record button ( ● ) again or the Stop button ( ■ ) on the Transport bar to stop recording.

Recording into an event with a time selection

Recording into a time selection allows you to compensate for a pre- and post- roll during recording. The time selection is adjustable to increase or decrease the pre- and post-roll duration. During recording, the selected event’s edges serve as the punch-in and -out points. Multiple punch-in and -out points can be created by selecting more events within the time selection.
You may need to split an existing event into three pieces so that you can select a smaller portion of the event to record into. For more information, see Splitting events on page 122.

To record into an event with a time selection:

1. Click the Arm for Record button (●) on the desired track(s).
2. Select the event to record into.

   **Note:** You may record into multiple events by pressing the Ctrl key and make your selections.

3. On the Marker bar, click and drag to make the time selection. You may adjust the time selection by dragging the selection bar’s starting and ending points. Make the time selection start before the event for a pre-roll.

   To record multiple takes, click the Loop play button (‖) on the Transport bar. For more information, see Working with multiple recorded takes on page 234.

4. Click the Record button (○) on the Transport bar to begin recording.

Using a pre-roll

The previous technique allows you to define the playback region with a time selection and sets the punch-in and punch-out points in the recording to the event boundaries. When the Record button is pressed, playback begins at the beginning of the time selection. The event is then filled with the newly recorded material. The audio file that is recorded to your hard disk is the full duration of the time selection. The event only contains a portion of the full recorded performance and can therefore be trimmed (both shorter and longer) and repositioned within the event.
Working with multiple recorded takes

Clicking the Loop Play button on the Transport bar will enable you to continually create takes during recording. Takes are different versions of a recorded event that can be quickly switched between to choose the best one. Each take within an event references a different source media file.

During recording, Vegas continually repeats the time selection and starts recording a new take until you stop recording. Takes can be previewed, selected, and deleted.

Previewing takes

Vegas allows you to view a list of takes and preview them before placing them in your project. The takes are listed from the selected event in which the takes were recorded.

To preview takes:
1. Select the event in which multiple takes were recorded.
2. Right-click to display a shortcut menu or, from the Edit menu, choose Takes to display a submenu.
3. Select Choose Active... from the submenu. The Take Chooser dialog appears.
4. Select the take that you want to preview and use the Play ( ) and Stop ( ) buttons within the dialog.
5. To use a take, select it and click OK or double-click the take that you want to use. The selected take is now the active take.
Choosing an active take after loop recording

As an alternative to the previous section, the active take may be selected using the shortcut menu. After multiple takes have been recorded, the take that appears on the timeline is called the active take. The active take is the last one recorded.

To change the active take:

1. Select an event with multiple takes.
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose **Take**. A submenu will appear with the event’s original file name (in this example, GuitarIntro) followed by the recorded takes, which are numbered sequentially. The active take will have a bullet next to it.

   **Note:** To avoid confusion, it may be useful to rename takes with different names. For more information, see Renaming an event take on page 236.

4. Select the take that you want to make active by clicking it.
Renaming an event take

Vegas names recorded takes by specifying the track number and the take number, for example, Track 2 Recording 24 Take 2. These take names are specific to your project, but are not descriptive of what sound(s) were recorded. Takes may be renamed and to give them more meaningful descriptions for easier reference while working on a project. Only the currently active take may be renamed. For more information, see Choosing an active take after loop recording on page 235.

To rename an event take:

1. Click an event to select it. The event being displayed is the active take.
2. Right-click on the selected event to display a shortcut menu.
3. From the shortcut menu, choose Rename Active. The take’s name will appear in a text box in the lower-left portion of the event. The event’s take name will be selected.
4. Type a new name in the text box.
5. Press the Enter key to save the new take name or click outside the text box.

Note: Event names may be changed via the event’s properties. For more information, see Take names on page 152.
Deleting an event take

Unwanted takes can easily be deleted from your project. Deleting a take does not remove the event or the source file. Source files must be deleted manually. For more information, see Using the Explorer window on page 344. There are two ways to delete event takes: deleting the active take and deleting takes from a list.

Deleting the active take

The active take is the event that appears on the timeline. If the event take you want to remove is not displayed, make it the active take before deleting it. For more information, see Choosing an active take after loop recording on page 235.

To delete the active take:

1. Click on the event take to select it.
2. Right-click on the event take to display a shortcut menu.
3. From the shortcut menu, choose Takes and then Delete Active from the submenu or, from the Edit menu, choose Takes and then Delete Active from the submenu.

The event take will be removed, and if there are multiple takes, the next take will appear on the timeline.

Deleting multiple takes

You may delete takes from a list when you have chosen the one that you want to use in your project. You may delete multiple event takes at a time.

To delete event takes from a list:

1. Click on the event take to select it.
2. Right-click on the event to display a shortcut menu.
3. From the shortcut menu, choose Takes and then Delete from the submenu. The Delete Takes dialog will appear.
Or, from the **Edit** menu, choose **Takes** and then **Delete** from the submenu. The Delete Takes dialog will appear.

4. Select the event take that you want to remove. Click the play button to confirm that the selected event is the one you want to remove.

   **Note:** To select multiple event takes, hold down either the **Shift** or **Ctrl** keys.

5. Click **OK** to remove the selected event take from your project.

**Specifying where recordings are stored**

Vegas is a nondestructive audio-editing environment. Events within your project are actually references to media source files located on a storage device such as a hard drive. When you record into Vegas, the event appears on the timeline while its media source file is written to your hard drive. By default, Vegas stores recorded media source files in the Vegas program folder. However, you may specify where Vegas writes and stores recorded media source files.

To change where recorded media source files are stored:
1. From the **File** menu, choose **Properties** or press the **Alt + Enter** shortcut keys. The Project Properties dialog appears.

2. Click the **Audio** tab to display the project’s audio properties.

3. Click the **Browse** button. The Recorded Files Folder dialog appears.

4. Navigate to the hard drive or folder where you want Vegas to write and store recorded media source files.

5. Click the **Save** button to set the destination drive or folder.

   Click the **Cancel** button to leave the current destination the same.

---

**Note:** Check **Start all new projects with these settings** to store recorded media source files to the same location in every new project. Otherwise, Vegas will use its default settings.
Advanced Video

While simple to learn, Vegas is a powerful application with many advanced features. This chapter covers the tips, tricks, and techniques that are needed to master the video features of this powerful tool.

Pan/Crop

The Pan/Crop tool can be used for cropping, zooming, rotating, panning, and scrolling. The dialog can be opened by right-clicking on any visual event and choosing Pan/Crop Event from the shortcut menu or by clicking the Pan/Crop button (≡) on the event itself.

Cropping

Cropping is the process of removing the outside edges from an image or video, thereby re-framing the subject. In the example below, the Pan/Crop dialog on the left has been used to create a selection area around the subject, removing extraneous information from the outside of the video. This creates a zoom effect that is identical to using a digital zoom on a camcorder. The Video Preview window on the right displays the final movie after cropping.
To crop a video event:

1. Click the Pan/Crop button ( ) on the event or right-click the event and choose Pan/Crop.

2. Drag the handles (small boxes) located around the perimeter of the selection area to change the size.

3. Click in the middle of the selection area and drag to reposition it.

The cropping occurs instantly and the results are updated in the Video Preview window. Cropping applies to the entire event and can be animated with keyframes. For more information, see Keyframe animation on page 305. The buttons along the left side of the Pan/Crop dialog are similar to the buttons found in the Video Motion dialog.

To use this dialog to crop the frame, grab the crop Handles using the Normal Edit Tool ( ) to resize the crop selection area. When the cursor is positioned anywhere over the crop selection area you can drag it into position. To prevent distortion, it is a good idea to maintain the relative X and Y values of the crop area by clicking the Lock Aspect Ratio button ( ). Maintain aspect ratio, on the other hand, prevents the source media from becoming distorted. The Constrain Movement button is a three-state button: Move Freely ( ), Move X Only ( ), and Move Y Only ( ). This is used to create straight scrolls or pans in a single direction.
The Rotation Clock works like an altimeter on an airplane. There are two hands on it. The larger hand represents the degree of rotation relative to 0°, which is straight up. The smaller hand shows the number of times the crop area has been rotated through 360°.

The crop area can be rotated to simulate camera rotation. Position, Size, and Rotation can all be animated with the Keyframe Controller.

When you right-click anywhere in the Pan/Crop dialog, a shortcut menu appears:

- **Restore** returns the crop area to full frame.
- **Center** moves the crop area to the center of the frame.
- **Flip Horizontal** flips event left to right and backwards.
- **Flip Vertical** flips event top to bottom and backwards.
- **Match Output Aspect** sets the x,y ratio to the output value.
- **Match Source Aspect** sets the x,y value to the source media.

**Zooming**

Pan/Crop can be used to create a digital zooming effect.

**To zoom in:**

1. Right-click on a video event and, from the shortcut menu, choose Pan/Crop.
2. Click on the Keyframe Controller at a later time.
3. Click the **Add Keyframe** button ( ). This determines the duration of the zoom effect.
4. Resize the Crop Selection Area to set the final zoomed-in frame.

This effect can be reversed for a zoom-out effect. You can create an interesting transition effect by zooming in on one event, crossfading to a second event, and then zooming out.

**Rotating**

The Pan/Crop dialog can also be used to spin or rotate a video sequence. If you rotate the entire frame, the background behind the video will show through. The results are identical to rotating the video using the Track Motion tool. To crop so that no background is showing, follow this procedure.

**To rotate a video event:**

1. Right-click a video event and, from the shortcut menu, choose Pan/Crop.
2. Toggle **Lock Aspect Ratio** on to prevent distortion, and toggle **About Center** on.
3. Rotate the Crop Area to 45° (or -45°).
4. Resize (shrink) the Crop Area until it fills the frame and covers the background.
5. Rotate back to 0° to set the first keyframe.
6. On the Keyframe Controller, move to the last frame of the rotation.
7. Rotate the Crop Area to 360°. A keyframe is added.
When using the Track Motion tool, expand the overlay until it fills the frame at 45° rotation. Again the results are the same. Make sure the About Center button ( ) is toggled on when you resize the crop area or the overlay. In the illustration below, notice that the Orientation Arrow always points to the top of the frame.

For more information, see Scrolling titles - Pan/Crop technique on page 246.

**Panning**

Another use for the Pan/Crop tool is panning, or Pan-and-Scan, which is a technique commonly used when film is converted for television. Movie screens and film are usually wider (~2.35:1) than television (~1.33:1). When you transfer the film to video, you have four choices: (1) squash the film horizontally to fit, distorting it in the process; (2) crop it, possibly losing information on the sides; (3) letter box it so the top and bottom have black areas and the picture is shorter overall; and (4) Pan-and-Scan. Pan-and-Scan is a variation of cropping, where someone actively goes through the movie and moves the crop area back and forth to follow the action or subject.
Scrolling titles - Pan/Crop technique

Scrolling titles can be effectively produced using the Pan/Crop dialog. This technique is especially effective for very long sequences. To start with, create the complete ending credits as an image in an image editing program. Make the width of the image the same as the dimensions of your final movie’s frame (for example 720 pixels for DV). The height will be determined by the number of titles and could be quite long - up to 4,096 pixels.

Note: This procedure is also effective when using a text generator to create the titles instead of an image file, although the maximum height of a text generator is 2,048 pixels.

To create scrolling titles - Pan/Crop:

1. Insert the title image into a track above a background video or insert a generated text event.
2. Right-click the overlaying title image and choose Pan/Crop.
3. In the Pan/Crop dialog, navigate to the beginning of the Keyframe controller. The cursor should already be there by default.
4. The box defined by the broken line represents the cropped area. At this point, the dimensions of the box are equal to the source (i.e. the image file or text generator). Since the crop area always fills the screen, the titles all appear in a narrow band in the middle of the Video Preview window.
5. Right-click the Crop Area and select Match Output Aspect to resize the Crop Area. The Crop Area is now the same size as the final frame size (720x480 for example). After
resizing, only a small portion of the middle of the titles is visible in the Video Preview window.

6. Click the Constrain Motion button (±) until it is in Move in Y Only mode (Ⅰ). This keeps the titles vertically aligned.
7. Drag the Crop Area box to the top of the titles. Position it so that the first credit is just below the Crop Area.
8. On the Keyframe controller, navigate to the end of the event.
9. Drag the Crop Area box to the bottom of the title sequence.
If you preview the video at this point, the titles appear to move up from the bottom, across the screen, and off of the top. What is actually happening is that the Crop Area is moving down across a title sequence. The best way to create transparency is to save the title image as a PNG file with an Alpha Channel or to use the text generator. For more information, see Chromakeying on page 292.
Working with images

Still images can be used in Vegas for a number of purposes including slide shows, overlay graphics, and titles. Images are inserted into projects and into the Media Pool just like any other media files and become events when inserted onto tracks. The default length for an image event when it is first inserted is five seconds, but this duration can be modified by dragging the edges to any length. Images cannot be looped, but share many characteristics with video files, including transparency.

There are many image formats that can be imported into Vegas: BMP, GIF, JPG, PNG, PSD, and TGA. The best format is probably PNG. JPG is not the best format for video because it is already compressed (which makes it an excellent format for the Internet). This does not mean that you should not use JPG images, but other uncompressed formats are better (BMP, PSD, etc.). PNG files are losslessly compressed and can also include Alpha Channel information, which is one of the cleanest methods of creating transparency for overlays.

Note: Vegas may not automatically detect the Alpha Channel in TGA images. Right-click a TGA image in the Media Pool or an event on the timeline and select Properties. Then, in the Media Properties dialog, select the type of Alpha Channel from the list.

A slide show composed of still images and an accompanying sound track can be an excellent way to show off your pictures. Multiple images can be selected and inserted together to instantly create a slide show, complete with crossfades. Importing high-resolution still images and using the Pan/Crop and Track Motion tools can add interest to an otherwise static slide show.

To automatically create a slide show:
1. Select all of the images you want to use in the slide show in the Explorer.
2. Right-click and drag these files to the timeline.
3. From the shortcut menu, choose Add Across Time.

Make sure Automatic Crossfade is selected on the Options menu to have the images automatically overlap each other by a small amount with a crossfade. These crossfades can be replaced later by dragging transitions to the crossfade region. The duration of each of the inserted files can be specified on the Editing tab of the Preferences dialog: enter a New still image length in seconds. For more information, see Inserting media on page 91.
Note: It is best to use images that are the same size as your project’s frame size. You may also need to change the Pixel Aspect Ratio of an image file to get it to display correctly. For more information, see Media file properties on page 259.

Titles

Most video projects include titles and credits. There are two ways to add text to your project. Vegas has a titling engine (Text Generator) for creating simple titles or you can use an external image-editing program to create titles. For more information, see Text on page 280.

Video compositing and multiple video tracks are only available in Vegas Video and is limited in Vegas Video LE.

Creating titles from images

Titles can also be created in an just about any image-editing program. While every program is slightly different, the general procedure for creating titles with a transparent background is as follows.

To create titles from an image (general):

1. Start your image editing application.
2. From the File menu, choose New. Set the dimensions of the new image to be the same as the frame size for the project. Make the default canvas (background) color a solid color. The background will be transparent in the final image, so any solid color will work.
3. Select the Text tool and enter the text for your title in the text box.

Note: Size and position your titles carefully to fit within the Title Safe Area or the titles may extend beyond the edges of your television. For more information, see Safe Areas on page 253.

3. Make sure the text is selected and, from the File menu, choose Save As.
4. From the **Save as type** drop-down list, choose TGA, PNG, PSD or BMP (PNG is recommended). Make sure that you save the Alpha Channel information (for TGA and PNG), which will be used for transparency.

5. Enter a name and click Save.

Insert the image into Vegas in a track just above the one with the video that will be in the background. Set the Overlay Mode of the title track to Source Alpha (default) if your image has an Alpha Channel associated with it. If it does not, you may have to add a Chromakey filter to the image and key out the background. *For more information, see Chromakeying on page 292.*

![Image](image.png)

---

**Note:** The Alpha Channel is saved as a selection area in some programs. If you cannot save the Alpha Channel, use a black background and Vegas will create a mask from the background. The Alpha Channel of TGA images may not be detected automatically. *For more information, see Media file properties on page 259.*

The Title Generator is an easier alternate method of creating titles. By using the more advanced features of your image editing program, you can create very interesting title sequences and corporate logos.

**Fading titles**

Another common technique is to fade a still title in and out. This effect can be accomplished by using a Fade envelope or an Opacity envelope on a title event.
To fade titles in and out:

1. Insert a title image file into a track above the background video.

2. Move the Opacity handles (located at the upper corners of the event) towards the center of the title event.

3. Double-click the title event to set the preview area and then click the Play button.

Transitions can also be used between two titles. Simply set your two titles on an A and a B roll with a bit of overlap and then insert a transition effect between them (available in the full version of Vegas Video only). When automatic crossfade is turned on, you can smoothly fade one title into the next just by overlapping the two events.

To automatically crossfade a title sequence:

1. Insert the multiple title images into the same track on the timeline.

2. Overlap the titles by about one second each. Make sure Automatic Crossfades is selected on the Options menu.

This is probably one of the easiest and most effective techniques for displaying long lists of credits at the end of a film. The example below shows four sets of titles that smoothly blend into one another where the three Xs mark the automatic crossfades. The titles themselves were made by typing white text onto a black background in a paint program and then inserting the PNG image files into Vegas.

**Note:** It is possible to insert all of these titles at one time with a single drag-and-drop, complete with automatic crossfades. For more information, see Inserting media on page 91.
Customizing the Video Preview window

The workspace for editing video can get quite crowded, so the Video Preview window can be configured in a number of ways to make it more useful. The Video Preview window can be used on a separate monitor (if your video hardware supports this feature), docked at the bottom of the workspace or floated freely on the screen.

- **Project Video Properties** - Displays the project’s properties (pg. 256).
- **Video Preferences** - Displays the video preview properties.
- **Copy Frame** - Copies the contents of the frame to Windows Clipboard.
- **Show Clipboard Image** - Displays the current image on the Windows Clipboard.
- **Video Output FX** - Opens a dialog for adding effects to an entire project.
- **Disable All Video FX** - Turns off all effects at every level (event, track, project).
- **Preview Mode** - Toggles the preview resolution for faster playback.
- **Overlays** - These include Safe Areas (see below) and Grids to aid alignment.
- **Isolate Channels** - Individual channels can be viewed separately. This is especially useful for analyzing Alpha Channels.

Overlays (safe areas and grids) and isolating channels are only available in Vegas Video.

Right-click anywhere in the window to adjust the following:

- **Background color** options include Default (project’s background color), Black, and White.
- **Display Square Pixels** displays the output in square pixels. This can prevent distortion of the preview when using sources with rectangular pixels. This does not affect the final render.
- **Display at Project Size** displays the output at the project’s dimensions only.
- **Show Toolbar** toggles the toolbar at the top of the window.
• **Show Statusbar** toggles the information display at the bottom of the window.

**Safe Areas**

The view of the video frame on a computer screen represents the entire frame as captured from the video source. This full frame size may be as high as 720x576 and is significantly larger than what actually appears on a television screen. The only way to truly verify the framing or masking of the video is to preview the video on the destination television monitor. While there is no substitute for previewing on a television, Vegas safe areas are a good method of estimating the extent of the masking.

*Safes areas are only available in Vegas Video.*

**Note:** There is also some variability between individual televisions that cannot be predicted.

• Click the Overlays button to toggle the Grid and **Safe Areas** on and off.
• Click the small arrow to the right of the Overlays button to select the type of overlay, in this case the **Safe Areas**.
• Choose **Settings** from the same menu to set up the size of the safe areas. In the Preferences dialog, on the Video tab, enter the Safe action and Safe title values as a percent of the frame size.
• The Safe Action area is the frame area that will actually be visible on a television screen.
• The Safe Title area is a suggested area to limit the extent of titles. It is always smaller than the Safe Action area.

The default values are generally adequate for most situations, but you should test these Safe Areas by outputting some video to a television to insure that these settings are appropriate. Preview preferences can be accessed by clicking the **Options** menu, choosing **Preferences** and clicking the **Video** tab. For more information, see **Video tab** on page 359.

**Optimizing previews**

Timing and synchronization are critical aspects of any multimedia production and real-time playback is a necessary feature. Because complex multimedia projects are very challenging for any computer, Vegas uses a number of tricks to maintain the timing of playback even though the computer may not be able to process the data quickly enough.
Dropping frames

Vegas automatically drops video frames when previewing if the computer can’t keep up with playback. Visually, this means that you are not seeing a perfectly rendered preview of your project. The advantage to this is that precise synchronization is maintained and video and audio can be accurately and quickly positioned. The process of dropping frames in a preview is handled by Vegas and cannot be changed. This in no way effects the final rendered video.

Reducing the resolution or quality

The resolution of the Video Preview window and the quality of the rendering can be adjusted to improve playback. Lower-resolution previews are visually less clear but allow Vegas to display more frames. This may be particularly important with projects that use a lot of overlays, transitions, and special effects. Click the Video Preview Quality button to toggle the lower-resolution preview on and off. Click the arrow to the right of the Video Preview Quality button to choose the resolution and quality settings from the drop-down list. The default setting is Good Quality. When working on a full-screen (e.g. 640x480) project with the Video Preview windowed at a smaller size, such as 320x240, the Full and Half Resolution previews will be the same, since the window is already half sized.

Pre-render Video in Loop Region

There are times where nothing but a full, high-quality preview will do. In these cases, Vegas will take the time necessary to render the portions of your project that need extra processing and create a preview file on your computer of the project as it will appear in the final render. This can take anywhere from a few seconds to a few minutes, depending on the length and complexity of the preview. Once these temporary files have been created, Vegas will use them whenever it needs to playback those sections of the project.

To create a partial full-quality preview:
1. Create a selection area of the portion of your project that you want to preview.
2. From the Tool menu, choose Pre-render Video in Loop Region [Ctrl+M].
3. Select the type of preview file to create. Click the Custom button to configure any compression options.
4. Click OK.
Vegas will delete these preview files when a project is closed. To reuse these preview files the next time you open a project, from the **Options** menu, choose **Preferences** and, in the Preferences dialog, select **Save active previews on project close**. The location of these files can be set by choosing a **Temporary files folder** in the same dialog. Ideally, this folder should be on a different physical drive from where Windows is installed. Only file types that can be both read and written by Vegas can be used to create preview files. Some formats that cannot be used include *.wmv, *.rm, and *.mpg. Pre-rendered preview files can be deleted from your hard disk by choosing **Clean Pre-Rendered Video** from the **Tools** menu.

*For more information, see* [Partial rendering and timeline playback on page 327].

A full-quality preview of the entire project can also be created. This is equivalent to doing a final render to create a finished movie.

**To create a full-quality preview of the entire project:**

1. From the **Tool** menu, choose **Preview in Player**.
2. Select the type of preview file to create (e.g. *.avi). Select a Template or click the **Custom** button to configure any compression options.
3. Click OK.

The progress bar at the bottom-left corner of Vegas displays the progress of the render. When it is finished, it will automatically playback. As long as no changes have been made to the project, sections that have been previewed this way will not need to be re-rendered in the future, increasing preview playback speed and performance. A yellow bar appears at the top of the timeline indicating the mixed to preview section.
Video properties and preferences

Project properties - Video tab

Project Properties can be accessed by clicking the File menu and choosing Properties or by clicking the Project Properties button on the Video Preview window. Many of these settings are identical to the settings found on the Project tab of the Custom Settings dialog. Final render properties set up in the Custom Settings dialog override the following Project Properties settings. For more information, see Video tab - Custom settings on page 332.

These properties control all of the default settings for your project. Without making any changes, these are also the settings that will be used to create a final rendered movie file.

- **Template** - Select a preset template to automatically configure the remaining five video controls in this dialog. Many popular formats are included, but you should consult your hardware manuals if you have any questions. You can also save your own custom template. The Project Properties dialog for NTSC DV can be automatically configured by choosing the NTSC DV (720x480, 29.97fps) template from the Template list.

- **Match Media button** - This important button allows you to select a raw media file captured from your camcorder to be used to determine your project’s properties automatically.

- **Width** and **Height** - This is the frame size of your final movie.

- **Field order** - Video that is displayed on a television is interlaced. This means that every frame of video is actually composed of two fields, each of which is made up of half of the lines that make the final frame. These two fields are woven together in alternate lines, but which of the two fields is displayed first can be important. Choose Progressive for video that is going to be viewed on a computer. For video on a television, most hardware supports Lower First. If the output is jittery or shaky, or your hardware’s manual specifies it, choose Upper First. For more information, see Interlacing and field order on page 379.

- **Pixel aspect ratio** - A pixel is a single picture element or dot on a television or computer screen. Computers display pixels as squares: 1.0. Televisions display individual pixels as rectangles: 0.909, 0.899, or anything other than square. Using the wrong pixel aspect ratio can result in distortions or stretching of the video. Select the aspect ratio for the final movie’s destination. Consult your hardware manual if you are in doubt about the appropriate ratio. The pixel aspect ratio is unrelated to the frame’s aspect ratio.

- **Frame rate** - The television frame rate in the US, North and Central America, parts of South America, and Japan (NTSC) is 29.97 frames per second (fps). In many parts of the world, including Europe and much of Asia, the television standard is PAL at 25fps. France, Russia, and most of Eastern Europe use SECAM, which is a variation on PAL and also uses 25fps.

- **Full resolution rendering quality** - Unless you have specific performance issues or are unhappy with the amount of time that it takes Vegas to render effects and transitions, it is recommended that **Best** (slowest rendering) be selected here.
• **Preview files folder** - Vegas plays back a project instantly and in real-time to give a rough preview of the project. At times, you may need to create a higher quality preview. This can take a little time for more complex projects with a lot of transitions, effects or overlays. Once the project has been rendered, Vegas saves these preview files to this folder location so that the project does not need to be rendered again in its entirety. Click the Browse button and select a location. Ideally, this location should be on a separate physical hard drive from where Windows is installed.

• **Start all new projects with these settings** - Select this option to always use these settings for new projects.

**Advanced Video Properties**

Click the Advanced button in the Project Properties dialog to access these attributes. In most cases, the default settings for this dialog are adequate. These settings affect how Vegas renders or draws transitions, effects, overlays, and changes in velocity.

• **Motion blur type** - Some effects and transitions can involve motion or animation. This list allows you to select whether the frames are blurred slightly to create the illusion of motion on individual frames. This can make computer generated animation appear more smooth and natural. Gaussian is the best choice in most situations where blurring is required.

• **Exposure time (seconds)** - This determines the time frame of the blurring. Longer exposures (>0.100) result in greater and more exaggerated blurring.

• **Deinterlace method** - Source video from a television is interlaced (see above). When Vegas renders effects, it needs to deinterlace the two fields that make up a frame. The exact method used can be selected here, although the default **Blend fields** is adequate in most situations.

**Event properties**

To access an event’s properties, right-click on the event and choose Properties.

• **Active take name** - This allows you to rename the Active take. This can also be done by right-clicking the event and choosing Rename. For more information, see Takes on page 151.

• **Playback rate** - Changing this value is equivalent to stretching or compressing an event, thereby changing its speed. Using this option maintains the duration of the event, however. For more information, see Time compressing/stretching on page 150.

• **Resample the video** - Select this option to allow Vegas to interpolate frames in an event to smooth modified video. See the following section on Resampling for more information.

• **Switches** - **Mute**: Keeps an event from playing to the mix or render. **Loop**: Sets the event to automatically repeat the media file when an event is longer than the source media. **Lock**: Prevents an event from being modified or moved. **Maintain aspect ratio**: Keeps the relative x:y dimensions constant.
Resampling

The Resample option in the Media Properties dialog and on the Project tab in the Custom Settings dialog during the final render both perform the same function. There are few cases where resampling may be particularly important.

- When the frame rate of the source media for an event is slower than the project’s frame rate. For example when you are using a source media file that has a 10fps rate in a 29.97fps rate project.
- When slowing an event, either with a velocity envelope or by stretching it. For example, when slowing a clip to 30% using a velocity envelope.
- When creating vertically scrolling titles.

When either of the above situations is true, there are only ten frames of source material for every second of project time. When the project is rendered, there must be roughly thirty frames in each second. Vegas must create the frames that are between the source media frames, sometimes known as padding. The easiest way to do this is to simply duplicate the previous frame. This can result in less than smooth video playback.

Without resampling, the intervening frames are simply the previous frame repeated.

With resampling, the intervening frames are interpolated from the source frames. It is similar to a crossfade effect between the original frames.
Media file properties

Vegas automatically detects the parameters of your media files. In most cases, these properties do not need to be modified, but there are times where access to these parameters is important. One notable exception is to change the Field Order to prevent jitters when a video is output to a television monitor. This can be especially prevalent in events that have been significantly slowed down. There are times when you may need manual control over some of these attributes, depending on the type of file and your specific hardware configuration.

To modify the properties of media files:

1. Right-click an event in the Media Pool or on the timeline and, from the shortcut menu, select Properties.

2. Modify the parameters in the Media File Properties dialog and click OK when you are finished.

File name - and location. This is not editable.

Tape name - This can be used to display the name of the tape for media files captured in Vegas Video Capture projects. The name can be edited here or in the corresponding field in the Media Pool.

Timecode (not all video files include timecode information)

- Use timecode in file - This is the default.
- Use custom timecode - This option allows you to set the timecode manually.
- Timecode format list - If you have selected Use Custom timecode above, this list contains the available timecode formats. SMPTE Drop (29.97fps, Video) for example, is the timecode format for NTSC DV. Changing the timecode format does not change the source media file in any way. It merely changes how the file is measured in time. For more information, see Timecode on page 382.

Note: Timecode must be the selected option from the Source frame numbering list on the Video tab of the Preferences dialog to allow event level specification.
Stream properties

Media files are opened in Vegas with a set of default values. When you change any of the values for a particular media file, these changes are saved and remembered for that file in the current project (*.veg) only. If you want to change the default settings for a particular type of video file whenever that type of file is used in Vegas, click the Save button to the right of the Stream list. This adds an entry to a file called vegas video profiles.ini that can be referenced for future use.

- **Stream** - If the file has more than one stream of the given type, this allows you to select the particular stream to work with.
- **Attributes** (unreadable)
  - **Frame size** - Displays the frame size in pixels (x,y) and the color depth.
  - **Frame rate** - Displays the frame rate in frames per second (fps).
  - **Duration** - Displays the length of the file.
  - **Format** - Displays the codec or method of compression.
- **Field order** - This is used to control how the video file is handled on a television monitor and depends on your hardware. If a media file is jittery or jumpy when played on a television, changing this setting may help.
- **Pixel aspect** - This can be changed, but should always match the source video's properties.
- **Alpha channel** - The Alpha channel determines how transparency is handled in a file. The default Alpha Channel setting for most video files is None. PNG image files can have an Alpha channel that is automatically detected by Vegas.

Output properties

Final output properties can be adjusted when you save your final movie. From the File menu choose Save As, and choose a video file format (*.avi, *.qt, *.wmv, or *.rm), click the Custom button, and go to the Video tab.

Every project (*.veg) has default settings that are used to determine the format of the movie files created from that project. These default settings are overridden by the Save As Custom settings.
- **Template** - Select a template from the list to automatically configure all of the settings on this tab. You can also create a custom template and save it for future use. The Description box simply summarizes the template properties.
- **Video size** - This sets the final frame size and is largely determined by the final viewing destination of the movie.
- **Frame rate** - This sets the final frame rate of the movie.
- **Video format** - This is used to select the specific codec used to compress the video file. This is a very important process. In short, codec stands for COmpress DECompress and is the mathematical algorithm used to encode a video file. The codec directly determines the size and quality of the movie, as well as its compatibility with various playback devices. The final destination for the movie dictates the choice of codec. Click the Configure button to open a dialog to configure the details of how the codec will compress the video.
- **Quality** - Some codecs let you select a level of quality based on a relative percentage (%).
- **Render alpha channel** - If the format (e.g., some *.qt movies) supports it, the Alpha Channel information can be saved along with the movie file.
- **Interleave every** - In some cases, this helps to synchronize the audio and the video streams by interleaving the audio every X frames.
- **Keyframe every** - Compression keyframes can be added to improve the performance of the codec. This can increase the final file size. For more information, see Video properties and preferences on page 256.
- **Data rate** - Enter a value here to set a ceiling on the maximum data rate for the codec.
- **Don’t recompress if possible** - Select this to allow Vegas to copy sections of a project that have not been modified without recompressing them. This saves time and maintains 100% of the quality of the original media files.
Edit Decision Lists (EDL)

Edit Decision Lists (EDL) are text lists of all of the media files used, where they are placed, and how they are trimmed. These simple text lists can be used as a printed summary of your project, can be used to open a Vegas project in another compatible application or can be used to convert a project form another application into a Vegas project. There are some necessary limitations to this conversion process because of the great disparity between video editing applications.

To create an EDL:

1. From the **File** menu, choose **Save As**. The Save As dialog appears.
2. From the Save as type list choose Vegas EDL (*.txt).
3. Enter a name for the file and browse for a destination.
4. Click **OK**.

EDLs created in another application can also be used to open a rough copy of a project created in another application in Vegas. For example, you could create an EDL from a project in Adobe Premiere and then import the project into Vegas via the EDL. To create an EDL from a project in another application, export a CMX 3600 EDL or a Sony 9100 EDL.

To open an EDL:

1. From the **File** menu, choose **Open**.
2. Locate the *.edl, select it, and click the **Open** button. If you were working on another project, you will be prompted to save your work as the EDL will open a new project.

---

**Note:** EDLs do not contain any information about the location of source media. Therefore, the *.edl file should be saved in the same directory as the source media. If it is not, or if media is stored in a number of different locations, Vegas will prompt you to relink these files when the EDL is imported.

---

Because of the significant differences between editing applications, projects that are converted from EDLs in Vegas (or exported from Vegas) are necessarily simplified. Events are inserted into the timeline on a single track and transition effects from the other application are replaced with crossfades. EDL imported projects are initially limited to four audio tracks.
Plug-ins are a broad category of tools that include filters, effects, transitions, and generators. There are a number of plug-ins that are included with Vegas, both video and audio. For more information, see Audio plug-ins on page 203. Masks are used extensively in television and movies. Understanding how they work is an important part of mastering overlays. Filters cover an extremely broad range of electronic modifications that can be used to improve substandard video or artistically enhance a creative production. Together, these professional tools will help you polish your productions.

Video effects, filters, and plug-ins are only available in Vegas Video and to a more limited extent, in Vegas Video LE.

Video plug-ins

The Video folder in the Plug-In window in Vegas has four subfolders: Filters, Generators, Mask Generators, and Transitions. To view the Plug-Ins window, from the View menu, choose Plug-Ins or press Alt+5. Plug-ins can be dragged to events, tracks, or the Video Preview window.
Filters

There are a huge variety of filters that are completely ready for you to drag-and-drop onto your projects, tracks, and events. The default settings may be enough for many people, but each filter has a handful of individual controls that allow you to customize the effects in precise detail. Most of these attributes can be animated with the keyframe techniques.

Video effects, filters, and plug-ins are only available in the full version of Vegas Video.

Using a video filter

Adding a filter to a video event is, like other activities in Vegas, a drag-and-drop routine. Filters can be applied to events in the workspace, clips in the Media Pool, to entire tracks or to an entire project.

To add a filter:

1. Click the Video FX button ( ) in one of the following locations (see the illustration):
   - **Media FX** are applied before a media file is inserted into an event on the timeline. Every occurrence of this media file in a project will have the effect applied to it.
   - **Event FX** are applied to events on the timeline.
   - **Track FX** are applied to every event on a particular track.
   - **Video Output FX** are applied to the final output and effect every event in a project.

2. In the Plug-in Chooser dialog, select the effect that you would like to apply and click OK.
3. Modify the effect in the Video Plug-In dialog.

For more information, see Video Signal Flow on page 44.
To remove a filter:

1. Click the **FX** button (اظ) on object with the filter applied to it (media, event, track or Video Preview window). This opens the Video FX dialog.

2. Click the button of the filter that you want to remove.

3. Click the **Delete Effect** button.

Filters can also be temporarily disabled (turned off) by deselecting them (clearing the check box on the filter's button). Since the effects are rendered very quickly in the Video Preview window, turning a filter on and off allows you to clearly see the results of the filter on your project.
Modifying filters

Most filters are highly customizable. Each has its own default settings that are adequate in most circumstances, but modifying these defaults is not difficult.

**To modify a filter’s properties:**
1. Click the **FX** button ( ).
2. Change the parameters in the Video Event FX dialog.

Changes you make will automatically be updated in the Video Preview window, using the current cursor position as the example. To see the effect as applied to the video in motion, you can save time by creating a time selection (loop region) to preview only a portion of the event.

**To save a filter as a preset:**
1. Click the Preset text box. The name of the current filter is highlighted and the cursor begins blinking.
2. Enter a new name for the preset.
3. Click the **Save** button ( ).

To use a saved Preset, simply choose it from the drop-down list.

**Ordering filters**

There are a large number of filters in Vegas. Filters can also be used in combinations of two or more for even greater flexibility. Adding additional filters to an event is simply a matter of dragging them onto an event. Filters are then arranged in an FX Chain in the Video Event FX dialog.
Effects that are selected with a check are active. You can toggle FX on and off by selecting and deselecting them. The filters are applied in the order that they appear. You can change this order by dragging the FX button to a new location in the chain or by clicking the FX Chain button. In the following illustration, you can see why the order of effects might be important.

The goal of the above example was to use filters to create a very high-contrast mask out of a video clip of some fire. In the image on the left, a Brightness and Contrast filter is applied first and then a Black and White filter. In the image on the right, the Black and White filter was applied first, removing the color, and then the Brightness and Contrast filter was applied. The mask created by the second example is much cleaner, even though all of the settings of the two filters are identical.

Effects chains can get rather complex when Track-level effects are also used. In general, the hierarchy is that effects are applied to the media in the Media Pool first, then the event-level effects are applied, followed by any track level effects, and then any Video Output FX (whole project FX). For more information, see Video Signal Flow on page 44.

Keyframe animation and filters

**Keyframe animation is only available in the full version of Vegas Video.**

Keyframe animation can be used to precisely control a filter over time. You can gradually ramp a filter up or start with wildly distorted video that returns to normal over the course of a few seconds. Keyframes are added to the Keyframe Controller at the bottom of the FX dialog. Since a number of filters can be added to a single event, track or project, click on the filter's button in the chain view and modify the particular attributes and Keyframe Controller for that filter. For more information, see Keyframe animation on page 305.

**Note:** Not all parameters can be animated.
Transitioning into an effect

Keyframe animation can be used to smoothly and gradually apply an effect to an event.

To transition into an effect:

1. Add an effect to an event and open the Effects dialog.
2. Add two keyframes to the event for a total of three including the one at the beginning. New keyframe attributes are copied from the previous keyframe.
3. Set the initial and final keyframe effect values to their minimum values (zero).
4. Click the second keyframe and set its attributes.
5. Press and hold the Ctrl key and drag the second keyframe to duplicate it. Position this new keyframe near the end of the sequence.

The effect will be off at the first keyframe and will smoothly transition to a maximum value at the second keyframe, at which point the effect will remain constant until the third keyframe. Then it will gradually fade out until it reaches a minimum value at the last keyframe. In the following illustration, the section of the Keyframe Controller between the second and third keyframes is solid, meaning that it does not animate between these two keyframes. The beginning and ending areas have gradients from white to black between them, representing the keyframe animation that occurs during these periods.

The results of gradually transitioning into an effect.
Video filter dictionary

These filters are only available in the full version of Vegas Video. A smaller subset is included with Vegas Video LE, Vegas Audio, and Vegas Audio LE.

Filter plug-ins in Vegas cover a broad range of special effects from basic color correction tools to bizarre warping effects. They are broadly grouped into three large categories: Correction filter, Creative filters, and Mask filters.

Correction filters

Although today’s modern camcorders do an excellent job with automatic exposure control and lighting temperature adjustments, there is no substitute for using good lighting and a tripod when shooting video. Shooting conditions are often less than perfect however, and Vegas can come to the rescue with a number of professional-quality filters to correct a broad range of source footage defects.

<table>
<thead>
<tr>
<th>Black and White</th>
<th>HSL Adjust</th>
<th>Sharpen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness and Contrast</td>
<td>Levels</td>
<td>Broadcast Colors</td>
</tr>
</tbody>
</table>

Creative filters

There is a large overlap between many of the Corrective filters and the Creative filters. The HSL Adjust filter, for example, can be used to remove the greenish tint from florescent lighting. If you push the filter just a little bit further, you can achieve a more imaginative color scheme. A number of filters in Vegas have been specifically designed to produce interesting, creative, and even warped special effects. These are some of the most fun areas of the program to play with and exploration of their almost endless possibilities is highly encouraged.

<table>
<thead>
<tr>
<th>Add Noise</th>
<th>Median</th>
<th>Quick Blur</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gaussian Blur</td>
<td>Min and Max</td>
<td>Sepia</td>
</tr>
<tr>
<td>Invert</td>
<td>Pixelate</td>
<td>Wave</td>
</tr>
</tbody>
</table>

Mask filters

Masks are used as overlays and are designed to help create transparency in an event that overlays a background video. Overlays can be as simple as a scrolling corporate logo and titles or as complex as any special effect in a science fiction movie. The nightly news also uses overlays to produce a picture-in-picture effect with an image of a news
story appearing in a small window next to the anchor, or a meteorologist standing in front of a weather map. Many other filters, such as Black and White or Brightness and Contrast, can be used to improve the quality of a video or image to make it more suitable for use as a mask.

<table>
<thead>
<tr>
<th>Chroma Keyer Filter</th>
<th>Mask Generator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Levels</td>
<td>Threshold</td>
</tr>
</tbody>
</table>

Video effects, filters, and plug-ins are only available in Vegas Video and to a more limited extent in Vegas Video LE.

Add noise

This filter adds static or noise to a video sequence. When added to a simple solid-colored background with a monochrome setting and animated, a pattern is produced that is similar to a television that is not tuned to any station.

<table>
<thead>
<tr>
<th>Amount</th>
<th>Determines the strength of the effect.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monochromatic</td>
<td>Select this option to make the noise all one color. When unselected, the static will be many random colors.</td>
</tr>
<tr>
<td>Gaussian Noise</td>
<td>This is a different mathematical method of generating noise. In general, this produces a stronger effect.</td>
</tr>
<tr>
<td>Animate</td>
<td>Check this box to make the static move in a random way.</td>
</tr>
</tbody>
</table>

Black and White

This filter removes all color information from an image without altering the luminosity. This converts a video to black and white. This can be an important filter when used in combination with other filters. For example, removing the color makes creating a grayscale mask a more predictable process.

Related Effects: HSL Adjust.
Brightness and Contrast

This is a straightforward correction filter that can be used to improve video with exposure problems.

<table>
<thead>
<tr>
<th>Brightness</th>
<th>Move the slider right to increase the overall brightness. 0 is no correction. Negative values decrease brightness, and positive values increase brightness.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contrast</td>
<td>Contrast is defined as the absolute difference between the darkest and lightest areas of an image or video. It is sometimes perceived as influencing the sharpness or crispness.</td>
</tr>
</tbody>
</table>

Broadcast Colors

Computer monitors typically display more than sixteen million colors, while NTSC television can only display somewhere around two million colors. This can cause problems with video that has been edited on a computer and subsequently displayed on a television monitor. These problems can range from tolerable color variation to noticeable ghosting artifacts, especially around computer generated graphics and titles. The Broadcast Colors filter can be used on individual media files, events or tracks where you suspect that the color space may be an issue (e.g. titles and still images) or as the last step in a project by adding the filter to the Video Preview window to insure color compliance. The effects of this important filter are only be apparent when the video is viewed on an external television monitor.

<table>
<thead>
<tr>
<th>Luma smoothness</th>
<th>This slide controls the blending of the luminance or brightness of colors in the video.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chroma smoothness</td>
<td>This slider controls the blending of the colors or hues in the video.</td>
</tr>
<tr>
<td>Bypass filter</td>
<td>This effectively turns the filter off.</td>
</tr>
</tbody>
</table>
**Chroma Keyer**

The Chroma Keyer filter is a mask filter that uses color (RGB or HSB values) to determine transparency. This filter shares many of the same properties with the Mask Generator. For more information, see Using the Mask filter on page 291.

<table>
<thead>
<tr>
<th>Key</th>
<th>Use these color controls to select the specific color you want to key out.</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGB/HSL</td>
<td>Switches the color swatches from Red, Green, and Blue values to Hue, Saturation, and Luminance (Brightness).</td>
</tr>
<tr>
<td>Eyedropper</td>
<td>Click the eyedropper and then click on the color in the source video (on the timeline) to determine the transparent key color.</td>
</tr>
<tr>
<td>Mask Type</td>
<td>This determines how the filter is used. Transparency Mask is the standard mask used to key out background colors. Color Correction Mask is used to isolate parts (and protect other parts) of the video for color correction.</td>
</tr>
<tr>
<td>Show Mask Only</td>
<td>Generates a mask from the settings in the dialog. This is identical to using the Mask Generator to create a mask.</td>
</tr>
<tr>
<td>Low Threshold</td>
<td>This adjusts the luminance value of the mask. Anything in the mask with luminance values below this setting become transparent. Combined with the High Threshold setting, a range of luminance is created for the mask.</td>
</tr>
<tr>
<td>High Threshold</td>
<td>This adjusts the luminance value of the mask. Anything in the mask with luminance values above this setting become transparent. Combined with the Low Threshold setting, a range of luminance is created for the mask.</td>
</tr>
<tr>
<td>Blur Amount</td>
<td>This controls how the edges of the key mask are treated. High values allow the mask to blend more smoothly into the background video.</td>
</tr>
</tbody>
</table>

**Gaussian Blur**

This filter alters the apparent focus of the video and blurs or softens its appearance. It can also be used to smooth some types of noise and can also be used as a corrective filter.

| Horizontal and Vertical Range | Sets the strength of the blurring by determining how many pixels in a block are blended together. Use the pixel sliders or enter a specific value in the text box. Double-click the slider thumb to match the two slider values. |
| Channels | Select All or only the specific color channels (Red, Green, or Blue) that you want to blur. If the video or image has an Alpha channel, you can use that as the basis of the blur, which can sometimes improve transparency and mask blending. |

Related effects: Blur, Median, Quick Blur.
HSL Adjust

HSL stand for Hue, Saturation, and Luminance (sometimes called Lightness or Brightness) and is another correction filter that is used to alter the display of colors in a video. In addition to improving an image or video event, this effect can be used in many creative and artistic applications.

<table>
<thead>
<tr>
<th>Hue</th>
<th>Adjusting the hue changes the colors in an image. Hue deals with color in a different way than the RGB/CYMK method of a color balance effect, with Hue represented by a 360 degree color circle. Either end of the hue slider (0.0000 or 1.0000) leaves the hue unaltered.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saturation</td>
<td>Controls the intensity of the particular hue selected with the hue slider. Moving the slider all the way to the left (0) removes all hue from the image, converting it to grayscale.</td>
</tr>
<tr>
<td>Luminance</td>
<td>Controls the overall brightness of the image or video. A value of 1.0000 leaves the brightness at its original level.</td>
</tr>
</tbody>
</table>

Related effects: Black and White.

Invert

This filter reverses the complimentary colors and the brightness in an image or video, giving it a photo negative effect. This can also be used to reverse a mask.
Levels

This mask filter can be used to create a better mask from a video or image source. This is a very effective method of remapping the total range of the colors and improving the overall quality of a mask.

<table>
<thead>
<tr>
<th>Input Start/End</th>
<th>Use these two sliders to select the range of values that are selected to remap (to the output range) and use for transparency.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Start/End</td>
<td>Use these two sliders to determine the range of values to which the input values are remapped (from the input range).</td>
</tr>
<tr>
<td>Gamma</td>
<td>Gamma compensates for differences in brightness between different sources and corrects the brightness as viewed on the destination monitor.</td>
</tr>
<tr>
<td>Channel</td>
<td>Select the particular color channel (Red, Green or Blue) or Alpha Channel that you want to adjust, or adjust all (which is similar to adjusting the brightness).</td>
</tr>
</tbody>
</table>

Related effects: Mask, Threshold.

Mask

The Mask filter can be applied to video events or images to create a mask. Typically, the Mask filter functions by remapping a channel (red, blue, green, luminance) to a narrower range of values, creating a more distinct mask. For more information, see Using the Mask filter on page 291.

<table>
<thead>
<tr>
<th>Mask Type</th>
<th>Select the method for determining transparency.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha</td>
<td>Uses the Alpha Channel to determine transparency.</td>
</tr>
<tr>
<td>Luminance</td>
<td>Uses the luminance or brightness to determine the transparency.</td>
</tr>
<tr>
<td>Red/ Green/ Blue</td>
<td>Select a specific color to determine the transparency.</td>
</tr>
<tr>
<td>Invert</td>
<td>Reverses the transparent areas with the opaque areas in the mask.</td>
</tr>
<tr>
<td>Low In/ High In</td>
<td>Use these two sliders to determine the range of the selected channel to use for transparency.</td>
</tr>
<tr>
<td>Low Out/ High Out</td>
<td>Use these two sliders to determine the range to remap the Low In/High In values to the output.</td>
</tr>
</tbody>
</table>

Related effects: Levels, Threshold.
**Median**

This filter is another method of blurring an image. It works by averaging values between groups of pixels. The size of the group of pixels to be considered in this effect is determined by dragging the slider or entering a value in the text box (range: 0-10). This effect produces more of a smudged appearance that looks similar to a watercolor painting effect at higher pixel values. At lower values, it can be used as a correction filter to remove noise.

![Median examples](image1)

**Related effects:** Blur, Gaussian Blur, Quick Blur.

**Min and Max**

This creative effect can be used to pixelate an image or video. The exact method of pixelation is based on minimum brightness or maximum brightness values. The pixels in the image are first grouped together and then the minimum (or maximum) pixel value in each group is applied to all of the pixels in that group.

![Min and Max examples](image2)

<table>
<thead>
<tr>
<th>Pixels</th>
<th>Min / Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the slider or enter a value (1-10) to determine the radius, in pixels, of a circle surrounding the pixels that are grouped together in this effect.</td>
<td>Select the method to use for the pixelation.</td>
</tr>
</tbody>
</table>

**Related effects:** Pixelate.
Pixelate

Pixelate creates the effect of viewing the video at a lower resolution, making it appear blocky. This is very effective when used with keyframe animation to move from highly pixelated to the unaltered video as a type of transition. The X and Y sliders control the dimensions of the pixels. If the X and Y are set to the same value, the pixels are square.

Related effects: Min and Max.

Quick Blur

This filter simply averages or blurs a video, dramatically reducing its sharpness. While this filter has been included in the Creative filters category, it can also be used to reduce noise.

Related effects: Gaussian Blur, Median.
Sepia

Sepia is a specific color tint associated with old movies. The default settings will produce a standard sepia tone, but you can use the color boxes to tint your video to any color that you want.

<table>
<thead>
<tr>
<th>Color Boxes</th>
<th>Select the color of the tint filter you want to use.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blending Strength</td>
<td>Determines the overall opacity/transparency of the color filter.</td>
</tr>
<tr>
<td>Blending Falloff</td>
<td>Determines how smoothly the filter mixes with the source video’s original colors. Values closer to 1.000 (right) will have less color overall and appear more grey.</td>
</tr>
</tbody>
</table>

Related effects: Black and White.

Sharpen

This correction filter is the opposite of the Blur and Median filters. It finds and emphasizes areas of contrast in the image, increasing the video's crispness. The original on the left in this series is a bit out of focus. While the effect is subtle, the middle image is a little sharper, although some artifacts are visible on close inspection. The last image has a much higher sharpen setting and is noticeably noisy.
Threshold

This filter is used to adjust a video so that it can be used as a mask more effectively. By adjusting the threshold, portions of the video can be made identical in color. This makes chromakeying and mask generation easier. The slider starts out at 50. This means four things in terms of HSB (Hue, Saturation, and Brightness), illustrated below.

Hues are limited (rounded) to radians
(0, 60, 120, 180, 240, 300)

Saturation and Brightness is set to 100 for all Hues.

Saturation values below 50 go to white.

Brightness values below 50 go to black.

Related effects: Levels, Mask.
Waves

This effect distorts the video horizontally, vertically, or in both directions. You can control the number and height of the waves as well as their position. When animated and combined with a transition, this effect can produce a great dream-sequence or underwater effect. See the illustration below for a demonstration of the controls.

<table>
<thead>
<tr>
<th>Vertical/Horizontal Waves</th>
<th>Controls the number of waves.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vert./Horiz. Amplitude</td>
<td>Amplitude refers to the height of the waves.</td>
</tr>
<tr>
<td>Vertical/Horizontal Phase</td>
<td>Sets the position of the waves on the screen.</td>
</tr>
</tbody>
</table>

Generators

Generators are not available in Vegas Audio or Vegas Audio LE.

Generators are a special class of plug-in in Vegas that create virtual media files that are contained in events on the timeline. These virtual files are stored in the Media Pool and their properties can be viewed and modified there.

The Generators are contained in the Plug-Ins window under the Video folder. To add a Generator to a project, drag it from the Plug-Ins window to the timeline. The default length of the generated media event is determined by the Preferences. To modify generated media events, click the Modify Generator button on the event.

When you duplicate an event that contains a generator, the generator itself is not duplicated, just as normal media files on your computer are not duplicated. Changing the properties of a generator therefore changes the generator and all occurrences of it on the
timeline, as contained in various events. This means that if you have an event that contains a Text generator, and you duplicate the event, both events will contain the same text. Changing the text of the generated text in one event will also change the contents of the other event.

Color Surface

Color Surfaces are quick methods of generating solid colored events to be used for backgrounds behind overlays or for fades. Use the Color Picker to select a color and transparency for the surface.

Test Pattern

The Test Pattern generator creates a standard color bar and test pattern that can be used to calibrate your video output stream. Color bars are used by studio engineers to set the level of color in video equipment. When used on a computer, you should output these test patterns as you would any video and run it through a vectorscope and a waveform monitor to calibrate the output settings. Many studios and broadcast facilities require a color bar pattern at the beginning of your video so that the engineers can calibrate their equipment. To use the color bars, drag the Test Pattern generator to the beginning of your project. This will create an event in a video track that contains the generated color bar pattern.

Text

The Text generator is only available in Vegas Video and Vegas Video LE.

Generating Text is probably the fastest and easiest way to create simple title sequences. Aspects such as color, size, and font are all controlled with familiar tools.

To add simple titles:

1. In the Plug-ins folder, open the Generator sub-folder.

2. Drag-and-drop the Text generator plug-in to a track above the background video.
Text can also be inserted into a track by choosing Text Media from the Insert menu. A video event that contains the generated Text is inserted into the timeline. The generated Text media itself is placed in the Media Pool.

To edit generated Text media:

1. Click the Modify Generator button ( ) on the event or right-click the event that contains the generated Text and choose Edit Generator Media.

2. Enter your text into the Text box. Use the standard word processor controls to modify the font, style, and size of the text. The color of the text and the background can be changed using the color picker to the right of the text box.

The Text generator is a Generator Plug-In. It creates a virtual media file that is placed in the project (e.g. into the Media Pool), with a default frame rate and dimensions that match the project’s frame rate and dimensions. When inserted into the timeline, it is contained in a video event with a default duration that can be changed in the Media Generator dialog or by trimming it. The event acts just like any other video event: a virtual media file remains unaffected by changes made to the event. Like other video events, it can be trimmed, copied, stretched, and looped. Envelopes and Video Filters can all be used on these events.

The text can be changed at any time. The Video Preview window updates changes when you preview the event. By default, the background is transparent, but any color can be selected with the color picker.
Positioning the text

The Vertical and Horizontal text position lists allow you to roughly position the text on the screen. Fine tuning the exact vertical position for single-line titles can be accomplished by adjusting the Leading. Normally, Leading controls the spacing between lines of text, but for single lines of text it can move the line up or down on the screen, provided there is a carriage return before the text (i.e. the text is on the second line). Spaces before the text can be used to fine tune the horizontal position. Tracking is used to set the spacing between individual letters.

To make the background transparent:

1. Select a background from the color picker group box.
2. Slide the Alpha Control all the way to the bottom (100% transparent).

The actual color is irrelevant since it is completely transparent. The text can also be made transparent in a similar way.

These events behave exactly the same way other events do. You can fade in and out on a Title event by dragging the Opacity envelope handles located at the upper corners of the event towards the center. Click the Track Motion button ( ) to open the Track Motion dialog to move or scroll the titles. A simple drop shadow can really emphasize titles set against a complex video background. For more information, see Track Motion on page 316.

To add a drop shadow:

1. Click the Track Motion button.
2. Select the Shadow option on the Keyframe Controller at the bottom of the dialog.
3. Set the shadow's attributes. One good example for titles is to set the Offset to 1x1, the Feather to 2.0, and the Intensity to 0.50. The results are pictured below.
Title sequences with generated Text

Maintaining consistency between a series of different titles is very important. Since generated text media acts as a virtual media file, duplicating the event on the timeline duplicates the event containing the same title. Right-clicking the event, choosing Edit Generator Media, and changing the generated text media changes the text in both events.

To duplicate the attributes of generated media:
1. Modify the text in the Media Generator dialog (font, style, color, position, etc.).
2. Enter a name for a new preset on the Preset list.
3. Click the Save Preset button.
4. Insert another Text generator plug-in into the timeline. This creates a new event and a new generated media item in the Media Pool.
5. Load the preset by selecting it from the drop-down list.

To maintain consistency between events that have been significantly modified (e.g. elaborate Pan/Crop animations), duplicate the event, and then add the newly generated text media to the duplicated event as a take.

To duplicate and change generated text media:
1. Press and hold the Ctrl key and drag the generated text event on the timeline to duplicate it.
2. Right-click on the Text generator in the Plug-Ins folder and drag the generator to the duplicated event.
3. Drop the generated text media onto the duplicated event. Choose Add As Take from the menu.
4. Right-click the event and choose Edit Generator Media. Change the generated text to the new title (including selecting the appropriate preset, as previously outlined). You now have two events with identical properties, each with a separate generated text media.

Keyframing generated text

Not all attributes of generated text media can be animated. You cannot, for example, morph one text message into a different one. Some aspects can be easily and smoothly animated using the Keyframe Controller at the bottom of the dialog: color, transparency, leading, and tracking. Keyframes can be copied, individually or as a group, and pasted into other Keyframe Controllers by right-clicking and selecting Copy or Paste. For more information, see Keyframe animation on page 305.
Other aspects of a generated text do not allow interpolated keyframe animation. For example, if you set the text to “One” initially and then at five seconds change it to “Two”, the text will suddenly jump to the new value at the five second keyframe. This behavior is considerably different from the behavior of other keyframe animation techniques. Keyframes can be used to have a title appear one letter at a time across the screen.

To create a typing effect:
1. Insert a Text generator into the timeline.
2. Right-click the new event and choose Edit Generator Media.
3. Enter the first letter of the title, for example “T”.
4. Click on the Keyframe Controller at the 1.000 second mark and enter the second letter, for example “y”. The tile now reads “Ty”. A new keyframe is added to the Keyframe Controller.
5. Proceed down the Keyframe Controller to 2.000 and enter the letter “p”.
6. Proceed down the Keyframe Controller repeating this process until the title is finished: “Typing”.

The word “Typing” will appear one letter per second until finished.
Compositing

Compositing is the process of mixing visual elements together into a final output. In Vegas this means mixing tracks together vertically. Masks, generated text, and chromakeying all involve compositing. Understanding how compositing works in Vegas is important to understanding these and many other video track mixing techniques.

Video compositing of multiple tracks is only available in Vegas Video and Vegas Video LE.

Parent/Child track relationship

The key to understanding overlays, masks, transparency, and compositing is to understand the parent/child relationship between tracks. In general terms, the Parent track is the highest track in a group of tracks (often only two) and the behavior of the Child tracks (i.e. how they are composited together) is determined by the Parent track. The first example shows two independent tracks. The top track contains a generated text event that has a transparent background. The second track therefore shows through the transparent areas in the Preview Window. Since the second track does not have any transparent areas, any tracks below it would be completely obscured.

In the second example, track two is the child track of track one, which is the parent track. This was done by clicking the Compositing Child button ( ) on track two’s Track Header. This makes the text in track one act as a mask over track two, allowing the fire to show through the mask (i.e. the text). The region outside of the text is still transparent, but there is nothing below these tracks, so it appears black.
In the third example, another video event was added below the first two, which are paired in a parent/child relationship. The video in track three shows through the transparent area of the top two paired tracks. If you look closely at the output, you can also see a shadow under the text. This shadow was created with the Track Motion tool on track one.

In the final example, the third track is the child of track two. The text in track one acts as a simple overlay and track two now acts as a mask over track three, allowing portions of track three to show through the fire. Since the fire video in track two does not make a particularly effective mask, this example is of limited usefulness in the real-world.

### Masks

Masks are the most important part of just about every Hollywood special effect. From the meteorologist standing in front of a weather map to rocket ships flying through an asteroid field, masks are used to create overlays, limit the effects of a filter, and to create transparent titles. In their simplest form, masks work by making a particular color in an image or video transparent. More complex effects can be created with gradients (smoothly blending transparent areas together) and by altering the sensitivity of the mask.

*Video compositing and masks are only available in Vegas Video and Vegas Video LE.*

### Image masks

Masks can be generated from just about any image file.

**To create a simple mask:**

1. Create an image of a solid white circle on a black background in any paint program. This will be the mask.
2. Insert the mask into the top-most track on the timeline.

3. Insert a video event just below the mask track. This is the background video behind the mask and is the event that is masked.

4. Click **Compositing Child** button ( ) located on the Track Header of the background video (lower) track. This makes the lower track the child of the mask track, which is the parent track.

In the following sample, the white circle is a *.bmp image file. Black is 100% opaque and white is completely transparent.

Masks can also be partially transparent. By using gradients and grayscale images, smooth blending can be achieved. Black is still 100% transparent and white is opaque, but the grays in between are only partially opaque.
The effects of the masks are very clear in these examples, but this is not how they would actually be used in a real production. Masks are commonly used to isolate a portion of the video from an effect. Masks do not need to be black and white, or grayscale, nor do they need to be still images.

**Note:** It is best to use images that are the same size as your project's frame size. You may also need to change the Pixel Aspect Ratio of an image file to get it to display correctly. For more information, see Media file properties on page 259.

**Masks and tracks**

Masks are rarely used as they were in the previous examples. The illustrations focus on the effects of geometric masks applied to a single event in a single track. In the real world, masks are used to hide or reveal a portion of an event that is then used as an overlay on top of another video. Take a look at the first simple white circle mask again. The white area is transparent revealing the background video that it masks. If another video event is added to the track just below the background video, the newly inserted event shows through around the mask. Another way to think about this is that the higher, masked tracks (parent mask track+child video track) appear on top of the lowest track. It is important to note that this lowest track is not a child of the higher tracks.

Video compositing of multiple tracks is only available in Vegas Video.
Video masks

Video files can also be used to create masks, although the process can be more complicated than using an image as a mask. The key to any mask is contrast. Increasing difference between the light and dark areas of a video file can be accomplished using video filters.

To create a video mask:

1. Insert the video that you want to use as a mask into a video track.
2. Drag a Black and White filter to the event to remove the color.
3. Drag a Brightness and Contrast filter to the event.
4. Adjust the Brightness and Contrast to create the mask. Watch the Video Preview window for a real-time preview of the mask. Ideally, the mask should be adjusted so that parts of the video are completely black (opaque) and other parts are completely white (transparent). This can often mean increasing the Contrast while decreasing the Brightness.

5. If necessary, mask areas can be inverted (reversing the black and white areas) with an Invert filter or by selecting Invert from the Mask Generator dialog.
After you have created the mask, place it in the highest track. Add another video event to another track below the mask and click the **Compositing Child** button ( ) on that track. Any video that appears in a lower track below the Parent mask track and its Child will then show through the areas outside of the mask. The entire setup is pictured in the following illustration.

Fine tuning masks

Depending on the source material, creating a clean mask can be a tricky exercise. The video mask generated above required significant experimentation to perfect. There are a couple of tools and tricks that should be used to fine tune a mask.

- **Solo the track** - In a complicated project, click the **Solo** button ( ) on the Track Header to mute all of the other video tracks in a project. This allows you to concentrate exclusively on the mask.

- **Toggle filters** - Turn individual filters on and off to isolate FX in a plug-in chain. Keep in mind the fact that the order of the plug-ins in the chain is important in determining the final, composited output.

- **Isolate Channels** - Individual color channels can be isolated in the Video Preview window by clicking on the Isolate Channels button. Click the button to toggle this feature on and off. Click the arrow button to the right of the main button to select the specific channel to be isolated and whether to display this channel in grayscale only. The most useful function of this tool is to isolate the **Alpha as Grayscale**, which isolates the Alpha Channel mask and displays it in grayscale.
Using the Mask filter

The Mask Generator is a plug-in that is specifically designed to control the transparency of events that are intended to be used as masks. It is applied to an event (or a track) in the same way as any other plug-in: just drag-and-drop. The Mask Generator plug-in can be found on the Plug-ins tab (from the View menu, choose Plug-ins) in the Filters folder under Video. This dialog is related to the Levels plug-in.

The Mask Generator is also an automatic part of the compositing process between parent/child tracks. To open the Mask Generator dialog, click the Mask Generator button ( ) on any track that is the parent of another. For more information, see Compositing on page 285.
How the Mask Generator works

The following illustration demonstrates some of the effects of the Mask Generator. The background image is the original mask. There are five ellipses on the mask: white, red, green, blue and an invisible Alpha Channel. Note especially the dashed-line ellipse in the lower left of the mask; this is the Alpha Channel. Alpha Channels can be based on a color or they can be defined in a paint program that supports Alpha Channel creation. Masks with Alpha Channels must be saved in a format that supports this method of transparency, such as *.png or *.tga. As in this example, the Alpha Channel may be invisible in the actual mask.

The top-right example is using the Luminance to determine the transparency in the mask. The white area is completely transparent. Since white is made up of 100% values of red, green, and blue (255,255,255), those three colors are all 33% transparent as well. In the lower-right example, blue is the selected transparent index. The blue area is 100% transparent and so are all areas that have a value of 255 for blue (0,0,255), including white (255,255,255).

Chromakeying

The Chroma Keyer plug-in is only available in Vegas Video and Vegas Video LE.

Chromakeying or blue screening is a special case of overlay transparency. A color key is simply a specific color, or a range of similar colors, in an image that are made transparent, allowing a background video to show through. The idea is to take a video subject and film it
against a solid, uniform background color. It is critical that the color be smooth and uniformly lit with no shadows, and that the color chosen for the background must not be used in the subject.

The most important factors in successful blue screening happen during shooting, well before the footage is imported into Vegas. Compression of the source video is also an important consideration. While almost all video is compressed in some way, highly compressed video does not key well because colors can be smeared together and edges tend to not be very sharp.

If your source footage is good and the captured video file is also of high quality, color keying is an easy process.

**To create a chroma key effect:**

1. Insert a video with a blue (or any solid colored) background into a track. This is the overlay video.

2. Insert the background video that will show through the blue areas into the next lower track.

**Note:** You do not need to set the lower background track as a Child track when using the Chroma Keyer filter as you would with a mask.

3. Click on the overlay video (foreground, higher track) to select it.

4. Open the Plug-Ins window and choose Filters under the Video folder.

5. Drag a Chroma Keyer filter onto the overlay video.

6. In the Event FX dialog (click the Event FX button (···) or, from the View menu, choose Plug-Ins), click the Eyedropper button (●). The cursor changes to an eyedropper icon.
7. Draw (click and drag) a small rectangular selection area around the color(s) to key out. Although you can select the color range from just about anywhere, the Video Preview window is the best location.

**Note:** Other effects that may change the color of the event should be turned off when using the Eyedropper tool.

When a subject is filmed against a solid colored background in a studio, the background color can be keyed out and made transparent using the Mask Generator or the Chroma Keyer filter. A wider range of colors can be selected using the Chroma Keyer filter, making it the perfect tool for less-than-perfect blue screens.

This procedure selects a small range of colors to use as a key. In the example above, the blue sky around the dome is far from uniform and it would be difficult to key it out with a traditional blue screen key. The color is uniform enough however, that a range of blues can be selected directly from the preview image in Vegas. Use the controls at the bottom of the dialog box to determine the sensitivity of the colors selected. Since the filter selects a range of colors, it is a good idea to try to select a relatively small range of similar colors. Drawing a color selection area that spans both blue and red colors would make very large sections of an overlay transparent. It is possible to use multiple Chroma Keyer filters on a single event, keying out the blues with one and the reds with the other, without keying out any colors between blue and red.

**To select multiple colors:**

1. Add a Chroma Keyer filter and select a small range of colors to key out.

2. Add a second Chroma Keyer filter. Select the second, contrasting range of colors to key out.

3. Repeat with as many separate Chroma Keyer filters as necessary on a single event.
Compositing Modes

Track compositing is only available in the full version of Vegas Video and is limited to Alpha transparency in Vegas Video LE.

The Compositing Mode button determines how the transparency in a video track is generated. Since lower tracks show through higher tracks, it is the Compositing Mode of the higher track that determines how much of the lower track shows through. The Compositing Mode of the lowest video track has no effect on a project (since it would only determine how much of the next track shows through, and there is no next track).

The Compositing Mode can be selected by clicking the Compositing Mode button and choosing a mode. Source Alpha is the default. There are three basic Compositing Modes:

1. Add: adds the colors of the tracks together.
2. Subtract: subtracts the colors of the tracks from each other.
3. Multiply: merges the colors of the tracks.
4. Alpha (default): uses the Alpha Channel to determine transparency.

Note: The Compositing Mode is based on the Alpha Channel characteristics of an event or media file. If no Alpha Channel is present, the Source Alpha Compositing Mode has no effect.

Level slider

The transparency or blending of the overlay can be precisely controlled with the Level slider. Left is 100% transparent and right is 100% opaque. You can also double-click the percent to enter a specific numeric percentage.
The illustration on the right is of four tracks that have been set up to illustrate how the various modes work. In each case, pairs of tracks are matched in a Parent/Child relationship to create a mask. The Parent tracks (tracks One and Three) each have a simple image that is used as a mask over a solid colored Child track (tracks Two and Four). The masks serve as the track’s Alpha Channel. The top level track’s Compositing Mode then determines how the four tracks (two pairs of tracks) are composited together. If a fifth track was added below these, it would show through the black areas (Alpha Channel), based on the Compositing Modes of the two parent tracks.

The examples below abstractly illustrate the four modes of the Compositing Mode button ( ) on track One.

Transitions

Transitions are the final type of Video plug-in. Transitions occur between two video scenes, smoothly blending one into another and are discussed in another chapter. For more information, see Transitions on page 297.
One of the most fun and exciting aspects of editing video on a computer is adding special effects. When you combine all of the transitions, filters, and motion generators, Vegas has an almost unlimited variety of effects.

Transition effects are only available in Vegas Video and Vegas Video LE.

Transitions

Transitions occur between two video events and are an entertaining and interesting segue way. Too many transitions in a single production can distract from your movie. Most professional productions, on television or on the big screen, use only two types of transitions. The first is a simple cut, where one scene immediately cuts to the other without delay or effects. The other is a fade, otherwise known as a crossfade or a dissolve.

Cuts

A cut is actually not a transition. Instead, the last frame from an event is immediately followed by the first frame of the next event. This is what happens when with two adjacent events on the Vegas timeline, either in the same track or in different tracks. This can also happen when an event is punched into another (with fade edge edits turned off).
Fading

You can fade smoothly from one event into another or into the background color using an Opacity envelope.

To fade to black:

1. Insert a video event onto the timeline.

2. Move the mouse pointer over the blue triangle at the upper corners of the event. Notice that the cursor changes: ( ).

3. Click and drag (horizontally) towards the middle of the event.

The line that appears is a visual representation of the fade and is known as an envelope. The timecode of the beginning of the fade appears in the ToolTip. By default, the event will fade to whatever the event overlays. If there are no additional events in lower tracks, the event fades into the project’s background color. Transitions can also be used in a transition-to-black effect. For more information, see Adding transitions to the ends of an event on page 300.

Right-click on an Opacity envelope and, from the shortcut menu, select the exact progression of the fade: Slow, Linear or Fast. This technique is not limited to fading out, but can also be used at the beginning of a video event. By using a fade out at the end of one event and a fade in at the beginning of the next, you can easily create a very effective fade to black between major parts of your production. The two events can be placed next to one another (without overlapping), or you can leave a one-second gap for a more significant pause.

Crossfades

You can fade one event out and fade into the next event by simply overlapping the two. The duration of the transition is determined by the amount of overlap.

To crossfade between two events:

1. Insert a video event onto the timeline. (From the Options menu, make sure Automatic Crossfade [X] is toggled on.)

2. Insert another video event onto the same track.
3. Drag the edge of the second event over the first.

You can see that the region of overlap changes and that there are two crossed lines representing the transition. There are a number of shapes (curves) that the crossfade can follow. Right-click on the crossfade envelope and choose **Crossfade** from the shortcut menu. Click on one of the nine types of fades to select it.

Using Transition effects

Transition effects are more complex than a simple crossfade. While each effect is different and can be customized in many different ways, the basic procedure for adding a transition effect is uniform.

Transition effects are only available in Vegas Video and Vegas Video LE.

Adding a transition

To add a transition effect:

1. Insert a video event onto the timeline or a track.
2. Insert another event so that it overlaps the first to create an automatic crossfade.
3. From the **View** menu, choose **Plug-Ins [ALT+5]**.
4. In the **Transitions** folder, browse for a transition effect.
5. Drag the effect to the timeline onto the automatic crossfade between two events.

The duration of a transition is automatically determined by the amount of overlap between the two events. As with other events in Vegas, the precise duration of a transition can be controlled by dragging the edges in and out.
One of the fastest ways to convert a crossfade to a transition event is to right-click the automatic crossfade and from the shortcut menu, choose the transition that you want to insert (e.g. Insert Transition ‘Iris’). Some transitions also have their own shortcut keys. On the **number pad** of your keyboard, press [![](https://via.placeholder.com/15)](https://via.placeholder.com/15) to insert a Crossfade, [![](https://via.placeholder.com/15)](https://via.placeholder.com/15) to insert an Additive dissolve, and [![](https://via.placeholder.com/15)](https://via.placeholder.com/15) to insert a Linear wipe. Holding the [![](https://via.placeholder.com/15)](https://via.placeholder.com/15) key while pressing any of these keys converts the transition to a cut at the cursor position.

**A and B rolls a are only available in Vegas Video and Vegas Video LE.**

Transitions can also be viewed and modified in a different mode. Click the **Expand A/B rolls** button ([![](https://via.placeholder.com/15)](https://via.placeholder.com/15)) to expand the track to reveal three sub-tracks within the main track. These sub-tracks are known as rolls and they are called A roll, B roll, and Transition roll.

### Adding transitions to the ends of an event

Typically a transition occurs between two events on a track, but transitions can also be used to fade to and from the background, whether that is an underlying image or video or a background color. For example, you can drag a Clock Wipe transition to the end of a video event and have the wipe go from the video event to black.

### Understanding the A/B roll

**A and B rolls a are only available in Vegas Video and Vegas Video LE.**

The concept of an A/B roll is fundamentally different from Vegas’ multitrack philosophy. Every track is in some way mixed (composited) into the final output in a multitrack system, but events are not mixed on the A/B roll. Instead, either the A roll or the B roll is playing, with the two trading places during a transition. You could mix the two for as long as you want with a transition, but they will not blend without an intervening transition. Transitions move **from** one roll and **into** the other. This could be from A to B or from B to A. The direction of the transition is automatically set by Vegas. The small arrows on the side of the Transition event indicate this direction. As the following sequence shows,
the video output can shift from the A to the B and back to A many times during a production, but there is only one video output from any particular roll at a time. This means that the A and B rolls are not composited or mixed together.

The A roll is on top and the B roll is on the bottom, with the transition located between them on the Transition roll.

Depending on the mode you have selected for the track, the transition can appear in one of two ways. In Collapsed mode, the A/B roll is compressed and cannot explicitly be seen, although it is still there. Instead, a rectangle in the middle of the two events displays the name of the transition. This has no effect on the final video output.

Converting cuts to transitions

The transition between two events that are adjacent to each other on the same roll and track is instantaneous and is called a cut. If the first event is trimmed back from the end and the second event is trimmed back from the beginning (both have enough media to overlap), the cut can be transformed to a transition effect, using this extra media.
To convert cuts:

1. Right-click the line between two adjacent events at the cut position.
2. From the shortcut menu, choose Transition and then select the transition that you want to insert (e.g. Insert Sonic Foundry Iris).

Transitions can also be dragged to the cut from the Media Explorer.

The duration of the newly inserted transition event is determined by the Transition fade time set in the Preferences dialog. To access this dialog, from the Options menu, choose Preferences and go to the Video tab.

Note: There must be enough media in the respective events to cover the transition (e.g. the end of the first event must not be the end of the media file).

Cuts between audio events can also be converted to crossfades. Position the timeline cursor on the cut and press [T] on the number pad on your keyboard to create a crossfade. There must be enough media on either side of the cut to create the crossfade. The specific duration is set in the Preferences dialog on the Editing tab under Cut to overlap conversion.
Previewing a transition

The easiest way to preview a transition is to set the preview area to the duration of the transition and then loop the playback. You can then adjust the transition while it is playing, quickly making your changes in real-time.

To preview a transition:

1. Double-click the transition. This automatically sets the selection (preview) area to the proper duration.

2. Click the Loop button ( ) to toggle automatically repeated playback. The selection area bar is dark blue when Loop is turned on.

3. Click the Play button ( ), or press the Space key.

Complicated transitions may need to be rendered. From the Tools menu, choose Render to Video Preview.

Modifying a transition

All of the transitions in Vegas include default settings that create a perfect transition. Most transitions are highly customizable with many attributes that can be changed and even animated.

To modify a transition:

1. Click the FX button ( ) on the Transition event or right-click the transition and choose Transition Properties from the shortcut menu. The Video Transition dialog appears.

2. Change the parameters. Changes are updated in real-time in the Video Preview window.

3. Use keyframe animation techniques to animate the transition. See the next section for more information.

Each transition has individual controls and variables, the details of which are discussed in the Transition Dictionary. For more information, see Video transition dictionary on page 308.
The Video Transition dialog is similar to the Effects dialog (pg. 266). One obvious difference between the two is that you can only apply one transition event to a particular track at a particular time. This means that the Effects Chain is limited to one effect.

After modifying a transition, it is possible to save the changes as a preset for use at a latter time. Default and custom presets can be accessed from the Preset drop-down list.

**To save a variation as a preset:**
1. Click the name in the Preset drop-down list.
2. Enter a name for the new preset.
3. Click the **Save Preset** button ( ).

Any additional changes can be instantly saved to the custom preset by clicking the Save Preset button. Changes cannot be saved to the (Default) preset.
Keyframe animation

Keyframe animation is only available in Vegas Video and Vegas Audio.

Keyframe animation is a technique that computer artists use to quickly make complex animated sequences. Instead of drawing every frame of a title scrolling in from top to bottom by hand, an animator simply has to set a starting and ending position for the animation and let the computer interpolate the intermediate frames. The animation pictured on the right would have two keyframes: a starting and ending keyframe. A third keyframe could be added to pause the title briefly in the middle or to change the direction of motion. More complex animations use more keyframes.

While keyframing motion may be the most obvious use for keyframe animations, just about any parameter of an effect can be animated with keyframes. Vegas uses keyframe animation techniques in many areas, including transition effects and filters. Color, brightness, transparency, motion, size, perspective, and many other parameters can all be easily controlled this way.

Keyframe Controller

The Keyframe Controller is only available in Vegas Video and Vegas Audio.

When you open the Video Event FX dialog, the Video Motion dialog or the Transition dialog, the options available depend on which effect you are working with. The bottom of the dialog contains the Keyframe Controller which is the same for every effect.
The cursor position is marked by a red line on the controller. This position can also be automatically updated on the timeline, with the Video Preview window also updating in real time to reflect changes. Position the cursor on the main timeline and click the Sync Cursor button (¶) on the Keyframe Controller to move the cursor to the corresponding position on the controller. For events, tracks and projects using more than one filter, each filter’s keyframe information is displayed on a separate strip. Click the particular strip of the effect that you want to modify to select it.

Adding a keyframe

Every effect has a starting keyframe at the beginning (left side) of the Keyframe Controller. This sets the initial parameters for the effect. These parameters will not change during the course of the effect. In order to animate the effect, it is necessary to add another keyframe to the effect and change some of the parameters.

Note: By default, when you move the cursor to a new location on the Keyframe Controller and change a parameter of an effect, a new keyframe is automatically added.

To add a keyframe:

1. Click on the Keyframe Controller timeline to move the cursor to where you want to add a keyframe. The current position is marked by a blinking red cursor.
2. Click the Add Keyframe button (¶).

The new keyframe’s attributes are copied from the previous keyframe. Since their attributes are identical, no animation will occur between them. This is especially useful at the beginning of an effect to lock the effect without any animation up to a certain time.

- To delete a keyframe, select the keyframe and click the Subtract Keyframe button (¶).
- Keyframes are added automatically by navigating to a particular time and changing any parameters in the dialog.
- Use the keyframe navigation buttons to quickly jump directly to a keyframe.
- Press [Ctrl]+[+] or [Ctrl]+[-] (Left or Right Arrow) to move to the previous or next keyframe.

Modifying keyframes

Keyframes on the controller can be copied, pasted, and duplicated.

To copy a keyframe:

1. Right-click a keyframe.
2. From the shortcut menu, choose Copy.

To paste the keyframe, right-click the Keyframe Controller and, from the shortcut menu, choose Paste.

- Duplicate a keyframe by holding the \(\text{Ctrl}\) key while dragging it.
- As with other objects, you can select multiple keyframes by holding the \(\text{Ctrl}\) key while you click on individual keyframes or hold the \(\text{Shift}\) key to select a range.

By default, the animation that Vegas interpolates between any two frames is linear. The right-click shortcut menu also allows you to select a different shape for the interpolation curve. **Hold Keyframe** prevents any animation from being interpolated between two keyframes. This is very similar to the envelope fade curves: **Linear**, **Slow**, and **Fast**. For more information, see Setting an event’s fade in and out on page 170.

The relative positions of the keyframes can also be changed as a group. This can be useful if you need to change the overall length of an animated sequence or if you need to copy a set of keyframes to another event that has a different duration than the original.

**To change the relative spacing of a group of keyframes:**
1. Hold the \(\text{Shift}\) key and click the first and last keyframes in the sequence to select all of the keyframes.
2. Hold the \(\text{Alt}\) key and drag to scale the keyframes.

When copying keyframes from longer event to shorter events, you need to temporarily lengthen the duration of the shorter event so all of the keyframes will appear on the Keyframe Controller, rescale the keyframes using the above procedure, and then resize the event to its original length.

**Keyframes and transition effects**

Some aspects of a transition effect can be modified and animated with keyframes and some cannot. Attributes that have a number of discrete states cannot be smoothly animated. There is no halfway between Clockwise and Counter Clockwise, for example. In these cases, the effect jumps to the new attribute at the keyframe, but no intermediate states are rendered.
Video transition dictionary

Transition effects are only available in Vegas Video and Vegas Video LE.

There are a number of transition effects available in Vegas and each has its own variables and parameters that can be customized. Many of the examples in this section are based on the video track pictured at the right. The example transitions from the beach scene in the A roll into the ornate temple roof in the B roll. The samples in the Transition window in Vegas display animated thumbnails of the effects: click on a transition thumbnail to view this animation.

The following is an alphabetical listing of the various transition effects and their options.

Additive Dissolve

Dissolves are also commonly known as fades. Additive simply means that the B roll video sequence is gradually added on top of the A roll video, with the transparency of A increasing while B’s transparency decreases until it is completely opaque. Because it is an additive dissolve, the video becomes brighter during the transition. This transition is similar to an Auto-crossfade or Fade.
Barndoor

This transition effect is a variation of a wipe transition. As the name implies, this wipe moves in two directions, not unlike two barn doors. Video transition barn doors can move in a number of different directions however: vertically or horizontally.

<table>
<thead>
<tr>
<th>Orientation</th>
<th>Select Horizontal / Vertical for doors that open side to side or top to bottom.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direction</td>
<td>The transition can start from the outside and move <strong>In</strong> towards the center or start at the center an move <strong>Out</strong> towards the edges.</td>
</tr>
</tbody>
</table>

| Slow In              | This controls the speed of the transition at the beginning of the effect. Move the slider to the right to slow the beginning. |
| Slow Out             | This controls the speed of the end of the transition. Move the slider to the right to slow the end of the transition. |

Border Controls

| Size                  | Move the slider to the right to create a larger border. |
| Feather               | Feather determines how crisply the edge appears. Higher values yield a softer edge. |
| Color                 | Use these color boxes to select a color for the border. |

Clock Wipe

This wipe effect moves in a circular pattern, either clockwise or counterclockwise.

| Direction            | Select Clockwise or Counterclockwise. |
| Feather Angle        | Determines how much of the edge is feathered or softened. |
Cross Effect

This is a composite transition effect that uses a crossfade combined with a Zoom, Pixelate or Blur transition. The following illustration shows a Pixelate Cross Effect where the first video gradually becomes more and more pixelated, then crossfades into a pixelated second event, which finally resolves to the second event, thus completing the transition.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fade Range</td>
<td>Determines the duration of the crossfade that occurs at mid transition. The fade takes place across the entire transition for a value of 1.</td>
</tr>
<tr>
<td>Effect</td>
<td>Select the type of transition to combine with the crossfade: None, Zoom, Pixelate or Blur.</td>
</tr>
<tr>
<td>Apply to</td>
<td>Determines which events are involved with the zooming aspects of this effect: Source, Destination or Both.</td>
</tr>
<tr>
<td>Max Zoom</td>
<td>Sets the maximum amount of zooming at the mid point of the transition: from 1 to 128%.</td>
</tr>
<tr>
<td>Source Center</td>
<td>Determines the center of the first event (transition from).</td>
</tr>
<tr>
<td>Destination Center</td>
<td>Determines the center of the second event (transition to).</td>
</tr>
<tr>
<td>Map</td>
<td>Drag the center dots (red = source/ blue = destination) to visually determine the center location.</td>
</tr>
</tbody>
</table>
Iris

This effect allows you to select the shape of the transition as it grows. The shape can be repeated any number of times in rows and columns and can be surrounded by a border. By freezing this transition in the middle using keyframe animation techniques (pg. 307), it is very easy to create a video window (in any of the default shapes that are included with this effect) using the transition as a mask.

<table>
<thead>
<tr>
<th>Center</th>
<th>Enter the coordinates of the center of the effect into the text boxes or drag the circle on the position map to the desired location.</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Repeat / Y Repeat</td>
<td>X Repeat is how many times the shape is repeated across the image from left to right (columns) and Y Repeat is the number of times the shape is repeated from top to bottom (rows).</td>
</tr>
<tr>
<td>Iris Shape</td>
<td>Sets the shape of the iris.</td>
</tr>
<tr>
<td>Feather</td>
<td>Determines how smoothly the border fades into the background.</td>
</tr>
<tr>
<td>Border Controls</td>
<td>The following three controls modify the border, if any, on the effect.</td>
</tr>
<tr>
<td>Border</td>
<td>Sets the width of the border.</td>
</tr>
<tr>
<td>Feather</td>
<td>Determines how smoothly the border fades into the background.</td>
</tr>
<tr>
<td>Border Color</td>
<td>Use the color boxes to select a color for the border.</td>
</tr>
</tbody>
</table>

Linear Wipe

At first glance, the Linear Wipe, Push, and Squeeze transitions look very similar. In a Linear Wipe transition, a line moves across the video, revealing the second video, which was always below the first and is unmoving. In a Push, the second video itself moves onto the screen as the first one moves off. A Squeeze distorts the transitioning video events, squeezing one as the other expands.

| Angle | Use the slider to control the direction the wipe comes in from. |
| Feather | This sets the size and softness of the edge of the wipe. |
Page Peel and Page Roll

These two Page transitions act as if the two video events involved in the transition are pages in a book. The first page (first video event) can be turned to reveal the next page (second video event). The difference between a peel and a roll is illustrated below, although it is more clearly seen by actually previewing the two transitions in Vegas.

<table>
<thead>
<tr>
<th>Angle (Peel and Roll)</th>
<th>This angle determines the corner the page is turned from. For example 0° to 90° is the lower right corner, with 45° being the exact center of the lower right corner. The angle of the peel in the above examples is about 60°.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fold radius</td>
<td>This determines how high the page is lifted. Lower values keep the peel closer to the page and make a much tighter roll, while higher values lift the peel further and make for a much looser roll.</td>
</tr>
<tr>
<td>Slide amount</td>
<td>This determines how much the entire first page slides away over the second.</td>
</tr>
<tr>
<td>Opacity (Peel and Roll)</td>
<td>This sets whether you can see through the back of the page as it is turned.</td>
</tr>
<tr>
<td>Perspective</td>
<td>This adjusts the viewer’s virtual perspective in relation to the page. Lower numbers simulate a higher perspective above the page, while numbers approaching 1.000 simulate a greater viewing angle.</td>
</tr>
<tr>
<td>Light color</td>
<td>Use these color boxes to set the color of the light that is reflected off of the back of the page.</td>
</tr>
</tbody>
</table>

Push

Event two pushes in over the first event, from any direction, replacing it. See the illustration accompanying the Linear Wipe effect.

<table>
<thead>
<tr>
<th>Direction</th>
<th>Select the direction from which the transition progresses: Up, Down, Left or Right.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push off previous image</td>
<td>The first video pushes the second video off of the screen when this is selected. When not selected, the second video merely slides over the first, with the first remaining unmoved.</td>
</tr>
<tr>
<td>Border</td>
<td>The following three controls modify the border, if any, on the effect.</td>
</tr>
<tr>
<td>Size</td>
<td>Sets the width of the border.</td>
</tr>
<tr>
<td>Feather</td>
<td>Determines how smoothly the border fades into the background.</td>
</tr>
<tr>
<td>Border Color</td>
<td>Use the color boxes to select a color for the border.</td>
</tr>
</tbody>
</table>
Slide

In this transition event two slides over event one (Slide In) or event one slides away off screen, revealing event two (Slide Out).

<table>
<thead>
<tr>
<th>Angle</th>
<th>Determines the angle of the transition’s movement.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direction</td>
<td>Slide In: event two slides over event one. Slide Out: event one slides off screen.</td>
</tr>
<tr>
<td>Border</td>
<td>The following three controls modify the border, if any, on the effect.</td>
</tr>
<tr>
<td>Size</td>
<td>Sets the width of the border.</td>
</tr>
<tr>
<td>Feather</td>
<td>Determines how smoothly the border fades into the background.</td>
</tr>
<tr>
<td>Border Color</td>
<td>Use the color boxes to select a color for the border.</td>
</tr>
</tbody>
</table>

Spiral

This transition uses a circular sliding motion to exchange the events. The events can also appear to zoom in or out during the transition. The following illustration shows a Spiral Out effect that zooms out to 0.

<table>
<thead>
<tr>
<th>Turns</th>
<th>Determines the number of rotations the transition undergoes before the effect is completed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>Determines the level of magnification at the start/finish of the transition from 0 (minimum size) to 1 (full size).</td>
</tr>
<tr>
<td>Orientation</td>
<td>Determines the starting position of the spiral: Left, Top, Right or Bottom.</td>
</tr>
<tr>
<td>Motion</td>
<td>Determines the direction of the circular component of the spiral motion: Counter-Clockwise or Clockwise.</td>
</tr>
<tr>
<td>Direction</td>
<td>Spiral In: event two spirals in from the outside, covering event one. Spiral Out: event one spirals away towards the center, revealing event two.</td>
</tr>
<tr>
<td>Border</td>
<td>The following three controls modify the border, if any, on the effect.</td>
</tr>
<tr>
<td>Size</td>
<td>Sets the width of the border.</td>
</tr>
<tr>
<td>Feather</td>
<td>Determines how smoothly the border fades into the background.</td>
</tr>
<tr>
<td>Border Color</td>
<td>Use the color boxes to select a color for the border.</td>
</tr>
</tbody>
</table>
Split

In this effect, one of the transitioning events is split apart into four sections and gradually covers, or reveals, the other event. The illustration uses Split Mode: Squeeze and Direction: In.

Squeeze

This effect is similar to Push and Linear Wipe. In a Squeeze effect however, the entire contents of both videos is visible for the duration of the effect. See the illustration accompanying the Linear Wipe effect for more information.
Swap

In this effect, event one slides out of the way and then exchanges places with event two, which comes to the forefront.

<table>
<thead>
<tr>
<th>Direction</th>
<th>Determines the initial direction that event one takes during the swap.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Border</td>
<td>The following three controls modify the border, if any, on the effect.</td>
</tr>
<tr>
<td>Size</td>
<td>Sets the width of the border.</td>
</tr>
<tr>
<td>Feather</td>
<td>Determines how smoothly the border fades into the background.</td>
</tr>
<tr>
<td>Border Color</td>
<td>Use the color boxes to select a color for the border.</td>
</tr>
</tbody>
</table>

Zoom

The second video appears on top of the first as a point at the beginning of this effect and gradually expands to cover the entire screen.

<table>
<thead>
<tr>
<th>Location</th>
<th>Drag the circle on the location map to determine the starting point of the effect.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Border</td>
<td>The following three control the border, if any, on the effect.</td>
</tr>
<tr>
<td>Size</td>
<td>This sets the width of the border.</td>
</tr>
<tr>
<td>Feather</td>
<td>Determines how smoothly the border fades into the background.</td>
</tr>
<tr>
<td>Border Color</td>
<td>Use the color boxes to select a color for the border.</td>
</tr>
</tbody>
</table>
Track Motion

Track Motion is only available in Vegas Video.

The Track Motion dialog is used to move a video track across a background. This background can be a solid color, but it is more common to use another video event or an image. Picture-in-picture effects and scrolling title sequences are two simple cases where this tool is important.

The Track Motion dialog is easy to use. The striped gray area in the center (covered by the blue/grey rectangle) represents the actual screen or area that is visible in the movie. The area outside of the main screen, which is filled with dotted lines, is the general workspace. The video you are moving can be positioned off of the visible screen and then animated onto and across the screen. The dots are markers to help position the video window. If snap is turned on, these serve as ‘snap to’ points. The main window allows you to control the placement, size, and orientation of the overlay video through time. The blue and gray rectangle in the middle of the screen represents the area of the full screen. The large “F” is used to represent the orientation of the track and is especially useful in indicating a track that has been reversed.

You can also create blue guide lines to help you align objects by moving to the edge of the ruler and dragging towards the center of the workspace to create a new line. Existing guides can be repositioned by dragging. Guidelines can also be used to snap the video window.
Track Motion context menu

When you right-click anywhere in the Track Motion window, a shortcut menu appears:

- **Restore** returns the overlay to its original state.
- **Match Aspect** sets the aspect ratio to the frame value.
- **Center** moves the overlay to the center of the frame.
- **Flip Horizontal** flips the overlay backwards or left to right.
- **Flip Vertical** flips the overlay upside-down.
- **Match Source Aspect** sets the x,y ratio to the overlay value.
- **Background** sets the color of the overlay window.

Controlling the Track Motion workspace

The Track Motion workspace allows you to position the video within the project frame. Select the **Zoom** tool ( ) and click on the workspace to zoom in. If you click and drag on the ruler that surrounds the workspace, a hand icon appears and allows you to move around the magnified workspace.

Keyframing and Track Motion attributes

*Keyframe animation and the Track Motion tool are only available in Vegas Video.*

The Keyframe Controller has three attributes that can be animated: Position, Shadow, and Glow. Each effect can be animated independently. The Shadow and Glow effects can be turned on and off. Each effect has its own set of controls that appear on the right-hand side of the dialog. These controls can be accessed by clicking on the respective item on the Keyframe Controller.

**Position**

Controlling the position of the overlay is easily accomplished in the main window by dragging the gray box. The controls in the dialog are invaluable when you need precision. Zooming can be used to shrink or expand the video overlay. The Grid Density is only used to control the ruler settings and snap to points.
Shadow
This creates a simple drop shadow that appears under the entire window or only under the opaque (nontransparent) parts of the overlay. The size and offset of the shadow can be controlled and animated, and you can specify the shadow color. A shadow is especially effective under a picture-in-picture window or to emphasize text and titles. Use the Eyedropper tool to select a specific color from anywhere on the screen.

Glow
Glow is a bright haze surrounding an overlay. In general, light colors are used for glow effects, but you can emphasize bright text on complex backgrounds by using a very small black glow, with little or no Feathering, and 100% Intensity.

Shadows and Glow
Drop shadows are simple shadows under an object, window, or title. It is an especially effective technique for emphasizing text against a complex background.

To create a drop shadow under titles:
1. Use the Title generator to create a title. For more information, see Text on page 280.
2. Click the Video Motion button ( ) on the track with the titles.
3. Select Shadow on the Keyframe Controller at the bottom of the Video Motion dialog.
4. In the Video Motion dialog, configure the following Shadow parameters:
   Offset: 1.00 X 1.00 - This sets the location of the shadow one pixel off center.
Feather: 0 - This makes the shadow very crisp and small with no fuzzy edges.
Intensity: 1 - This is an opaque shadow. Other values near one will also work.

A Glow can be applied in a similar way. A Glow is not offset and is centered on the overlay video, surrounding the overlay video with a diffuse colored border.

Modifying the shadow
The shadow can also be animated and modified independently of the main track area.

Picture-in-Picture
Picture-in-Picture is an easy technique to reproduce using the Track Motion tool.

To create a Picture-in-Picture effect:
1. Insert the background video into a track.
2. Insert the overlay video into another track just above the first.
3. Click the Track Motion button ( ) on the upper overlay track.
4. In the overlay dialog, position and resize the Track Area in the Track Motion dialog.
The illustration below shows some of the relevant parts of this procedure. Note the shadow cast by the overlay video. This is added by selecting the Shadow option on the Keyframe Controller. The attributes in this dialog can all be animated with keyframe animation techniques. The Video Preview window displays the results.

Note: As in the above example, overlay picture-in-picture windows are often completely opaque. Fade envelopes can be used to fade the picture in and out.

 Animating the overlay

Many aspects of an overlay can be animated using the keyframes at the bottom of the Track Motion dialog.

To create a moving video window:
1. Insert a video event onto the timeline and click on it to select it.
2. Click the Track Motion button ( ) located on the Track Header on the left side of the track.
3. Drag the Resize Squares at the edges of the video to change the size.

4. Drag the middle of the video to position it for the start of the animation.

5. Click on the timeline of the Keyframe Controller at a later time to move the cursor to that position.

**Note:** You can also navigate to a new position on the main timeline and then click the **Sync Cursor** button ( ) in the Track Motion dialog to automatically move the cursor on the Keyframe Controller.

6. Reposition the overlay. A new keyframe is automatically added to the Keyframe Controller timeline.

When you preview the video, Vegas will interpolate the position of the overlay between the two keyframes with a smooth animation.

- To rotate the video overlay, move the cursor outside of the Track Area box. The cursor changes to a circle with an arrow on it. Drag to rotate.
- The clock icon in the Track Area shows the orientation of the track and the exact angle is displayed in a small ToolTip below the cursor. Dragging the clock icon moves the center of rotation.
- The position of the clock icon in the Track Area determines the center of rotation.

**Note:** Since this animation applies to an entire track, each separate event that you want to apply the same motion to must be placed on a different track.

### Scrolling titles - Video Motion technique

The Track Motion tool is only available in Vegas Video. The Title generator is only available in Vegas Video and Vegas Video LE.

The Title generator can be used to quickly create titles. These title sequences can then be animated using the Track Motion dialog. An alternate method is to create an image file (*.bmp, etc.) and then scroll it across the video.
To create scrolling titles - Video Motion:

1. Insert a title sequence into a track above the main video.

2. Click the **Track Motion** button ( ) on the left side of the title (overlay) track in the Track Header.

3. Move the overlay titles above the screen area (see the illustration below).

4. Move to the end of the title clip. One way to do this is to move the cursor to the end of the event on the main timeline ( + + ) and then click the **Sync Cursor** button ( ) on the Keyframe Controller. You can also move the cursor directly on the Keyframe Controller in the Track Motion dialog.

5. In the Track Motion dialog, click the **Constrain Motion** button ( ) until it is in **Move in Y Only** mode ( ). This keeps the titles vertically aligned.

6. Move the track down and off of the bottom of the screen. A position keyframe is automatically added to the Keyframe Controller at the bottom of the dialog.

Another tool that makes many operations in Vegas easier is the Snap tool. In the Track Motion dialog, click the **Toggle Snap** button ( ) to turn this feature on, or simply hold down the **Shift** key to toggle it on temporarily. Another method for creating scrolling titles is to use the Pan/Crop dialog. This alternate technique is preferable in many situations, especially when the title sequence is long, such as during closing credits. For more information, see *Scrolling titles - Pan/Crop technique* on page 246.
Saving and Rendering Projects

Vegas allows you to save and render projects into many different multimedia formats. The chosen format is determined by how you want to deliver the media. When you render a Vegas project to a different format, your project is not affected, and a single project may be rendered in any number of different formats.

This chapter explains saving a project and using the Save As and Render As functions. In addition, you will find reference information for the rendering options available in Vegas.

Saving your project

A project in Vegas is saved as a small *.veg file. This file contains all of the information Vegas needs to recreate your project: source file locations, trimming, track and bus plug-ins, volume and panning envelopes, bus assignments, assignable FX settings, etc. This is not the same as creating a final media file, which is done with the Render As command.

To save the project:

1. Select one of these save methods:
   • From the File menu, choose Save.
   • Click on the Save button.
   • Press Ctrl+S on the keyboard.

   The first time a project is saved, the Save As dialog appears.

   In subsequent saves, the above dialog is bypassed, your existing file name is retained, and your project is updated to include any implemented changes.

2. Select Vegas Project (*.veg) from the Save as type list (default).

3. Select the drive and folder where you want to store the project.
4. Type the project name in the File name box.

5. Click the Save button in the Save As dialog.

To make a project more portable or to simply organize your project more efficiently, select the Copy all media with project check box. This will create a copy of all of your source media files in the destination directory. While this will initially require a lot of disk space because there will be two copies of every file, it does allow you to organize a project into one convenient location and then clean up your hard drive.

Creating a copy of a project (using Save As...)

After you have been working with your project, you may use the Save As command in the File menu to create a copy of the small project file with a different name. Since multimedia projects can be very complex, and since Vegas project files are so small, saving a number of different versions of a project is a good way to try new techniques without risking ruining your project.

To create a copy of the Vegas project:

1. From the File menu, choose Save As. The Save As dialog appears.
2. Select the drive and folder where you want to store the project.
3. Type a new name in the File name field.
4. Click the Save button on the Save As dialog.

Click the Copy all media with project check box if you want all the media copied into the same folder as the project.

Save As dialog check boxes

The Save As dialog has three check boxes, which you can use when saving your file or rendering it to a different format. These check boxes appear in the lower-left corner of the dialog.

Vegas (*.veg) projects only. This option copies the media that is referenced in the project to the same folder to which you are saving the project (for portability).

If you have a time selection in your project, this option ensures that the entire project is rendered. If you do not select this option, only the time selection is rendered.

If your project contains markers or regions, you may save that information in the rendered file. Saving markers into a media file can enhance the end user's interaction with the media file.
Rendering projects

Rendering refers to the process of converting the Vegas project into a single new multimedia file and formatting it for the desired playback method: media player, Internet streaming media, CD-ROM, video tape, etc. The project file is not overwritten, deleted, or altered during the rendering process. You may return to the original project to make edits or adjustments and render it again later. The following table describes the formats available for rendering your Vegas project:

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Interchange File Format</td>
<td>*.aif</td>
<td>The standard audio file format used on Macintosh computers.</td>
</tr>
<tr>
<td>MPEG Layer 3</td>
<td>*.mp3</td>
<td>Compressed audio format. You may render up to 20 *.mp3 files without registering the optional plug-in (see note below this table).</td>
</tr>
<tr>
<td>RealMedia G2</td>
<td>*.rm</td>
<td>The RealNetworks standard for streaming media via the Web. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Vegas EDL</td>
<td>*.txt</td>
<td>This option creates a text version of event placements in the Track View. EDLs can be used by an outside studio to recreate your movie from the source media files.</td>
</tr>
<tr>
<td>Vegas project</td>
<td>*.veg</td>
<td>This option saves the references to media files used in the project. Also saved is project information, track plug-ins, envelopes, bus assignments, and output properties. The *.veg file does not combine events into a single file.</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>*.avi</td>
<td>The standard video file format used on Windows-based computers. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Wave (Microsoft)</td>
<td>*.wav</td>
<td>The standard audio file format used on Windows-based computers.</td>
</tr>
<tr>
<td>Windows Media Audio</td>
<td>*.wma</td>
<td>The Microsoft audio-only format used to create files for streaming or downloading via the Web.</td>
</tr>
<tr>
<td>Windows Media Format</td>
<td>*.wmv</td>
<td>The Microsoft standard used for streaming audio and video media via the Web.</td>
</tr>
<tr>
<td>QuickTime</td>
<td>*.mov</td>
<td>Apple QuickTime multimedia format.</td>
</tr>
<tr>
<td>Perfect Clarity audio</td>
<td>*.pca</td>
<td>A Sonic Foundry proprietary format that is compressed and completely lossless.</td>
</tr>
<tr>
<td>Wave64</td>
<td>*.w64</td>
<td>A Sonic Foundry proprietary format that allows wave files that are (practically) unrestricted by file size.</td>
</tr>
<tr>
<td>MPEG-1 and MPEG-2</td>
<td>*.mpg</td>
<td>Some versions of Vegas also support MPEG-1 and MPEG-2 file creation through the use of Ligos GoMotion technology.</td>
</tr>
</tbody>
</table>
Rendering to an audio format

The audio-only formats that you can choose from are *.aif, *.mp3, *.wav, *.w64, *.pca, and *.wma. The file formats *.aif, *.wav and *.w64 allow you to set the frequency, bit-depth, channel, and sample rate to which the Vegas project will be rendered. The *.wma format allows you to set the streaming qualities. The *.mp3 file format allows you to set its exclusive controls for the best audio quality based on your delivery method. For more information, see Creating *.mp3 files on page 336.

Rendering to a *.aif, *.mp3, *.wma or *.wav file

The procedure is identical for each audio format to which you want the project rendered. The only difference is the selection from the File of type list on the Render As dialog.

To render a Vegas project to one of these formats:

1. From the File menu, choose Render As. The Render As dialog appears.
2. Select the drive and folder where you want to save the rendered file.
3. Type a new name in the File name field, if necessary.
4. In the Save as type drop-down list, choose AIFF (*.aif), MP3 Audio (*.mp3), Wave (Microsoft) (*.wav), or Windows Media Audio (*.wma).
5. Click the Save button. A small dialog box appears displaying the progress of the render and a status bar appears in the lower-left portion of Vegas.

Note: You may cancel the rendering process by clicking the Cancel button or the button on the status bar.

About the *.w64 and *.pca formats

The *.w64 and *.pca formats are proprietary formats developed by Sonic Foundry to work around some limitations inherent in other currently available formats. Currently, neither is compatible with many other applications and may not be playable in other media players, but both are excellent choices for Sonic Foundry projects.

- *.w64 files work around the maximum file size limitation inherent in the *.wav format. The *.w64 format is unlimited by a maximum file size and is very useful in long format productions.
- *.pca is the Sonic Foundry Perfect Clarity audio format and is a compressed format that is completely lossless. Unlike *.mp3 and other highly compressed formats which are lossy, 100% of the quality of your audio is maintained by compressing your audio files to the *.pca format.
Rendering to a video format

The process of creating a video file is known as rendering and can take quite a bit of time, depending on how many effects and transitions you have used, your CPU’s speed, and the final format you have selected. For longer movies, you might want to plan to render your movie overnight or when you are not otherwise using your computer.

There are four primary locations from where your final movie can eventually be played: on a VTR or camcorder, on a hard drive on a computer, on a CD-ROM, or over the Internet. This final location directly determines the format of your movie. For more information, see Selecting a video format on page 335.

To render a Vegas project to an *.avi file:
1. From the File menu, choose Render As. The Render As dialog appears.
2. Select the drive and folder where you want to save the rendered *.avi file.
3. Type a new name in the File name field, if necessary.
4. In the Save as type drop-down list, choose Video for Windows (*.avi).
5. Click the Save button. A small dialog box appears displaying the progress of the render and status bar appears in the lower left portion of Vegas. Upon completion of the render, your Vegas project is ready for distribution and playback.

Partial rendering and timeline playback

Timeline playback is only available in Vegas Video and is also hardware dependent, meaning that it will only work with video hardware that supports this feature. Additional information is available at the Sonic Foundry Web site.

The rendering process for video can take many hours and require gigabytes of hard disk space, depending on the size and complexity of your project. In some situations, it may not be necessary to render an entire video project. Instead, you may be able to play the video from a project back directly from the timeline out to your television, VTR, or camcorder. This is an excellent method of giving your project a final video preview on a television monitor (which differs significantly from a computer monitor) before executing a final render. Again, this process will not work on all machines or in all situations:

- Timeline playback must be supported by your video hardware in order to work with Vegas. The process is most likely to succeed with newer (but not all) DV video capture cards.
- Complex effects and/or transitions may not playback in real-time from the timeline. What effects can and cannot be played back depends on the speed of your computer.
- Audio is not played back from the timeline to the external monitor.
One solution to the second problem is to render the more complex portions of a project (e.g. transitions) to temporary files. For more information, see Pre-render Video in Loop Region on page 254. As long as these sections of the project remain unchanged, Vegas will not need to re-render them. During timeline playback, Vegas will playback these files seamlessly with the rest of the project.

---

Note: The compression settings used to create the pre-rendered video must be identical to your captured files for timeline playback to work.

---

Rendering to a streaming media format

Streaming media formats are excellent choices for projects that are destined for the Internet. Vegas can render a project to either Windows Media (pg. 337) or RealMedia players. With these formats, you may set the audio portion’s frequency, bit depth, channel, and sample rate. In addition, you can set the frame rate, frame size and compression for the video portion, depending on which version of Vegas you are using.

Rendering to a *.wmv, or *.rm file

This procedure is identical for each streaming format to which you want the project rendered. The only difference is the selection from the drop-down list.

To render a Vegas project to one of these formats:

1. From the File menu, choose Render As. The Render As dialog appears.
2. Select the drive and folder where you want to save the rendered file.
3. Type a new name in the File name field, if necessary.
4. In the Save as type drop-down list, choose Windows Media Video (*.wmv), or RealMedia (*.rm).
5. Select a template and/or customize the render settings.
6. Click the Save button. A small dialog box appears displaying the progress of the render and a status bar appears in the lower left portion of Vegas. Upon completion of the render, your Vegas project is ready for distribution and playback.
Using rendering format controls and templates

Every format has different variables and controls. Vegas has a number of templates that appear on the Render As dialog's Template drop-down list to automatically configure a particular format for a particular destination. You may also save your own templates by clicking the Custom button. However, in many cases, a template may provide the best results for rendering your projects.

The following sections present an overview of each format's controls and template creation. Central to the process of creating a multimedia file from your project is the compressor or codec. A codec is simply the algorithm that is used to compress the media file. Many of the codecs used for specific rendering formats are updated periodically by their creators. For information about specific codecs, contact the codec's manufacturer.

In some versions of Vegas, full customization of the rendering formats is not available. Instead, you are limited to selecting from one of the many templates that most closely matches your needs. Professional level control of all of the rendering parameters is only available in Vegas Video.

Customizing a render

Every project (*.veg) has default settings that are used to determine the format of the final file created from a project. The settings are determined at the beginning of the project, but can be changed at any time: from the File menu choose Preferences.

To customize the Render As settings:

1. From the File menu, choose Render As.
2. In the Render As dialog, choose the format [e.g Video for Windows (*.avi)].
3. Click the Custom button and go to the Video tab.
• Select a Template from the list to automatically set up all of the settings on this tab. You can also create a custom template and save it for future use. The Description box summarizes the template properties.

• The appropriate frame rate and frame size are determined by the final destination of the movie. See the next section in this manual and your video capture card’s manual for more information.

• The Compression button opens a dialog to set up the exact codec used to compress the video. This is a very important process. In short, codec stands for COMpressor/DECompressor and it is the mathematical algorithm used to encode a video file. The codec directly determines the size and quality of the movie, as well as its compatibility with various playback devices. The final destination for the movie dictates the choice of codec. Some codecs have additional options that can be adjusted by clicking the Configure button.

4. Click OK to close the Custom Settings dialog.

5. Enter a name and location for the new file and click OK.

The customize settings that have been chosen here can be saved for future use. One of the most important reasons to save a new template is to save the specific compression codec used to create the movie, since this is not pre-determined by the project properties.

To save a new template:

1. Modify the parameters in the Custom Settings dialog.

2. In the Template drop-down list, enter a name for the new template.

3. Click the Save Template button (\(\text{Save Template}\)).

Changes cannot be made to the default template. To use the new template in the future, simply select it from the Template list in the Save As dialog. Custom Audio and Video settings are saved in the same template.

Note: To delete a template, select it from the drop-down list and click the Delete button (\(\text{Delete}\)).

Custom rendering settings

The format of the final file that is created from a Vegas project can be set by clicking the Custom button in the Render As dialog. The Custom Setting dialog appears and has three tabs: Audio, Video, and Project. The Attributes drop-down list displays available choices depending on the Format option that you choose.
Audio tab - Custom Settings

Format
This lists the rendering codecs that are available.

Sample rate
The sample rate directly affects the audio's quality. The sample rate is defined as the number of times a second that data is sampled in an audio file. It is similar to the concept of resolution in an image file. The higher the setting you choose, the better the quality, but the larger the file size.

Bit depth
The bit depth directly affects the audio's quality. The bit depth is defined as how much data is used to save each sample (see above). The higher the setting you choose, the better the quality, but the larger the file size.

Channels
A project may be rendered by channel types: Stereo, Mono, Multiple Mono, and Multiple Stereo.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>Renders all the project's busses to a stereo file. The signal is saved to the respective right and left channels that you specified in the project. This may cause clipping in the rendered stereo file. You can compensate for the clipping by reducing each channel's volume fader prior to rendering.</td>
</tr>
<tr>
<td>Mono</td>
<td>Renders the project so that both the right and left channels are summed to one mono signal. This may cause clipping in the mono file. You can compensate for clipping by reducing each channel's volume fader prior to rendering.</td>
</tr>
<tr>
<td>Multiple Mono</td>
<td>Renders each of the project's busses into two mono files: one left and one right. For example, if your project has two busses, Vegas will render 4 mono files (two right and two left). This feature is useful if you are using applications that do not work with stereo files. Therefore, if you wanted to export tracks from Vegas into one of these applications, you would need to export each channel as a mono file.</td>
</tr>
<tr>
<td>Multiple Stereo</td>
<td>Renders each of the project's bus into a stereo file. For example, if your project has two busses, Vegas will render 2 stereo files. Therefore, each bus in your project (and the tracks assigned to the bus) are rendered into a single stereo file.</td>
</tr>
</tbody>
</table>
Video tab - Custom settings

There are many possible formats to select from when creating a video file. Not all options are available for all types of video files. The particular compression chosen in the Video format list determines which of these options are available. For more information, see Selecting a video format on page 335.

Video size

The final frame size of the movie can be different from the project's default settings. Frame size also contributes to quality and file size.

Frame rate

The final rendered multimedia file can have a different frame rate from the project itself. Frame rate is very important in determining the quality and size of the final media file.

Video format

The Video tab has a Compression button that is used to access the actual codecs or compressors that are used to create the final video file.

Each codec is a small program by itself and many have additional custom controls that are used to fine tune the output. Click the Configure button to adjust these parameters manually.

Quality slider

If the codec chosen in the Video format list supports it, use this slider to adjust the quality of the compression applied by the codec chosen from the Video format list.
Render Alpha Channel

If the codec chosen in the Video format list supports Alpha Channel transparency, select this option to save this information with the file.

Interleave every

When enabled, this control allows you to specify how often the audio and video streams are interleaved. Interleaving relates directly to how the data is saved in the file. For example, during the rendering process, the audio data is written in between the video data based on the frame setting that you specified.

Interleaving allows for optimal playback of the *.avi file.

Keyframe every

If the codec chosen in the Video format list supports compression keyframes, select this option to set compression keyframes to adjust the quality of the compression. More keyframes typically produce higher quality video, but a larger files size (and thus a higher data rate).

Data rate

If the codec chosen in the Video format list supports a data rate ceiling, select this option and enter a maximum data rate for the final file.

If possible don’t recompress frames

Select this option to ensure that video that has not been altered in any way in a project other than simple trimming is not recompressed. This only works if the output format matches the source media file format exactly. There are two significant advantages to not recompressing video: (1) 100% quality is maintained and (2) significantly faster render times.

Configure button

Click this button to access the advanced settings of the particular codec chosen in the Video Format list.

Project tab - Custom settings

There are many possible formats to select when creating a video file. Not all options are available for all types of video files. The particular compression chosen in the Video format list determines which of these options are available. Many of these settings are identical to
your Project Properties and can be saved as a part of a project template. Final render settings over-ride Project Properties settings. For more information, see Project properties - Video tab on page 256.

Image rendering quality
Higher quality settings result in longer rendering times. Good is the default.

Motion blur type
Motion blur can be used to smooth any animated effects created in Vegas, including Track Motion and Pan/Crop effects.

Exposure time (seconds)
This determines the amount of Motion blur to apply. Specify a duration over which the blur will occur. Smaller fractions of a second are recommended.

Interlace
Video that is displayed on a television monitor is interlaced. This means that every frame of video is actually composed of two fields, each of which is made up of half of the lines that make the final frame. These two fields are woven together in alternate lines, but which of the two fields is displayed first can be important. The interlace can be ignored for video that is going to be displayed on a computer: choose Progressive. For video on a television, most hardware supports Lower First. If the output is jittery or shaky on a television, or your hardware's manual specifies it, choose Upper First.

Pixel aspect ratio
A pixel is a single picture element or dot on a television or computer screen. Computers display pixels as squares: 1.0. Televisions display individual pixels as rectangles: 0.909, 0.899, or anything other than square. Using the wrong pixel aspect ratio can result in distortions or stretching of the video. Select the aspect ratio for the final movie's destination. Consult your hardware manual if you are in doubt about the appropriate ratio. The pixel aspect ratio is unrelated to the frame's aspect ratio.

Resample the frame rate of all video
This option resamples the frame rate for all source media files in a project that differ from the target frame rate of the final movie where necessary. This may or may not improve the quality of the final video, but will almost certainly increase rendering times. For more information, see Resampling on page 258.
Selecting a video format

When you create a final movie, you will find that there are literally dozens of formats to choose from, each having dozens of options. The destination of your final movie is the most important factor in selecting a format. Movies created for broadcast television must be of the highest quality, but for many other destinations, such as a CD-ROM or the Internet, you are going to have to sacrifice some quality when you render the file. Heavy compression may create visible artifacts in the video, such as when you create streaming video for the Internet. Every case is different and it is necessary to experiment to obtain the best results.

VCR or television
If you are creating a movie that you want to send back out to a television, a VCR or a camcorder, there is only one choice:

Use the same settings as the original video.

There is no way to improve upon the quality of your original video (as far as compression is concerned). If you have captured your video at 640X480, at 24fps in an MJPEG codec, then that is how you should set up your final movie. This is the only way to maintain 100% quality.

Computer
This can be the most complicated case because you have to decide exactly which computer it is going to be played back on, how fast it is, what software is installed, and how you are going to get it there (e.g. burned to a CD). Your biggest concern with creating a video file is compatibility. When you create a movie, you must select a specific codec to compress the video. That same codec must then be used to view the movie. This is not a problem if you are viewing the movie on your own computer, since the appropriate codec is already installed. To ensure that your audience has the appropriate software, you should use a fairly universal codec. Intel Indeo, Cinepak, and QuickTime (which is not a codec, but installs with a number of different codecs) are all widely available. Be careful not to use the latest version of these codecs unless you are sure that your viewers’ systems are up to date. These codecs are good for older computers and maintain pretty good quality, but they do not provide high compression ratios and the resulting files are rather large.

Internet
When video on the Internet is discussed, people almost always mean streaming. There are two streaming media formats that come with Vegas: RealMedia and Windows Media Format. There is nothing particularly magical about streaming video, and the three rules of creating video files for the Internet are as follows: compress, compress, and compress. The smaller the file size the better, and this inevitably results in a loss of quality. There are two main places where you can save space: frame dimensions and frame rate. Typical Internet video files should be about 160X120 and should rarely exceed 320X240. This is not very big, and video...
with lots of detail will not translate well to this frame size. The frame rate should also be as low as possible, with 15fps being a good maximum. Fast action, pans, and moving backgrounds (e.g. tree leaves or ocean waves) will not compress well. Streaming media files need to be placed on a special Internet server in order to stream properly.

**Miscellaneous formats**

**Creating *.mp3 files**

Vegas allows you to render up to 20 *.mp3 files without registering the optional plug-in. This feature gives you the opportunity to try the plug-in. After the 20th *.mp3 file is created, you need to purchase the plug-in to create more *.mp3 files. To access this format’s controls, click the Custom button in the Save As dialog. The MPEG 1 Layer 3 Templates dialog appears.

To create a new *.mp3 template:

1. In Template field, enter a name.

2. Click the Settings button. The Sonic Foundry MP3 Plug-In dialog will appear.

   **Note:** If you have not registered the Sonic Foundry MP3 plug-in, Vegas will launch a Registration wizard. You may follow the dialog’s instructions to purchase the plug-in from Sonic Foundry, or click the I would like to continue using the trial version radio button. *The trial version is good for up to 20 *.mp3 file renderings.*

3. On the Encode tab, choose a bit rate from the drop-down list.

4. Click and drag the Quality slider and click the control check boxes that you want to use for the rendered *.mp3 file.

5. Click the ID3 Summary tab, to enter optional information about the file.

6. Click the OK button to return to the MPEG 1 Layer 3 Templates dialog.

7. Click the Save button ( ) to save the template.
You may edit a previously saved template by choosing it from the drop-down list, making your setting changes, and clicking the Save button ( ).

Creating *.wma or *.wmv files

Vegas allows you to render your project to Microsoft *.wma files, which can be used for streaming or downloading via the Web. When you render to this format, Vegas displays Microsoft’s encoding wizard that carries you through the rendering (encoding) process.

The *.wma format also allows you to set up Redirector settings, which will appear on the Windows Media player. Click the Redirector button to display the WMV Redirector Setting File dialog.

Templates

There are a number of included templates that may be chosen from the drop-down list. These templates may also be accessed from the Render As dialog.

To create a new *.wma template:

1. On the Render As dialog, click the Custom button. The Edit Template dialog will appear.
2. Click the **Custom** button to start the Windows Media Encoding template.

3. In **Template Name** field, enter a name and then type a description (optional).

4. Click the **Next** button to set the bandwidth settings.

5. Click the **Next** button to set the **Resample** rate from the drop-down list.

6. Click the **Next** button to choose an audio format form the **Format** drop-down list. (There is only one Audio codecs available from the Audio drop-down list.)

7. Click the **Finish** button to save the template and return to the Edit Template dialog.

   You may edit a previously saved template by choosing it from the drop-down list, clicking the Edit button (starting the wizard again), and making your setting changes.
8. Click the Next button to choose a video bit rate setting.

9. Click the Next button to set the bandwidth settings.

10. Click the Next button to set Resample rate from the drop-down list.

11. Click the Next button to choose an audio codec, format and video codec from their respective drop-down lists.

12. Click the Finish button to save the template and return to the Edit Template dialog.

You may edit a previously saved template by choosing it from the drop-down list, clicking the Edit button (starting the wizard again), and making your setting changes.

Creating MPEG files

Some versions of Vegas also support MPEG-1 and MPEG-2 file creation through the use of Ligos GoMotion technology.

Creating MPEG video is as simple as creating any other type of video.

1. From the File menu, choose Render As.

2. In the Render As dialog, enter a name for the file.

3. From the Save As type list, choose MPEG (*.mpg).

4. Choose a template from the Template list or click the Custom button to adjust the various MPEG settings.
5. Click the Save button.

MPEG renders can sometimes take more time than renders with some other formats. MPEG
video files can be played back on most computer systems. MPEG video files can also be
burned to CDs or DVDs for playback in standalone VCD, SCVD, and DVD players. Sonic
Foundry cannot guarantee the compatibility of MPEG files with VCD/DVD authoring
software or VCD, SCVD, and DVD standalone players. Please consult your specific
authoring software's documentation for information on what constitutes a valid file and
then customize the MPEG rendering properties to match.
Vegas may be customized to your project needs and working preferences. Many of the settings depend on your equipment or studio setup. Vegas can be set to work with the components that you use in your studio.

In this chapter, you will find information about functions that allow you to customize the appearance of Vegas, set a project’s properties, and set the application’s preferences.

**Dockable Vegas windows**

Vegas has eight dockable tool windows that you may use while working on a project. These windows may be accessed from the View menu or by pressing the associated shortcut keys.

<table>
<thead>
<tr>
<th>Window</th>
<th>Shortcut keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explorer</td>
<td>Alt + 1</td>
<td>The Explorer window is similar to the Windows Explorer. Use the Vegas Explorer window for selecting media files to place in your project (pg. 344).</td>
</tr>
<tr>
<td>Trimmer</td>
<td>Alt + 2</td>
<td>The Trimmer window is a good place to edit an audio event. When an event is placed in the Trimmer window, you may take portions of the event and place them on separate tracks by dragging and dropping.</td>
</tr>
<tr>
<td>Mixer</td>
<td>Alt + 3</td>
<td>The Mixer window gives you access to your project’s properties, bus assignments, output levels, and FX chains (pg. 34).</td>
</tr>
<tr>
<td>Edit Details</td>
<td>Alt + 4</td>
<td>The Edit Details window provides an alternate and precise means of working with your audio events.</td>
</tr>
<tr>
<td>Plug-ins</td>
<td>Alt + 5</td>
<td>The Plug-in Explorer window allows you to create, organize, and rename the plug-ins compatible with Vegas.</td>
</tr>
<tr>
<td>Video Preview</td>
<td>Alt + 6</td>
<td>This Video Preview displays a project’s video event during project editing and playback.</td>
</tr>
<tr>
<td>Media Pool</td>
<td>Alt + 7</td>
<td>The Media Pool window acts as an organizer for a project’s media files. It is a database that contains a wealth of information about individual files and how they are being used in a project.</td>
</tr>
<tr>
<td>Transitions</td>
<td>Alt + 8</td>
<td>The Transition explorer window displays a thumbnail representation of the various transitions. Transitions can be dragged to the Transition roll between two overlapping events in opposite A/B rolls.</td>
</tr>
</tbody>
</table>
When you display these windows, they can float freely on the workspace. You may let them float, place them in the Windows Docking Area or even move them to another monitor on a multi-monitor system.

**Floating (undocking) a window**

To float or undock a window, drag the float handle and drag the window away from the Docking Area at the bottom of the program.

**Docking a window**

The Window Docking Area at the bottom of the workspace keeps frequently used windows available, but out of the way, while you are working with a project. Since there are eight possible windows that can be docked, windows can be next to each other, subdividing the docking area, or they can appear as tabs on top of one another.

To dock a window:

1. If the window is not already displayed, choose it from the View menu or press its shortcut key.
2. Click the window’s title bar and drag the window below the Track View. You control where the window will be placed by moving the window to the left or right.
3. When the window’s title bar disappears, release the mouse. The window is now docked.
Note: If you dock a window on top of another one, the newly docked window will appear on the top layer. The window beneath it displays a title tab, which you can click to bring it to the top layer or press the window’s shortcut keys to display it.
Using the Explorer window

The Explorer window is very similar to the Windows Explorer. The Explorer window is primarily used to browse for and to place media files into your projects. In addition, the Explorer window can be used to locate, preview, rename, and delete media files.

The Explorer window is a dockable window and can be customized to fit your needs and preferences.

![Diagram of Explorer window]

**Toolbar**

- **Up** Selects and opens the folder or drive one level above the active folder.
- **Refresh** Displays any content changes in the active folder or drive if a file was added, renamed, or deleted.
- **New Folder** Creates a new folder within an active folder or drive.
- **Delete** Removes a selected folder or media file.
- **Favorites** Adds the selected folder to your Favorites folder. The Favorites folder contains media files that you use most often.
- **Play** Plays the selected media file.
- **Stop** Stops play back of the selected media file.
- **Auto Preview** When enabled, automatically plays a media file when it is selected.
- **Browse for Media** Opens your default Web browser to locate media on the Internet.
- **View** Displays Explorer viewing options.

**Summary view:**
This area displays information about the selected file.
Managing your media files

The Explorer window is used to organize your media files by moving them to new folders, renaming, deleting, and playing back media files prior to placing them in a project. If the Explorer window concept is new to you, the following instructions cover the basics of media file management.

Finding your media files

The Explorer window’s Tree View pane is used to select the drive or folder and view its contents in the Contents List pane.

To select a drive or folder:

1. From the drop-down list, select the drive that you want to view or select any drive or folder from the list that is already visible in the Tree View pane.

2. Click the plus sign next to the drive or folder to display its contents. (The plus sign becomes a minus sign. Click the minus sign to hide the drive or folders contents.)

3. Click a folder from Tree View pane and the files in it will display in the Contents List pane.
Moving folders to different drives or other folders

Folders and their contents may be moved to different drives or placed in existing folders by dragging them to a new location.

---

**Note:** If you rename, move or delete files or folders that contain media files that are being used in projects, Vegas will prompt you to locate the media files when that project is opened again.

---

Moving media files to different folders

Drag media files to move them to new locations (folders, drives) either singly or in groups.

Creating a new media folder

New folders can be created from within Vegas Explorer window to store media files.

**To create new folders:**

1. Navigate to the drive and folder location where you want to create the new folder.
2. Click the **New Folder** button ( ). A folder will appear in the Contents List pane.
3. Type the name of the new folder and press the `Enter` key to save the name.

Once the new folder is created, you may begin moving media files to it or move it to a new location.

Renaming media files and folders

Media files and folders that are not currently being used in an active (opened) project may be renamed within the Explorer window. If you try to rename a media file or folder that is used in an active project, Vegas will notify you of a sharing violation. Save and close the open project before renaming these project items.

**To rename a media file or folder:**

1. Select a media file or folder in the Tree View or Contents List pane.
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose **Rename**.
4. Type the new name for the media file or folder and press the `Enter` key to save the name.
Deleting media files and folders

Media files and folders that are not currently being used in an open project can be deleted from within the Explorer window. If you try to delete a media file or folder that is used in an open project, Vegas will notify you of a sharing violation. Save and close the open project before deleting these project items. Click the Delete button (X) or right-click a selected media file or folder and, from the shortcut menu, choose Delete.

Adding folders to Vegas Favorites

Vegas includes a Favorites folder found in the Tree View pane. Folders that contain media files may be added to this folder. The Favorites folder allows you to quickly access frequently used media files and place them in your project.

To add folders to Vegas Favorites:

1. Select a folder in the Tree View or Contents List pane.

   To select multiple folders, hold the Shift or Ctrl keys

2. Click the Add to Favorites button ( ) or right-click a selected folder and, from the shortcut menu, choose Add to Favorites.

   The folder will appear under the Favorites folder in the Tree View pane.

Using the Explorer window Transport bar

The Explorer window contains a transport bar that allows you to listen to media audio files before you place them into your project. When media files are played back, the volume level can be monitored on the preview bus that is located in the Mixer window. For more information, see Using the Audio Mixer on page 213.

Previewing a media file

One file at a time may be automatically previewed from the Contents List pane of the Explorer window.
To preview a media file:

1. Select the media file that you want to preview.
2. Click the Play button ( ). The media file's levels may be monitored on the preview bus.
3. Click the Stop button ( ) to quit playback before the media file finishes playing.

The Video Preview [ALT+6] window must be visible for video media files to be previewed.

Using Auto Preview

The Auto Preview button can be used to set Vegas to automatically preview media files when you select them in the Contents List pane. When the selected media file begins playback, you may monitor its volume level on the preview bus that is located in the Mixer window. The Video Preview [ALT+6] window must be visible for video media files to be previewed.

To automatically preview media files from Vegas Explorer, click the Auto Preview button ( ) to toggle it ON or OFF.

Changing the Explorer window views

The Explorer window can organize how files and folders are displayed. To toggle through the display options, click the View button ( ) or select a display option from the buttons submenu. The various view options are described below.

Tree View

This view option displays all of the available drives and folders that you may select to locate media files.
Region View
This information appears below the Contents List pane. It displays the embedded regions, if any, that are contained in the selected media file. A file's regions may be directly placed on a track in your project. This option can save editing time because you do not need to place the entire media file: just the region(s) that you want.

Summary View
Information about the selected media file appears below the Contents List pane.

Details
Information about a file's size, type, and date of last modification is displayed in the Contents List pane.

All Files
By default, Vegas Explorer only displays media files that are supported by Vegas. By selecting the All Files option, all types of files are displayed; not all of these files can be used in Vegas.

Changing the Ruler format
The Ruler in Vegas can be customized to display a number of different standard formats. The Ruler, located above the Track View, divides time in several different formats. The format that you select affects how the Ruler and Time window will display time units. For more information, see Timecode in Vegas on page 382.

To change the ruler's format, right-click on the ruler and select the desired time format from the shortcut menu or, from the Options menu, choose Ruler Format and select the desired time unit. You may also change ruler settings on the Project Properties dialog's Ruler tab. For more information, see Ruler tab on page 360.
The following is a description of the different time units available in Vegas:

<table>
<thead>
<tr>
<th>Time format name</th>
<th>units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute Frame</td>
<td>frames are numbered starting with 0.</td>
</tr>
<tr>
<td>Feet &amp; Frames 16mm (40fps)</td>
<td>feet+frames, where 40 frames = 1 foot</td>
</tr>
<tr>
<td>Feet &amp; Frames 35mm (16fps)</td>
<td>feet+frames, where 16 frames = 1 foot</td>
</tr>
<tr>
<td>Seconds</td>
<td>seconds (to three decimal places)</td>
</tr>
<tr>
<td>SMPTE 30 (30fps, Audio)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE Drop (29.97fps, Video)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE EBU (25fps, Video)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE Film Sync (24fps)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE Non-Drop (29.97fps, Video)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>Time</td>
<td>hh:mm:ss.sss</td>
</tr>
<tr>
<td>Time &amp; Frames</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>Samples</td>
<td>in Hz</td>
</tr>
<tr>
<td>Measures &amp; Beats</td>
<td>measures.beats.seconds (to three decimal places)</td>
</tr>
</tbody>
</table>

**Using Edit Ruler Offset**

The ruler doesn’t necessarily need to start with zero at the far left side. An offset may be entered to change the orientation of the ruler in a project. One use of this, for example, is to create a lead in into a project. A five-second offset would mean that the Ruler would start at - 5 seconds and would be at zero five seconds into the project.

**To set the Ruler offset:**

1. Position the cursor to the desired location along the timeline.

2. On the ruler, right-click to display a shortcut menu.

3. From the shortcut menu, choose *Edit Ruler Offset.*

4. Enter a time value using the number keys.

5. Press the *Enter* key to set the ruler's time. The value that you enter at the cursor's position will affect the entire ruler.
Grid spacing

Grid spacing is different from the Ruler and provides an alternate method of subdividing a project's time. This may be useful if you want the Ruler to display SMPTE video time code, but you need to create your music in terms of beats and measures. The grid spacing may be set in time, frame, measure, or note units. The grid may also be set to match the Ruler’s time format. The grid appears across all track in your project and the grid’s lines can be used as snap points.

To change the grid spacing:
1. From the Options menu, choose to Grid Spacing. A submenu will appear.
2. From the submenu, choose the desired time unit. The grid spacing changes to reflect your selection.

Note: In some cases, the grid lines and the Ruler will not match. This is because they are two independent functions.

Working with the Toolbar

Vegas is preset to display the Toolbar below the Menu bar. However, you may move, resize, hide, and customize the Toolbar to suit your preferences. The setting that you apply to the Toolbar will remain set until you change them again.

Moving the Toolbar

You may move the Toolbar and have it float anywhere on the Vegas workspace. The Toolbar may then be returned to its preset position, below the Menu bar, where it will dock into place.

To move the Toolbar from its preset location:
1. Place the mouse pointer on the move handle located on the left side of the Toolbar.
2. Drag the Toolbar to the desired location. Notice that the Toolbar now has a title bar.

3. Release the mouse to drop the Toolbar on the Vegas workspace.

Note: To return the Toolbar to its preset position, simply drag it up to the Menu bar and release the mouse. The Toolbar will automatically dock in position.

Resizing the Toolbar

Vegas allows you to resize the Toolbar after it has been moved away from the original docked position.

To resize the Toolbar:
1. Drag the Toolbar's frame in a horizontal or vertical direction.
2. Release the mouse when the Toolbar is at the preferred size.

Hiding and displaying the Toolbar

The Toolbar may be hidden to create more workspace if you prefer to use the Vegas shortcut keys for editing and arranging. For more information, see Keyboard command reference on page 37. After the Toolbar is hidden, you may display it again where it will appear in its preset position, below the Menu bar.

Hiding the Toolbar

There are two ways to hide the Toolbar depending on whether it is floating or not.

- If the Toolbar is docked or floating, choose Toolbar from the View menu. The check mark next to the command is removed and the Toolbar disappears. The Toolbar will remain hidden until you display it again.
If the Toolbar is floating, you may simply click the Close button in the upper right hand corner of the Toolbar.

Displaying the Toolbar

From the View menu, choose Toolbar. A check mark will appear next to the command and the Toolbar will appear in its preset position. The Toolbar will remain visible until you hide it again.

Reordering the Toolbar buttons

Vegas allows you to easily change the order of the buttons on the Toolbar by dragging them or via the Customize Toolbar dialog to suit your work preferences.

To reorder buttons by dragging:

1. Press and hold the Shift key.
2. Click and drag the button that you want to move to the new location on the Toolbar. The cursor changes to a hand within an outline of the button ( ) that you are moving.
3. Release the mouse to drop the button in its new location.

Note: If you drag and drop the button off the Toolbar, the button will be removed.

The Customize Toolbar dialog allows you to control the available buttons and their order from the Toolbar. The Toolbar may be returned to its default settings by clicking the Reset button on the Customize Toolbar dialog.

To use the Customize Toolbar dialog:

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog will appear.
2. On the Current toolbar buttons: pane, select the button you want to move and click the Move Up and Move Down buttons.

3. Click the Close button to save the changes and close the Customize Toolbar dialog.

Adding buttons to the Toolbar

Vegas includes a series of function buttons that you may add to the Toolbar. These buttons are listed in the Customize Toolbar dialog. You may also add separators on the Toolbar to organize the buttons to your preferences.

The Toolbar may be returned to its default settings by clicking the Reset button on the Customize Toolbar dialog.

To add a button to the Toolbar:

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears.

2. On the Available toolbar buttons pane, select the button that you want to add.

3. On the Current toolbar buttons pane, select the button that you want the newly added button to precede in order.
For example, if you want to add the Trim/Crop button and want it to precede the Cut button, select the Cut button on the Current toolbar buttons pane.

4. Click Add or double-click the button to add it above the selected button on the Current toolbar buttons pane.

Removing buttons from the Toolbar

Buttons and separators may be removed from the Toolbar. If you have added buttons to the Toolbar, removing unused or unwanted buttons allows you to maximize the Toolbar's space for buttons that you may want. Toolbar buttons may be removed by dragging them or via the Customize Toolbar dialog.

To remove buttons by dragging:
1. Hold the Shift key.
2. Drag the button that you want to remove off the Toolbar. You will see a hand icon (__) within an outline of the button that you are removing.
3. Release the mouse to remove the button.

To remove buttons via the Customize Toolbar dialog:
1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears.
2. On the Current toolbar buttons pane, select the button that you want to remove.
3. Click the Remove button or double-click the button to remove it from the Toolbar.

The Toolbar may be returned to its default settings by clicking the Reset button on the Customize Toolbar dialog.
Using the Time Display window

The Time Display window reflects the cursor’s position on the time line and the end point of a time selection. The Time Display window’s time settings may be customized, including what time the window displays, and color usage.

The Time Display window may be moved from its docked position, above the Track List, to float on the Vegas workspace. In addition, the Time Display window may be docked in the Windows Docking Area. For more information, see Docking a window on page 342.

Changing the Time Display window’s settings

The Time Display window always reflects the ruler settings that are selected. You may change the ruler settings via the Time Display window or vice versa. For more information, see Changing the Ruler format on page 349.

To change the time settings:

1. Place the mouse pointer on the Time Display window.
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Time Format to display a submenu.
4. From the submenu, choose the desired time format.
   Both the Time window and ruler will display the chosen time format.

Changing the Time Displays colors

The background and text color used by the Time Display may be changed.

To change the color usage:

1. Right-click on the Time Display to display the shortcut menu.
2. From the shortcut menu, choose Custom Text color or Custom Background color. The Color dialog will appear.
3. On the Color dialog, choose the color setting that you want.

4. Click the OK button to set the text or background color or click the Cancel button to keep the existing color settings and close the Color dialog.

Note: To return the Time Display's text or background color to its default settings, select either Default Text color or Default Background color from the shortcut menu.

Setting the Time Display to monitor MIDI time code

The Time Display window can be set up to monitor the status of incoming or outgoing MIDI time code. Vegas can monitor MIDI time code being generated from an external device and monitor MIDI time code and MIDI clock information that is being generated. From within Vegas, the Time Display settings work in conjunction with your project's properties and MIDI setup options. For more information, see Sync tab on page 367.

To change the Time Display to monitor MIDI input or output:
1. Place the mouse pointer on the Time Display window.
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose the type of MIDI monitoring that Vegas will display.

Once you have made your selection, the Time Display window displays both the MIDI code being input or output and a status message.
Working with project properties

Vegas supports a large range of formats and various types of media files. Some settings in a project’s properties are simply informational details about the project, while others control how Vegas will work and handle your project and its output. If you have multiple projects, Vegas stores the settings used for each project and these settings can be saved as templates for future use.

The Project Properties dialog may be accessed in three ways:

- From the **File** menu, choose **Properties**.
- Click the **Project Properties** button ( ).
- Press the **Alt + Enter** shortcut keys.

The Project Properties dialog has four tabs: Summary, Audio, Video, and Ruler. To display a properties page, click the desired tab. An overview of each tab and its setting options is presented below. The following list describes how to work with this dialog:

- To enter information, click inside a field and type.
- Click **Apply** to save information, but keep the Project Properties dialog open.
- Click **OK** or press the **Enter** key to save the information and close the Project Properties dialog.
- Click **Cancel** to keep the original settings and close the Project Properties dialog.

### Summary tab

This tab allows you to enter information about the project. These tab fields may be left blank or, if information exists, you may change it at any time.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter the name or title of the open project.</td>
</tr>
<tr>
<td>Artist</td>
<td>Enter the name of the narrator, band, or artist(s) being recorded into the project.</td>
</tr>
<tr>
<td>Engineer</td>
<td>Enter the name(s) of the people who mixed and edited the project.</td>
</tr>
<tr>
<td>Copyright</td>
<td>Enter the date and ownership rights of the project.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter information that identifies and describes the project.</td>
</tr>
<tr>
<td>Check box</td>
<td>Select the Start all new projects with these settings check box if your projects’ requirements do not change or you want consistent settings for future projects.</td>
</tr>
</tbody>
</table>
Audio tab

This tab allows you to set different characteristics the project will use to handle the audio. This page also displays the available drive space where Vegas stores recorded audio.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of stereo busses</td>
<td>Enter the number of stereo busses that you want in your project. You may add up to 26 busses. The busses appear in the Mixer.</td>
</tr>
<tr>
<td>Sample rate</td>
<td>Choose a sample rate from the drop-down list or enter your own rate. The sample rate range is 2,000 Hz to 96,000 Hz. Higher sample rates result in better quality sound, but also mean larger audio files.</td>
</tr>
<tr>
<td>Bit-depth</td>
<td>Choose a bit depth from the drop-down list. A higher bit-depth results in better quality sound, but also means larger audio files.</td>
</tr>
<tr>
<td>Recorded files folder</td>
<td>Displays the path where recorded audio is stored. The Browse button allows you to select a new location to store recordings.</td>
</tr>
<tr>
<td>Free storage space in selected folder</td>
<td>Displays the available disk space where recorded audio is stored.</td>
</tr>
<tr>
<td>Check box</td>
<td>Select the Start all new projects with these settings check box if your projects' requirements do not change or you want consistent settings for future projects.</td>
</tr>
</tbody>
</table>

Video tab

This tab allows you to set different characteristics the project will use to handle the video. Also, this tab displays information about the video contained in your project. For more information, see Project properties - Video tab on page 256.
Ruler tab

This tab allows you to change the ruler settings used in your project. You may also change ruler settings on the Tack View. For more information, see Changing the Ruler format on page 349.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ruler time format</td>
<td>Choose a ruler time format from the drop-down list.</td>
</tr>
<tr>
<td>Ruler start time</td>
<td>Enter a value that the ruler will use at the beginning of your project. This feature is useful for synchronization purposes.</td>
</tr>
<tr>
<td>Beats per minute (tempo)</td>
<td>Enter the desired number of beats per minute for the project.</td>
</tr>
<tr>
<td>Beats per measure</td>
<td>Enter the desired number of beats to occur per measure for the project.</td>
</tr>
<tr>
<td>Note that gets one beat</td>
<td>The value entered will determine the time signature used by the ruler when its format is set to Measures and Beats. For example, if the entered value is 4, then a quarter note gets one beat.</td>
</tr>
<tr>
<td>Check box</td>
<td>Click the Start all new projects with these settings checkbox if your projects’ requirements do not change or you want consistent settings for future projects.</td>
</tr>
</tbody>
</table>

Using Vegas preferences

The Preference options are different from project Properties. The distinction to remember is that Project properties are unique to each project, while preferences affect and control how Vegas works as an application. Adjusting preferences allow you to set Vegas to optimally function with your equipment and process audio in a variety of ways. Some of these options you will probably set up one time, while others may be adjusted on a project basis.

Any changes that you make to the preferences, will remain set until you change them again or reset Vegas to use the default presets.

The Preferences dialog may be accessed by choosing Preferences from the Options menu. This dialog contains four tabbed pages: General, Video, Audio, Routing, Editing, Sync, and External Monitor.

The following sections explain the preference settings on each tab.
General tab

These preferences are found by clicking the Options menu, choosing Preferences and then going to the General tab. The following is a list of these preferences and their meaning. An “x” means it is selected by default and an “o” means it is unselected.

<table>
<thead>
<tr>
<th>Default</th>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>Automatically open last project on startup</td>
<td>When Vegas is run, the last project saved automatically opens.</td>
</tr>
<tr>
<td>x</td>
<td>Show logo splash screen on startup</td>
<td>Briefly shows the Vegas logo while the program is loading. The logo does not increase loading time.</td>
</tr>
<tr>
<td>o</td>
<td>Show a Tip of the Day on startup</td>
<td>Select this item to show a special tip every time Vegas is run. This can be a good way to gradually learn new techniques.</td>
</tr>
<tr>
<td>o</td>
<td>Show active take name in events</td>
<td>Display the name of the take that is active in an event.</td>
</tr>
<tr>
<td>x</td>
<td>Draw waveform and frames in events</td>
<td>Draws a graphical representation of an audio file’s waveform and thumbnail images of a video file’s frames.</td>
</tr>
<tr>
<td>x</td>
<td>Show video event button</td>
<td>Shows/hides the Event FX, Pan/Crop, and Generated Media buttons on video events.</td>
</tr>
<tr>
<td>x</td>
<td>Animate video frames in Trimmer</td>
<td>Animates the thumbnail representations of frames in a media file opened in the Trimmer. This can visually aid trimming.</td>
</tr>
<tr>
<td>x</td>
<td>Prompt to keep files after recording</td>
<td>Opens a dialog to enter a name and select a location to save a file to after recording into a track.</td>
</tr>
<tr>
<td>x</td>
<td>Create undos for FX parameter changes</td>
<td>Allows you to undo changes made in the FX, Transition, Pan/Crop and Track Motion dialogs.</td>
</tr>
<tr>
<td>x</td>
<td>Confirm media deletion from project when still in use</td>
<td>When deleting media in the Explorer or Media Pool, Vegas will warn you if any events in the project are using these files.</td>
</tr>
<tr>
<td>o</td>
<td>Double-click on media file in Media Pool or Media Explorer loads Trimmer</td>
<td>The default Explorer double-click behavior is to insert an event at the cursor position on the timeline. Select this option to open the media file in the Trimmer instead.</td>
</tr>
<tr>
<td>x</td>
<td>Show Trimmer history with file name first, then folder</td>
<td>The Trimmer history drop-down list displays the media file’s name first, followed by the folder it is in. Select this to reverse the names.</td>
</tr>
<tr>
<td>o</td>
<td>Automatically save Trimmer markers and regions with media file</td>
<td>Markers and regions created at the media file level in the Trimmer can be saved to the file.</td>
</tr>
<tr>
<td>x</td>
<td>Show progress in Video Preview window while rendering</td>
<td>Frames can be displayed in the Video Preview during a render. This will slow a render somewhat.</td>
</tr>
<tr>
<td>x</td>
<td>Save active previews on project close</td>
<td>Full quality preview renders are cleaned up and deleted when a project is closed. Select this if you want these to be available later.</td>
</tr>
<tr>
<td>x</td>
<td>Close media files when Vegas is not the active application</td>
<td>This allows media files to be edited in external editors (audio, image, etc.) while they are contained in events in Vegas.</td>
</tr>
<tr>
<td>x</td>
<td>Enable multimedia keyboard support</td>
<td>This allows you to use a multimedia keyboard to control playback of a project.</td>
</tr>
<tr>
<td>o</td>
<td>Render large Wave files as Wave64</td>
<td>The *.wav format is limited by a maximum file size of ~20GB. You can choose to render larger files as Sonic Foundry Wave64 files.</td>
</tr>
</tbody>
</table>
Recently used project list - Select the number of files listed.

Temporary files folder - Select a location for all temporary files.

Video tab

The Video tab in the Preferences dialog controls the display of video media, video events and video tracks in Vegas.

Show source frame numbers on event thumbnails as
None; absolute Frame Numbers starting with 0; Time in hours; Timecode.

Preferred video capture application
Browse for the application to be launched when the Open Video Capture button is clicked.

Video Preview display options
- Action Safe Area and Tile Safe Area - This is used to set the reference overlay safe areas in the Preview window. For more information, see Safe Areas on page 253.
- Horizontal Grid Divisions and Vertical Grid Divisions - This sets the spacing of the grid overlay in the Preview window used in aligning visual elements in a project.
- Display square pixels - Determines how the video is displayed in the Preview window. In short, televisions display rectangular pixels and computer monitors display square pixels. This can result in a distorted preview, although the source media and rendered video is unaffected.
- Display at project size - This sets the preview window to always display the video at full project size.
- Background color - This sets the background color of the Preview window (black by default) that shows either when there is no visual content or when using a transparent overlay with no background visual content.

| x | Automatically name regions and markers if not playing | When regions and markers are added, this option automatically prompts you for a name. This does not happen when adding markers on-the-fly during playback. |
| o | Always use Sonic Foundry DV reader | DV files can be read by Microsoft or other readers by default, or you can select this option to use the latest DV reader from Sonic Foundry. |
| o | Strictly conform to AVI2 specifications | Select this option to create 100% AVI2 compliant files. While these files conform to the standards, not all applications follow these specifications and some programs may not be able to read them. |
| x | Create project file backups (*.veg, *.bak) | Automatically create backups of your project files. |
| o | Use alternate technique to read QuickTime video | It can sometimes be slow to work with QuickTime files. Select this option to change how Vegas handles these files. |

Timecode numbering on thumbnails
Audio tab

The Audio tab allows you to set preferences to optimize how Vegas uses your computer’s components efficiently to handle the resource-intensive audio that you are using in your projects. The following table briefly describes each preference. More details of each preference is discussed later in this section.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Playback Buffering (seconds)</td>
<td>Sets the amount of memory Vegas uses during project playback.</td>
</tr>
<tr>
<td>Automatically Fade Edit Edges (ms)</td>
<td>Sets the fade length of a split or resized event.</td>
</tr>
<tr>
<td>Normalize Peak Level (dB)</td>
<td>Sets the maximum level that Vegas will use when normalizing an event.</td>
</tr>
<tr>
<td>Location of Preferred Audio Editor</td>
<td>Displays the path of the audio editor that you can start directly from Vegas to perform destructive edits to audio.</td>
</tr>
<tr>
<td>Metronome sound files</td>
<td>Allows you to select sound files to be used as the metronome beats.</td>
</tr>
</tbody>
</table>

Adjusting the Playback Buffering slider

The playback buffer controls how much memory is used by Vegas when playing back your project. This preference is useful but must be carefully adjusted. If you set the buffer size too high, you may experience gapping during playback.

Conversely, if you set the buffer size too low, you may experience gapping as well because Vegas has too little memory to work with during playback.

The Playback Buffer slider needs to be set in such away to balance RAM usage and playback buffering. The rule is to set this slider as low as possible without introducing gapping.

To adjust the slider to avoid gapping during play back:
1. Open a project that has multiple events.
2. On the Audio preferences tab, click the Playback Buffer (seconds) slider and move it to 0.25.
3. Start playing back the project.

4. If the playback still gapping, increase the Playback Buffer (seconds) slider slightly.

As you increase the buffer size, the RAM meter at the bottom of Vegas will indicate more RAM is being used.

You may have to experiment to find the correct settings. If you continue to experience gapping and the RAM meter begins to display in yellow or red, you are experiencing gapping due to lack of RAM. You can try the following to control the gapping within Vegas:

- Decrease the number of events you are trying to play back. This may mean muting tracks or soloing a couple of tracks. RAM is mostly affected by the number of unique events that are playing back simultaneously.
- Use the Mix to New Track feature to combine all the events into one event.

If you are still experiencing gapping, you may need to add RAM to your computer. Vegas only requires a minimum of 64 MB of RAM, but 128 MB of RAM is recommended for optimum performance.

**Adjusting the fade length for editing events**

This control allows you to set Vegas to automatically fade events at their edges where you have trimmed audio information. You can specify, in milliseconds, the length of the fade. The fade affects transitions between event edges so that popping is not introduced during playback.

**Setting the Normalize peak level**

This control allows you to specify the maximum decibel level used when normalizing an event.

**Setting advanced audio preferences**

From the Audio preferences tab, you may access advanced settings by clicking the Advanced button. The Advance Audio Preferences dialog will appear. This dialog displays all of the audio devices that are installed on your computer.

If you select one of these devices from the list, you may set the controls that Vegas will use with the device. Each device may be set up independently of the other devices. Following are descriptions of each control.
Interpolate position
During project playback, you may notice that the cursor position is different than what you are hearing. This problem stems from inaccuracies in some audio devices.

Select this control's check box and Vegas will attempt to compensate for the inaccuracies by interpolating the cursor's correct position during playback or recording.

Position bias
The position bias control gives you additional cursor control when it is inaccurately displayed during project playback and recording.

If you have enabled the Interpolate position control and are still experiencing cursor position inaccuracies, move the Position bias control forward or backward to compensate for the inaccuracies of the audio device.

Do not pre-roll buffers before starting playback
When this option is not selected, Vegas will begin storing (buffering) project audio information prior to playback. This storing is very fast and unnoticeable in most cases. However, some audio devices stutter when you begin playback as a result of the buffering process. If your audio stutters when you start playback, select this check box to prevent Vegas from buffering audio information prior to playback.

Routing tab
Multiple busses are only available in Vegas Video and Vegas Audio.

The Routing tab allows you to configure Vegas to the equipment that is connected to your computer. When you installed Vegas, it automatically determined the hardware available for output on your computer. These options are available on the Routing tab.

In the table on this tab, you will see virtual bus designations that you may add to a project. For more information, see Audio tab on page 359. Each bus may be routed to a specific output device of your choosing. You may notice that some of the busses are grayed out because they have not been added to your project yet. However, you may still configure the busses not currently in use, so they will be ready when you add them later. You can add busses to your project using the Project Properties Audio tab. For more information, see Audio tab on page 359.

To route busses to hardware:
1. Select the Use a Custom Routing radio button.
Note: When the Always Use Sound Mapper radio button is selected, you can not assign the busses to different hardware devices. All busses will use the hardware that is assigned to the Microsoft Sound Mapper. To view this information, access the Multimedia control panel on your computer.

2. In the table, click the radio button in the output device’s row and in the bus’s column to assign a bus to a specific output device.

Note: Multiple busses may be mapped to a single sound card.

3. From the Default recording device drop-down list, select a device used when recording.

Editing tab

Enable looping on events by default - This sets events that are trimmed longer than their source media to automatically loop. When this option is not selected, extended events repeat the final frame of a video file.
Collapse loop region when no time selection is present - When selected, loop region do not persist when there is no time selection. This means that when you click on the timeline and move the cursor (destroying the any previous time selection), the loop region is also reset to zero. By default, this option is not selected and loop regions persist until modified or until a new time selection is created.

Fade edge edits of audio event - This sets a fast fade on the edges of audio events (10ms by default) to soften potentially harsh beginnings and endings.

Fade edge edits of video events - This can be used to automatically fade a few frames in and out of inserted video events.

New still image length - This sets the default duration of inserted still image files (e.g. BMP, PNG).

Cut to overlap conversion - This sets the behavior of the cut-to-overlap feature. For more information, see Converting cuts to transitions on page 301.

- Amount - Sets the duration of the extended overlap.
- Alignment - Determines the direction of the extension: To Cursor, Centered on Cursor, From Cursor.

Sync tab

The following table briefly describes each preference found on the Sync tab in the Preferences dialog. These preferences are used to set up Vegas to generate or chase MIDI time code to and from external MIDI devices. For more information, see Synchronizing MIDI Time Code on page 225. More details of each preference is discussed later in this section.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate MIDI Time Code settings</td>
<td>Select the output device and frame rate that Vegas will use when generating MIDI time code.</td>
</tr>
<tr>
<td>Generate MIDI Clock settings</td>
<td>Select the output device that Vegas will use when generating MIDI Clock information. This device may be set to the same one that you selected for Generate MTC.</td>
</tr>
<tr>
<td>Chase to MIDI Time Code settings</td>
<td>Select the input software or device and frame rate that Vegas will use when chasing MTC.</td>
</tr>
</tbody>
</table>
Note: When Sync is active (chasing MTC), media files are not closed (i.e. cannot be edited outside of Vegas) when Vegas is not the active application. You will also not be prompted to rename or delete recorded takes as this may interrupt the synchronization.

Setting advanced Sync preferences

From the Sync preferences tab, you may access advanced settings by clicking the Advanced button. The Advanced Sync Preferences dialog will appear and display three tabs for MTC input, MTC output, and MIDI Clock Output. The following sections display the selected tab followed by definitions of the controls.

MTC input

This tab contains controls for MTC input. It is displayed only if a device is selected for MTC input on the Sync tab.

When Trigger playback only (do not chase) is selected, Vegas will not chase its playback speed to the incoming MTC data. Instead, Vegas will simply trigger at the appropriate time. There are two situations when you may want to use this option.

- If your computer does not have the speed required to accurately chase time code. This method is best used for shorter periods of time. We recommend not using this feature for long periods of time because Vegas may fall out of sync.
- If your sound card has an external “Word Clock” input, this clock source will keep your digital signals locked together and eliminate the need for Vegas to chase. This is the preferred option.

When Free-wheel for time code loss is selected, Vegas will continue to play for a specified period of time without chasing if time code is lost. Enabling this option can compensate for infrequent losses in time code monitoring. If losses in time code are frequent, troubleshooting should be done on your hardware to find the cause of the problem.
The Free-wheel slack time field specifies the amount of time that time code can be lost before the Free-wheel playback time starts. A longer time is more tolerant of loses in the incoming time code.

The Free-wheel playback time field specifies the amount of time that Vegas will play back after the Free-wheel slack time has been exceeded.

The Synchronization delay time field specifies the amount of time required for Vegas to synchronize itself to incoming time code. On slower computers this time should be set to around two seconds. On faster computers, it may be set lower. However, setting this value too low can sometimes result in audible pitch shifting at the start of playback.

**MTC output**

This tab contains controls for MTC output. It is displayed only if a device is selected for MTC input on the Sync tab.

When the Use internal timer for MTC generation check box is enabled, the MIDI Time Code that Vegas generates will be based off of your computer’s internal clock. Otherwise, Vegas will generate MTC based on the sound card’s clock.

The Internal timer resolution field allows you to control MTC resolution.

When the Sync tab’s Generate MIDI Time Code is used, the Full-frame message generation radio button list specifies when Vegas will send full-frame time code messages.

Full-frame messages are used by some external audio synchronizers to seek a proper location prior to synchronization. For example, tape-based recorders benefit from seeking to full-frame messages because of the time required to move the transport to the proper location. However, full-frame messages are ignored by some devices and may actually cause unexpected behavior in other devices. Check your hardware documentation to find out if it supports full-frame messages.
MIDI Clock Output

This tab contains controls for MIDI Clock output. It is only displayed if a device is selected for MIDI Clock output on the Sync tab.

When Send Start instead of Continue when beginning playback option is selected, Vegas will send a Start command rather than a Continue command when Generate MIDI Clock is enabled on the Sync tab. Normally, Vegas will send a Continue command to allow the chasing device to start at a specific time. However, some older MIDI sequencers do not support the Continue command and must start from the beginning every time.

When the Use internal timer for MIDI Code generation option is selected, the MIDI Clock that Vegas generates will be based on your computer’s internal clock. Otherwise, Vegas generates MIDI Code based on the sound card’s clock.

When the Always send MIDI clock option is selected, Vegas will send MIDI Clock information when Generate MIDI Clock is enabled on the Sync tab. Some applications and devices listen for MIDI Clock information, even when the master application is not playing. This listening allows the applications and devices to synchronize faster. If your MIDI Clock slave device does not support this feature, we recommend that you disable this feature. For more information, see Chasing MIDI Time Code on page 228.

Song Position Pointer generation

The Song Position Pointer generation radio button list specifies when Vegas will send Song Position Pointer messages when Generate MIDI Clock is enabled on the Sync tab. Song Position Pointer messages are used by MIDI applications and devices to seek to a proper location prior to starting the synchronization process.
External Monitor tab

External Monitor support is only possible with the full version of Vegas Video.

This tab allows you to control how video is displayed on an external monitor through OHCI compliant IEEE-1394 DV capture cards and some MJPEG capture cards. There are two cases where Vegas can play back to an external monitor. One is when you have special hardware that has both computer and television monitor outputs. The other is for (OHCI compliant) DV capture cards where DV data can be previewed out through your DV camcorder to an external monitor. The following procedure configures Vegas to use an external monitor.

To configure an external monitor:
1. Connect your camera to the IEEE-1394 card and turn it on in VTR mode.
2. Run Vegas.
3. From the Options menu, choose Preferences.
4. Click the External Monitor tab.
5. Select your device from the Device list (e.g. OHCI Compliant IEEE-1394/DV).

The output from Vegas will be directed out to the camcorder through the IEEE-1394 card. You can preview this output on the camcorder’s LCD screen or connect the camera to a television monitor to preview the output there. Once you have verified that the external monitor settings are working correctly, you can use it to preview your project.

To verify that everything has been correctly configured:
1. Click the Preview on External Monitor button ( ) on the Preview Window.
2. Open a properly formatted AVI (e.g. a DV AVI) file in the Trimmer in Vegas.
3. Click the Play button to test the output.

Timeline playback of a project is sensitive to the complexity of a project and the speed of your computer. Heavy use of Plug-Ins, effects, and complex compositing will play back at a slower frame rate. Even in these situations, an external monitor can still be useful in reviewing cropping and color presentation.

This can be a complex hardware issue. More detailed information is available at the Sonic Foundry Web site:

http://www.sonicfoundry.com/Support/Productinfo/OHCI.asp
Why are some of my DirectX plug-ins not working correctly?

Vegas is a nondestructive time-based editor. As a result, there are certain types of DirectX plug-ins that perform poorly in Vegas as Assignable FX, Track FX or Bus FX. These types of plug-ins are roughly classified as any plug-in that outputs a different amount of time than what goes in. This includes all plug-ins such as time compress/expand, gapper/sniper and pitch shift without preserving duration. However, these types of FX plug-ins may perform suitably as Bus FX, but only if only one bus is used in the project. Plug-ins that require a lot of pre-buffering will also perform poorly, such as Sonic Foundry Acoustic Mirror when using long impulse files.

Why do I hear gaps in my audio playback?

There are a few reasons that your audio playback can gap:

- Playing back too many tracks simultaneously can overload your hard drives.
- Not enough physical RAM can cause Windows to use virtual memory, which is slower.
- Your CPU may not be able to process a complex mix of plug-ins.
- Older sound card drivers may not process some DirectX plug-ins correctly.

Following are some things you can check and do to make sure your system is optimized to prevent gapping.

RAM usage meter

If the RAM usage meter at the bottom of the Vegas Track View indicates that most of your physical RAM is in use, you could be gapping because Windows virtual memory is being used. Virtual memory is a method used by Windows to write information to your hard drive to make room in physical RAM. This process uses a lot of your computer’s resources.
To minimize the amount of RAM being used:

- Exit all background applications not in use.
- Adjust the playback buffering slider on the Preferences’ Audio tab.

Adjust this slider as low as possible, but setting it too low will cause gaps as well.
- Mute/Solo some of the events or tracks in the mix.
- Add more RAM to your computer.

**Disk meter**

If the Disk meter at the bottom of the Track View ever bounces near or above 50%, you will probably experience gapping. This issue is due to the data not being read off the hard drive fast enough.

To optimize the reading of data off the hard drive:

1. Fully defragment your audio hard drives regularly.
2. Split audio usage between different physical hard drives, not just different partitions of the same drive.
3. Run fewer events simultaneously. It is not how many tracks you have in the project, but how many different events are playing simultaneously that matters.
4. Make sure that you trim out any silent sections of events to minimize the wasted disk access.
5. Use hard drives with fast seek times and spindle speeds of 7200 RPM or greater. SCSI drives usually have better prolonged data transfer performance than IDE drives. Under Windows NT and 2000, Vegas can take advantage of SCSI asynchronous reads, which can be a big performance advantage.
**CPU usage**

If neither the RAM or Disk meter looks out of the ordinary and you are still experiencing gapping, you can try to adjust how Vegas utilizes the central processing unit (CPU).

**To minimize CPU usage:**

- Zoom out (Ctrl + [-]) fully on the Track View while playing so that the screen does not have to scroll to keep the cursor on it.
- Run fewer DirectX plug-ins.
- Make sure that the peak files are built for all of the audio data in the project before playing. Peaks are only built for those files on screen. You can get into the situation where the screen scrolls as it plays and Vegas ends up building peaks on the fly. You can play while peaks are being built, but gapping is a distinct possibility. Press F5 before playback to Rebuild Peaks for all of the events, on or off of the screen.

**QuickTime Video Audio/Video Synchronization Issues**

Vegas is able to open QuickTime audio/video files using Microsoft DirectShow codecs. However, there is an implementation issue that sometimes causes the audio and video to fall out of sync. This may happen fairly frequently and it is not consistent in its offset. Therefore, this issue makes working with these types of files troublesome.

If you are experiencing this problem, one workaround is to separately save out the video and audio portions of the files into *.avi and wave files, respectively. After that, you can reload them into Vegas, re-synchronize them so that the synchronization will stay constant.

**Why do mono events increase 6 dB when panning a track hard?**

In Vegas, all audio events are considered stereo. A mono audio event is interpreted as a stereo event with the same data in both channels. The Vegas track-pan control preserves some amount of stereo separation when panning a stereo signal and gradually mixes the level from channel to channel. Therefore, with a mono audio event, Vegas is adding a duplicate of the event on top of itself. This duplication doubles the amplitude and results in a 6 dB increase in volume when you pan a track hard left or right. To compensate for this increase, adjust the tracks volume with the fader. Or, lower the event’s sustain portion using an event envelope (ASR).

**Trouble-free video: software solutions**

There are literally dozens of possible configurations of hardware for editing video on a PC. While it is impossible to go into detail for each and every system, the following explains some of the concepts behind the various settings in Vegas. Editing and playing back full-frame, 30fps video is one of the most demanding activities for any computer. The hardware
you use is an important part of the equation, but there are a number of things you can do to optimize your PC for video. The following list is arranged from the most to the least important.

- Close all other applications. When capturing video or playing it back, it is critical that no other applications interrupt this process. Close any applications that are not vital. This includes screen savers, task schedulers, and even virus-detection software. You can ensure that you have closed all unnecessary applications by pressing \( \text{Ctrl} + \text{Alt} + \text{Del} \), selecting the individual applications, and clicking the **End Task** button to close them. Certain processes are required and should not (cannot) be terminated (for example Explorer).
- Check your virtual memory. Windows uses virtual memory when RAM is low. This is a method for Windows to use the hard disk to create more memory and is sometimes called a swap disk. If Windows tries to write to the swap disk during playback or capture, this can interrupt the video software and cause problems. Make sure that Windows is using a different disk drive for virtual memory other than the one from which you are capturing or playing your video. If you have enough space, force Windows to use C:\ for virtual memory and use a physically distinct drive for capturing and playing back video.
- Make sure you have the latest drivers for your video card and capture card and the latest updates and patches to all relevant software. One caveat to this is that you shouldn’t try to fix a program that is working correctly. Many times patches and updates fix relatively minor bugs that only affect a small number of users. If you are not experiencing any problems, it is probably best not to upgrade unless the manufacturer recommends it.
- Uncompressed video may be high quality, but it results in very large files with very high data rates. Selecting a more appropriate compression scheme (codec) will definitely improve the situation. If you are creating movies that need maximum quality however, this may not be an option.

**Trouble-free video: hardware solutions**

Even with a fast computer, video is still a hardware challenge. On the other hand, it is definitely possible to properly configure a Pentium 200 to work with large video files. There are three parts of your PC that are important and the speed of your CPU is not necessarily the most critical. The following list is arranged from the most to the least important.

**Video subsystem**

Many graphics cards (video boards, primary display cards) on a PC cannot handle full-screen, full-frame rate video. While this leads to jerky, hesitating playback, it may not actually be a serious problem. A common video configuration is to have a separate video capture card and a primary display card. In this case, the playback using the primary display on the computer may be jerky, but when you finally output the video to tape and view it on
your television monitor there may not be any problems. If you are not creating movies to go back to the television or VCR and you are experiencing stuttering playback, you should consider using a smaller frame size (320X240) and frame rate (15fps).

**Hard disk**

The second most common problem is slow hard disks. Until recently, fast, expensive SCSI AV hard disks were required to properly capture and play back video on a PC. Slow hard disk problems also manifest themselves with jerky video playback, although the stutters are less frequent and of longer duration than if the video subsystem is the problem. Slower hard disks (e.g. 5400 RPM IDE) can cause an occasional dropped frame, which is devastating if you are trying to achieve perfection. Digital Video (DV) enthusiasts have fewer problems due to the low data rate (~3.6MB/sec) of that format. The following section outlines some recommendations arranged in order of importance.

- **Buy a dedicated video drive.** This is easily the most important piece of hardware advice. A dedicated, physically distinct hard drive is almost a requirement for any type of serious video work. This means that you have one primary C:\ drive (or wherever Windows is installed) and a separate drive for video. You can use your dedicated drive for other purposes, especially storage, but it is a good idea not to run any applications from it and to keep Windows virtual memory off of it. It is very important that the drive only be used for video when playing and capturing, and that other programs (including Windows) are not trying to access it. Since video files are so large, a dedicated drive is not an unreasonable item even if digital video is just a hobby. You can never have too much hard disk space.

- **Buy a faster hard drive.** Older 5400 RPM hard drives may not be fast enough for capturing and playing back video for any length of time, while newer 7200 RPM drives are almost always adequate. Be careful: manufacturers are usually talking about burst transfer rates when they talk about the speed of a drive. A drive that can transfer data at 80MB/sec is worthless for video if it cannot sustain a much slower rate of 8MB/sec for thirty minutes (or more) without dropping a frame. Look to other computer video enthusiasts for additional advice. Again, the RPMs are a very good indicator, because 7200 RPM IDE drives are usually newer (c.1998) and older 7200 RPM drives are usually SCSI, which are already higher quality drives to begin with.

- **IDE vs. SCSI.** While this was a big issue just a few years ago, it has fortunately faded in importance. Hard drives can be hooked up to your computer in a number of ways, with the two largest divisions being IDE and SCSI. This interface simply determines how much data can be transferred to and from the drive in a second. The interface almost always outstrips the performance of even the best hard disks and even the slower interfaces exceed the transfer requirements of video data. SCSI hard disks are usually more expensive and require a special controller, and while SCSI-2 promises 80MB/sec transfer rates, this is overkill for most people. Newer IDE hard disks with designations of EIDE, DMA, Ultra-DMA, ATA-33, and ATA-66 (and newer drives that came out after this writing) can all handle most sustained video requirements.
CPU and RAM (memory)

While the CPU and the RAM are probably the most important overall aspects of a PC’s speed and performance, these factors are only third on the list for video. For the most part, these critical components do not affect the capture or playback of video. This does not mean that a faster CPU or more RAM will not help, because bigger and faster is always better: CPU and RAM will definitely impact rendering speeds. Creating a final *.avi file, especially in a movie project that uses a lot of effects and transitions, can take a long time. A thirty-minute movie could easily take six or more hours to render, depending on the format and effects used. CPU speed is also important for more advanced compression codecs, such as MPEG and newer streaming formats.

The 2GB limitation

Certain older file systems did not allow files larger than 2GB. At 6 MB/sec for typical MJPEG video, the 2GB limit is reached at around six minutes. This is not a problem for the creators of short music videos, but is a major issue in longer productions.

Vegas does not necessarily have this limitation. Large *.avi files are supported through the ODML file standard, which means that Vegas is only limited by the operating system and/or file system. When Vegas is run in Windows 98SE for example, files of up to 4GB are possible under the FAT32 file system. The NTFS file system (Windows NT, 2000) does not have this limit.

Unfortunately, other multimedia applications may still be unable to handle these larger files correctly. One area where this might be a problem is if your capture card and its software is unable to read these larger files when you want to output your final video to tape. If this is the case, you will need to break your project into 2GB sections, render these to separate files, and then queue them up in your output software for seamless playback (if supported).

Audio proxy files (*.sfap0)

Working with certain types of media files with particular audio compression schemes can be inefficient and slow. To compensate for this, Vegas creates audio proxy files for formats that are known to dramatically impact performance. There are two cases where this occurs.

Multimedia video files often contain both video and audio information. In certain formats, these two streams can be packed together in such a way as to make editing slow and inefficient. Vegas therefore takes the audio stream from these files (e.g. type-1 DV, QuickTime 4) and saves it to a separate and more manageable audio proxy file.

QuickTime 4 audio-only files can also be compressed in a way that makes editing slower. Vegas also uses audio proxy files in this situation as well. While audio proxy files may be large (because they are uncompressed), the performance increase is significant.
The file is saved as a proprietary *.sfap0 file, with the same name as the original media file and has the same characteristics as the original audio stream. So **movie.avi** yields a **movie.avi.sfap0** audio proxy. Additional audio streams in the same file are saved as **movie.avi.sfap1, movie.avi.sfap2, etc.** This is a one-time process that will greatly speed up editing. The conversion happens automatically and does not result in a loss of quality or synchronization. The original source file remains unchanged (the entire process is nondestructive). Audio proxy files can be safely deleted at any time since Vegas will recreate these files as needed.

*Note:* Audio proxy files are saved to the same folder as the source media. If the source media folder is read-only (e.g. a CD-ROM), the files will be saved to a temporary directory.

### Interlacing and field order

Field order in interlaced video is an important parameter that can severely impact the quality of video on a television monitor. While the concept is easy enough to understand, the lack of standards in both technology and terminology clouds the issue.

The path of the electron gun across the screen is fundamentally different between television monitors and computer monitors. Computer monitors scan every line in order, from left to right and top to bottom. This is known as progressive scanning. On a standard television monitor, the electron gun scans every other line from top to bottom, twice for every picture or frame. For example, the first scan from top to bottom might scan all of the odd numbered lines first, then jump back to the top of the screen and, in the second scan, draw all of the remaining even numbered lines, completing the frame. The two fields are said to be interlaced together to form a single frame. The reason for this behavior lies in technical issues surrounding the development of color television in the mid-1950’s. It is an elegant solution to some rather difficult problems.

This following illustration shows how two frames in a video are actually composed of two fields each, for a total of four fields. These fields can be referred to as field one (F1) and field two (F2). Obviously, it is critical that these two fields are paired together to create a whole frame. What may not be so obvious is that the actual order of these two fields is not particularly important. In other words, F1 could be scanned first and then F2, or F2 could be scanned first and then F1. Both situations would create a perfectly valid, error-free frame of video. While that may sound like good news, in reality this is the source of all of the
problems associated with field order. Since both methods are technically correct, both methods have been used. It is important to use the correct order when rendering video files for your particular hardware (capture card).

The next illustration shows the effects of incorrectly interlacing a frame of video. In this case, F2 from frame one is combined with F1 from frame two. Remember that there is nothing inherently right or wrong with a field order of F2/F1; it just happens to be wrong in this case. At a minimum, this can create slightly blurry or hazy video. In most situations, the video is jumpy or jittery and is unwatchable. Interlacing problems can be especially noticeable when two adjacent frames are significantly different; for example, at a cut or in video with fast moving action. It can also manifest itself in certain computer-generated special effects; for example, in slow-motion sequences.

The basic problem is that there is no standard correct field order. Some capture cards use F1/F2 and some use F2/F1. If this were the extent of our troubles, we could check out our hardware manual, look up the correct field order and that would be that. Unfortunately (if
this information is even available) the terminology used can be equally baffling. F1 may be called the odd, upper, or A field, or (more rarely) it may be called the even, lower, or B field. Add into the mix the fact that the first scan line might be numbered 0 or 1 (which changes whether the field is considered odd or even), and that cropping may change which line is ultimately scanned first, and you can see that this is not a very clear-cut problem. The remainder of this section deals with how to sort this out in Vegas. Fortunately, you will only have to determine the correct settings once for any particular hardware setup.

Identifying problems

Vegas Video refers to the two fields as Upper field first and Lower field first. These are probably the most common terms used to distinguish the two fields, and you may find a page in your hardware's manual that says something like "Use a field order of lower first." In many cases (but not all or even most), Upper=Odd=A and Lower=Even=B.

In Vegas, you can select the field order of a project by clicking the File menu and clicking Properties. The pre-configured templates should work for almost everyone (e.g. if you are editing and outputting DV video in the US, select the NTSC DV template). If you have problems, on the Video tab you can manually select a different Field order: Upper field first or Lower field first. You can also override the project settings and set the field order when you render a video file. Click the File menu and choose Render As. Then, click the Custom button and set the Field order on the Video tab of the dialog that opens. Field order can also be set at the level of the media file or event. Right-click a media file in the Media Pool or in an event on the timeline and select Properties. The field order is found on the Media tab. Vegas automatically detects the correct field order in most situations.

Interlacing problems only manifest themselves on television monitors. Video that is only going to be played back on a computer does not need to be interlaced, and you can use None (progressive scan) for the Field order. Rendered video must be displayed on a television monitor to identify any problems. The only way to see interlacing problems is to record (print) a rendered video file out to tape and play back the tape on a television. Problems will be most apparent in video that has a lot of motion or that has been modified in some way; for example, a slow-motion effect. (Some codecs force the correct field order during a render, making it difficult or impossible to create video with the wrong field order.)

Solving interlacing problems in Vegas Video

If your hardware's documentation does not contain any information about the proper field order, you will need to determine this information for yourself. It is not a difficult process, and involves rendering one video file with an upper first field order and another with a lower first field order. Source material that will dramatically and clearly demonstrate the improperly interlaced video is important: use a media file with a lot of motion in it and then slow the event down with a velocity envelope or by time stretching the event.
Timecode

Timecode is a method of measuring time in video. It is primarily important for synchronizing video (in frames per second) with time in the real world and, in Vegas’ case, with other media in a project. Changing the timecode used to measure a video file does not alter the contents of the file. For example, no frames are ever “dropped” or removed when using SMPTE 29.97 drop frame timecode. Instead, specific frame numbers are periodically dropped to compensate for differences between timecode and time in the real world. Confusion between using drop versus non-drop timecode can cause synchronization problems between video and audio. For very short periods of time, the error would be unnoticeable. After about a half an hour, you might notice that mouths and words do not quite match in shots of people speaking. Longer stretches of time will show larger discrepancies in synchronization.

Changing the timecode displayed on an event is not equivalent to converting a video to another format. You cannot convert NTSC video at 29.97fps to PAL video at 25fps by simply changing the timecode. To convert NTSC video to PAL video in Vegas, you need to re-render the video in the new format. In this situation, the conversion process will necessarily result in some frames of video actually being removed from the original sequence.

Timecode in Vegas

Video timecode crops up fairly frequently in Vegas. Being a multimedia production tool, time in Vegas can be measured in real-world time (hours, minutes, seconds), in video timecode (involving frames of video), or in musical time (measures and beats).

Ruler format and timecode

The ruler in Vegas can be set to measure time in any way that is convenient. This setting does not change how the final file is rendered, but does control the grid lines and how snapping behaves. Right-click the ruler and select a time format from the shortcut list. See the table at the end of this section for specific time format details.

Preferences dialog timecode settings

From the Options menu, select Preferences and click the Video tab to adjust the Source frame numbering. These settings take precedence over those found in the source media Properties dialog (see the next topic) and are displayed on events inserted into the timeline. None means that no numbers are displayed on events, Frame Numbers marks frames in the media file starting with 0, Time displays the time in seconds, and Timecode allows the source media’s timecode to be detected or selected.
Source media timecode format

Right-click an event, choose Properties, and click the Media tab to view these properties. By default, Use timecode in file is selected. See the table at the end of this section for specific time format details.

**Note:** These settings may be over-ridden by the settings on the Video tab of the Preferences dialog. Select Timecode from the Source frame numbering list to allow event level specification. See the previous topic.

---

Render media file format

The timecode of a final rendered media file is determined by the specified format. The frame rate of the project ultimately determines the timecode and is often constrained by the type media file being rendered or the codec being used for compression. For example, NTSC DV is typically limited to a frame rate of 29.97fps and uses SMPTE Drop Frame timecode.

**Time formats in Vegas**

The following table lists all of the possible methods of displaying time in Vegas (hh=hours, mm=minutes, ss=seconds, and ff=frames).

<table>
<thead>
<tr>
<th>Time format name</th>
<th>units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute Frame</td>
<td>frames are numbered starting with 0.</td>
</tr>
<tr>
<td>Feet &amp; Frames 16mm (40fps)</td>
<td>feet+frames, where 40 frames = 1 foot</td>
</tr>
<tr>
<td>Feet &amp; Frames 35mm (16fps)</td>
<td>feet+frames, where 16 frames = 1 foot</td>
</tr>
<tr>
<td>Seconds</td>
<td>seconds (to three decimal places)</td>
</tr>
<tr>
<td>SMPTE 30 (30fps, Audio)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE Drop (29.97fps, Video)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE EBU (25fps, Video)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE Film Sync (24fps)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>SMPTE Non-Drop (29.97fps, Video)</td>
<td>hh:mm:ss:ff</td>
</tr>
<tr>
<td>Time</td>
<td>hh:mm:ss.sss</td>
</tr>
<tr>
<td>Time &amp; Frames</td>
<td>hh:mm:ss.ff</td>
</tr>
<tr>
<td>Samples</td>
<td>in Hz</td>
</tr>
<tr>
<td>Measures &amp; Beats</td>
<td>measures.beats.seconds (to three decimal places)</td>
</tr>
</tbody>
</table>
Troubleshooting DV hardware issues

Vegas (and sonic Foundry Video Capture) is designed to integrate seamlessly with OHCI compliant IEEE-1394 DV video capture hardware and DV camcorders. While most people never have any problems, the vast number of hardware configuration possibilities makes this a potentially complex issue. Although Sonic Foundry is exclusively a software company, there are a number of resources at Sonic Foundry’s Web site that may be able to assist you.

More detailed information is available at:

http://www.sonicfoundry.com/Support/Productinfo/OHCI.asp
Glossary

A-Law
A companded compression algorithm for voice signals defined by the Geneva Recommendations (G.711). The G.711 recommendation defines A-Law as a method of encoding 16-bit PCM signals into a non-linear 8-bit format. The algorithm is commonly used in United States’ telecommunications. A-Law is very similar to µ-Law, however, each uses a slightly different coder and decoder.

Adaptive Delta Pulse Code Modulation (ADPCM)
A method of compressing audio data. Although the theory for compression using ADPCM is standard, there are many different algorithms employed. For example, Microsoft’s ADPCM algorithm is not compatible with the International Multimedia Association’s (IMA) approved ADPCM.

Aliasing
A type of distortion that occurs when digitally recording high frequencies with a low sample rate. For example, in a motion picture, when a car’s wheels appear to slowly spin backward while the car is quickly moving forward, you are seeing the effects of aliasing. Similarly, when you try to record a frequency greater than one-half of the sampling rate (the Nyquist Frequency), instead of hearing a high pitch, you may hear alias frequencies in the low end of the spectrum.

To prevent aliasing, an anti-aliasing filter is used to remove high-frequencies before recording. Once the sound has been recorded, aliasing distortion is impossible to remove without also removing other frequencies from the sound. This same anti-aliasing filter must be applied when resampling to a lower sample rate.

Amplitude Modulation (AM)
A process whereby the amplitude (loudness) of a sound is varied over time. When varied slowly, a tremolo effect occurs. If the frequency of modulation is high, many side frequencies are created which can strongly alter the timbre of a sound.
Analog
When discussing audio, this term refers to a method of reproducing a sound wave with voltage fluctuations that are analogous to the pressure fluctuations of the sound wave. This is different from digital recording in that these fluctuations are infinitely varying rather than discrete changes at sample time (see Quantization).

Attack
The attack of a sound is the initial portion of the sound. Percussive sounds (drums, piano, guitar plucks) are said to have a fast attack. This means that the sound reaches its maximum amplitude in a very short time. Sounds that slowly swell up in volume (soft strings and wind sounds) are said to have a slow attack. See the section on ASR (Attack Sustain Release) envelopes for more information.

Audio Compression Manager (ACM)
The Audio Compression Manager, from Microsoft, is a standard interface for audio compression and signal processing for Windows. The ACM can be used by Windows programs to compress and decompress *.wav files.

AVI
A file format of digital Video for Windows. Vegas allows you to open, edit and create new *.avi files.

Bandwidth
Refers to the EQ plug-in that is built in. Each frequency band has a width associated with it that determines the range of frequencies that are affected by the EQ. An EQ band with a wide bandwidth will affect a wider range of frequencies than one with a narrow bandwidth. Bandwidth can also refers to the amount of data that can be transferred via a connection, such as a network or modem. For example, streaming media must be compressed due to the limited bandwidth of most Internet connections.

Beats Per Measure (BPM)
In music theory, the time signature of a piece of music contains two pieces of information: the number of beats in each measure of music, and which note value gets one beat. Vegas uses this notion to determine the number of ticks to put on the Time ruler above the Track View, and to determine the spacing when the ruler is displaying Measures & Beats.

Beats Per Minute
In music theory, the tempo of a piece of music can be written as a number of beats in one minute. If the tempo is 60 BPM, a single beat occurs once every second. Lower BPM's equal slower tempo, and vice versa.
Bit
A bit is the most elementary unit in digital systems. Its value can only be 1 or 0, corresponding to a voltage in an electronic circuit. Bits are used to represent values in the binary numbering system. As an example, the 8-bit binary number 10011010 represents the unsigned value of 154 in the decimal system. In digital sampling (specifically the PCM format), a binary number is used to store individual sound levels, called samples.

Bit Depth
The number of bits used to represent a single sample. Vegas uses either 8, 16, or 24-bit samples. Higher values will increase the quality of the playback and any recordings that you make. While 8-bit samples take up less memory (and hard disk space), they are inherently noisier than 16 or 24-bit samples.

Byte
Refers to a set of 8 bits. An 8-bit sample requires one byte of memory to store, while a 16-bit sample takes two bytes of memory to store.

Clipboard
The Clipboard is where data that you have cut or copied in Vegas is stored. You can then paste the data back into Vegas at a different location, or paste it into other applications. Some data, such as audio, cannot be pasted into applications such as Microsoft Word or Notepad, but the text data from the Edit Details window can be pasted. This allows you to then print or format the data. The Video Preview window also lets you capture still frames to the Clipboard for use in any image editing program.

Clipping
Clipping is what occurs when the amplitude of a sound is above the maximum allowed recording level. In digital systems, clipping is seen as a clamping of the data to a maximum value, such as 32,767 in 16-bit data. Clipping causes sound to distort.

CODEC
An acronym for COmpressor/DECompressor. A codec is an computer algorithm that is used to compress video and audio data, shrinking file sizes and data rates.

Composite
Compositing is the term used to describe the way separate video sources are mixed together. Overlay titles are composited onto a background video sequence.

Crossfade
Mixing two pieces of overlapping audio or video by fading one out as the other fades in.
Cutoff frequency
The cutoff-frequency of a filter is the frequency at which the filter changes its response. For example, in a low-pass filter, frequencies greater than the cutoff frequency are attenuated while frequencies less than the cutoff frequency are not affected.

DC Offset
DC Offset occurs when hardware, such as a sound card, adds DC current to a recorded audio signal. This current causes the audio signal to alternate around a point above or below the normal -infinity dB (center) line in the sound file. To visually see if you have a DC offset present, you can zoom all the way into a sound file and see if it appears to be floating over the center line.

Decibel (dB)
A unit used to represent a ratio between two numbers using a logarithmic scale. For example, when comparing the numbers 14 and 7, you could say 14 is two times greater than the number 7; or you could say 14 is 6 dB greater than the number 7. Where did we pull that 6 dB from? Engineers use the equation $dB = 20 \times \log(V1/V2)$ when comparing two instantaneous values. Decibels are commonly used when dealing with sound because the ear perceives loudness in a logarithmic scale.

In Vegas, most measurements are given in decibels. For example, if you want to double the amplitude of a sound, you apply a 6 dB gain. A sample value of 32,767 (maximum positive sample value for 16-bit sound) can be referred to as having a value of 0 dB. Likewise, a sample value of 16,384 can be referred to having a value of -6 dB.

Device Driver
A program that enables Windows to connect different hardware and software. For example, a sound card device driver is used by Windows software to control sound card recording and playback.

Digital Signal Processing (DSP)
A general term describing anything that alters digital data. Signal processors have existed for a very long time (tone controls, distortion boxes, wah-wah pedals) in the analog (electrical) domain. Digital Signal Processors alter the data after it has been digitized by using a combination of programming and mathematical techniques. DSP techniques are used to perform many effects such as equalization and reverb simulation.

Since most DSP is performed with simple arithmetic operations (additions and multiplications), both your computer's processor and specialized DSP chips can be used to perform any DSP operation. The difference is that DSP chips are optimized specifically for mathematical functions while your computer's microprocessor is not. This results in a difference in processing speed.
Dithering
The practice of adding noise to a signal to mask quantization noise. See also “Noise Shaping”.

Drag and Drop
A quick way to perform certain operations using the mouse in Vegas. To drag and drop, you click and hold a highlighted selection, drag it (hold the left-mouse button down and move the mouse) and drop it (let go of the mouse button) at another position on the screen.

Dynamic Range
The difference between the maximum and minimum signal levels. It can refer to a musical performance (high volume vs. low volume signals) or to electrical equipment (peak level before distortion vs. noise floor). For example, orchestral music has a wide dynamic range, while thrash metal has a very small (always loud) range.

Endian (Little and Big)
Little and Big Endian describe the ordering of multi-byte data that is used by a computer’s microprocessor. Little Endian specifies that data is stored in a low to high-byte format; this ordering is used by the Intel microprocessors. Big Endian specifies that data is stored in a high to low-byte format; this ordering is used by the Motorola microprocessors.

Envelopes (Audio and Video)
Envelopes, as used by Vegas, are a way of automating the change of a certain parameter over time. In the case of Volume, you can create a fade out (which requires a change over time) by adding an envelope and creating an extra point to the line that indicates where the fade starts. Next, you pull the end point of the envelope down to infinity.

Equalization (EQ)
The process by which certain frequency bands are raised or lowered in level. EQ has various uses. The most common use in Vegas is to simply adjust the subjective timbrel qualities of a sound.

Event
Media files that have been dragged onto the timeline in Vegas are referred to as events. An event is actually a window into a media file and is a reference, or pointer, to the file. It can display all or part of a media file and can be edited without altering the source media (nondestructive). See also Media Files.
File Format
A file format specifies the way in which data is stored on your floppy disks or hard drive. In Windows for example, the most common audio file format is the Microsoft *.wav format. However, Vegas can read and write to many other file formats so you can maintain compatibility with other software and hardware configurations.

Frame Rate (Audio)
Audio uses frame rates only for the purposes of synching to video or other audio.

Frame Rate (Video)
The speed at which individual images in the video are displayed on the screen. A faster frame rate results in smoother motion in the video. However, more times than not, frame rate is associated with SMPTE standard frame rates for video: 29.97 for NTSC, 25 for PAL or 24 for film.

Frequency Spectrum
The Frequency Spectrum of a signal refers to its range of frequencies. In audio, the frequency range is basically 20 Hz to 20,000 Hz. The frequency spectrum sometimes refers to the distribution of these frequencies. For example, bass-heavy sounds have a large frequency content in the low end (20 Hz - 200 Hz) of the spectrum.

Hertz (Hz)
The unit of measurement for frequency or cycles per second (CPS).

Insertion Point
The Insertion Point (also referred to as the Cursor Position) is analogous to the cursor in a word processor. It is where pasted data is placed or other data is inserted, depending on the operation. The Insertion Point appears as a vertical flashing black line and can be moved by clicking the left mouse button anywhere in the waveform display of a data window.

Markers
Saved locations in the sound file. Markers are stored in the Markers and Regions list and can be used for quick navigation.

Markers can be displayed in the Trimmer window for sound files that contain them, but more often, markers and regions are used at the project level to mark interesting places in the project.
Media Control Interface (MCI)
A standard way for Windows programs to communicate with multimedia devices like sound cards and CD players. If a device has a MCI device driver, it can easily be controlled by most multimedia Windows software.

Media File
A media file, or multimedia file, is any image, audio or video file on a computer. These files can be browsed for in Vegas’ Explorer window and can be dragged to the timeline or inserted into the Media Pool. Media files that have been dragged to the timeline are referred to as events. See also Events.

Media Player
A Microsoft Windows program that can play digital sounds or videos using MCI devices. Media Player is useful for testing your sound card setup. For example, if you can’t hear sound when using Vegas, try using Media Player. If you can’t play sound using Media Player, check the sound card’s manual. Please contact your sound card manufacturer before calling Technical Support at Sonic Foundry.

MIDI Clock
A MIDI device specific timing reference. It is not absolute time like MIDI Time Code (MTC); instead, it is a tempo-dependent number of “ticks” per quarter note. MIDI Clock is convenient for syncing devices that need to do tempo changes mid-song. Vegas supports MIDI Clock out, but does not support MIDI Clock in.

MIDI Port
A MIDI Port is the physical MIDI connection on a piece of MIDI gear. This port can be a MIDI in, out or through. Your computer must have a MIDI port to output MIDI Time Code to an external device or to receive MIDI Time code from an external device.

MIDI Time Code (MTC)
MTC is an addendum to the MIDI 1.0 Specification and provides a way to specify absolute time for synchronizing MIDI capable applications. Basically, it is a MIDI representation of SMPTE time code.

Mix
The process of combining multiple audio events and effects into a final output. The analogous process of combining video events together is called compositing.
Multiple Stereo
This allows you to assign individual tracks to any number of stereo output busses. In single stereo mode, all tracks go out the same stereo bus. Multiple stereo configuration output allows you to keep your signals from the Tracks discrete and save each channel to a separate audio file.

Musical Instrument Digital Interface (MIDI)
A standard language of control messages that provides for communication between any MIDI compliant devices. Anything from synthesizers to lights to stage equipment can be controlled via MIDI. Vegas utilizes MIDI for synchronization purposes.

Noise-shaping
Noise-shaping is a technique which can minimize the audibility of quantization noise by shifting its frequency spectrum. For example, in 44,100 Hz audio, quantization noise is shifted towards the Nyquist Frequency of 22,050 Hz. See also “Dithering”.

Non-Destructive Editing
This type of editing used by Vegas that involves a pointer-based system of keeping track of edits. When you delete a section of audio in a non-destructive system, the audio on disk is not actually deleted. Instead, a set of pointers is established to tell the program to play the active sections during playback.

Non-Linear Editing (NLE)
A method of editing video non-sequentially or in random order. Editing video in Vegas is non-linear as opposed to editing video tape, which is linear.

Normalize
Refers to raising the volume so that the highest level sample in the file reaches a user-defined level. Use this function to make sure you are fully utilizing the dynamic range available to you.

Nyquist Frequency
The Nyquist Frequency (or Nyquist Rate) is one-half of the sample rate and represents the highest frequency that can be recorded using the sample rate without aliasing. For example, the Nyquist Frequency of 44,100 Hz is 22,050 Hz. Any frequencies higher than 22,050 Hz will produce aliasing distortion in the sample if an anti-aliasing filter is not used while recording.

Pan
To place a mono or stereo sound source perceptually between 2 or more speakers.
**Peak File (*.sfk)**

Vegas displays the waveform of audio files graphically on a computer monitor. This visual information must be generated by Vegas when the audio file is opened and can take a few seconds. Vegas then saves this information as a Peak file (*.sfk). This file stores the information for displaying waveform information, so that opening a file is almost instantaneous. The peak data file is stored in the directory in which the file resides and has a *.sfk extension. If the peak data file is not in the same directory as the file, or is deleted, it will be recalculated the next time you open the file.

**Plug-In**

An effect that can be added to the product to enhance the feature set. Vegas supports DirectX compatible plug-ins. The built-in EQ, Compression and Dithering effects are also considered plug-ins because they work in other DirectX-compatible applications.

**Plug-In Chain**

Plug-ins can be strung together into a chain so that the output of one effect feeds into the input of another. This allows for complex effects that couldn’t otherwise be created.

**Pre-roll/Post-roll**

Pre-roll is the amount of time elapsed before an event occurs. Post-roll is the amount of time after the event. The time selection defines the pre- and post-roll when recording into a selected event.

**Preset**

A snapshot of the current settings in a plug-in. Presets are created and named so that you can easily get back to a sound or look that you have previously created.

A preset calls up a bulk setting of a function in Vegas. If you like the way you tweaked that EQ, but do not want to have to spend the time getting it back for later use, save it as a preset. All presets show up in the combo box on the top of most function dialogs in Vegas.

**Pulse Code Modulation (PCM)**

PCM is the most common direct binary representation of a level of an uncompressed audio signals. This method of coding yields the highest fidelity possible when using digital storage.

**Punch-In**

Punching-in during recording means automatically starting and stopping recording at user-specified times. In Vegas, shorter events can be punched into longer ones.
Quadraphonic

A mixing implementation that allows for four discrete audio channels. These are usually routed to two front speakers and two back speakers to create immersive audio mixes.

Quantization

The process by which measurements are rounded to discrete values. Specifically with respect to audio, quantization is a function of the analog-to-digital conversion process. The continuous variation of the voltages of a analog audio signal are quantized to discrete amplitude values represented by digital, binary numbers. The number of bits available to describe these values determines the resolution or accuracy of quantization. For example, if you have 8-bit analog-to-digital converters, the varying analog voltage must be quantized to 1 of 256 discrete values; a 16-bit converter has 65,536 values. Quantization is to level as sampling rate is to time.

Quantization Noise

A result of describing an analog signal in discrete digital terms (see Quantization). This noise is most easily heard in low resolution digital sounds that have low bit depths and is similar to a “shhhhh” type sound while the audio is playing. It becomes more apparent when the signal is at low levels, such as when doing a fade out. See also “Dithering”.

Region

A subsection of a sound file denoted by a start and end point. You can define any number of regions in a sound file.

Resample

The act of recalculating samples in a sound file at a different rate than the file was originally recorded. If an audio file is resampled at a lower rate, Vegas decreases sample points. As a result, the file size and the frequency range are reduced. Resampling to a higher sample rate, Vegas will interpolate extra sample points in the sound file. This increases the size of the sound file but does not increase the quality. When down-sampling, one must be aware of aliasing (see Aliasing). Vegas automatically resamples all audio to the project’s sample rate.

Ripple; Ripple Editing

A type of editing where events are moved out of the way to make room for newly inserted events as opposed to simply being overwritten. When a one minute event is ripple inserted into a project, the duration of a project lengthens by one minute. If ripple editing is turned off, the same operation would not affect the overall duration of the project.
Roll
Originally, a conventional studio typically had two source decks that were used to play back video to a final destination or output deck. These two source decks were commonly referred to as the A and B rolls. In Vegas, a video track can be configured to display an A and a B roll, which appear as sub-tracks. The concept is extended further in Vegas to include a Transition roll and a Mask roll.

Ruler, Time
The Time Ruler is the area on a data window above the tracks display window that shows the horizontal axis units.

Sample
The word “sample” is used in many different (and often confusing) ways when talking about digital sound. Here are some of the different meanings:

- A discrete point in time which a sound signal is divided into when digitizing. For example, an audio CD-ROM contains 44,100 samples per second. Each sample is really only a number which contains the amplitude value of a waveform measured over time.
- A sound which has been recorded in a digital format; used by musicians who make short recordings of musical instruments to be used for composition and performance of music or sound effects. These recordings are called samples. In this manual, we try to use sound file instead of sample whenever referring to a digital recording.
- The act of recording sound digitally, i.e. to sample an instrument, means to digitize and store it.

Sample Rate
The sample rate (also referred to as the sampling rate or sampling frequency) is the number of samples per second used to store a sound. High sample rates, such as 44,100 Hz provide higher fidelity than lower sample rates, such as 11,025 Hz. However, more storage space is required when using higher sample rates. Sampling rate is to time as quantization is to level.

Sample Size
See Bit Depth.

Sample Value
The sample value (also referred to as sample amplitude) is the number stored by a single sample. In 16-bit audio, these values range from -32768 to 32767. In 8-bit audio, they range from -128 to 127. The maximum allowed sample value is often referred to as 100% or 0 dB.

*.sfk
See Peak File.
Shortcut Menu
A context-sensitive menu which appears when you click on certain areas of the screen. The functions available in the shortcut menu depend on the object being clicked on as well as the state of the program. As with any menu, you can select an item from the shortcut menu to perform an operation. Shortcut menus are used frequently in Vegas for quick access to many commands. An example of a shortcut menu can be found by right-clicking on any waveform display in a data window.

Signal-to-Noise Ratio
The signal-to-noise ratio (SNR) is a measurement of the difference between a recorded signal and noise levels. A high SNR is always the goal.

The maximum signal-to-noise ratio of digital audio is determined by the number of bits per sample. In 16-bit audio, the signal to noise ratio is 96 dB while in 8-bit audio it's 48 dB. However, in practice this SNR is never achieved, especially when using low-end electronics.

Small Computer Systems Interface (SCSI)
A standard interface protocol for connecting devices to your computer. The SCSI bus can accept up to seven devices at a time including CD-ROM drives, hard drives and samplers.

Society of Motion Picture and Television Engineers (SMPTE)
SMPTE timecode is used to synchronize time between devices. The timecode is calculated in Hours:Minutes:Seconds:Frames, where Frames are fractions of a second based on the frame rate. Typical frame rates for SMPTE timecode can be 24, 25, 29.97 or 30 frames per second, depending on your local standards.

SMPTE Drop Frame Timecode:
A method of measuring time in video. Drop frame involves skipping two frame numbers (no frames are actually dropped) every ten minutes to compensate for the different between NTSC 29.97 fps video and 30 frame counts per second.

Tempo
Tempo is the rhythmic rate of a musical composition, usually specified in Beats Per Minute (BPM).

Time Format
The format by which Vegas displays the Time Ruler and selection times. These include: Time, Seconds, Frames and all Standard SMPTE frame rates. The status format is set for each sound file individually.
Time Signature
See Beats per Measure.

Timecode
For more information, see Timecode on page 382.

Track
A discrete timeline for audio or video data. Events are placed on tracks and determine when sound or images start and stop. Multiple audio tracks are mixed together to give you a composite sound that you hear. Multiple video tracks are composited on top of each other to create the final video output.

Trim
A function that will delete all data in a sound file outside of the current selection.

µ-Law
µ-Law (mu-Law) is a companded compression algorithm for voice signals defined by the Geneva Recommendations (G.711). The G.711 recommendation defines µ-Law as a method of encoding 16-bit PCM signals into a non-linear 8-bit format. The algorithm is commonly used in European and Asian telecommunications. µ-Law is very similar to A-Law, however, each uses a slightly different coder and decoder.

Undo Buffer
This is the temporary file created before you do any processing to a project. This undo buffer allows the ability to revert to previous versions of the project if you decide you don't like changes you've made to the project. This undo buffer is erased when the file is closed or the Clear Undo History command is invoked.

Undo/Redo
These commands allow you to change a project back to a previous state, when you don't like the changes you have made, or reapply the changes after you have undone them. The ability to Undo/Redo is only limited by the size of your hard drive. See Undo Buffer.

Undo/Redo History
A list of all of the functions that have been performed to a file that are available to be undone or redone. Undo/Redo History gives you the ability to undo or redo multiple functions as well as preview the functions for quick A/B-ing of the processed and unprocessed material. To display the history list, click the down-arrow button next to the Undo and Redo buttons.
Unsigned
Data that has only positive values and uses half the maximum value to represent silence. This is a format option when opening and saving RAW sound files.

Video for Windows (AVI)
See AVI.

Virtual MIDI Router (VMR)
A software-only router for MIDI data between programs. Vegas uses the VMR to receive MIDI Time Code and send MIDI Clock. No MIDI hardware or cables are required for a VMR, so routing can only be performed between programs running on the same PC. Sonic Foundry supplies a VMR with Vegas called the Sonic Foundry Virtual MIDI Router.

Waveform
A waveform is the visual representation of wave-like phenomena, such as sound or light. For example, when the amplitude of sound pressure is graphed over time, pressure variations usually form a smooth waveform.

Waveform Display
A section inside of the Trimmer window that shows a graph of the sound data waveform. The vertical axis corresponds to the amplitude of the wave. For 16-bit sounds, the amplitude range is -32,768 to +32,767. For 24-bit sounds, the range is -8,388,607 to +8,388,607. The horizontal axis corresponds to time, with the left-most point being the start of the waveform. In memory, the horizontal axis corresponds to the number of samples from the start of the sound file.

Zero-crossing
A zero-crossing is the point where a fluctuating signal crosses the zero amplitude axis. By making edits at zero-crossings with the same slope, the chance of creating glitches is minimized. Vegas simulates zero crossings by applying short (10 mS default) fades to trimmed audio.

Zipper noise
Zipper noise occurs when you apply a changing gain to a signal, such as when fading out. If the gain does not change in small enough increments, zipper noise can become very noticeable. Vegas fades are accomplished using 64-bit arithmetic, thereby creating no zipper noise.
Index

A

Active take, selecting, 235
Adding empty tracks, 177
Additive Dissolve, 308
AIFF
  rendering, 326
Alpha Channel, 292
Animation, 267
Arming tracks for recording, 225
Arming tracks to record, 99
ASR  See Envelopes
Assignable FX, 194–195
  assigning track to, 191
  routing to busses, 195
  send, 102
  tracks, See Track FX
  video filters, 264
  volume adjustment, 191
Audio plug-in dictionary, 203–210
Audio preferences, 363
  advanced control settings, 364
  controls, 363–364
Audio property settings, 359
Audio proxy files, 378
Audio tab, 359
Auto-crossfades to transitions, 300
Automatic Crossfade, 298
Auxiliary bus, 102
  track assignment, 190
  volume adjustment, 190
AVI
  bit-depth, 331
  channels, 331
  creating a movie, 107
  format, 331, 335
  frame rate, 330, 332
  frame size, 330, 332
  rendering, 327
  sample rate, 331
  template, 330
  video compression, 330, 332

B

Background
  transparent, 282
Black and White filter, 270
Blue screening, 292
Blur, 276
Broadcast Colors, 271
Busses, 216–221
  adding to project, 216
  adjusting faders, 220
  adjusting for clipping, 220
  assign track to, 189
  assigning plug-ins to, 193
  assignment, 99
controls, defined, 216
deleting from project, 217
meter resolution, 220
muting, 220
naming/renaming, 221
routing to hardware, 218
soloing, 221
Bypassing
track plug-ins, 199

C

Capturing video, 84
Chasing MIDI Time Code, 228
Child tracks, 285
Child, compositing, 287
Chromakeying, 292
multiple keys, 294
Clean Pre-Rendered Video, 255
Clearing the edit history, 130
Clock Wipe, 309
Color
track, 180
Color key, 292
Color Surfaces, 280
Command markers, 135, 256
defined, 138
editing, 138
placing, 137
Scott Studios, defined, 137
Command Ruler, 137
Compositing, 285
Compositing Child, 287
Compositing Modes, 295
Compression plug-in, 206
amount control, 207
attack control, 208
auto gain comp. control, 208
controlling clipping, 206
input gain control, 207
output gain control, 207
presets, 207
reduction meter, 207
release control, 208
smooth saturation control, 208
threshold control, 207
Converting format  See Rendering a project
Copying events, 114
time and events, 116
time selections, 115
Creating a movie, 107, 262
Cross Effect, 310
Crossfade, 299
Crossfades, 127–128, 298
automatic, 127
curve types, 128
curve types, changing, 128
Fade Type, 299
manually setting, 127
video, 298
Cursor movement, 109
Customizing Vegas, 341–371
docking windows, 341
Explorer window, 344–349
preferences, 360–370
project grid spacing, 351
project properties, 358
project ruler, 349
time display window, 356–357
toolbar, 351–355
Cuts, 297
to transitions, 301
Cutting events, 116
ripple mode, 146
time and event selection, 117

D

Deleting
tracks, 178
Deleting envelope points, 184
| Deleting events, 126  | Empty events, 121 |
| Deleting multiple takes, 237 | Envelope Edit Tool, 174 |
| Desktop shortcut, 24 | Envelopes, 169–170  |
| Digital multitrack setup, 224 |   adding points, 172, 183 |
| DirectX plug-ins, 193 | Event, 169  |
| Dither plug-in, 210 | fade in and out, 170, 298 |
| dither depth, 210 | Fade Type, 299 |
| noise shape type control, 210 | Fade Types, 170 |
| quantization control, 210 | Opacity, 171, 298 |
| Docking Vegas windows, 341–343 | setting points, 184 |
| Drop shadow, 282 | Track, 182 |
| Duplicating | Velocity, 171 |
|   events, 120 | video, 171, 186 |
|   tracks, 178 | Volume (event), 169 |
|   DV capture cards, 371, 384 | volume fade curves, 184 |
| E | Equalization plug-in, 204 |
| Edge trimming, 121 |   band mode, 205 |
| Edit Decision Lists (EDL), 262 |   bandwidth control, 206 |
| Edit Details window, 34, 159 |   enable control, 205 |
|   commands category, 162 |   frequency control, 205 |
|   customizing, 162 |   gain control, 205 |
|   displaying, 159 |   presets, 204 |
|   edit functions, 159 |   rolloff control, 206 |
|   events category, 160 | Equipment setup, 223–225  |
|   markers category, 161 |   basic, 223 |
|   regions category, 161 |   mixer, 224 |
|   selected events category, 161 |   with digital multitrack, 224 |
|   with MIDI option, 224 |   with MIDI option, 224 |
| Event edge fade, setting, 364 | Event editing, 114 |
| Event editing, 114 | Event properties  |
| Event edge fade, setting, 364 | displaying names, 152 |
| Event editing, 114 | name, changing, 152  |
| Event editing, 114 | pitch shift, 149 |
| Event switches, 164–169 | Event switches, 164–169  |
|   locking, 165 |   adding, 151 |
|   looping, 165 |   locking, 165 |
|   maintain aspect, 167 |   looping, 165 |
|   muting, 164 |   maintain aspect, 167 |
|   normalizing, 166 |   muting, 164  |
| Event takes  |   normalizing, 166 |
|   adding, 151 | Event takes  |
|   adding, 151 |   adding, 151  |
changing active, 152
deleting, 152, 237
displaying names of, 152
renaming, 152, 236
video, 151

Events
automatic crossfades, 248
copying, 114
crossfades, 298
crossfading, 127
cutting, 116
defined, 84
deleting, 126
duplicating, 120
defining, 52, 54
empty, 121
envelopes (ASR), 169, 171, 186
grouping, 55, 174–175
locking, 52
moving in time, 93
moving multiple, 94
moving single, 93
name, changing, 153
name, displaying, 153
pasting, 117–119
placing, 50, 91, 92
recording into, 232
removing audio from video, 95
ripple editing, 145
selecting multiple, 111
selecting with time, 114
shifting the contents of, 125
snapping, 141
splitting, 122
splitting with time selection, 53
switches, 164
trimming, 121

Expanding a track, 181

Explorer window, 33
all files view, 349
auto preview, 348
details view, 349
managing media files, 345–347
previewing media files, 347
region view, 349

summary view, 349
toolbar, 344
transport bar, 87, 347
tree view, 348
using, 47, 85, 344
view options, 86, 348–349

External Monitor, 371

F
Fader
Assignable FX, 191
auxiliary bus, 190
track, 181
Fades, 298
to black, 298
to color, 186
Faster render times, 333
Field order, 256, 379
Filters
animating, 267
keyframes, 267
modifying, 266
ordering, 266
removing, 265
transitioning into, 268
video, 264
Focus, 110
Frame by frame cursor movement, 110

G
General editing, 109–139
event vs. file, 84
General preferences, 361
Generators, 279, 280
Color Surface, 280
Test Pattern, 280
Text, 280
Glossary, 385–398
Glow, 318
Grid lines
changing type, 143
enable/disable snapping, 142
safe areas, 253
snapping events to, 142
spacing, 351
Grouping events, 55, 174–175
clearing, 175
creating new, 174

H
Hold Keyframe, 307

I
IEEE-1394 DV capture cards, 371, 384
Ignore Event Grouping, 175
Images, working with, 248
Importing media from other projects, 149
Insert
empty event, 121
time, 146
Inserting media, 91
Installation, 24
system requirements, 21
Interlace, 256, 379
Iris, 311
Isolate Channels, 290

K
Keyboard commands, 37–40
cursor placement, 38, 109, 113
edit, 37
event, 39
miscellaneous, 40
playback, 39
project file, 37
selection, 38
track view, 40
Trimmer, 41
view, 40
window view, 37
Keyframe animation, 267, 305
generated text, 283
Keyframe controller, 305
Keyframes
adding, 306
deleting, 306
interpolation curves, 307
modifying, 306
Keying, 292

L
Labeling busses, See Naming busses
Labeling tracks, See Naming tracks
Launch Video Capture, 84
Level slider, 295
Linear Wipe, 311
Locking events, 165
Locking events to track envelopes, 187
Loop playback, 114
Looping events, 165
Luminance, 292

M
Main window, 29
Maintaining quality, 333
Managing media files, 345–347
adding folder to Favorites, 347
creating folders, 346
deleting files and folders, 347
finding media files, 345
moving files, 346
renaming files and folders, 346
Marker
deleting, 132
naming, 131
navigating, 132
placing and moving, 131
Marker bar, 30
Markers and regions, 131–138
   snapping events to, 144
Mask filter
   using, 291
Masks
   and tracks, 288
   fine tuning, 290
   video, 289
Match Media button, 256
Media files
   adding to Favorites, 347
   auto preview setting, 87
   creating folders, 346
   deleting, 347
   finding, 345
   inserting, 91
   moving, 346
   opening, 86
   previewing, 87
   properties, 259
   renaming, 346
   video placement options, 92
Media Pool
   replacing media in events, 89
   using the, 88
   window, 36
metronome, 226
Microsoft Encoding wizard, 337
MIDI Clock output, 370
MIDI Time Code
   chasing, 228
   input devices, 368
   output devices, 369
   time display window, 357
Mixer, 213
   busses, 216
   preview fader, 214–215
   toolbar, defined, 214
   viewing/hiding, 213
   window, 34
Mixer setup (external), 224
Mixing multiple tracks to a new track, 187
Mixing video tracks, 285
Mouse scroll-wheel shortcuts, 41
MPEG
   rendering, 326
   saving a template, 336
   template, 336
MTC, 228
Multiple takes
   previewing, 234
   recording, 234
Mute button, 100
Muting
   all audio or video tracks, 182
   Assignable FX, 164
   busses, 220
   tracks, 181
Name, takes, 152
Naming
   busses, 221
   naming tracks, 179
Noise Gate plug-in, 209
   attack time control, 209
   presets, 209
   release time control, 209
   threshold control, 209
Non Real-Time Event FX, 202
Normal Edit Tool, 111
Normalize
   audio event, 166
   peak level, 364
OHCI 1394-IEEE cards, 371, 384
Online Help, 27
   accessing, 27
   icon, 27
PDF manual, 28
Tip of the day, 28
via the web, 28
What’s This? Help, 28
Online registration, 25, 26
Opacity envelope, 298
Optimizing previews, 253
Ordering of effects, 267
Organizing tracks, 179
Overlays
  animating, 320
  compositing modes, 295
  Safe Areas, 253
  transparency, 292
Pan/Crop, 241
Pan/Scan, 241
Panning, 102, 183
Parent track, 287
Parent/Child tracks, 285
Partial rendering, 327
Paste insert, 118
Paste repeat, 118
Pasting events, 117–119
pca format, 326
PDF online manual, 28
Peak files, 89
Perfect Clarity audio format, 326
Picture-in-Picture, 319
Pitch shift, 149
Pixel Aspect Ratio, 256
Placing media
  as takes, 91
  double-clicking, 92
  dragging/dropping, 91
  multiple files, 91
  same track, 91
  separate tracks, 91
Playback
  buffer control, 363
  interpolate cursor position control, 365
  position bias control, 365
  pre-roll buffer control, 365
  scrubbing, 104
  video, 50
Plug-in chain
  changing order, 198, 266
  changing order from Track FX dialog, 198
  creating on tracks, 195
  saving presets, 266
  video hierarchy, 44
Plug-ins
  audio, 203
  filters, 264
  generators, 279
  masks, 286
  transitions, 299
  video, 263
  window, 35
Position, Track Motion, 317
Post-roll, 232
Preference settings, 360–370
  audio tab, 363
  audio tab, advanced settings, 364
  Editing tab, 366
  External Monitor tab, 371
  General tab, 361
  routing tab, 365
  Sync tab, 362, 367
  sync tab, advanced settings, 368
  viewing dialog, 360
Pre-render Video in Loop Region, 254
Pre-roll, 233
Preset chains, 200–202
  editing, 201
  organizing, 201
  saving from existing chains, 200
Presets, saving, 304

Preview fader
  adjusting for clipping, 215
  adjusting volume, 214
  hiding/viewing, 215
  meter resolution, 215

Previews
  optimizing, 253
  partial, 254
  rendering, 102
  resolution, 254
  to media player, 105
  transitions, 303

Project playback
  entire, 103
  media player, 105
  time selection, 103

Project property settings, 358
  audio tab, 359
  ruler tab, 360
  summary tab, 358
  video tab, 359

Projects, 81
  saving, 83
  starting, 81

Properties
  events, 163
  events, setting, 163
  media file, 259
  project, 82
  project - video, 256

Proxy files, audio, 378

Punch-In, 119
Punch-in, 232
Push, 312

Q
  Quick Blur, 276
  Quick start, 81–107

R
  RealMedia (*.rm)
    commands, defined, 136
    rendering, 328
  Rebuild Peaks, 90
  Recompressing frames, 333
  Recording, 223–239
    arming tracks, 225
    choosing an active take, 235
    deleting a take, 237
    deleting multiple takes, 237
    into a time selection, 231
    into an empty track, 229
    into an event, 232
    into an event with time selection, 232
    multiple takes, 234
    previewing takes, 234
    renaming a take, 236
    selecting track input devices, 192, 227
    specifying storage folder, 238
    starting and stopping, 227
    stereo, left, right channel options, 192, 226, 227
    track setup, 192
  Redo/Undo commands, 129–130
    clearing history, 130
    multiple, 130
  Region, 133
    deleting, 134
    naming, 133
    navigating, 134
    placing and adjusting, 133
    selecting, 134
  Registering Vegas, 25
    online, 25, 26
    telephone, 26
  Remove
    All Unused Media From Project, 88
    Selected Media From Project, 88
  Removing plug-ins, 199
  Renaming a project Save As…, 83, 324
  Render As, 325
Rendering
AIFF (*.aif), 326
custom settings, 329
increasing speed of, 333
MPEG (*.mp3), 326
RealMedia (*.rm), 328
selecting a video format, 335
to new track template, 188
Video for Windows (*.avi), 327
Wave (Microsoft)(*.wav), 326
Windows Media Audio (*.wma), 326
Windows Media Format (*.asf), 328
Rendering a project, 78, 106, 325–328
audio formats, 326
controls and templates, 329
format options, 78, 106, 325
streaming formats, 328
video format, 327
Reordering tracks, 179
Resample an event, 172
Resampling
event properties, 257
explained, 258
Resampling, example, 150
Resolution and quality, 254
Reversing a video event, 173
Ripple editing, 145–149
across all tracks, 147
cutting events, 146
deleting events, 146
pasting multitrack information, 148
Trimmer, 145
Routing hardware preferences, 365
Ruler, 31
format, 349
offset, setting, 350
property settings, 360
time formats, 350
Ruler tab, 360

S
Safe Areas, 253
Saving a project, 56, 106, 323–324
options, 83
Saving As
dialog commands, 324
project, 324
Scott Studio commands, 137
Scribble Strip, 100
Scrolling, 96
Scrolling titles
Pan/Crop, 246
Track Motion, 321
Scrub control, 33
Scrubbing, 104
Selecting
all members of a group, 175
events and a time range, 114
multiple events, 111
range of events, 111
time range, 112
Selecting a video format, 335
SFAP files, 378
SFK files, 89
Shadow, 282, 318
adding, 318
modifying, 319
Shifting the contents of an event, 125
Signal flow, 43
Simultaneous Play & Record, 228, 230
Skipping, 110
Slide, 313
Slide show, creating, 248
Snap offset, 142
Snapping events, 141–144
disabling, 144
Solo button, 100
Soloing
  busses, 221
  tracks, 182
Sound editor program, 138–139
  opening from Trimmer, 158
  opening from Vegas, 139
  setting up, 138
Source Alpha, 295
Spiral, 313
Split, 314
Splitting, 122–125
  event selection, 124
  time selection, 124
Splitting events, 53
Square pixels, 256
Squeeze, 314
Starting a project, 81
Starting Vegas, 24
Status bar, 32
Streaming media commands, 136
  for RealPlayer, 136
  for Windows Media, 136
Summary tab, 358
Swap, 315
Switches, 164–169
  Lock, 165
  Loop, 165
  Maintain aspect ratio, 167
  Mute, 164
  Normalize, 166
Sync. preferences, 367
  advanced control settings, 368
Synchronizing audio with video, 51, 54
Synchronizing MIDI Time Code, 225
System requirements, 22
  common, 22
T
Takes, 151
  adding events to, 151
  changing the name of, 152
  deleting, 152
  duplicating events and, 120
Target media player, previewing on, 105
Technical support, 22
Technical support Title page
Telephone registration, 26
Text Media, 281
Text, generated
  duplicating, 283
  keyframing, 283
  positioning, 282
Time Code, 225
Time display window, 356
  changing color usage, 356
  changing time format, 356
  MIDI Time Code settings, 357
Time selection, 112
  copying, 115
  cutting, 117
  editing, 53
  recording into, 231
  with events, 114
Timecode, 382
Timeline
  moving events along, 93, 95
Timeline playback, 327
Tip of the day Help, using, 28
Titles
  automatic crossfade, 251
  Safe Areas, 253
  scrolling - Pan/Crop, 246
  scrolling - Track Motion, 321
  sequences, 283
Toolbar, 30
- adding buttons to, 354
- hiding/displaying, 352
- moving, 351
- removing buttons from, 355
- reordering buttons on, 353
- resizing, 352

Track envelopes, 182
- changing volume curves, 184
- deleting from track(s), 185
- hiding on track(s), 185

Track FX, 193–210
- adding via Plug-in Chooser dialog, 195
- adding via Plug-in Explorer window, 196
- bypassing plug-ins, 199
- Compression plug-in, 206
- creating a plug-in chain, 195
- Dither plug-in, 210
- Equalization plug-in, 204
- Noise Gate plug-in, 209
- rearranging chain order, 198
- reference, 203–210
- removing plug-ins from chain, 199

Track FX button, 99

Track Header, 31

Track Motion, 316
- glow, 318
- Picture-in-Picture, 319
- position, 317
- shadow, 282, 318

Track Number, 98

Track panning envelopes
- adding, 183

Track View, 32

Track volume envelopes
- adding, 183
- adding points, 183
- colors defined, 183
- setting points, 184

Tracks
- adding empty, 177
- arm for record button, 99

Assignable FX send, 102
Assignable FX, assigning, 191
auxiliary bus, 102
auxiliary bus, assigning, 190
basics, 177–192
bus assignment, 99
bus, assigning, 189
color, changing, 180
deleleting, 178
 duplicating, 178
 expanding the view, 181
 fader, using, 181
 FX button, 99
 height, changing, 180
 mixing to a single track, 187
 multi-purpose slider, 101
 mute button, 100
 muting, 181
 naming/renaming, 179
 Number, 98
 organizing, 179
 panning, 102, 183
 recording into, 192, 229
 reordering, 179
 scribble strip, 100
 solo button, 100
 soloing, 182
 view buttons, 98
 view options, 180
 volume fader, 101

Transitions, 297
- adding, 299
- animating, 305
- dictionary of, 307
- from auto-crossfades, 300
- from cuts, 301
- keyframing, 307
- modifying, 303
- using, 299
- window, 36

Transparency, 171
- and overlays, 292
- backgrounds, 282

Transport bar, 32, 50, 102
- reference, 104
Triggering recording from MIDI device, 228
Trim, 122
Trimmer window, 34, 154–158
   events, placing on track, 156
   mark in and out points, 156
   overview, 154
   regions and markers, adding, 157
   ripple editing, 145
   sound editor, opening from, 158
   working with, 155
Trimming events, 122
   time and event selection, 122
Troubleshooting
   Audio, 373–375
   Video, 373–383
Tutorial, 45–79
   aligning audio with video, 51, 54
   editing time selection, 53
   editing voice-over, 52
   equalization (EQ) settings, 60
   event editing, 54
   folder, copying, 45
   grouping audio and video, 55
   locking events, 52
   placing music bed, 58
   rendering the project, 78
   saving the project (*.veg), 78
   splitting an event, 53
   time selection editing, 53
   video compression settings, 79
   video placement, 48
   video playback, 50
   Video Preview window, 49
   voice-over placement, 50
   volume envelope, 58

U
Undo/Redo commands, 129–130
   clearing history, 130

V
Vegas
   creating a copy of a project, 324
   registering, 25
   renaming a project, 83
   rendering a project, 106, 325–328
   saving a project, 323
   starting, 24
Vegas Audio, 23
Vegas overview, 29–43
   Edit Details window, 34
   Explorer window, 33
   Keyboard commands, 37
   Main window, 29
   Marker bar, 30
   Media Pool window, 36
   Mixer window, 34
   Plug-ins window, 35
   Ruler, 31
   Scrub control, 33
   Toolbar, 30
   Track Header, 31
   Track view, 32
   Transport bar, 32
   Trimmer window, 34
   Video Monitor window, 35, 36
   Windows Docking Area, 33
Vegas Video, 23
Vegas windows, docking, 342
Velocity envelope, 171
Version Limitations, 23
Video capture, 84
Video compression, 79
Video events
   moving along timeline, 95
   placing, 48
   removing audio, 95
Video filters, 264
Video masks, 289
Video Motion, 316
Video plug-ins, 263
Video Preview window, 35, 49
Video property settings, 359
View buttons, 98

Volume
  Assignable FX fader, 191
  auxiliary bus fader, 190
  track fader, 181
Volume envelopes, 183–185
  adding, 58
  deleting from track(s), 185
  hiding on track(s), 185
  setting points, 59

W
  w64 format, 326
Wave (Microsoft)
  rendering, 326
Waveforms, displaying, 89
Web site
  Help, using, 28
What’s This? Help, using, 28
Window Docking Area, 33, 342
Windows Media Audio
  Microsoft encoding wizard, 338
  rendering, 326
  saving a template, 337
  template, 337
Windows Media Format (*.asf)
  rendering, 328
Windows Media streaming command, defined, 136

Z
  Zoom, 315
  Zoom Edit Tool, 97
  Zooming, 96